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1. EasyBuilder Pro Installation

and Startup Guide

This chapter explains how to install EasyBuilder Pro.

1.1.  Installation REQUIFEMENTS.......ccciiiiiiee ettt e e e e e e e e e e enaeeeeeaes 1-2
1.2.  Steps to Install EaSyBUIlAer Pro .......coooccuiiieiiciiiie ettt e e e s e e 1-3
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1.1. Installation Requirements

Software:

Download EasyBuilder Pro from CD-ROM or visit Weintek Labs, Incs website at

. The language versions include Simplified Chinese, Traditional

Chinese, English, Japanese, German, ltalian, Korean, Spanish, Russian, French, and Turkish. The

latest upgraded files can be downloaded too.

Hardware (Recommended):

CPU: INTEL Pentium Il or higher

Memory: 256MB or higher

Hard Disk: 2.5GB or higher (Disc space available at least 500MB)
CD-ROM: 4X or higher

Display: 1024 x 768 resolution or greater

Keyboard and Mouse

Ethernet: for project downloading/uploading

USB Port 2.0: for project downloading/uploading

RS-232 COM: for on-line simulation

Printer

Operating System:
Windows XP / SP3
Windows Vista

Windows 7 (32bit / 64bit)
Windows 8 (32bit / 64bit)
Windows 8.1 (32bit / 64bit)
Windows 10 (32bit / 64bit)

L—| WE!NTEK
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1.2. Steps to Install EasyBuilder Pro

1. Insert the CD-ROM into your CD-ROM drive. The computer will automatically install
EasyBuilder Pro driver. Or, you can manually execute [Autorun.exe] file under the root

directory. The installation screen is shown as the following figure.

RWE!NTEK

EasyBuilder Pro

www.weintek.com

2. Click [Install] and select the language for the installation process, and then click [Next].

(5 Setup - EasyBuilder Pro V3.00.05 =] = =

Welcome to the EasyBuilder Pro
V3.00.05 Setup Wizard
This will install EBpro ¥3.00,05 on your computer.

Itis recommended that you dose all other applications before
continuing.

Click Next to continue, or Cancel to exit Setup,

Mext = ]| Cancel

L—| WE!NTEK
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3. Ifthereis a previous version of EasyBuilder Pro on the PC, please remove it before
installation.

4. Select a folder for EasyBuilder Pro installation, or use the default folder. Click [Next].

({5 Setup - EasyBuilder Pro V3.00.05 o @ =3

Select Destination Location
Where should EasyBuilder Pro ¥3.00.05 be installed?

| Setup will install EasyBuilder Pro ¥3.00.05 into the following folder.

To continue, didk Mext, If you would like to select a different folder, dick Browse.

EED Browse...

At least 448, 5 MB of free disk space is required.

[ < Back ][ Mext = ][ Cancel ]

5. Select a start menu folder, or use the defulat folder. Click [Next].

i5! Setup - EasyBuilder Pro ¥3.00.05

Select Start Menu Folder
Where should Setup place the program's shortocuts?

= i Setup will create the program's shortouts in the following Start Menu folder.,

To continue, dick Mext. If you would like to select a different folder, dick Browse.,

EasyBullde Browse...

< Back ][ Mext = ][ Cancel
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6. Select additional tasks, for example: [Create a desktop icon]. Click [Next].

i5! Setup - EasyBuilder Pro ¥3.00.05

Select Additional Tasks
Which additional tasks should be performed?

Pro V3.00.05, then dick Mext.

Additional icons:

| Create a desktop icon

Select the additional tasks you would like Setup to perform while instaling EasyBuilder

| < Back |[ Mext = ]| Cancel |

7. Confirm all setting. To change the setting, click [Back]. To start installation, click [Install].

i5 Setup - EasyBuilder Pro ¥3.00.05

Ready to Install

Setup is now ready to beqin installing EasyBuilder Pro ¥3.00.05 on your
computer,

change any settings.

Destination location:
C:\EBpro

Start Menu folder:
EasyBuilder Pro

Additional tasks:
Additional icons:
Create a desktop icon

Click Install to continue with the installation, or dick Badk if you want to review or

< Back

[ Install

] | Cancel
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8.

9.

L—| WE!NTEK

Installation progress.

Extracting files...
C:\EBpro\project\mTV_demo.emtp

Cancel

i3/ Setup - EasyBuilder Pro V3.00.05 = SR < |

Installing ~
Please wait while Setup installs EasyBuilder Pro V3.00.05 on your computer. C

Click [Finish] to complete the installation.

-

5! Setup - EasyBuilder Pro 3.00.05 =] =

Completing the EasyBuilder Pro
V3.00.05 Setup Wizard

Setup has finished installing EasyBuilder Pro ¥3,00,05 on your
computer, The application may be launched by selecting the
installed icons.

Click Finish to exit Setup.

£
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10. The EasyBuilder shortcut can be found in [Start] » [All Programs] » [EasyBuilder Pro].

The description of each item in EasyBuilder Pro menu:

Installed file

Description

Administrator Tools

Saves the data of User Accounts, USB Security Key,
e-Mail SMTP Server Setting, e-Mail Contacts to USB
disk and import to HMI.

cMT Viewer

Supports access to cMT Server (cMT-SVR) via

network.

Easy Access

Supports access to any HMI connected to the
internet. The HMI can be operated on PC.

EasyBuilder Pro

EasyBuilder Pro project editor.

EasyConverter

Conversion tool for Data Sampling and Event Log.

EasyDiagnoser

Monitoring and debugging tool operated on HMI.

EasyPrinter

Remote screen hardcopy and backup server.

EasySimulator

Executes simulation.

EasySystemSetting

Allows updating hardware system settings by using
SD card or USB drive.

EasyWatch

On PC to monitor or set HMI and PLC address value.

Recipe Editor

Tool for setting the format of Recipe data. Users can

open Recipe data or data in the External Memory.

Release Note

Software release notes.

Structure Editor

Supports AB TAG and improve the flexibility to read /

write an object.

Utility Manager

EasyBuilder Pro management tool.

0 Note

B HMI supports downloading/uploading projects via USB cable. After installing
EasyBuilder Pro, please go to [Computer Management] » [Device Manager] to check if the

USB driver is installed, if not, please install it manually.
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2. Utility Manager

This chapter explains how to use Utility Manager.

2.1, OVEIVIEW .coiiiiiiieeieee ettt e e e e e e e e s
2.2, HMIIP, PassWord .....ccccooovrievvemieieeiiiieeeiieeee e
2.3, Editing TOOIS....uueiiiieeee et e
2.4, TrANSTOI it
2.5, SIMUIAtION oo
2.6, Pass-Through ......ccccccvieeicciiieee e
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2.1. Overview

2-2

After installing EasyBuilder Pro, double click [UtilityManagerEx] shortcut on the desktop to

start. Utility Manager is for launching several utilities and it is a stand-alone program.

Design

Analysis &
Testing

Addr

Publish

Maintenance

Data
Conversion

Run ® Edit®

@0
1

EasyBuilder Pro @

Launch EasyBuilder Pro, the HMI screen
composer/editor, to edit projects.

EasyAddressViewer @

Show supported PLC devices (or related
devices), and their corresponding operable
PLC address ranges and formats.

Simulation

Simulate a HMI on PC by On-line Simulation
(with PLC) or Off-line Simulation (without PLC).

7,

Utilities Description

Select Model

Select your HMI model. Please note that if the model is incorrect,

certain features may not work correctly.

Design

EasyBuilder Pro: Launch EasyBuilder Pro to edit projects.

EasyAddressViewer: Review the address ranges and formats of

supported PLCs.

Simulation: Simulate a HMI on PC by On-line Simulation (with PLC)
or Off-line Simulation (without PLC).

Analysis & Testing

EasyDiagnoser: On-line monitoring and debugging tool. Diagnose

the connection status between PC/HMI and PLC.

C?See “33 EasyDiagnoser”.
EasyWatch: Allows users to monitor HMI or PLC address values via

Ethernet on PC.

Cf'See “35 EasyWatch”.
Reboot HMI: Restart a HMI to its initial condition by Ethernet or

USB connection.

Pass-Through: Allows PC applications to control PLC via HMI. In this

case the HMI is an adaptor.

[\& WEINTEK
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@See “29 Pass-through”.

Publish

Download: Download project file to HMI via Ethernet.

Upload: Upload files on HMI to PC via Ethernet.

Build Download Data for SD/USB Disk:

Build the data to be saved in SD card / USB drive and then insert
the device to HMI to download the data. This feature is not
supported by cMT Series.

Maintenance

EasyPrinter, Backup/Printer Server: A backup/printer server on PC,
which receives backups from HMI and run a defined batch to
convert, or HMI screenshots to print out on PC.

Administrator Tools: Allows storing the data of [User Accounts],
[USB Security Key], [e-Mail SMTP Server Settings], and [e-Mail
Contacts] to USB. This feature is not supported by cMT Series.

If?See “36 Administrator Tools”.

cMT Viewer: Connect to a cMT-SVR machine. PC acts as a display
terminal for cMT-SVR.

Data/Event log Information: Connect with HMI via USB cable or
Ethernet to check the number of history files in HMI. This feature is
not supported by cMT Series.

EasyAccess 1.0: Control remote HMI instantly and conveniently no
matter which corners in the world you are. You can find more

information at:

Data Conversion

Database Editor: Used to edit recipe data.

¥

= Click the icon to download the document about Recipe
Database.

Easy Converter: Reads the data sampling file (.dtl) and event log file
(.evt) in HMI and convert the files to Excel (.xls) format.

@See “25 EasyConverter”.

Recipe Editor: Used to create, view, and edit recipe data.

@See “24 Recipe Editor”.

Minimize the window.

&)

Close the window.

v

Add the frequently used utilities to the toolbar at the bottom of the

window.
Run Run the selected utility on the toolbar.
Edit Delete the selected utility on the toolbar.
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2.2. HMI IP, Password

Settings
When operating HMI via Ethernet or USB cable, please set the password for HMI to protect

against unauthorized access.

Password :

[¥] Mask
Set the download password. To use masking password, select [Mask] check box.

@ Note

B Please remember the password, otherwise, while restoring HMI default settings, the
project files and data in HMI will be completely erased.

Reboot HMI
Reboot the HMI without unplugging. After reboot, the system returns to the initial state. Set

the correct IP address when rebooting HMI via Ethernet.

Data/Event Log File Information
After setting, connect with HMI to check the number of history files in HMI.

Data/Event Log File Information @

| [&-sample_HMI

12013082848
L 2,20130825.dt
3,20130824.d
L 4,20130822.d8
. 5,20130821dt

i [ GreenHouse

=8 eventlog
1. EL_20130830.evt
-~ 2, EL_20130820.evt
3. EL_20130809.evt
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2.3. Editing Tools

2.3.1.

A W INR

Build Download Data for SD/USB Disk

Build Download Data for SD/USE Disk (=23
Select the folder to save download data :
PLEASE INPUT DIRECTORY MAME !
Sources
Project
PLEASE INPUT EXOB FILE NAME !
Redpe (RW)
PLEASE INPUT RECIPE FILE NAME !
Recipe A (RW_A)
PLEASE INPUT RECIPE_A FILE NAME !
Data log
PLEASE INPUT DATA LOG FILE NAME !
User-defined startup screen
PLEASE INPUT START-UP SCREEN FILE MAME ! Browse...
——

Insert an external device (SD card or USB drive) to PC.
Assign the directory to store data.
Select the directory of the source file.

Click [Build] to create files for downloading.

Files will then be store to the inserted device for users to download to HMI without connecting

via a USB cable or Ethernet.

2.3.2.

Steps to Download Project to HMI via USB Disk or SD Card

Assume we will download data in the folder named “123” (K:\123) on an USB disk.

1.
2.
3.
4
5.

6.
7.

Insert USB (in which the project is saved) to HMI.

In [Download / Upload] dialog box select [Download].

Enter Download Password.

In [Download Settings] dialog box, select [Download project files] and [Download history
files] check boxes.

Press [OK].

In [Pick a Directory] dialog box, select directory: usbdisk\disk_a_1\123.

Press [OK].

Project will then be updated.

I__| WE'NTEK EasyBuilder Pro V5.05.02
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@ Note

B If only the history files are downloaded, it is necessary to reboot HMI to update files.

2.4. Transfer

2.4.1.

Download

Download files to HMI via Ethernet or USB cable.

Download

Firmware
Project

RW

RW_A

Recipe database

[¥]Data log

Destination :

FLEASE INPUT EXOB FILE NAME ! Browse...

PLEASE INPUT RECIPE FILE MAME ! Browse...

PLEASE INPUT RECIPE_A FILE NAME 1 Browse...

PLEASE INPUT RECIPE DATABASE FILE NAME ! Browse...

PLEASE INPUT DATA LOG FILE NAME !
PLEASE INPUT DESTINATION FOLDER. NAME !

Browse...

Browse...

PLEASE INPUT LOGO FILE NAME ! Browse...

10 I |

Connection
@ Ethernet () USB cable
ﬂ P MName ﬂ
HMI Mame: -
Search All
Reboot HMI after download
[¥] Reset recpe [¥] Reset recipe database [ elete startup screen
Reset event log Reset data log Reset operation log
e oo (o) e
Setting Description
Firmware Update HMI kernel programs. The firmware
must be downloaded at the first time
downloading data to HMI.
Project Select an .exob project file.
RW /RW_A Select a .rcp recipe file.

Recipe database

Select a .db file of Recipe Database.

Data log

Select the data sampling folder in HMI and then

I__| WE!NTEK
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select a .dtl file.

Startup screen

Download a .bmp bitmap file to HMI. After HMI
is rebooted, this .bmp file will be shown before

project starts.

Reboot HMI after
download

Automatically reboot after download.

Port No. Setting

Select the port by which to download the

project file via Ethernet.

Reset recipe / recipe
database / event log /
data log / operation log
/ Delete startup screen

Erase the selected files in HMI before download.

2.4.2. Upload

Upload files from HMI to PC via Ethernet or USB cable. Click [Browse] and assign the file path

before uploading.

Upload

Project

RWW

RW_A

Recipe database
Operation log
Data log

Event log

(=)

PLEASE INPUT EXOB FILE NAME |
PLEASE INPUT RECIPE FILE NAME !
PLEASE INPUT RECIPE_A FILE NAME |
PLEASE INPUT RECIPE DATABASE FILE NAME !
PLEASE INPUT OPERATICN LOG FILE NAME | Browse...

PLEASE INPUT DATA LOG FILE NAME !
PLEASE INPUT EVENT LOG FOLDER NAME !

[T use csv (Comma Seprated Values) format to save data/event log files,

PLEASE INPUT EM FOLDER NAME !
EM file location : () 5D card (@) USB disk
Connection
(@ Ethernet () USB cable
ﬂ IF MName ﬁ
HMI Name: -
Search
Search All
Port Mo, Setting... Password @ =ssxs* [¥] Mask I Upload ] [ Exit

I__| WE!NTEK
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Setting Description

Event log Upload the .evt file in HMI to PC.

Extended Memory Upload the .emi file saved in SD card or USB disk
(EM) to PC.

or For information about [Project], [RW / RW_A], [Recipe database] or [Data log], see “2.4.1

Download” in this chapter.

@ Note

B The file will be uploaded to PCin .exob format. Please decompile it into editable .emtp file
first and open the .emtp file in EasyBuilder Pro.
B To upload the historical files saved in the external device, please use FTP. See “32 FTP

Server Application” for more information.

2.5. Simulation

2.5.1. Off-line Simulation / On-line Simulation

Off-line simulation: Simulate project operation on PC without any connection.

On-line simulation: Simulate project operation on PC and PLCs are directly connected with PC.

@ Note

B When using [On-line simulation] on PC, if the target device is a local PLC (the PLC directly
connected to PC), there is a 10 minutes simulation limit.
Before executing On-line/Off-line Simulation, please select the source .exob file.

When executing On-line/Off-line Simulation, right click to use these functions:

Qo ..

Run EasyDiagnoser

Screenshot

Setting Description

Exit simulation Stop simulating.

Run EasyDiagnoser To monitor current communication status.
Screenshot Capture and save current screen image as a

picture file in the screenshot folder under the
installation directory.
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2.6. Pass-Through

This function allows the PC application to connect PLC via HMI. In this case, the HMI works like
a converter.

Pass-through provides two modes: [Ethernet] and [COM port].

When using [Ethernet], please install the virtual serial port driver first.

r For more detail, please refer to “Chapter 29 Pass-Through Function”.
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3. Create an EasyBuilder Pro

Project

This chapter explains the basic steps to create an EasyBuilder Pro project.

N R O V=T oV =1 PP PUUPPPPI 3-2
3.2, Create @ NEeW ProjeCt FIle ...t e e e 3-2
3.3. Save and Compile the Project File ...t 3-4
3.4.  Run On-Line or Off-Line SimMuUIation........cccoviiiiiniiiiiieecieccecce e 3-5
R T o] |V, W BV T Y= TP TP PP PPUPPOPPI 3-5
3.6. Download the Project File to HMI ........ooiieiiiiieeeee et 3-6
3.7. Upload the Project File from HMI.........ccoooiiiiiiiiee e 3-11
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3.1. Overview

The following is the process of creating a project.

1. Create a new project file.

2. Save and compile the project file.
3. Run On-line or Off-line simulation.
4. Download the project file to HMI.

The following describes each process.

3.2. Create a New Project File

1. Launch EasyBuilder Pro and open a new file.
2.

Select [Model] and select [Use template] check box.

EasyBuilder Pro (Copyright ¢ 2006 Weintek Lab., Inc) (=23
Welcome to EasyBuider Pro. Please select your model. L‘I
Model : [eMT3105 (800 x 600) -
Display mode : [Landsmpe v]
Use template (template_800x600.emtp)
[ oK ] ’ Cancel ]
3. Click [New].
System Parameter Settings | §3_|
| PrintewBackup Server | TimeSyneDST | eMal | Recipes |  Cellular Data Network
Device | Model | Gemeral | SystemSetting | Security | Non-ASCIIFonts | Extended Memory
Device list : What's my IP ?
Name Location Device type Interface I/F Protocol
(3 Local HMI Local HMI eMT3105(800.. - |- ]
CEF . »
[ New... ][ Delete ][ Security... ]
4. Configure parameters.

[\& WEINTEK
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Device Properties
Name : | Mitsubishi FX0S/FXON/FXLS/FX1N/FX2
) HMI @ PLC
PLC type : | Mitsubishi FEOS/FEON/FE 1S/FE LN/FH2 |

IV.1.4U, MITSUBISHI_FXOM.e30

7

PLCIF : [R5485 4W

* Support communications between HMI and PLC in pass-through mode
* Set LW-9903 to 2 to enhance the speed of download/upload PLC program in pass-through mode

COoM : |CDM1 (9600,E,7,1)

PLC default station no. : g
[] Default station no. use station no. variable

[7] Use broadcast command

Interval of block pack (words) : D

Max. read-command size (words) @ |32

Max. write-command size (words) : |22

Settings...

[ 0K ] l Cancel
5. A new device is added to the [Device List].
"System Parameter Settings -‘
Printex/Backup Server I Time Sync /DST | e-Mail | Recipes I Cellular Data Network
Device | Model | Genersl | SystemSetting | Security | Non-ASCIIFonts | Extended Memory
Device list : What's my [P ?
No. Name Location Device type Interface I/F Protocol
{LocalHMI™ | Local HMI Local eMT3105 (800 ... - -
Y Cocai e |
6. Create an object, take Toggle Switch @ asan example, and set the address.

[\& WEINTEK
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7.

New Toggle Switch/Bit Lamp Object
Genersl | Seourity | Shape | Label |
Comment :

Bit Lamp @ Toggle Switch

V| Read/Write vse different addresses
Read address

PLC : | Mitsubishi FXOS/FEON/FE1SFEINFE2
=0

Address : E X

| Invert signal

Write address :
PLC: lMitsubishi FEOS/FHON/FEISFLINFEL
Address: [y ,“ 0

v |[ Settings... |

Write when button is released

Attribute
Switch style : [Set OFF v

Place the object in the edit window. A project is now created.

EasyBuilder Pro : EMTP1 - [10 - WINDOW_010] fole =
i

=l 2 SR % Lidaeka REERTH LS EEE S A

Edit View Option Draw Objects Energy [IoT Library Tools Window Help - X

10- WINDOW 010 X b

=) v X 4

i Object list ha

3 R
4
5:PLC Response
6: HMI Connection
7 : Password Restriction
8
9
@10 : WINDOW_010

X=128 Y

f

1

3.3. Save and Compile the Project File

1.
2.

In EasyBuilder Pro toolbar click [File] » [Save] to save the .emtp file.
In EasyBuilder Pro toolbar click [Tools] » [Compile] to compile .emtp file as .exob file,

which could be downloaded to HMI. This also checks if the project can run correctly.

@ Note

|
3.

L—| WE!NTEK

For cMT-SVR, the project file extension is .cmtp, and the compiled file extension is .cxob.

To use multiple languages, all languages must be configured in Label Tag Library first.
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When downloading the project to HMI, select the needed languages only. A successful
compilation is shown in the following figure.

Compiling @I
Project name : C:\Users\user\Desktop\EMTP2.emtp
EXOB file name : C:\Users\user\Desktop\EMTP2.exob
EXO0B password : (used in decompiler) [l Decompilation is prohibired
Select the languages used on the HMI
Startup language after redownloading the project : |Language 1 -
[#] Language 1 [#]Language 2 [#]Language 3 [¥#]Language 4 [¥lLanguage 5 (¥ Language 6
Language 7 [¥|Language 8 Language 9 Language 10 Language 11 Language 12
Language 13 Language 14 Language 15 Language 16 Language 17 Language 18
Language 19 Language 20 Language 21 Language 22 Language 23 Language 24
Mote : A maximum of 8 lBnguages can be selected simultaneously.
Double click error messages to modify the attributes of relative objects !

3.4. Run On-Line or Off-Line Simulation

Z0ff-line simulation: Simulate project operation on PC without connecting any device.

&= 0On-line simulation: Simulate project operation on PC without downloading the project to
HMI. The PLC is connected to PC, please set correct parameters.

0 Note

B When using On-line Simulation on PC, if the target device is the PLC directly connected to
PC, there is a 10-minute simulation limit.

3.5. cMT Viewer

This program connects to cMT Server (cMT-SVR) via network, similar to cMT Viewer App on
iPad. To run this program, execute cMTViewer.exe under installation directory. Or, in
EasyBuilder Pro toolbar, click [Tools] » [cMT Viewer].

I__| WE'NTEK EasyBuilder Pro V5.05.02
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., cMT Viewer E@@

0150122102357

This is"Start Button". Drag move |t

Project

Running projects | 3 ‘ x :
will show up here | Search ', History

Setting

iOS App related
preferences.
Such as
preventing your
iPad from
sleeping.

Maximum 3 running || f ;
projects. \ Search for cMT Previously

|| Serverson LAN or connected
\“. connect to an ‘ projects are
|| assigned IP stored here.
\‘ Address. ‘

(Each cMT Server runs
| and contains only one
Project.)

Setting Description

Start Button Click to enter the main configuration screen, users
can drag and move the button.

Project Running projects will show up here. Maximum 3
running projects. Each cMT Server runs and contains
only one project.

Search Search cMT Servers on LAN or connects to an
assigned IP Address.

History Previously connected projects are stored here.

System Related preferences, such as using portrait mode.

3.6. Download the Project File to HMI

The following explains four ways to download the project file to HMI.

@ Note

B For cMT-SVR, only the way described in 3.6.1 is available.
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B When download project file to HMI using mini USB cable, please do not connect PLC

simultaneously, in order to avoid noise from PLC interfering with HMI.

3.6.1.

Configure in EasyBuilder Pro

1. In EasyBuilder Pro toolbar, click [Tools] » [Download]. Make sure that all the settings are

correct.

2. Select [Ethernet], set password and HMI IP.

Download

(@ Ethernet

IP:

Runtime

|| Use system settings file

Reset recipe
Reset recipe database

4 7 IP HMI Mame

182.168.1.100 -

Font files

* Necessary if update runtime or execute download first time.,

[] Use user-defined startup screen

* Supported 05 version : 20150131 or later

[] Synchronize HMI clock with PC

Reboot HMI after download

[] Automatically using current settings to download after compiling

Password/Port no. of download/upload :

I

, 7
EasyAccess 2.0 Discizilly

[] Delete user-defined startup screen
Reset event log
Reset operation log

Reset data sampling
Reset string table

Setting Description

Firmware Select the check box to update the HMI kernel
programs. If this is the first time downloading file or
EasyBuilder Pro version is updated, please download
the firmware before downloading files to HMI.

Font files

Download the font used in the project.

EasyAccess 2.0

Download EasyAccess 2.0 driver to HMI. (This option
is available only for MT8000iE models. For other
models, EasyAccess 2.0 will be automatically

downloaded.)

Use user-defined
startup screen

Use the picture selected by user as the startup

screen. The picture format must be .bmp.

L—| WE!NTEK
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?re system settings Download the system settings file to update
ile
hardware settings.

Synchronize HMI Synchronize HMI time with PC time when
clock with PC

downloading project file.

Reset recipe/

event log/

data sampling/ The selected files will be erased before
recipe database/ _

operation log/ downloading.

user-defined
startup screen

Reboot HMI after HMI will reboot after the downloading process is
download

done.

Automatically
using current
settings to to the latest target HMI. The way to enable this
download after
compiling

0 Note

B For cMT-SVR, the [Firmware] and [Font files] check boxes are not available.

The system will compile the project and download it

function is described in the following part.

[Automatically using current settings to download after compiling]

If this check box is selected, EasyBuilder Pro will compile the project and download it to the
latest target HMI.

1. In EasyBuilder Pro toolbar, click [Option] » [Preferences].

2. Select [Automatic save and compile when download and simulate] check box.
Preferences (2

Display : [¥] Object ID

[ pisplay Common Window objects on Base Windows

[[] wsing function key to make shape library ohject

[¥]{ Automatic save and compile when downioad and simulate!

[7] Generate backup of project file before save

[7] Automatically make used bitmaps and shapes into the project library

[ OK l I Cancel

3. In EasyBuilder Pro toolbar, click [Save] and then [Download].

4. In the dialog box, select [Automatically using current settings to download after compiling]
check box.

5. Click [Download].

6. When finished, next time when [Download] is clicked, EasyBuilder Pro will automatically

compile and download the project to the latest target HMI.
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3.6.2. Use HMI Name

1. Go to [System settings] on HMI and then set HMI name first.

Network\ TimefDate" Securit  HMI name\getting\gg‘\

System settings

HMI namei

i Cancel l i Apply | igK 7~ I

2. On PC, select the HMI name and start downloading. To use [Search], enter the HMI name

first to search for the HMI. [Search all] searches for all HMIs in the same subnet network.

Download

==

Runtime

* Necessary

(@ Ethernet

4 1P HMIName

[] Synchronize HMI clock with PC
Reset recipe
Reset recipe database

(71 USB cable

Password/Port no. of download/uplead :

b
HMI Name: test -
Search All
" 7
[¥] Font files What's my IP 2

if update runtime or execute download first time.

[] Use user-defined startup screen

[] Use system settings file
* Supported 05 version : 20150131 or later

[] Delete user-defined startup screen
Reset event log

Reset operation log Reset string table

Reboot HMI after download

[] Automatically using current settings to download after compiling

Stop

Reset data sampling

I__| WE!NTEK
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3.6.4.

3.6.3. Use USB cable
Download @
") Ethernet @) USB cable Password :
[¥] Runtime [¥] Font files

* Necessary if update runtime or execute download first time.

[] Use user-defined startup screen

[] Use system settings file

* Supported 05 version : 20150131 or later

Reset recipe
Reset recipe database

Reset event log
Reset operation log

Reboot HMI after download

[] Automatically using current settings to download after compiling

Download Stop

[] Delete user-defined startup screen

Reset data sampling
Reset string table

Exit

Select USB cable to download project to HMI. The way of setting is same as “3.6.1 Configure in

EasyBuilder Pro”. Before downloading via USB cable, please make sure the USB driver is

installed. Go to [Computer Management] » [Device Manager] to check if USB driver is installed.

If it is not installed, please refer to

Use USB Drive or SD Card

to install manually.

The following explains how to download project file by using USB drive or SD card.
1.  On EasyBuilder Pro toolbar click [Tools] » [Build Download Data for SD / USB Disk].

USE Disk/CF Card/SD Card Data
Select the folder to save download data :

H:\

Use system setting (OS version 20131106 or ater supports only)
System setting file location :

[ Build

J

System Settings...

=5

Browse...

Browse...

L—| WE!NTEK
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2. Insert an external device, such as SD card or USB disk to HMI.

3. Select [Download] and enter password.

Download/Upload

Download Download Settings =
Upload Password: ||
Restart project and exit w
¥ Download project files
Load System Setting |7 Download history files
Cancel l_ Clear history files
Stop after download/upload
Time remaining 4

4.  After password is confirmed, it will show the directories in the external device. (pccard: SD
Card; usbdisk: USB Drive)

Pickapirectory P
Directory: |/usbdisk/disk_a_1
#3 pccard
=Jusbdisk
disk a 1
Imt8000ie

oK /‘r Cancel

5. Select the directory that contains project, and then click [OK] to start downloading.

@ Note

B Please select the parent directory of the generated files when downloading. For the
structure above, please select disk_a_1, not mt8000ie.

B You may click [System Settings] to save the hardware settings configured in EasyBuilder
Pro into SD card or USB disk, and then download the settings file to HMI. See “4 Hardware

Settings” for more information.

3.7. Upload the Project File from HMI

1. On EasyBuilder Pro toolbar click [Tools] » [Upload].
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2. Set HMI IP, HMI model, project location and project name, and then click [Upload].

Upload [E|
@ Ethernet ) USB cable Password/Port no. of download/upload :
4 P Name I
IP: 182.168.1.100 -
W hat's mey IF 7
HMI model : | eMT3070 -
Project location @ C:\EMTP1.exob
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4. Hardware Settings

This chapter explains HMI settings.

4.1.
4.2.
4.3.
4.4,
4.5.
4.6.

OVBIVIBW ...ttt ee ettt e e e e ettt et e e e e e sttt e e e e e e s e anbe et eeeeeesesanssseeeeeeeeessannnrnenaeaeens 4-2
4@ 31 2o o £ TOPRRRRTRR 4-2
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SYSEEM RESEE it 4-3
A €= 0 0 T Lo Yo | o - SRR 4-4
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4.1. Overview

This chapter discusses the HMI settings.

It-l Click the icon to download the cMT-SVR User Manual if needed.

Please confirm your internet connection before downloading the document.

4.2.1/0 Ports

The I/0O ports are different from one HMI type to another; please see the relevant datasheet

for more information.
The 1/0 Ports include:

SD card slot: Download / Upload project via SD card, including recipe transfer, event log,
data log...etc and to backup or record history data.

COM Port: Connects PLC or other peripheral devices. The type of serial port include:
RS-232, RS-485 2W, RS-485 4W, and CAN Bus.

Ethernet: Download / Upload project including recipe transfer, event log, data log...etc.
Connects to Ethernet devices, such as PLC, laptop.

USB Host: Supports USB devices, such as mouse, keyboard, USB disk, printer, or barcode
device.

USB Client: Download / Upload project including recipe transfer, event log, and data

log...etc.

In addition, Weintek provides [FLZ232000 Multi-Connector Cable] and [FLZ485000

Multi-Connector Cable] to expand the COM port for easier operation.

For the first time operating HMI, please complete the following system settings. When finished,

the project files designed using EasyBuilder Pro can be used on HMI.

4.3. LED Indicators

The LED indicators on the HMI indicate:
Models: MT8121XE, MT8150XE, MT8121iE, MT8150iE

LED Description

PWR (Orange) Indicates power status.

CPU (Green) Blinks when read/write Flash Memory.

COM (Blue) Indicates COM port communication status, blinks
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during communication. When communication is
good, it may stay on. (Not including network
communication)

Other Models:

LED Description
PWR (Orange) Indicates power status.
CPU (Green) Indicates CPU status. If it blinks or goes out, there

may be a CPU error.

COM (Blue/Red) Indicates communication status, blinks during

communication. When communication is good, it

may stay on.

4.4. System Reset

Each HMI is equipped with a reset button and a set of DIP switches. When using the DIP
switches to change modes, the corresponding functions will be triggered. If system password is
lost or forgotten, see the following steps to restore factory default.

1. Flip DIP Switch 1 to ON and the rest to OFF, and then reboot HMI. HMI will switch to touch
screen calibration mode.

2. A “+” sign appears on the screen, touch the center of the sign, after all 5 signs are touched,

+” disappears and the touch screen parameters will be stored in HMI system.

3. After calibration, confirm to restore the default password, select [Yes].

4. Confirm to restore the default password again by typing [yes] and clicking [OK]. The
project files and history records stored in HMI will all be removed. (The default Local
Password is 111111. However, other passwords, such as Download/Upload passwords
have to be reset.)

The following lists the DIP switch settings of different models. Please see the relevant

installation instruction.

eMT / i

Dip Switch OFF OFF OFF Touch Screen Calibration Mode
N OFF ON OFF OFF Hide HMI System Setting Bar
HHHH OFF OFF ON OFF  Boot Loader Mode
! OFF OFF OFF ON Reserved

OFF OFF OFF OFF Normal
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0 Note

B The state of DIP Switch 4 on each unit may be different. If it should be ON when out from
factory, the Dip Switch 4 would be set ON and cut off. If it should be OFF, the Dip Switch 4
would be set OFF but the switch is not cut.

mTV

Dip Switch ON ON Restore factory default
H B ON  OFF Hide system setting bar
OFF ON Boot loader mode

OFF OFF Normal mode

cMT-SVR

Dip Switch ON Restore factory default
H B ON  OFF Restore Ethernet IP Settings
OFF  ON Boot loader mode

OFF OFF Normal mode

4.5. System Toolbar

After rebooting HMI, you can set the system with [System Toolbar] at the bottom of the screen.
Normally, this bar is hidden automatically. Only by touching the arrow icon at the bottom-right
corner of the screen will the System Toolbar pop up. From left to right the icons are: System

Settings, System Information, Text Keyboard, and Number Keyboard.

How to hide HMI System Setting Toolbar:

® When [DIP Switch 2] is set ON, the system setting toolbar is disabled. When set OFF; the
system setting toolbar is enabled. Please restart HMI to enable/disable the toolbar.

® For mTV Series, flip DIP Switch 1 to ON to hide system setting toolbar.

® System register [LB-9020] can also enable/disable system setting toolbar. When [LB-9020]
is set ON, the toolbar is displayed, and set OFF to hide the toolbar.

4.5.1. System Setting

Set or modify system parameters. Confirm password for security first. The factory default
password is 111111.
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Network

Netwcrk\Tlme/Date\ Secumtv\v\me\\r semnq‘\o

When downloading project file to HMI via Ethernet,

(€ Obtain an 1P Address Automatcally set the correct IP of the target HMI. You can obtain
@ IP address get from below an IP address automatically or enter the IP address
Paddress:  [102|[168 [t |[s54 manually. To use Email and EasyAccess2.0, please set

Subnet Mask: 255 |.|255 |.|255 |0

-kl ekl el G correct DNS address.
Ry 192|168 [1  |254

DNS address: g s s s

Prev | MNext | Cancell App\vl oK /Il

Time / Date

etworl g ime, ate ecun \[Y‘bme%e | ] \T\ .
Nebnark Time/DeteSeariy e Set HMI local time/date.

8 g Day: |8 éi
Week:@
12:3 Sec:

2013 & Mon

Year:

Mir:

285

| Prev | Next | Cancel | i Apply | 10K /Il
Security

Network' Tlme/'Date\ Securltv\n‘\ame\sett\ng\wq\

Password protection, the default is 111111. Please
Local Password | click the buttons to set the passwords, and finish

Pmr——— password confirmation.

[Password for entering system]

Download Password |

[Password for uploading project]

Upload (History) Password

[Password for downloading project]

[Password for uploading history data]

| Prev | Next | Cancel | i Apply | 10K /Il
History

Network' Tlme/Date‘ Se H\story\me‘\\r semnq‘\o

Clears history data in HMI.

| Clear Recipe

|_ Clear Operationlog

| Clear Eventlog

I Clear Data Log

Clear |

Prev | Next | éCanceIél Apply K < |
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System settings B

Network' Time/Date\ Sec HMI mame\semnq\nq\

HMI name: |Default HMI

! Prey | Next | Cancel | Apply | oK /Jl

System settings =

Network' Tlme/Date‘ Se 0OS settmg\r semnq‘\o
Upagrade

Upgrade OS

Portrait Mode

0 C o0 |C 180 270

(It will take effect at next reboot)

Prev | Next | Can 1| Apply | OK /’l

System settings B

Network Time/’Date\ Sec  WNC server setting\

Start VNC single-connection

Start VNC multi-connection

Stop/NE ‘

VMNC login password |

Prev | Next | Cancel | Apply | OK ”l

L—| WE!NTEK

HMI name
Set HMI name to be used when download/upload

project.

Firmware setting

[Upgrade OS]

Upgrade firmware. Please do not turn off or unplug
HMI during OS upgrade process. For more details,
see the instruction about OS upgrade of the model
used.

[Portrait Mode]

Set screen orientation mode. After changing the
mode, reconnect HMI to power supply, for the
setting to take effect. That is, disconnect all power
from HMI, and then connect again. If portrait mode
is used (90 or 270 degree), the project must be
designed for portrait mode, otherwise it cannot be
correctly displayed.

VNC server

Remote HMI monitoring and controlling via
Ethernet.

[Start VNC single-connection]

Allows connection with one VNC client.

[Start VNC multi-connection]

Allows connection with multiple VNC clients.
Connecting more VNC clients may slow down the
communication speed.

Please see the settings steps in the later part.

EasyBuilder Pro V5.05.02
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System settings =

Network' Tlme/'Date\ Sec  VNC Miscellaneous
Backlight

Brightness

Download setting

V¥ Popup download window

¥ Restart after download/upload

| Prev | Next | Cancel | i Apply | 10K /Il

Network' Time/Date' Secur’ _ VNr Misc Z\IESS ;.D\

" Hide mouse cursor

Enable [Reset HMI to default] button
in calibration mode

FTP client can modify USB/SD data

Prev | Next | Cancell Applyl oK /Il
Systemsettings P4

Network' Tlme/Date‘ Se VN EasyAccess 2.0

EasyAccess 2.0 Is activated

ACCOWRE ¢ |

password |

HWlkey =YCTSE500-S5BN-JOWE
-VSH7-42A4-NVBMEWHH

i Proxy | IEEEE | PACHVERS |

Prev | Next | Cancell Apply | OK e |

Miscellaneous

Rotary switch for adjusting LCD brightness.
[Popup download window]

If selected, after inserting USB disk or SD card to

HMI, the Upload / Download dialog box is displayed.

[Restart after download/upload]
If selected, restarts HMI automatically after
uploading / downloading project.

Misc 2

[Hide mouse cursor]

If selected, the mouse cursor will be hidden.
[Enable [Reset HMI to default] button in calibration
mode]

If selected, when the operator presses and holds
anywhere on the screen for more than 2 seconds
during HMI startup, the touch screen calibration
mode will start. After calibration, [Reset HMI to
default] option shows.

[FTP client can modify USB/SD data]

If selected, USB/SD data can be modified using FTP.
[Modify HMI ports]

Change the port number for Upload/Download and
FTP.

EasyAccess 2.0

Activate EasyAccess 2.0 service.

The following steps explain how to set VNC server.

1.

2.
3.

Enable HMI VNC server, set password.

Install Java IE or VNC Viewer on PC.

Enter remote HMI IP in Internet Browser. Or, in VNC Viewer enter remote HMI IP and

password.

L—| WE!NTEK
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SR WM MR NSARG TRT N >

Ot7- O HNEFG Prefrmmnr @ 3-587 & - °

P01 8] My 192160 3 v QoE >

L.
REAL

Vi ’

VNG Viewer Free Eolon 41
Copyright (C) 2002- 2008 ReaMNC LY.
Sae 105 S reabnc COM or MISMABEN 6N VNG

DL @ et

0 Note

B [f there is no activity of VNC client for more than one hour, HMI system will log out

automatically.
4.5.2, System Information

Network: Displays network information & HMI IP.

rmation (Default HMI)

Version: Displays HMI firmware version and model type.

4.6. EasySystemSetting

EasySystemSetting allows updating hardware system settings by using SD card or USB drive.
The feature is available for HMI OS version 20131106 or later.
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fo) [System Setting] Editor @
Current local password : 111111
o bl
Network
Clear History HMI name : Default HMI
VNC Server
Download Back ||ght |15 -
Time offset : hour(s)
Portrait mode : degree(s)
Import... || FExport... ||  Defaut |
Setting Description
General [HMI name] Enter HMI name.
[Back light] Adjust LCD backlight brightness.
[Time offset] Set the HMI RTC with offset.
For example, if the current RTC time is 15:00:00, and
the time offset is set to -3, the updated time will be
12:00:00.
[Protrait mode] Set the display mode.
Import Import and edit an existing .conf file.
Export Export the configured data to a .conf file.
Default Restore default.

The following explains how to update HMI IP address by using SD card or USB drive.

1. On EasyBuilder Pro toolbar click [Tools] » [Build Download Data for SD / USB Disk], and

then select [Use system setting] check box.

USB Disk/CF Card/SD Card Data ==

Select the folder to save download data :

)

Use system setting (OS5 version 20131106 or later supports only)
System setting file location =

Browse...

’ Build ] l System Settings... ]

2. Click [System Settings] button to open [System Setting] Editor dialog box. Specify HMI

network information as shown in the following figure.

I__| WE'NTEK EasyBuilder Pro V5.05.02
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fo [System Setting] Editor
Current local password : 111111
Password
General V1 Enable
Clear History CI DHCP
VNC Server IP: 192 . 168 .
Download Mask - 0 . 0
Gateway : o .0
CIDNS :
’ Import... ” Export... “ Default ]

. 100

3. Click [Export] to generate a “systemsetting.conf” file.

4. Click [Exit] to leave EasySystemSetting.
5. Click [Build] button in [USB Disk/CF Card/SD Card Data] dialog box to generate the file for
download by using SD card or USB disk.

6. Insert the storage device that stores the download file to HMI and the Download/Upload

dialog box appears.

Download/Upload

Download

Upload

Restart project and exit

| Load System Setting |

Cancel

Stop after download/upload

Time remaining 3

7.  Press [Load System setting] and then the [Download Config Settings] message appears.

The project file will be updated after finishing system settings.

L—| WE!NTEK
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5. System Parameter Settings

This chapter introduces the system parameter settings.

5.1.
5.2.
5.3.
5.4.
5.5.
5.6.
5.7.
5.8.
5.9.

5.10.
5.11.
5.12.
5.13.

OVBIVIBW ...ttt ee ettt e e e e ettt et e e e e e sttt e e e e e e s e anbe et eeeeeesesanssseeeeeeeeessannnrnenaeaeens 5-2
DIBVICE .ttt ettt ettt e e e e e s ettt e e e e e s e rrr et e e e e e e e e nnrreeeeeeeeaeann 5-2
1 oo 1= D PP PP PPRTPPPPRO 5-11
(CT=T 1] - | PP UUPOPPPPRROPPPPPRI 5-14
SYSEEM SELHING «oiiiiiiiiii 5-17
L =To{ U1 g1 AV 5-19
0] o | PP P PR POPRPRPPRRRRRPRPRt 5-22
[ T=T Yo [=Te Y/ =T o' o] o VU PRUPRR 5-23
PriNter / BaCKUP SEIVEN........uviieie ettt et e e e are e eeaaeeeneeas 5-25
THMIE SYNC./DST ettt ettt e et e e et e e e te e e e be e e e beeesabeeesabeeeeaseeeaaseesnseeenrens 5-26
[ 1V T D PP PSP UPPRROPPPTRRUPPPPRIN 5-27
=0l o TN 5-29
Cellular Data NETWOIK ...cooeiieeeeeeee et e s e s eaee e e e 5-31
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5.1. Overview

Launch EasyBuilder Pro, in the main menu select [Edit] » [System Parameters] to open the
[System Parameter Settings] dialog box. System Parameter Settings are divided into several

tabs as shown in the following figures. These tabs will be introduced respectively in this

chapter.
eMT, iE, XE, mTV Series
Systemn Parameter Settings @
| Extended Memorys I Printe/Backup Server I Time Sme DET I e-Mail I Recipes
Dievice | Model I (reneral I Swstem Setting I Security I Font
Device list: W hat's ey TP 7
Mame Location Device type Interface IiF Protocol

¥ Local Hil Local HHI Local MT8O7OEMTE.. [- [ |

1 [l | +

[ Hew ... ][ Delete ][ Security... ]
cMT Series
Systemn Parameter Settings @
Extended Memory |  Time®wne/DST | eMal |  Resipss |  Cellular Data Network
Device | Madel I (General I Systemn Setting I Security I Font Mapping
Device list: W hat's ey TP 7
Mame Location Device type Interface IiF Protocol

4| 11 | [3

[ WewHMI. [ NewPLC.. Delete

5.2. Device

Parameters in this tab determine the attributes of each device connected with HMI. The device
can be a Local / Remote HMI / PLC. When creating a new project file, there is a default device
"Local HMI" which indicates the HMI that will be updated and programmed. To change the
relevant device settings, click [System Parameter Settings] » [Settings] to open [Device

Properties] dialog box.
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5.2.1. How to Control a Local PLC

n i, | PLC Device

HMI
“Local PLC” means the PLC is connected to the local HMI. To control/connect a Local PLC, add
this type of device first. Click [System Parameter Settings] » [New] to open [Device Properties]
dialog box. For example, when connecting MODBUS RTU as a Local PLC:

Device Properties
Name :
) HMI @ PLC
Location : Settings ...
PLC type : MODEUS RTU [»]
V.2.50, MODBUS_RTU.230
PLCIF : [Rs-232 -]

* Support communications between HMI and PLC in pass-through mode
* Set LW-9903 to 2 to enhance the speed of download/upload PLC program in pass-through mode

COM : COM1 (9600,E,8,1) Settings...

PLC default station no.: 1
[T Default station no. use station no. variable
[Tl Use broadcast command

How to desiznate the station no. in object's address ?...

Interval of block pack (words) : |5 - [ Address Range Limit... ]
Max. read-command size (words) : (120 v [ Conversion... ]
Max. write-command size (words) :

[ OK H Cancel ]
Setting Description
Name The name of the device.
HMI / PLC In this example the device used is a PLC, so select [PLC].
Location Select [Local] or [Remote]. In this example the PLC is

connected to the Local HMI, so select [Local].

PLC type Select the type of the PLC.

PLCI/F The available PLC interface: [RS-232], [RS-485 2W], [RS-485
4\W], [Ethernet], [USB], and [CAN Bus].
® |[f the interface used is [RS-232], [RS-485 2W], or

[RS-485 4W], configure communication parameters

by clicking [Device Properties] » [Settings] and then
[Com Port Settings] dialog box opens.
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COM Port Settings

COM : (20#117- Timeout (sec) : 107'
Baud rate : Qﬁﬂﬂiv Tumn around delay (ms) : 0
Data bits : |7 Bits - Send ACK delay (ms) : 0

Parity : E\.reniv Send RESET when power on : Dsahleiv

Stop bits : |1 Bit -

The number of resending commands : |0 -

* 0S5 version 20120920 or later support 14400 baud rate | 0K \ | Cancel |

Timeout

If the communication has been disconnected for more

than preset time limit configured in [Timeout] (in sec),

Window No. 5 will pop up and show “PLC No Response”

message.

Turn around delay

While sending the next command to PLC, HMI will delay

the sending according to the time interval set in [Turn

around delay]. This may influence the efficiency of the

communication between HMI and PLC. Default value is

“0”.

Note: If the PLC used is SIEMENS S7-200 Series, it is

recommended to assign “5” to [Turn around delay] and

“30” to [Send ACK delay].

® |If the interface used is [Ethernet], click [Device
Properties] » [Settings] and the [IP Address Settings]
dialog box opens. Please set correct PLC IP address

and port number.

IP Address Settings

IPaddress: 192 . 168 . 1 . 100

Port no. : 500

Timeout (sec) : [1.0 - Tumn around delay (ms) : 0

Send ACK delay (ms) : 0 Parameter 1: 0
Parameter2: 0 Parameter3: 0
The number of resending commands : | g -
[ oK ] | Cancel ‘

® |[f the interface is [USB], no further setting is
required. Please check the settings in [Device
Properties].

® |If the interface is [CAN (Controller Area Network)
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Bus], please see “PLC Connect Guide” for “CANopen”

and import the .eds device file.

PLC default The default station number for PLC address if the PLC
station no. station number is not included in the address. PLC station
no. can be set in PLC address. The address format:
ABC#DEFGH
ABC stands for PLC station number and ranges from 0 to
255. DEFGH stands for PLC address. And the “#” sign
separates the station number and the address. As shown
in the following figure, the data is read from PLC station
number 1, and address 0x-20.
Toggle Switch/Bit Lamp Object's Properties \E\
General | Secuity | Shape | Label | Profile |
Comment :
@ Bit Lamp ) Toggle Switch
Read address
PLC name:[Moosus RTU v} Settings...
Address:@ 1#20
[ Invert signal
Address @
PLC name : [MODBUS RTU -
Device type : [Ox v]
Address: 1220
Address format : DDDDD [range : 1 ~ 65535]
Default Use the station number variables as the default PLC
station no. station number. Select one from LW-10000 to LW-10015

use station

no. variable

(varO to varl5) as the station number variables. If the
station no. is not specified in PLC address, the station
number will be determined by the station no. variable.

For example, if var3 is set for default station no:

PLC defaul station no. : [LW—lDDD3 (16bit) : var3 v]

Default station no. use station no. variable
[7] Use broadcast command
The followings demonstrate some examples:
® The PLC station number is “5”.

Read address

PLC name : [MODBUS RTU

v] Setting...

Address:’4x v] #1111

® The PLC station number is determined by var7
(LW-10007)

L—| WE!NTEK
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Read address

PLC name : [MODBUS RTU v] Setting...

Address :[4,( v] var7#111

® PLC addressis set to “111”, since PLC station no. is
not specified, and the default station no. is var3, the
PLC station no. is determined by var3 (LW-10003).

Read address

PLC name :[MODBUS RTU v] Setting...
Address :[4,( v] 111
Use When [Use broadcast command] check box is selected,
broadcast please fill in [Broadcast station no.] according to the
command broadcast station number defined by PLC. When HMI

sends a broadcast command to the station number set
here, PLC will only receive the command and not reply to
HMI.

PLC default station no. : ¢
[7] Defautt station no. use station no. variable

[#] Use broadcast command Broadcast station no. : [255 -

As shown in the following figure:

Read address

PLC name :[MODBUS RTU v] Setting...

Address :[4,( v] 255%200

When HMI sends a command to address 255#200, all the
PLCs will receive this command and will not reply.

Only PLCs that support broadcast command can use this

feature.
Interval of If the interval between read addresses of different
block pack commands is less than this value, the commands can be
(words) combined to one. The combining function is disabled if

this value is set to “0”.

For example, the interval value is set to “5”, to read 1 word
from LW-3 and 2 words from LW-6 respectively (read from
LW-6 to LW-7), since the interval of addresses between
LW-3 and LW-6 is less than 5, these two commands can be
combined to one. The result is to read 5 consecutive words
from LW-3 to LW-7.

Note: The maximum size of command combination data

must be less than [Max. read-command size].
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Max. read - The maximum data size to read from the device at one
command time. Unit: word

size (words)

Max. write - The maximum data size to write to the device at one time.
command Unit: word.

size (words)

After all settings are completed, a new device named “Local PLC 1” is added to the [Device list].

Systern Parameter Settings @
| Extended Memory I PrinterBackup Server | Time Sync /DET | e-bdail | Recipes
Diewvice | IModel I Cieneral | Swatem Seting | Security I Font
Device list: Wi hat's oy [P ¥
Mo. Mame Location Dievice type Interface IIF Protocol
Local HMI Local HMI Local MTE8O070IEMTS... -
@ Local PLC 1 |MODBUS RTU MODBUS RTU |COM 1 (9600.E...|RS485 2W

0 Note

B When using cMT-SVR, select “Local HMI” in [System Parameter Settings] dialog box and
then click [New PLC] to add a “Local PLC 1” under “Local HMI”.

System Parameter Settings @
|  ExendedMemory | TimeSyne/DST | eMail |  Recipes |  Cellular Data Network
Device | Madel | (General | Systern Setting I Security | Font Mapping
Dervice list : What's my [P 7
Mo. Mame Location Device type Interface IIF Protocol
= Local HMI Local HMI Local cMT-SVR (1024...
¥ Local PL.. |MODBUSRTU MODBUS RTU |COM 1 (9600E...

5.2.2. How to Control a Remote PLC

m Ethernet o Ethernet
.-.—,1 ﬂ

HMI
Desktop HMI

uod WOD
Hod oD

PLC Device " JPLC Device
“Remote PLC” is a PLC being connected to a remote HMI. To control a remote PLC, add this
type of device first. Please click [System Parameter Settings] » [New] to open [Device
Properties] dialog box. For example, use MODBUS RTU as the Remote PLC:
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Device Properties

Name : MODBUS RTU
HMI @ PLC

Location : [Remote | [ Settings ... | [IP : 192.168.1.100 (Port = 8000)

PLC type : MODEUS RTU [»]

V.2.50, MODBUS_RTU.e30

PLCI/F : [Rs485 2w -

COM : [COM1 i Settings...

PLC default station no. : 1

["] Default station no. use station no. variable

How to designate the station no. in object's address ?...

Interval of block pack (words) : E
Max. read-command size (words) :
Max. write-command size (words) :

[ OK ] [ Cancel ]

Setting Description
HMI or PLC In this example, the device used is a PLC, so select [PLC].
Location Select [Local] or [Remote]. In this example the PLC is
connected to Remote HMI, so select [Remote]. Set the IP
address and port number of the Remote HMI by clicking
[Settings] next to [Remote].
IP Address Settings
@ Ethernet () COM port (use master-slave protocol)
IP address: 192 . 168 . 1 . 10
Port no. : 8000
| ok | [ cancel
PLC Type Select the type of the PLC.
PLCI/F The interface used for Remote PLC. If the remote PLC uses a
COM port, select [RS-232], [RS-485 2W], or [RS485 4W].
CoOM Set the correct COM port used by the Remote PLC.
PLC default
station no. Set the station number of Remote PLC.

After all settings are completed, a new device named “Remote PLC 1” is added to the [Device

list].
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System Parameter Settings IEI

Extended Memory I Printex/Backup Server | Time Symc DET | e-Mail | Recipes

Device | Iodel I Greneral | Swatern Seting | Security I Font
Device list: What's mey [P 2
Mao. Name Location  Device type Interface IIF Protocol
Local HMI Local HMI Local MTEO070IEMTS... -

(3 Remote HMI 1 [MODBUS RTU | Remote (1... | eMT/XEAE SER... | Ethernet TCPIP

@ Note

B When using cMT-SVR, select the defined “Remote HMI 1” in [System Parameter Settings]
dialog box and then click [New PLC] to add a “Remote PLC 1” under “Remote HMI 1”.

System Parameter Settings @
|  ExtndedMemory | TimeSyne/DST | eMail |  Recipes |  Cellubr Dais Network
Device | Madel I General | Systern Setting I Security | Font Mapping
Device list : ¥hat's moy IF 7
No. MName Location Device type Interface IIF Praotocol
Local HMI Local HMI Local CMT-SVR (1024... - -
= [Remote HMI 1 CMT-SVRHMI  Remote (I.. CMT-SVR Ethernet TCPIP
> MODBUS RTU  [Remote (1. |MODBUS RTU  |COM 1 (9600,E... | RS485 2W

5.2.3. How to Control a Remote HMI

4 Ethernet Ethernet
e -—’i
- HMI HMI HMI

Desktop
“Remote HMI” is the HMI other than “Local HMI”, and PC is also a “Remote HMI”. To control a
Remote HMI, add this type of device first. Click [System Parameter Settings] » [New] to open

[Device Properties] dialog box as shown in the following figure:

Device Properties

Name : Device
@ HMI @ PLC

Location : [Remote ~| [ Settings ... | [IP : 192.168.1.10 (Port = 8000)

Setting Description
HMI or PLC In this example, the device used is a HMI, so select [HMI].
Location Select [Local] or [Remote]. In this example Remote HMI is

used, select [Remote]. Set the IP address and port number
of the Remote HMI by clicking [Device Properties] »
[Settings].
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IP Address Settings
@ Ethernet
IP address: 192
Port no. : 8000

188 . 1 . 10

[ oK Cancel

J |

After all settings are completed, a new device named “Remote HMI 1” is added to the [Device

list].
System Parameter Settings IEI
| Extended Memory | Printex/Backup Server I Time Sxme DST | e-Mail | Recipes
Device | IModel I General | Bastern Betting | Security I Font
Dievice list: What's ey IP 2
Mo. Mame Location  Device type Interface IIF Protocol
Local HMI Local HMI Local MTE070IEMTE... - -
(3 Remote HMI 1 |MODBUS RTU  |Remote (I... | eMT/XENE SER... | Ethernet TCPIP

0 Note

B When using cMT-SVR, in [System Parameter Settings] dialog box click [New HMI] to add a

“Remote HMI 1”.

[\& WEINTEK

System Parameter Settings @
| Exterded Memory | TimeSwneDST |  eMail | Recipes |  Cellular Dats Network
Device | Model | (ieneral I Bwatem Seting I Security | Font Mapping
Dievvice list : Wi hat's my [P 7
Ma. MName Location Device type Interface IfF Protocol
Local HMI Local HMI Local cMT-SVR (1024... - -
Remote HMI 1 | CMT-SVR HMI Remaote (I...| CMT-5VR Ethernet TCPIP

EasyBuilder Pro V5.05.02
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5.3. Model

Configure the [HMI model], [Timer], [Printer] and [Scroll bar] settings.
eMT ~ iE ~ XE ~ mTV Series

cMT3151

[\& WEINTEK

f System Parameter Settings

E=

| Extended Memory |  PrintrBackupServer |  TimeSyc/DST | e-Mail

I Recipes |

Device Model | General ] System Setting I Security

I Font

HMI model : [MTBU?UiEIMTSlIJI]iE (800 x 480)

z)

HMI stationno : —

Portno.: 8000 (used as MODBUS server's port no.)

[V Support cM T communication protocol
Portno.: 8010
Timer
Clock source :  External device v

PLC name f[MODBUS RTU

v][ Settings... ]
[16-bit Unsigned

Printer

Type : [$B-M, D, E, F -
B
Fsiy

Pixels of width : 100 pixel(s)

Data bits :

*100 pixcels (for 1610 type) or 220 pixels (for 2407, 4004 type)

Stop bits : _1 Bit s
Sereen hard copy scale : | 100% A

Seroll bar
« [
Width
© Small ) Middle ) Large
Pass through (Virtual COM port)
Portno.: 2000 (2000~2100)
=)
f System Parameter Settings
| Extended Memory |  TimeSyne/DST | eMail | Recipes |  CellularDataNetwork |
| Deyice | Model | Gememal | Systemgetting | Security | Now-ASCHFonts | FontMapping |

HMI model : [cMT}lSl (1024 x 768)

=)

HMI station o :

Portno.: 8000

[7] Support iE/XE/eM TinTV HMI communication protocol

Printer
Type : HP LaserJet Professional p1606dn. lw StatusiControl...
Paper Size :
Interface
© Ethernst O USB
Ip: 192 ; 168 ; 1 100
Port: 9100
Pass through (Virtual COM port)
Portno.: 2000 (2000~2100)

Cancel

EasyBuilder Pro V5.05.02
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0 Note

5-12

B When using cMT-SVR, configure only [HMI model], [HMI station no.], and [Port no.].

Setting

Description

HMI model

Select the HMI model to use.

If the HMI model is changed, the [Resize pop-up windows /
objects] dialog box will pop up. Select required adjustment
and click [OK]. In most cases, select all options.

Resize pop-up windows/objects @
General windows
Resize pop-up windows
[¥] Resize objects

Keyboard windows
Resize keyboard windows
Resize function key objects

[ OK | ’ Cancel ]

HMI station no.

Set the station number of current HMI. The default value is
IIOII.

Port no. Set the port number of current HMI. It is also used in
MODBUS server. The default value is “8000”.
Slixgvr\)lg:t cmT Supports cMT Viewer using this HMI as a Remote HMI. The
communication Remote HMI port number in cMT-SVR project must be
protocol
identical to the port number set here.
Timer Clock source

Set the source device of the clock/time information. It is

used by [Data Sampling], [Event Log], etc.

® [f [HMIRTC] is selected, the time information comes
from the internal clock of the HMI.

® [f [External device] is selected, the time information
comes from an external device. The address of the
source device must set correctly. As shown below, the
time information is from “TV” address type of the
“Local PLC”. The addresses of “TV” start from 0 and
contain 6 consecutive words and each of them store

the following information:

TV 0 - Second (range: 0~59)
TV 1 - Minute (range: 0~59)
TV 2 - Hour (range: 0~23)
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TV 3 > Day(range: 1~31)
TV 4 - Month (range: 1~12)
TV 5 > Year(range: 1970~2037)

Timer

Clock source :  External device -
PLC name : [Mitsubishi FX05/FXO0N/FX 15 FX INfFX2 - ] Setting...
Address :’W v] 0 16-hit Unsigned
Address (m23a]
PLC name : [Mitsubishi FX0S FX0N/FX 15 /FX IN/FX2 v]
Device type : [T\l' v]
Address: 0

Address format : DDD [range : 0 ~ 255]

[ index register
C—
Printer (eMT, Type
iE, XE, mTV) A printer can be connected with the HMI. The HP PCL Series

printer is connected through USB interface while other
printers through a COM port.

&r For more information, see “23 HMI Supported
Printers”.

If the printer is connected through [COM], configure the
parameters correctly. If the printer type is [SP-M, D, E, F],
the [pixels of width] has to be set accurately, i.e. the set
pixel(s) cannot exceed printer’s default setting, or the HMI

will fail to print data.

Printer The printer driver can be installed on HMI.
(cMT3151) Type

Select printer type.

Status address

Shows printer status.

LW-n Status

0 Printer driver is not installed yet.
1 Installing printer driver.

2 Printer is ready.

3 Printer is printing.

LW-n+1 Error

0 None

1 Printer is not found.

2 Unknown error.
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Control address

Updates printer connection parameters.

LW-n Command

0 Printer driver is not installed yet.
1 Update connection parameters.
LW-n+1 1/0

0 Ethernet

1 USB

LW-n+2 IP address (Total: 4 words)
LW-n+6 Port (Default port number: 9100)

Scroll bar Set the width of Scroll Bar, when the size of the object is too
small to display the contents, a scroll bar is displayed in the
object. This feature can be applied to objects that allow
scrolling, such as Alarm Display, Event Display, History Data
Display, and Option List.

Pass through Set the port number for Pass-through communication.

5.4. General

Configure the properties related to screen display.
eMT, iE, XE, mTV Series

I__| WE!NTEK

System Parameter Settings @
i Printex/Backup Server ] Time Sync./DST | e-Mail | Recipes [ Ce].t@sxDamNehuork ]
| Device | Model | Gemeral | SystomSeting | Secuity | Non-ASCHFomts | Extended Memory |
Fast selection button
Attribute : Disable v [ Settngs.. |
Position : ] Hide button when HMI starts
Screen saver
Back light saver : yninute(s)

[¥] Enable back light when alarm occurs
* Notice : mTV Series HMI must vse keyboard or mouse to enable back light

Screen saver : yninute(s)

Saver window no. : [10. WINDOW_010

z)

Options

Startup window no. : (10, WINDOW_010

z)

[VIRW_& enabled
Event
[T Use LW9450~9455 as time tags of event logs

*If this key is different from HMI key, the project won't be executed normally.
*Use LWO046~9047 to change HMI key. LBO046 indicates check result (key error when status is on).

Common window : | Above base window v Object layout : | Nature v

Keyboard
Extmal keyboanlilayout LW-0199)
g%:%zgﬁ E'I;f;egf‘ | © QWERTY () () AZERTY (1)
53. Keypad 4 - Integer
54. Keypad 5 - Integer > Caretcolor :  |EEG_—_——— S v
[ add. | [ Dekte | Selectcolor:  INNEG—_—_— v
Project protection
[¥] Enable Projectkey : 111111 (range : 0 ~ 4294901750)

EasyBuilder Pro V5.05.02
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cMT-SVR cMT3151

System Parameter Settings @ System Parameter Settings @
Extended Memory [ Txmﬂy)gc M,f,] e-Mail I Recipes [ Cellular Data Network i i Extended Memory l 7{711:12 §y1m DST ] e-Mail ] Recx:yes [ Cellular Data Network
| Dovie [ Mot | Gemnl | Syemseting | Sewiy | Fomdopping | | | | Devie [ Model | Gemenl [ Syemseting [ Seowiy | NowASCHFoms | FontMeoping |
Monitor Mode Monitor Mode
|| Enable [¥] Enable
* When enabled, cMT Viewer uses window no. 3 to display brief information about the machine, and mscro * When enabled, cM T Viewer uses window no. 3 to display brief information sbout the machine, and macro

settings of window no. 3 will be cleared. settings of window no. 3 will be cleared.

Sereen saver Ik Screen saver

Back light saver : wndnute(s)

*Notice : mTV Series HMI must use keyboard or mouse to enable back light

Screen saver : | None v | minute(s) Scraeylsaver' minute(s)

Options Options
Startop window no. : (10, WINDOW_010 - Startup window no. : [10. WINDOW_010 v
Common window : [Above base window v Common window : [Above base window v
VIRW_A enabled [ZJRW_A ensbled
Event Event
| Use LW9450-0455 as time tags of event logs [T Use LWO450-8455 as time tags of event logs
Keyboard Keyboard
[50. Keypad 11 - Integ N .| [50.Keypsd 11 - Integer | External keyboard layout (L W-9199)
51. Keypad 12 - Integer 51. Keypad 12 - Integer r &
52 Keypad 3 - Integer 4 52 Keypad 3 - Integer ‘ @OWRITQ) @ummd
53. Keypad 4 - Integer 53. Keypad 4 - Integer
54 Keypod 5 Integes - 54 Keypad 3 Ineger -
Add.. Delete Add...
Project protection Project protection
[¥] Enable Projectkey : 111111 (range : 0 ~ 4294901750) [¥] Enable Projectkey : 111111 (range : 0 ~ 4294901750)
*1f this key is different from HMI key, the project won't be executed normally. *1f this key is different from HMI key, the project won't be executed normally.
*Use LWO046-9047 to change HMI key. LBI046 indicates check result (key error when status is on) *Use LWI046-9047 to change HMI key. LBI046 indicates check result (key error when status is on).

[ OK JL Cancel ] [ Help J T‘ Cancel [E

Setting Description

Fast This setting is applicable for eMT, iE, XE mTV Series.
selection Setting the attributes for fast selection button for Window
No. 3. To use the fast selection button, create Window No.

button

3 first.

Attribute

Enable or disable fast selection window. Select [Enable] and
click [Settings] to set the attributes, including color and text
of the button.

Position

Select the button position on the screen. If [Left] is chosen,
the button will show up in at bottom left side of the screen;
if [Right] is chosen, the button will show at the bottom
right side of the screen.

Monitor This setting is applicable for cMT Series.

Mode Window no. 3 in the project is monitored in this mode in
cMT Viewer. The user can select up to 50 cMT Series HMls
to monitor in cMT Viewer, and in 3x3 or 5x4 tile view.

Screen saver Back light saver

If the screen is left untouched and reaches the time limit
set here, the back light will be turned off. The unit is
minute. Back light will be on again once the screen is
touched. If [none] is set, the back light will always be on.
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Screen saver

If the screen is left untouched and reaches the time limit
set here. The current screen will automatically switch to a
window assigned in [Saver window no.].The setting unit is
minute. If [none] is set, this feature is disabled.

Saver window no.

To assign a window for screen saver.

Option

Startup window no.

Designate the window shown when start up HMI.
Common window

The objects in the common window (Window No. 4) will be
shown in each base window. This determines that the
objects in common window are placed above or below the
objects in the base window.

Object layout

If [Control] mode is selected, when operating HMI,
[Animation] and [Moving Shape] objects will be displayed
above other kinds of objects neglecting the sequence that
the objects are created. If [Nature] mode is selected, the
display will follow the sequence that the objects are
created, the first created will be displayed first.

RW_A enabled

Enable or disable recipe data RW_A. Enable this, the
objects can then control RW_A .The size of RW_A is 64K.

Event

Extra no. of events

The default number of the events in the system is 1000. For
additional number of events, modify this setting. The
maximal is 10000.

Keyboard

The window number in which the keyboard is placed.
When using Numeric Input or ASCII Input objects, the type
of keyboards can be selected. Up to 32 keyboards can be
added. To design a keyboard, a window should be
designated for creating it. Press [add] after creating, and
add the window to the list.

C?See “12 Keyboard Design and Usage”.

External keyboard layout

Applicable for eMT, iE, XE, mTV, and cMT 3151 models.

The available USB keyboard layouts are QWERTY and
AZERTY. System register LW-9199 allows switching keyboard
layouts on HMI.

Caret color / Select color

This setting is applicable for eMT, iE, XE, and mTV Series.
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Set the color of caret that appears when entering data in
Numeric Input and ASCII Input objects, or change the

selection color.

Project

Projects can be restricted to be executed by a specific HMI.

protection & See “30 Project Protection”.

5.5. System Setting

[System Setting] is used to configure different features of EasyBuilder Pro.

Some features are duplicated from system registers, such as, [Hide system setting bar
(LB-9020)], [Hide mouse cursor (LB-9018)], [Disable buzzer (LB-9019)], [Prohibit remote HMI
connecting to this machine (LB-9044)], and [Disable upload function (LB-9033)]. Users can also

System Parameter Settings =]

Printer/Backup Server ] Time Syne.DST | e-Mail | Recipes |  Cellular Data Network

Device | Model | General | SysemSetting | Security | Non-ASCIIFonts | Extended Memory

Startup language after redownlosding the project : [Language 1 -

[] Execute init. macro when power on

Auto logout
[T] Enable

* When a vser does not operate the HMI for longer than the setting time, the system will
automatically logout.

[ Hide system setting bar [V] Hide mouse cursor Mouse cursor size : | Default v

*Use LB-9062 to open hardware sstting dislog.
Sound control
~) With each touch on a button, & sound is emitted.
© With each operation from a button, a sound is emitted.

[ Disable sound output {or use LB-9019 to disablefenable sound output)

[7] Prohibit remote HMI connecting to this machine

[ Disable upload function (effective after rebooting HMI){or set LE9033 on)
[] Prohibit password remote-read operation (or set LBI053 on)

[ ] Prohdbit password remote-write operation {or sst LB9054 on)

[7]Use a disconnection icon on relative objects when PLC communication fails

VNC server

[ Password free [T Monitor mode

[ Password from project

Easylccess sexver
[ Login EasyAccess 1.0 server s ihomi net
Location of Easyfccess 2.0 sexver : [G]obal v 1
[ OK ] [ Cancel ] Help

set these features via system tag.

To select a system tag, select [Address] » [System tag] check box when adding a new object and

then select the [Device Type].

To browse all the system tags, Select [Library] » [Tag] » [System] from the main menu of

EasyBuilder Pro.
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Setting

Description

Startup language after
redownloading the
project

Set the language to use when HMI starts after
the project is re-downloaded.

Execute init. MACRO

when power on

Designate the macro to be executed when HMI
power on.

Auto logout

If leaving HMI untouched for longer than the
set time, the objects protected by security
classes will not be able to operate. The user ID
and password must be entered again to unlock
it.

Hide system setting bar

Hide the system setting bar in the bottom right
corner of the HMI screen.

Hide mouse cursor

Hide the mouse cursor in HMI screen.

Mouse cursor size

Set mouse cursor size.

Sound control

Disable Buzzer: Mute HMI.

With each touch on a button, a sound is
emitted: A sound is emitted when touching a
button.

With Each operation from a button, a sound is
emitted: When the [Min. press time] is
specified, there may be a time gap between
touching the object and the action of the
object. This setting can control the timing to
emit a sound.

Prohibit remote HMI
connecting to this

machine

Prohibit the connection with a remote HMI.
The remote HMI will not be able to control the
local HMI.

Disable upload function
(effective after rebooting
HMI) (or set LB9033 ON)

Disable HMI to upload project, after
downloading, HMI must be rebooted to
disable uploading project.

Prohibit password
remote-read operation
(or set LB9053 ON)

Prohibit Remote HMI to read Local HMI.

Prohibit password
remote-write operation
(or set LB9054 ON)

Prohibit Remote HMI to write Local HMI.
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Use a disconnection icon
or relative objects when

PLC communication fails

If selected, displays a ,
_,?—:

disconnection icon on relevant %

objects when failing to ﬁ

communicate with PLC.

This icon will be shown in the /\\ﬁ
Iovyer right corner of the .\\:3;’
object.

VNC Server

If [Password free] check box is selected, the
client can connect with HMI via VNC without
entering the password.

If [Monitor mode] check box is selected, the
HMI connected via VNC can only be monitored
but not controlled.

If [Password from project] check box is
selected, set the password for VNC login.

LW protection
RW protection

If select [Disable LW/RW remote-write] check
boxes and set the protect range in [LW/RW
range], values within the protected range
cannot be adjusted using Remote HMI.

Easy Access server

Login EasyAccess 1.0 server:

Through this technology, users can easily
access to any HMI connected to the internet
and operate them on PC just like holding touch
screen in hand.

Easy Access does not transmit updated graphic
images directly but only the real time data.
This makes transmission really quick and
efficient. Please refer to “EasyAccess Manual”
for more information.

Location of EasyAccess 2.0 server:

Current location includes Global and China.

0 Note

B cMT-SVR Series does not support VNC Server.

5.6. Security

Parameters in this tab configure the user passwords and security classes. There are two

authentication modes: General Mode and Enhanced Security Mode.

& For more information, see “10 Security”.
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5.6.1. General Mode
System Parameter Settings
_ Extended Memory | PrinteBockup Server | TimeSyneDST | eMeil |  Recipes |
Device . | Model | Genenl SysemSetting | Secusty | Fomt |
@ General mode Enhanced sscurity mode
Select operable classes for each user
Password range : 0 ~ 4294967295
No. Enable Password Class & ClasB ClasC ClassD Clas ~
1 & 0 # = ® ] E
2 & 222 ¥ ® E [
3 & 333 2] ® 2
4 (F o 2} [
5 I 7 2
< L] »

Up to 12 sets of user and password are available. Password should be one non-negative integer.
Once the password is entered, the objects that the user can operate are classified.

There are six security classes available: Ato F.
If [None] is selected for an object, every user can access this object.
For example, when the security class of User No. 3 is set as the preceding figure, User No. 3

could only access objects of classes A, B, C and “none”.

Project password (EMTP file)
Enable

Setting...

Users can set password to protect the project (.emtp) files. The password set here must be

entered when editing the project file.

Select [Enable] then click [Setting] to set the password.
Before editing a project, a popup window is shown for entering the password. Only when the

password is correct can the user edit this project.

5.6.2. Enhanced Security Mode

At most 11 users can be set here. An [Administrator] user is provided in this mode. An

[Administrator] has all privileges and can operate all object classes. User passwords must be

alphanumeric and each user can have up to 12 classes: A to L.
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Address

[ Enable

[V]Enable

Status address

System Parameter Settings @
| Extended Memory | Printex/Backup Server [ Time Syme /DST I e-Mail J Recipes
| Device | Model | Gemerdl |  SystemSeting |  Seewity |  Fomt

() General mode © Enhanced security mode
Select operable classes for each ueer
[} Use existing vser accounts on HMI

No. Enable Secretuser User name Password Class & ClasB  »
1 2] [l userl 1 4] ® |= i
2 2] [ user2 2 ] 2]
3 [ ] user3 3 ] &
4 [ @ userd 4 2] E
5 _[F [ meerf 5 @ Y

< LU »
Class Description -~
Class &
ClassB
ClassC -

Administrator

[T Secret user User nawme : | adimin Password : 111111
Control address
PLC name :

LW 8950

Project password (EMTP file)

Execute auto loginfogout when insert an USE key into HMI

* Simulation not supports this function and L W-11165s display expiration time of USE key.

Local HMI

Settings

PLC name : [Local HMI

v] Settings...

Address : [LW - J 0

16-bit Unsigned

| Help

[ OK J[ Cancel ]

Setting

Description

Select operable
classes for each

user

When selecting [Use existing user accounts on HMI]
check box, the operable objects for each user will be
decided by the account settings in HMI.

Administrator

Default administrator account, cannot be deleted, has
all privileges, and cannot be changed. Enhanced
Security Mode can be used with Option List object. It
displays the account names and privileges. If [Secret
user] is checked, the account names and privileges
will be hidden in Option List.

Control address

An address for users to manage the accounts directly
on HMI.

Execute auto.
Login/logout
when insert an
USB key into HMI

This feature allows automatic login / logout using an
USB security key. The login / logout status will be
written into a designated address. Insert the USB disk
to HMI to log in, and remove the USB disk to log out.
The result codes of login / logout: 0x00: No action,
0x01: Login succeeds, 0x04: Login fails, 0x08: Logout
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succeeds, 0x10: Logout fai

Is.

@ Note

B cMT Series only supports Enhanced Security Mode, but does not support [Execute auto.

Login/Logout when insert an USB key into HMI.]

5.7. Font

5.7.1. eMT, iE, XE, mTV Series

Parameters in [Font] tab determine the non-ASClII fonts.

The non-ASCII fonts are listed here. When using non-ASCll characters or double byte characters
(including Simplified or Traditional Chinese, Japanese, or Korean) which are not listed in [Fonts
for non-ascii strings] table, EasyBuilder Pro will select a font from the list to substitute for it
automatically.

The non-ASCII fonts in Windows can be added to the [Fonts for non-ascii strings] table.

System Parameter Settings

==

Extended Memory I

Printer/Backup Server | Time Sync/DST

| eMail

Recipes

1

Device l Model

| Gememl | SysemSetting |

Security ]

Fonts for non-ascii strings
lingsepatlew [N

Arabic Typesetiing
Arial

Arial Black

Arial Bold

Arial Narrow

Arial Narrow Bold
Batang

Book Antiqua
Book Antiqua Bold
Bookman Old Style
Bookshelf Symbol 7
Calibri

Calibri Bold
Century Gothic
Century Gothic Bold
Comic Sans MS

Courier New
Courier New Bold
Droid Sans Fallback

Garamond
Georgia
Georgia Bold
Gulim

Impact
Latha
Lucida Console

T neida Yane ITnicada

Comic Sans M3 Bold

m

Franklin Gothic Medium

Lucida Sans Demibold Roman &

[ Add Al Non-aseii Fonts ]

Line spacing : @

["]Support Arabic, Persian, Hebrew, and Thai, ... alphabets (OS version 20130914 or later)

* "Droid Sans Fallback" font includes support for Simplified and Traditional Chinese, Korean,

Japanese.

Add...

Delete 411

Font

[ OK J { Cancel

)

Help

Decide the space between lines in the text in [Line spacing] field.
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Select [Support Arabic, Persian, Hebrew, and Thai, ... alphabets] check box to correctly display
these alphabets.

5.7.2. cMT Series

This tab lists the fonts used in WINDOWS and the corresponding fonts displayed on iPad.

System Parameter Settings @
Extended Memory Time Sync.DST | e-Mail | Recipes. |
Device |  Model Genersl | SysemSetting |  Secuity |  FontMapping
[¥] Support cMT-i¥5 Fonts
Windows font 4 OS font cMT-iV5 Font A
Agency FB Helvetica Neue Droid Sans =
A gency FB Bold Helvetica Neuve Droid Sans =
Aharoni Bold Arial Hebrew Droid Sans
Algerian Helvetica Neue Droid Sans
Andalus Helvetica Neue Droid Sans
Angsana New Helvetica Neue Droid Sans
Angsana New Bold Helvetica Neve Droid Sans
AngsanallPC Helvetica Neue Droid Sans
AngsanalPC Bold Helvetica Neve Droid Sans
AL parajita Helvetica Neue Droid Sans
A parajita Bold Helvetica Neve Droid Sans
Arabic Typesetting Helvetica Neue Droid Sans
Arial Arial Droid Sans
Arial Black Helvetica Neve Droid Sans
Arial Bold Arial Droid Sans
Arial Narrow Helvetica Neve Droid Sans
Arial Narrow Bold Helvetica Neue Droid Sans
Arial Rounded MT Bold Helvetica Neve Droid Sans
Baskerville Old Face Helvetica Neue Droid Sans
Batang Helvetica Neue Droid Sans
Bavhaus 93 Helvetica Neue Droid Sans
Bell MT Helvetica Neue Droid Sans
Bell MT Bold Helvetica Neue Droid Sans
Berlin Sans FB Helvetica Neue Droid Sans
Berlin Sans FB Bold Helvetica Neue Droid Sans
Berlin Sans FB Demi Bold Helvetica Neue Droid Sans -
[ OK J [ Cancel ] Help

5.8. Extended Memory

Parameters in this tab determine the location of the extended memory.
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System Parameter Settings
viDie\{sgg | Model | Gemerl | SystemSetfing |  Secusity I Font i
Extended Memory | Printer/Backup Server ] Time Syme/DST I e-Mail I Recipes |
EMO
File name : | eml emi @ USBE disk
EM1
File name :  eml emi © USB disk
EM2
File name : | em2 emi © USB disk
EM3
File name : | em?.emi 9 USB disk
EM4
File name : | emd emi ©@ USBE disk
EM5
File name : | em5.emi © URE disk
EM6E
File name : | emf emi @ USB disk
EM7
File name :  em7.emi © URB disk
EM8
File name :  emS emi @ USB disk
EM9
File name :  em9 emi © USB disk

Extended Memory is numbered from EMO to EM9. It works in a way similar to other device
types (i.e. LW or RW address). Users can simply select from [Device type] list while adding a

new object. Size of each extended memory is up to 2G word.

Address (=]
PLC name : [L0C3| HMI ‘]
Device type @ [LW v]

LW
R

RW_A

RWI

EMO

EM2

EM3

EM4

EMS

EME

Tag Library... Em; ]

EM3 -

Address :

Address format :

Extended memories are saved as files in [SD card] or [USB disk]. [EMO] to [EM9] are saved as
“em0.emi” to “em9.emi” respectively. Users can use RecipeEditor.exe to open these files and
edit the data in the extended memory.

Data in extended memory will not be erased when power is cut, which means next time when
start up HMI again, data in the extended memory remains the same as before power off. This is
similar to recipe data (RW, RW_A). The difference is that users can specify the location to store
data. (SD card, USB disk)

When the device of extended memory does not exist and to read data in it, the data content
will be “0”; to write data to a device that does not exist, the "PLC no response" message will be
shown in HMI.

Users can insert or remove the external device to or from HMI without cutting the HMI power

to update or take data in extended memory.
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5.9. Printer / Backup Server

Configure remote printer / backup server.

System Parameter Settings @
| Device Model I General l Systemn Setting I Security I Font
_ Extended Memory Printer/Backup Server | TimeSyne/DST | e-Mail |  Recipes
[¥] Use Remote Printer/Backup Server
* Use EasyPrinter to configure PC for printing screen hardcopy and storing backup data.
Qutput settings
Orientation : @ Horizontsl ) Verticel
Printer size © @ Original size () Fit to printer margins
Margin : 0 & mm
0 S| mm ] $ mm
0 mm
Communication settings
IPaddress : 192 - 168 - 1 - 100
Portno.: 8005
User name :  admin Password : 111111
Setting Description
Output Orientation
settings Set how will words or pictures be printed out, [horizontal]
or [vertical].
Printer size
Set to print out in [Original size] or to [Fit to printer
margins].
Margin
Set the top, bottom, right and left margin width.
Communication IP address
settings Assign the IP address of the printer via network.

[Port], [User name], [Password]
Specify the data to log in printer.
Port can be set from 1 to 65535.

Maximum length of user name or password is 12

characters.

& For more information, see “26 EasyPrinter”.
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5.10. Time Sync./DST

Synchronize HMI time with NTP server.

System Parameter Settings

sl

Device | Madel | (reneral | System Setting I

Securiby |

Font

Extended Memory I PrinterBackup Server | Time Syoc DST |

eMail |

Recipes

Enable time symchronization via NTP (Network Time Protocol) server

Execute time synchronization when HMI stacts
[ Server responss time has been adjusted in accordance with DST

HMI time zone : (UTC+08:00)
Berver response time @ (UTC+00:00) GMT Standard Time

Network time server 2
Network time server 3
Network time server 4
Tpdate interval {10 ~86400) © 10 meonds

* e LW-11273 ~ 11294 to modify settings on HMI
*If failed to execute time synchrondzation, the statos of LB-12055 iz st o ON.

A utomatically set daylight saving time (DET)

Network time server 1 : (e.g. wwry ndst.gov or 24.56.178.140 3

Start : [March v | [Second  +| [Sunday

v jozoo b 2

End : [November v] [F]m{ v] [Sunrlay

) jpzoo b 2

Diaylight bias : 0100 5 | (00:20 ~ 12:00)

# HMI enters into DET period when LB-12355 {read only) iz ON.
# s LW-11260 ~ 11272 to modify settings on HMI
*#DET iz not supported. in on-line smulation.

l oK J [ Cancel

| Help

Setting Description

Enable time Execute time synchronization when HMI starts

synchronization Automatically synchronizes HMI time with the

via NTP (Network designated NTP server when HMI starts.

Time Protocol) HMI time zone

server Select HMI time zone.
Server response time
Select NTP server time zone.

Network time server

Provides four fields to fill in Network Time Servers for
user’s device. If the synchronization with server 1 fails,
the system will try to synchronize with server 2, and so
on. If HMI time cannot synchronize with any of the
Network Time Servers, the system register LB-12055 will
change to ON status.

L—| WE!NTEK

EasyBuilder Pro V5.05.02

5-26



System Parameter Settings 5-27

Update interval

The frequency of synchronization, the range is from 10 to

86400 seconds.
Automatically set Start / End
daylight saving Set the start/end of Daylight Saving Time.
time (DST) The option [Last] may refer to the 5" or 6™ week

depending on the selected month.
Daylight bias
Set the time zone's offset during DST.

0 Note

When DST ends, and the time falls back, the Trend Display object in Real-time mode will
stop refreshing for the overlapping hour(s) when it just going back to standard time.
However, historical data will not be affected.

When DST ends, adjusting HMI time (manually or by network) back to the DST period will
not be effective to the system. The system register LB-12355 stays OFF.

When DST ends, and the time falls back, the system will not start DST for the overlapping
hour(s). The system register LB-12355 stays OFF.

Before DST starts, adjusting HMI time (manually or by network) into the DST period will
start DST. The system register LB-12355 will be set ON. The HMI time will be the specified
time without adding the offset.

During DST, adjusting HMI time (manually or by network) to a time that is not within DST
period will end DST. The system Register LB-12355 will be set OFF. The HMI time will be
the specified time without subtracting the offset.

This feature does not yet support the DST in Southern Hemisphere.

C?For more information on system registers relevant to DST, see “22 System Registers”.

5.11.

e-Mail

Select [Enable e-Mail function] check box to configure the parameters.

If [Use existing contact settings on HMI] check box is selected, the system will use the contact

settings in HMI.
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System Parameter Settings @

| Device | Model | General | SystemSetting | Security | Non-ASCIFonts | Extended Memory

| PrinteBackup Server l Time Sync/DST | e-Mail | Recipes } Cellulax Data Network

[V] Enable e-Mail fonction [7] Use existing contact settings on HMI
SMTP settings
Server . smtp.gmail com Portno.: 587

User name :

Password :

Confirm Password :

Sender information
Name : [¥] Use HMI name

Mail address :

* LB-12053 or LB-12054 is ON when failed to send an e-Mail

[T]SMTP sexver requires authentication

| Use the following type of encrypted connection
TLS

Local HMI

Test SMTP Settings...

Setting

Description

SMTP Settings

Server: Set SMTP Server.

Port: Set communication port.

User name: Set e-mail address.

Password: Set e-mail password.

Confirm Password: Confirm e-mail password.

Log on using Secure Password Authentication (SPA):
Decide whether SPA is needed when log in e-mail.

Use the following type of encrypted connection:

Decide whether the encrypted connection (TLS, SSL) is

needed when sending e-mail.

Sender

Information

Name:
Specify the sender name or use HMI name.
Mail Address:

Setting e-mail address.

Test SMTP
Settings

Verify SMTP settings in advance by sending a test email to

the specified e-mail address.

Click [Open Contact settings] to open the following dialog to edit contacts:

I__| WE!NTEK
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Contacts @
Mo. of groups : 1 Z
Contacts list Group information
Contact Haime Madl Address Contact Haime Mail Address
p | ebdT2000 ebd T3000@weintek com ebd T3000 el T3000@weintek com
Current group : [Group A ‘]
Add ] [ Remove Comment :
Import... ] ’ Export... ] [ OK l ’ Cancel ]
Setting Description

Contact list

Add or remove contacts from the list.

Group
Information

Group up contacts.

No. of groups:

Set no. of contact groups, according to the number, the
groups are named from A to P and up to 16 groups can be
set.

Current group:

Displays the group that includes the contacts above.
Comment:

Enter a description for the current group.

& For more information on sending Event Log, see “7 Event Log”.

& For more information on e-mail related system registers, see “22.3.40 e-Mail”.

5.12. Recipes

Configure the recipe list for [Recipe Database].

L—| WE!NTEK
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”'System Parameter Settings '
Device I Model I General ] System Setting I Security I Font |
Extended Memory |  PrintrBackupServer | TimeSync/DST |  e-Mail |  Recipes
Recipes List :
Recipes E] Itemname  Data type Size  Display width DecimalPt.  Alignment
1. test NewItem 16-bit BCD 1 5 0 Left
» I6htBCD 1 15 0 [leit [
v
New ] [ Settings ] [ Delete ]
Export definition file of recipes
* At most 100 items in one recipe are recommended. More items might reduce the performance of HMI.

Setting Description

Recipes List Add or delete a recipe.

New Add a new item.

Settings All the item information can be user-defined and modified,
see the following description.

Delete Delete the selected items.

Click [Settings]:

Recipes Item Information

Mame : Mewlteml

Display Type : [16-bit BCD - ]

Item size (WORD) @ |1

Display width (Chars) : [5 -]
Right of decimal Pt. : [0 -]
Alignment : | align left -
ok [ cancel
Setting Description
Name Enter recipe item name.
Display Type Setting item data type.

Item size (WORD)

Setting the size of the item.

Display with (Chars)

Setting the number of characters of the item to be
displayed.

Right of decimal pt.

Setting the decimal place when displaying data.

Alignment

Setting the alignment when displaying data. [Align
left], [Align center], and [Align right] can be selected.

@For more information, see “24 Recipe Editor”.

[\& WEINTEK

EasyBuilder Pro V5.05.02

5-30



System Parameter Settings 5-31

5.13. Cellular Data Network

This tab is for setting cellular data. Cellular data network settings may differ from one model to
another.

cMT Series

Attaching a 3G/4G USB dongle to the USB port enables the cMT-SVR to connect to 3G/4G

networks.

System Parameter Settings ﬁ
Dievice I Model I Creneral I Swatem Sethng | Security | Font Mapping |

Extended Memory | TimeSyne/DST |  eMal |  Recipes | Cellulaw Diata Network

USE cabl
3G/AG Dongle Skl
303403 Dongle (M T-SVE support only) Tethering
PIN code : 0000 AFN ;- internet
Usemame ©  sermame Pasgword © password

Dial number :  +30#

Setting Description
Use existing contact If this check box is selected, the cellular data currently
settings on HMI in HMI will be used. When no specific settings are

required, generally, [PIN code] is “0000”, [APN] is
“internet”, and [Username], [Password], [Dail number]
are optional.

The relevant registers:
LW-11297: (16 words) : PIN code of SIM card (cellular network)

LW-11313: (16 words) : Access Point Name (cellular network)

LW-11329: (16 words) : username (cellular network)

LW-11345: (16 words) : password (cellular network)

LW-11361: (16 words) : dial number (cellular network)

LW-11377: (16bit) : stop (set 0)/start (set 1) connection (cellular
network)

LW-11378: (16bit) : last error code (0:success, 1:incorrect PIN code,
2:no SIM, 3:no device, 4:puk locked, 5:other) (cellular
network)

LW-11379: (16bit) : connection status (0:no device, 1:disconnect,

2:connecting, 3:connected) (cellular network)
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eMT, iE, XE, mTV Series

5-32

By connecting an Android mobile phone with HMI using a micro USB cable, or any USB data

cable that is compatible with the phone, the internet connection of the phone can be shared

with HMI. On the Android mobile phone please enable USB Tethering.

Tethering or hotspot active

Tethering & portable hotspot

USB tethering

Tethered

Portable Wi-Fi hotspot

Set up Wi-Fi hotspot

AndroidAP WPA2 PSK portable Wi-Fi hotspot
Bluetooth tethering

Not sharing this phone's Internet

connection

When successfully connected, the following registers can be used to monitor and control the

connection status.
LW-11380:

LW-11381:

L—| WE!NTEK

(16bit) : stop (set 0)/start (set 1) connection (USB
tethering)

(16bit) : connection status (0:no device, 1:disconnect,
2:connected, 3:fail, 4:0S not support, 5:HMI not
support) (USB tethering)
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6. Window Operations

This chapter describes different types of windows and how to create, set and delete a window.

0 R @ 1V T o VT L SRS 6-2
6.2, WINUOW TYPES ..erereieeieieeiitiiieee e e e eesecittteee s e s e sesetaeaeeeeeeeesssssetereeeesesesanssnnneeeasesessansnsnens 6-2
6.3. Create, Set, and Delete @ WINAOW.........uueiviiiiiiiiiiiccee et e e 6-4

I__| WE'NTEK EasyBuilder Pro V5.05.02



Window Operations

6.1. Overview

A window is a basic element in a project. With a window, all kinds of information like objects,
pictures, and texts can be displayed on HMI screen. In total, 1997 windows numbered from 3 ~
1999 in EasyBuilder Pro can be built and edited.

6.2. Window Types

There are 4 types of windows, each with different functions and usages:
® Base Window

® Fast Selection Window

® Common Window

® System Message Window

6.2.1. Base Window

The most frequently used window, except for main screen, it can also be:
® A background of other windows.

A keyboard window.

A pop-up window of Function Key object.

A pop-up window of Direct Window and Indirect Window objects.
A screen saver.

0 Note

B Base Window should be in same size as the HMI screen. Therefore, the resolution of the
base window should be set to the resolution of HMI.

6.2.2. Fast Selection Window

Window no. 3 is the default Fast Selection Window. This window can co-exist with base
window. Generally, it is used to place the frequently-used buttons on the lower-left side or the
lower-right side on the screen. Please create window no. 3 first, and set the relevant properties
in [System Parameter Settings] » [General] tab. Apart from showing or hiding fast selection
window with the button on the screen, there are system registers to do so:

[LB-9013] Fast Selection window control [hide(ON)/show(OFF)]

[LB-9014] Fast Selection button control [hide(ON)/show(OFF)]

[LB-9015] Fast Selection window/button control [hide(ON)/show(OFF)]

0 Note

B cMT-SVR Series does not support Fast Selection Window.
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6.2.3. Common Window

Window no. 4 is the default Common Window. Objects in this window will be displayed in

other base windows, not including pop-up windows. Therefore, the common objects in

different windows are often placed in common window.

When operating HMI, select [Function Key] » [Change common window] to change the source

of common window.

In menu [Option] » [Preferences] select whether or not to [Display Common Window objects

on Base Windows] when editing a project. This can avoid overlapping objects in base window

with objects in common window.

Preferences &J
Display Object 1D Display Object Address
Font size : (12 - Text color : | ~
[¥] Background Background color : ﬂ
The number of displayed addressas :
Display Common Window objects on Base Windows
[] Display Underlay Window objects on Base Windows
|| using function key to make shape library object
Autormaticaly save and compile the project when download and simulate
[T] Generate backup of project file before save
[T] Automaticaly make used pictures and shapes into the project library
Save AutoRecover information
Every minutes

6.2.4. System Message Window

Windows No. 5, 6, 7, 8 are the default System Message Windows:

PLC no response

il close

Failed connection to remote HMI

Close

Password Protected! Access Denied I

{9

L—| WE!NTEK

Window No. 5: PLC Response
When the communication between PLC and HMI is
disconnected, this message window will pop up

automatically right on the base window currently opened.

This window can be disabled by system registers.
Window No. 6: HMI Connection

When failing to connect HMI with a remote HMI, this
message window will pop up automatically.

Window No. 7: Password Restriction

When attempting to control an object without
authorization, this window may pop up as a warning
depending on the settings of the object.
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Window No.8: Storage Space Insufficient
) When HMI flash memory, USB disk or SD card run out of
Storage Space Insufficient !I!

storage space, this message window will pop up
oa s

automatically. (When the memory space is under 4 MB)

The following system registers can be used to check the free memory space in HMI, USB disk,
or SD card:

[LW-9072] HMI current free space (K bytes)

[LW-9074] SD current free space (K bytes)

[LW-9076] USB disk current free space (K bytes)

To check if there is sufficient storage in the devices, the following system registers can be used.
These addresses will set ON when the space is under 4 MB.

[LB-9035] HMI free space insufficiency alarm (when ON)

[LB-9036] SD card free space insufficiency alarm (when ON)

[LB-9037] USB disk free space insufficiency alarm (when ON)

C?For more information, see “22 System Registers”.

The text shown in windows no. 5 ~ 8 can be edited for easier reference.

0 Note

B Ascreen can display up to 16 pop-up windows simultaneous including System Message
Window, Direct Window and Indirect Window.

B The system does not allow opening the same window with two Direct (or Indirect)
Windows in one base window.

B  Windows no. 3 to 9 are used by the system only, and windows no. 10 to 1999 can be
edited based on actual usage.

B For cMT-SVR Series, only 1 pop-up window can be displayed simultaneously.

6.3. Create, Set, and Delete a Window

Check the existing windows in [View] » [Window Tree].

[Object list] displays window numbers and window names. Opened windows are marked with
(*) sign. Press the (+) sign to see the object ID, address and description in this window.
[Window preview] displays the thumbnails of windows.
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Wiew | Option  Draw  Ohjects  Litwary Toole Window Help

Standand Teclbe
Pucject Toolbe
Lituay Toalbex
Text Toalber
Edit Teelbor
State TooTher
JE
PL Toalber
Cibject 1 Toolber
Chject 2 Toalbar

. Window Tree

diowr_020
FWindony i
Ohject list [T
0003 -~
3: Fast Selection ~ =
4: Commen Window = D
5. PLC Responss
6: HMI Comnection Fast Selection
7: Pazpword Restriction 0004
8 Btorage Space Insufficient
E
#10: WINDOW_010
11 Conumon Windowr
12 0005
i =
14 v

6.3.1. Creating and Setting a Window

In window tree right click on a window number then select [New].

Window Setti

ngs

Size

Frame

Background

Macro

Window no. : 10

Underlay windaw

Bottom : | 11, Window_011 -]

Popup window
Start position

¥: 0 v. 0 [¥] Monopaly [¥] Title bar

Name : WINDOW _010

Width : 800 Height : 480

width : Color : G|

Color :  p——— ~
[T Filled

Middle : [None v]

Top: [None v]

Open : [[ID:UUO] macro_0 v]

Cyde: [Disable -]

Close : [Disable v]

Setting

Description

Name

The name appears on the title bar and also in window tree.

Window no.

Can be 3 to 1999.

Size Set the window size in accordance with the HMI resolution.
Underlay Underlay Window can be seen as an extra Common
window Window. When designing the project, some commonly

used objects are used in some windows but not all. These
objects can be placed in underlay window.

[\& WEINTEK
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Each base window can set three underlay windows as
background, from [Bottom] to [Top]. The objects in underlay
windows are displayed in this order in base window.

Pop-up
window

Base window can also be used as a pop-up window. Use [X]
and [Y] to set the coordinates indicating where in the screen
will this base window pop up. The origin of the coordinates
is the upper-left corner of the window.

Monopoly

If the option is selected, when the base window pops up, no
operations of other pop-up windows and background
windows are allowed until the monopoly window is closed.
If a base window is used as a keyboard window, “Monopoly
is automatically enabled.

Title bar

If the option is selected, a title bar appears on a system
message window. This feature is only available for system
message windows no. 5 to no. 8.

Macro

Select the macro to be executed when the window opens or
closes, or the macro to be executed periodically (each 500
ms).

Please build the macro in advance.

@ Note

B The objects in underlay window cannot be edited from the base window that displays
them. To edit those objects, please open the underlay window where they are located.
B  When the window number of the underlay window used by the base window is identical

to the pop-up window, the pop-up window is disabled.

B When base window and pop-up window use the same underlay window, the objects in

the underlay window cannot be displayed in pop-up window.

Or, from the main menu click [Window] » [Open Window] and then click [New] and select the

type of the window and click [OK].
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Open Window
Nao. Window name Size
3 Fast Selaction 100,450
4 Common Window 800,480
5 PLC Response 320,100
6 HMI Connection 320,100 SeUings..,
7 Password Restriction 320,100
8 Storage Space Insufficient 320,100
*10 WINDOW_010 800,480
50 Keypad 11 - Integer 275,280
51 Keypad 12 - Integer 275,280
52 Keypad 3 - Integer 200,170
53 Keypad 4 - Integer 304,213
54 Keypad 5 - Integer 160,230
55 Keypad & - Integer 241,331
56 Keypad 7 - HEX 306,223
57 Keypad 8 - Floating 198,220
58 Keypad 9 - Numeric 248,248
60 ASCII Middle 576,240
61 ASCII Srrall 480,200
62 ASCII Upper M 576,240
63 ASCII Lower M 576,240
64 ASCII Upper § 480,200
65 ASCII Lower § 480,200
Exit

Ways to call up [Window Settings] dialog:

® Right click on the window number in the window tree and select [Settings].
® In[Window] » [Open Window] select the window then click [Settings].
® |nthe window, right click when no object is selected, and select [Attribute].

6.3.2. Open, Close, and Delete a Window

The ways to open an existing window:

® Double click on the window number in the window tree.
® Inthe window tree, select the window, right click, and then select [Open].
® In[Window] » [Open Window] select the window then click [Open].

The ways to close or delete an existing window:

® |nthe window tree, select the window; right click, then select [Close] or [Delete].

® In[Window] » [Open Window] select the window then click [Delete].
® To delete a window, please close it first.

I__| WE'NTEK EasyBuilder Pro V5.05.02
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/. Event Log

This chapter explains how to set and use Event Log.

7.0, OVEIVIEW ittt ettt e e e e e sttt e e e e e s e bbbttt e e e e e e s e nnnrbeeeeeeeesasnnsrnbeeeeeeeessannnrees 7-2
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7.3, Creating a NeW EVENT LOG ..cccovviiiiieiecececccececece e 7-6
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7.1. Overview

The following are the basic steps to use Event Log:

1. Define event content and trigger condition.

2. Trigger event according to the condition.

3. Save the event log to the specified device.

4. View the process of event by using the relevant objects.

This chapter will explain how to set and use Event Log.

7.2. Event Log Management

Firstly, define the event content then use Alarm Bar =2, Alarm Display @’, Event Display
objects to view the process of the whole event from triggering—waiting to be processed—

return to normal.

7.2.1. eMT, iE, XE, mTV Series

Local HMI: LB-0 | Disable Disable | Disable | Enable

Eventl BIT |ON Local HMI: LB-1 Disable Disable Disable Disable

] I J

Enable back light when alarm occurs
History files
Save to HMI memory Save to USB disk

Preservation limit

[ mew. |[ mnsert.. |[ Deete |[ settings.. |[ Ewport.. |[ Import.. |

[ Copy ] | Paste | | Paste (Add Mode) |
Setting Description
Category Classifies events by dividing them into 0 ~ 255 categories.

Select one category to add or view event log. In the bracket

“'1”, it shows the number of events are in this category.
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History
files

To specify a location to save event log files. However, when
executing On-line or Off-line Simulation on PC, the files will
be saved in the HMI_memory / SD_card / USB folder under
the installation directory.

Preservation limit

This setting determines the maximum number of Event Log
files to be preserved in HMI memory. This does not include
the file generated today. That is, if [Days of preservation] is
set to 2; the two latest files excluding the file generated today
will be kept. The files that are not within the range will be

deleted automatically for saving the storage space.

Save to
history

When a loacation to save event log files is specified in
[History files] group box, each event can be respectively
defined whether to be saved to history. The events will still be
displayed in Event Display object Real-time mode, but not in
History mode.

Print

In [System Parameter Settings] » [Model], select a printer and
set the printing format.

Paste

Overwrites the selected item with the new items. A message

window will pop up to confirm this operation.

Paste
(Add Mode)

Appends as a new entry.

L—| WE!NTEK
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7.2.2. cMT Series

Event (Alarm) Log

“

Category :

Al - 2]

MNo. Category‘Tex‘t |Mode|Condition|Readaddress |Notiﬁcation address|Euzzer |e Mail

Control address
Enable

EventQ BIT |OM Local HMI : LB-0 | Disable Disable  Disable

BN O s o T [ T Y e e A o

Address : [y ~|0 |1E-bitUnsigned

PLCname:ILodw v][ Setting... ] |

History files

Enable

Sync to SD card [¥] Sync to USB disk

New...

|[ mnset.. |[ Delete |[ settings.. |[ BExport.. |[ Import.. |

][ Paste || Paste (Add Mode) ]

Setting

Description

Category

Classifies events by dividing them into 0 ~ 255 categories.
Select one category to add or view event log. In the bracket

“['17, it shows the number of events are in this category.

Control
address

If select [Enable] check boxes under both [Control address]
and [History files], entering a specific value in the control
address sends the corresponding command.

When entering 1, clears the event log on cMT-SVR.

When entering 2, synchronizes event log to the external
device.

When entering 3, synchronizes event log to the external
device and then clears the event log on cMT-SVR.

If none of these values is entered, the system will synchronize
data in the same rules as [History files] setting explained

below.

History
files

If enabled, saves the synchronized data to SD, USB disk, or
database. The rules of synchronizing the data saved in the
external device are:

B When the number of events is under 10000, the events

[\& WE!NTEK
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will be temporarily saved in cMT-SVR.

B When the number of events reaches 10000, the system
will automatically save the data to the external device
and deletes the earliest 1000 events in cMT-SVR.

B [f the external device already contains some events, the
new data is appended without overwriting the original
data each time in synchronization.

B [f the external device is removed from cMT-SVR, and
inserted back again at the time when the number of
events is under 9000, the data generated during the
time the external device is removed is saved in cMT-SVR
and is not cleared. If the data exceeds 9000 records
during the time the external device is removed, the
earlier data is cleared and cannot be synchronized even

to insert the external device back.

Paste Overwrite the selected items with the clipboard contents.
A message window will pop up to confirm this operation.

Paste
(Add Mode)

@ Note

B Toremove SD card or USB disk, event log data can be synchronized by using control

Append the clipboard contents to the end of the list.

address first.
7.2.3. Excel Editing

Click on the Excel icon in Event Log setting dialog box to open the Excel template for a
reference of editing. This template is under the installation directory, the file name is

EventLogExample.xls. This template includes the ready-made dropdown lists and validation

mechanism.
A E C D E F G H 1 ] K
1 | Category |Priority level | Address type|PLC name Device type Syatem fag |User-defined tag|4ddress  |Index Data Format Enable
2 0[Middle Word Local HMI LW False False 100|null 32-bit Signed Tiue
3 1|Low Bit Local HMI LE-9009 True False 9009|IDX 5 16-bit BCD ¥ [se
4 F2-bit BCD
5 16-bit Unsigned
16-bit Binged
6 33-it nsigned
32-bit Signed
7 33-bit Float

A@ Note

B [System tag] and [User-defined tag] cannot be set to true simultaneously, otherwise, the

system will view the User-defined tag to be a System tag, and [User-defined tag] to be
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false. If setting [Device type] to [User-defined tag], please set [System tag] to false.

B When setting [User-defined tag] to true, if the system compares the [Device type] with
the user-defined tag in the system, and no suitable tag is found, the system will set the
[User-defined tag] in event log to false

B [Color] format is R:G:B, each should be an integer form 0 to 255.

B Before importing Label Library / Sound Library, please make sure the library names exist in
the system.

7.2.4. Quick View of Errors

When compiling the project, the errors in Event Log will be displayed in the Compile window.

To open Event Log and view the errors, double click on the item in the Compile window.

Compile \EI

Project name : C\EMTP1l.emtp

EXOB file name : [C:\EMTP1.exob

EXOB password = (used in decompiler) || Decompilation is prohibited

[~ Disable HMI upload function

Select the languages used on the HMI
Startup language after redownloading the project : | Language 1 -

[#] Language 1 [#] Language 2

rrorfsi—:
1. Event (Alarm) Log 1 (Category 1) : PLC name undefined {Rockwel DF1)
2. Event (Alarm) Log 1 (Category 1) : incorrect device type
3. Event (Alarm) Log 2 (Category 1) : PLC name undefined {Rockwel DF1)
4. Event (Alarm) Log 2 (Category 1) : incorrect device type
5. Event (Alarm) Log 3 (Category 1) : PLC name undefined (Rockwell DF1)
6. Event (Alarm) Log 3 (Category 1) : incorrect device type
7. Event (Alarm) Log 4 (Category 1) : PLC name undefined (Rockwell DF1)
8. Event (Alarm) Log 4 (Category 1) : incorrect device type

m

Double click error massages to modify the attributes of relative objects!

[ Compile ] [ Font Management... ] Build font files

7.3. Creating a New Event Log

General Tab

Click [New] in the [Event (Alarm) Log] dialog box.

I__| WE'NTEK EasyBuilder Pro V5.05.02



Event Log
Event (Alarm) Log @
Categaryr: 0 Pnoritylevel:
Address type - () Bit @ Ward
Dielay time for event monitoring when HMI resets -
Read address
FLC n-3|'“E=[Laca| HMI v] Settings...
Address : 1] 16-bit Unsigned
Hotification
[¥] Enable () St ON @) Set OFF
[ Follow
PLC name  Local HML ~ ][ setings...
Condition
Tigeerifveleis: [«
Drymiauide condition value
Read AZondition vse different addresses
Condition value address
FLC n-3|'“E=[Laca| HMI v] Settings...
Cancel Help
Setting Description
Category Select event category, the range is from 0 to 255.
Priority When the number of events equals to the max number of the
level system (default 1000), the lower priority events will be
deleted and new events will be added in.
Delay time This feature is used to set the delay time of Event Log after
for ex(en_t HMI reboot, in order to avoid false alarm that occurs upon
‘Tﬁgr'] glrl:;l]lg HMI reboot due to uninitialized values. This feature is often
resets used with [Dynamic condition value]. The delay time only
occurs once upon HMI reboot.
Read The system reads data from this address to check if the event
address matches the trigger condition.

Notification

When enabled, the system will set the specified address ON
or OFF when the event is triggered.

Follow

The notification bit will reset to its original state once the
alarm condition returns to normal. For example, when the
alarm is triggered, the state of the notification bit turns ON.
When the alarm condition returns to normal, and [Follow]
check box is selected, the state of the notification bit turns
OFF.

Condition

When [Bit] is selected, Event Log will detect the state of a Bit
address.
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When [Word] is selected, Event Log will detect the value of a
Word address to check if it is greater than, less than, or
equals to a specified value. See Example 1 and Example 2.
Dynamic condition value

Allows online change of the comparison value for trigger
condition when the condition is a Word address type. If
[Read/Condition use different addresses] is not selected, the
source of condition value will be the next consecutive address
from [Read address].

Read/Condition use different addresses

Allows selecting the Word address type to be the source of
condition value.

Example 1

Condition

Trigger if value is : l;l 30

In tolerance @ 1 Out tolerance : 2

The setting above indicates:
When [Read address] value is greater than or equals to 29 (=30 - 1)
Or less than or equals to 31 (= 30 + 1), the event will be triggered. The trigger condition:
29 < [Read address] value < 31

After the event is triggered, when [Read address] value is greater than 32 (= 30 + 2) or less than
28 (= 30 - 2) the system will return to normal condition:

[Read address] value < 28 or [Read address] value > 32
Example 2

Condition

Trigger if valueis ; | <= ~| 30

In tolerance : 1 Cut tolerance @ 2

The setting above indicates:
When [Read address] value is less than 29 (= 30 - 1)
or greater than 31 (= 30 + 1), the event will be triggered. The trigger condition:
[Read address] value < 29 or [Read address] value > 31
After the event is triggered, when [Read address] value is greater than or equals to 28 (=30 - 2)
or less than or equals to 32 (= 30 + 2) the system will return to normal condition:
28 < [Read address] value < 32
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Message Tab

Event (Alarm) Log @
| Generl | Message | Statistics|
Text
Content :
sz label library [ Label Library... ]
[¥] Use string table ( String Table... |
Section : | [ID:000 v
String ID (zm0001 ]
[V] Dymamic
PLC: [LocalHMI v] Settings...
Address : [LW v] 10 16-bit Unsigned
Font: | &rial
Color :  —— vl Background color v

Acknowled ge value for Event/Alarm Display object
Acknowledge valve : 11 )

Sound
[ Enable

Sound Library

Addresses of WATCH1 ~ WATCHE

Multi-watch : [0 v Settings Symtax...

* Please use "Droid Sans Fallback" font if the content of text is detexmined in run time. (This

font will increase HMI startup time.)
Help

[ OK ] [ Cancel

Setting

Description

Content

The text content displayed in [Alarm Bar], [Alarm Display],
and [Event Display] objects. Use the formats in the
following two examples of WATCH addresses to use
register data in content. See Example 3, and Example 4.
The content in Label Tag Library and String Table can be

used in the Event Log message.

Font / Color /
Background
color

The font / color / background color can be set respectively
for each event. The font and color settings determine how
[Alarm Bar] shows the text, while The font, color, and
background color settings determine how [Alarm Display]
and [Event Display] show the text. These settings are not

available in the [Event Display] under History mode.

Write value for
Event/Alarm
Display object

When an event in [Event Display] or [Alarm Display] is
acknowledged, the value is written to the assigned [Write

address].
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Sound If enabled, the selected sound will be played when an
event is triggered. Continuous beep can also be enabled,
which only stops when the event is acknowledged or
recovered.

For continuous beep, a delay time can be set between

triggering the alarm and the start of beeping.

Acknowledged

een] _| L

< >
N 1 O
PR SRR
The time interval for beep sound
is once in each second

Address of Click [Syntax] to edit and display the value in watch

WATCH1~8

address when the event is triggered. Up to 8 watch

addresses can be set.

Example 3

The data of the LW register can be used in the content displayed when an event is triggered:

Format: %#d (% -> initial sign, # -> address, d -> end sign)

When an event is triggered, if the value in LW-20 is 13:

Setting: “High Temperature = %20d”-> Display: “High Temperature = 13”
Example 4

The data in the specified address when the event is triggered can be included in the content
displayed. The address should be set to the [Read address] of Event Log, take MODBUS RTU 4x

address as an example:

Format: $#d (S -> initial sign, # -> address, d -> end sign)

When an event is triggered, if the value in MODBUS 4x-15 is 42:

Setting: “High Temperature = $15d” - Display: “High Temperature = 42"

e-Mail Tab

Please enable this function in [System Parameter Settings] » [e-Mail] first.
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Event (Alarm) Log

| General I Message | e-Mail |Oocurrenoe|

Enable Condition
Send when event triggered
» Send when event cleared

Recipients

Group A

Subject

Subject :

]

Message
Opening :
4
Use label library

Ending :

]

Use label library

Recipients

Giroup &

[ As recipients of triggered mail settings

Use event content as subject

Tank level low. level=26(WATCH1)d.0

3

Label Library...

] [Language 1 -

] [ Cancel

Setting

Description

Recipients

Select the [To], [Cc], and [Bcc] recipients.

Subject

Enter the subject of the e-mail.

Message

Enter the [Opening] and [Ending] content of an E-mail.

Attach

If the [Contains a screenshot of window] check box is
selected, the screenshot of the selected window will be

attached.

Statistics

[\& WEINTEK

Event (Alarm) Log @
| Grengral | Message | e-bail | Statistics |
Occurrence read and reset address
Enable
ELC : (Local HMI - [ Settings...
Address [LW ,] il 16-bit Tnsigned
Elapsed time read and reset address
Enable
ELC : [Locsl HMI v |[ Settings. .
Address [LW ,] 1 16-bit Tnsgned
TTnit of elapsed time : second

EasyBuilder Pro V5.05.02
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Setting

Description

Occurrence
read and reset
address

If enabled, the number of events occurred after HMI
startup will be written to the designated word address.
The word address can be read / written.

Elapsed time
read and reset
address

The elapsed time (in seconds) of the event will be written
to the designated word address. The word address can be
read / written.
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8. Data Sampling

This chapter explains how to set and use Data Sampling.

8.1.
8.2.
8.3.
8.4.
8.5.

OVBIVIBW ...ttt ee ettt e e e e ettt et e e e e e sttt e e e e e e s e anbe et eeeeeesesanssseeeeeeeeessannnrnenaeaeens 8-2
Data Sampling ManagemENt .......cciii i i e e e e e e e rer e e e e e e e e 8-2
Creating a New Data SampPling .......uuieiieriiiiceee e e e 8-2
Synchronizing cMT Viewer data and Saving to External Device.......ccccovvveeeeeiieicnnnnnee, 8-9
Checking History Data of a Specific Date on CMT VIieWEr. .......cceeeeeeiiieeeiiiiieee e 8-9
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8.1. Overview

After defining how the data is sampled, by sampling time, address, or data length, the sampled
data can be saved to the designated location, such as HMI memory, SD card, or USB disk. Trend

Display and History Data Display objects can be used to display sampling records.
8.2. Data Sampling Management
Create a new Data Sampling object first by the following steps:

1. From the menu select [Objects] and click [Data Sampling].

2. Click [New] to finish relevant settings.

Data Sampling Object

Mo, | Description | Read address Hample mode | Trigger address | Clear address Hold address Autn. stop

Local HMI: LW-0 | Periodical Local HMI: LED | Local HMI; LEL

New... I [ Delete ] [ Settings... @

8.3. Creating a New Data Sampling

The following introduces how to set a new Data Sampling.
eMT, iE, XE, mTV Series

(Data Sampling OBJct /7

e PLC name : [Loml HMI ']
Sampling mode Clear real-time data address
([ High priority (this may reduce refresh rate of screen components.) Enable
(@ Time-based (7) Trigger-based
Sampling time interval : |1 second(s) -
Hold address
Enable
Read address.
PLC name =[Lom|H\ﬂ vl[ Settings... ]
History files
Address ;| Lwy > |0 Y

[¥]5ave to HMI memory

=1In prior to display or store the data log, you can use the conversion tag to check and [C]save to USB disk
modify the data log.

=\When the Data record is converted by the user-defined conversion tag, the

@ Each fie consists of all records of a day

GetCnvTagArraryIndex() function of [Read conversion] subroutine can get the relative (7 Customized file handiing
array index.
Data Record Folder name : Datalog
Max. data records (real-time mode) : 1000 S Fie name example : | 20150727 4 \
Data Format ... Data length : 1 word(s) Preservation limit 7 day(s)
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cMT Series

Data Sampling Object

Comment :

Sampling mode

Control address

Time-based ©) Trigger-based [V]Enable
Mode : [OFF->0N |  [T]set OFF after triggered PLC: [Local HMI v] Settings...
Address : |Lw v | 10 16-bit Unsigned
PLC: [Local HMI v %Setﬁngs..‘
Address: |LB vl0 History file
[¥]Enable []Enable status address
Read address Name : Datalog
PLC: [Local HMI ~ | settings...
Address : |Lw v)0 [7]sync. to SD card []sync. to USB disk
Data Record
[ Data Format ... Data length : 0 word(s)
Sync to database
Hold address [V]Enable
Database : | 1. 192.168.1.0 2
PLC : [Local HMI v settings...
Address: (LB vi1
OK ] i Cancel
Setting Description

Sampling mode

High priority

Data sampling processes with this feature enabled will be
prioritized. Please note that too many priorities can slow
down update rate of other objects.

Time-based

Samples data in a fixed frequency. The [Sampling time
interval] can be set from “0.1 second(s) to 120 mins”.
Trigger-based

Triggers data sampling by the status of a designated bit
address.

Mode Conditions to trigger Data Sampling:

[OFF -> ON] Triggers sampling when the status of the
address changes from OFF to ON.

[ON -> OFF] Triggers sampling when the status of the
address changes from ON to OFF.

[OFF <-> ON] Triggers sampling when the status of the
address changes.

Set ON/OFF after triggered

If selected, after triggering Data Sampling, the system will
set the designated bit address back to ON/OFF state.

Read address

Specify an address to be the source of Data Sampling.

Data Record
(Real-time)

In Real-time Mode, when [Auto. stop] is not selected, the

max. number of data records can be saved on HMI is

L—| WE!NTEK
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86400. When the number of records exceeds 86400, the
earliest data will be deleted.

Data Format

Data of different formats in consecutive registers can be
sampled. For example, setting: LW-0 (16-bit Unsigned),
LW-1 (32-bit Float), and LW-3 (16-bit Unsigned).

Data Format

1. "16bit Unsigned” 16-bit Unsigned
2. "32bit Float" 32-bit Float

signed signed

]

[ New... ][ Delete ][ Settings... ]

*When the [Read address] uses an user-defined conversion tag, it is suggested that
each item of the Data Record selects the same data length even in different data
types. i.e. 16bit BCD, 16-bit Signed, 16-bit Unsigned)

Auto. stop
Data sampling will automatically stop when the number

of records reaches [Max. data records].

C"’?‘See “8.3.1 Demonstration of Auto. stop”.

Clear real-time

data address

Set when the bit address status changes from [OFF -> ON]
or [ON -> OFF], clear the sampled data in Trend Display

Real-time Mode. The number of data records returns zero
but the data records that are already saved as history files

will not be cleared.

Hold address

If the status of the designated address is set ON or OFF,
sampling will be paused until the status of the designated
address returns.

Control
address
(cMT Series)

Entering a value in the control address sends the
corresponding command.

Enter 1: Clears the sampled data in HMI.

Enter 2: Synchronizes data to the external device.
Enter 3: Synchronizes data to the external device and

then clears the sampled data in HMI.

History files

® eMT,iE, XE, mTV Series

Save to HMI momery

Saves Data Sampling to HMI every 10 seconds. Or, use
system register [LB-9034] to force storing data.

L—| WE!NTEK
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Save to SD card / USB disk

Saves Data Sampling to the specified external device.
Each file consists of all records of a day

The data sampling file will be saved on a daily basis into
the specified folder, and the file name will be
yyyymmdd.dtl, indicating the date of the file.
Cutomized file handling

This feature can be used to customize naming and

management of data sampling files (*dtl).

@See “8.3.2 Customized File Handling”.

Folder name

Specify Data Sampling file name which must be all in
ASCII characters. The folder name will be written as:
[Storage Location] \ [Folder Name] \ [File Name]
Preservation limit

Determines the number of data sampling files to be
preserved. Please note that the current .dtl file is not
included in this limit. That is, if this limit is set to 2, apart
from the current file, two latest files will be preserved.
® cMT Series

History data can be saved to USB disk, SD card, and
Database Server. When the sampled data reaches 10000
records, the sampled data is automatically saved to the
selected external device, and the earliest 1000 records
are deleted. To save data in Database Server, please set

the computer’s IP address.

C?See synchronization rules in “8.4 Synchronizing cMT
Viewer data and Saving to External Device”.

C’:’_—vSee Database Server usage in “13.44 Database

Server”.

0 Note
[ |

A Data Sampling may include more than one type of records. Data Sampling can retrieve
different types of records at the same time. For example, if define three types of data, 4
words in total, the system retrieves a 4-word data each time from the designated address to
be the content in one Data Sampling.

B When using [Each file consists of all records of a day] and set [Preservation limit] to 2 files,
the data of yesterday and the day before yesterday will be kept. Data that is not built in this
period will be deleted to prevent the storage space from running out.
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B When using [Customized file handling] and set [Preservation limit] to 2 files, not only the
currently sampled file, another 2 newest files (3 files in total) will be kept. The rest of the
data will be deleted to prevent the storage space from running out.

B When running simulation on PC, all data sampling will be saved to the datalog folder in
C:\EBPro\ [Storage Location] \datalog. If you change the data format of data sampling,
delete the previous data records in the installation directory to prevent the system from
reading the old records.

B When saving files to USB disk or SD card, the capacity of a FAT32 folder depends on the
length of the file names. Fewer files can be saved when the file names are longer.

8.3.1. Demonstration of Auto. stop

This feature depends on the arrangement of different objects and modes. (Set [Max. data
records] to n.)

Object [Auto. stop] not selected [Auto. stop] selected
Trend Display- Deletes the earlier Stops after reaching the

. records and displays the specified number of
Real time latest number of records data records (n).

(n) in Trend Display. See
the following figure.

Trend Display- Keeps on sampling data Stops after reaching the
o and displays all history specified number of
Historical data in Trend Display. data records (n).
History Data Keeps on sampling data Stops after reaching the
. and displays all history specified number of
Display data in History Data data records (n).
Display.
Data Sampling Keeps on sampling new Stops after reaching the
data. specified number of

data records (n).

The figure illustrates how the data is sampled in Trend Display — Real Time mode when [Auto.
stop check] box is not selected. Set the number of data records to 10, when the 11" data is

generated, the earliest record is deleted and the newest record is added.
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Record Not selecting
Number Data [Auto. stop]
1 101 102
2 102 103
3 103 104
4 104 105
5 105 106
6 106 b. 107
7 107 108
8 108 109
9 109 110
10 110 111

11 111

8.3.2. Customized File Handling

This feature can be used to customize naming and management of data sampling files (*.dtl).

Customized File Handling

File creation

() Automatic mode (A new file will be areated when the file name is changed.)
(@ Trigger mode (Use the trigger method to create a new file.)

Trigger method
Limit by number of data records
Max. datarecordsin a file : 1000

Register status

Mode : |OFF-»0N - | [/] Set OFF after triggered

PLC name : [Loml HMI = ] Settings...

Address : [LB v] 0

File name
[ ynamic format

[ Year (1911-2048) || Year (0093) | Month(01-12) | Day(0131) |

[ week(00-53 || weekday (06) |
[ Hour 0023 | minute (0053) |[ Second (00-53) | (%]

Format: &Y %%em%ed
Example ; | 20141121.d4

%Y Year {1911-2048)

%oy Year, last two digits (00-99)

om Month as a decimal number (01-12)
%ed Day of the month (01-31)

W Week number (00-53)

B Weekday, 0 is Sunday (0-8)

%H Hour in 24h format (00-23)

%M Minute (00-53)

%S Second (00-59)

%% %

Jdtl

* A filename cannot contain any of the following characters: \f: =7 < = |

[ oK ] ’ Cancel

Setting

Description

File creation

Automatic mode

[\& WEINTEK
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A new file will be created when the name of an existing
file is changed.

Trigger mode

A new file will be created according to the [Trigger
method] settings.

Trigger method Limit by number of data records
A new file will be created when the number of data
sampling records reaches the specified "Max. data
records in a file"
Register status
A new file will be created when the status of a designated
bit address meets the specified condition. The condition
is specified in Mode field.
Set ON/OFF after triggered
If selected, after the new file is created, the system will
set the designated bit address back to ON/OFF state.

File name The file name can be an alphanumeric name, and certain

half-width symbols are allowed. The file name can also be
specified by a file name syntax.

Dynamic format

The file names can be set by a designated word address,
or by a file name syntax indicating the current system
time. The file name syntax can be specified by selecting
time buttons or entering the syntax in Format field. The
length limit is from 1 to 25.

The following half-width characters are not allowed:
\/:*¥?“<>|

@ Note

B |f both [Limit by number of data records] and [Dynamic format] check boxes are selected,
before startup HMI, please enter the name in the designated register for Dynamic Format,
otherwise, it is impossible the reach the “Max. data records in a file”, and the data sampling
file will not be generated.

B When a new file is generated, the systm will first detect if the filename already exists. If the
file name does exist, the newly sampled data will be appended to the existing file.
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8.4. Synchronizing cMT Viewer data and Saving to External Device

History data in external device Real-time data

» <&

v

For other series, when displaying the sampled data in Trend Display object, it is necessary to
select from Real-time mode or History mode and the two modes cannot simultaneously be

displayed in one object.

cMT Series allows displaying history data and at the same time updates real-time data in one

Trend Display or History Data Display object. The data saved in the external device can be
updated.
The rule of synchronizing the data saved in the external device:

1. When the sampled data reaches 10000 records, HMI will automatically save data to the

external device and deletes the earliest 1000 records in HMI.

2. If the external device is removed from HMI, and inserted back again at the time when the

sampled data is under 9000 records, the data generated during the time the external

device is removed is saved in HMI and is not cleared. If the data exceeds 9000 records

during the time the external device is removed, the earlier data is cleared and cannot be

synchronized even to insert the external device back to the HMI.
3. If there already exists sampled data in the external device, the new data is appended

without overwriting the original data each time in synchronization.

8.5. Checking History Data of a Specific Date on cMT Viewer.
To check the history data, see the following steps (Use Trend Display object as example).

1. Tapthe icon in the upper-right corner of the Trend Display object.
2. The following dialog box appears.

I__| WE'NTEK EasyBuilder Pro V5.05.02
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Option ﬁ

Begin Date () oFF

Ended Date () OFF
Trend Display Setting

Channel Visibility >
Y Scale On >

Reset to project default

3. Specify the [Begin Date] and [Ended Date].

Option ﬁ
Begin Date MI

2013-08-15 >
Ended Date MI
2013-08-15 >

4. Tap [Done] button to finish setting.
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9. Object General Properties

This chapter explains the basic settings of an object.

9.1.
9.2.
9.3.
9.4.
9.5.

OVBIVIBW ...ttt ee ettt e e e e ettt et e e e e e sttt e e e e e e s e anbe et eeeeeesesanssseeeeeeeeessannnrnenaeaeens 9-2
Selecting PLC and Setting Read/Write Address ........ccouveeeeeeeciieeccieeeciee e 9-2
Using Shape Library and Picture Library......cccccooocoiieeie e 9-3
SettiNG Label TEXL.coeei i e e e e 9-6
AdJUSting Profile SiZ€ .......ueeeeeiiieieeccee e e 9-8
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9.1. Overview

The basic steps to create an object:

1.
2.
3.
4.

Selecting the PLC device and setting the read/write address.

Using Shape Library and Picture Library.

Setting label text.

Adjusting profile size.

This chapter explains the basic settings of an object.

9.2. Selecting PLC and Setting Read/Write Address

Most objects read data from PLC devices, so a properly configured PLC address is needed.

Select the PLC to control at [PLC name] which comes from [System Parameters Settings] »

[Device List].

Write address
PLC name : [Local HMI v] [ Setting... |
Address:’Lw ] IDX 0  [16-bit Unsigned
Address @
PLC name : [L0C3| HMI ']
Device type : [Lw ']
Address: 0 [ system tag
Address format : DDDDD [range : 0 ~ 10799]
5] [ ot
Setting Description
PLC name Select the PLC type.
Device type Different PLCs have different device types.
Address Set the read/write address.
System tag Address tags include [System Tag] and [User-defined Tag].

This option allows users to use [System Tag]. [System Tag]
consists of the preserved addresses by system for
particular purposes. The address tags include bit registers
or word registers (LB or LW).

After selecting [System tag], not only will the [Device type]
field display the chosen tag, but [Address] field will also

display the chosen register.
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Index register

Select this check box to use the [Index Register]. Certain

objects require data type setting. The following data types

are supported in EasyBuilder Pro, Selecting correct data

type is necessary especially when using address tag.

16-bit Tnzizned L

16-hit BCD
32-bit BCD
16-bit Hex
32-bit Hex
165-bit Binawy
32-bit Binawy
16-bit Tnsigned
16-bit Signed
32-bit Undgned

32-hit Si%d

& For more information about System Tag, see “22 System Reserved Words and Bits”.

& For more information about Index Register, see “11 Index Register”.

& For more information about Tag Library, see “16 Address Tag Library”.

9.3. Using Shape Library and Picture Library

Shape Library and Picture Library are used to add visual effects on objects. Select [Shape] tab

to use the libraries when creating an object.

I__| WE!NTEK

New Bit Lamp Object (==3al
| General | Security | Shape |Label |
Shape
[ Shape Library...
Inner N
Frame -
Interior pattern : - | Pattern Style...
[ Duplicate these attributes to every state ]
Picture
[ Picture Library... ] |se picture
Set to original dimensions
Freview
(o] State:
Picture :
Background : -
o] [cane
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Setting Description

Shape Library Select [Use shape] check box and select a shape from the
library. See next page.

Inner Select this check box to set the inner part of a shape. Click
the drop down button to select a color or customize a
color and click [Add to Custom Colors]. EasyBuilder Pro will
save this color.

Color
Basic colors:
Al el § |
HTEN NN 14
EREEEEEN
ENEEEEEN
EEEEEEEN
EEEENTE
Custom colors:
Frrrrrrrrr
Hue: 200 Bed: 255
I_I_I_I_I_I_I_I_ Sat: 240 Green: 128
Define Custom Colors >3 ColoriSghd |\ ;180 Blue: 255
’ Add to Custom Colors ]
Frame Select this check box to set the frame of a shape. Click the

drop down button to select a color.

Inner Pattern

Set the color of the interior pattern of the shape.
Pattern Style

Click this button to select a pattern.
-Pal'tanStyle

| |

Duplicate these
attributes to

every state

Duplicate all attributes of the current state to other states.

[\& WEINTEK
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9.3.1. Shape manager

Click [Shape Library...] button to open the [Shape manager] dialog box. The currently selected
shape is highlighted yellow.

S
Library
[buttonz v]
[] 1 -
Fhapeu 2 Fhapel 2 |
I W W
P @) [T
2 3
oz (@) Fas @)
W W
) @
« : ﬂ a
Fhapez 2 Bhapes ) | E]
tates : 2 tates : 2 1 Inner
= # [pBiects:0 1
6 7 A
‘ I Fhapﬁﬁ @ I Fhape7 [Z]
N o ol em—— - (s | [ _cem |
Background \vl [ oK. ][ Cancel ][ Help ]

The illustration above provides information of one of the Shapes in the Shape Library:

Shape5 Name of the shape.

States: 2 Number of states of the shape.

Objects: 1 This shape is used by 1 object in the project.

The illustration above shows the shape has two states, State 0 and State 1, and contains only
“inner” but not “frame.” When finished, click [OK], and the object will use the selected shape.

9.3.2. Pictures manager

Click [Picture Library...] button to open the [Pictures manager] dialog. The currently selected
picture is highlighted yellow.

Pictures manager
[button_type14 -]
0 1 -
@ @ @
Ftabes:z Ftabes:?.
priects <0 ) JpBiects s 0
2 B
[ [
@[ @
tates : 1 ‘-J tates : 1
— e
PNG 126x185
4 = 0 5 5975 bytes @
) @ | PG 126x185 '
tates : 2 tates : 2 1 5 5948 bytes
ﬁbjects 0 @] ﬁmacts ) [E] — NG 126185
. S 2 6002 bytes =}
_
- 2 | - s 8
I Been T |[ Men || peete |[ Cen |
Mare pichrs libraiss... Background: [ Jiw| [ ok [ cancad |[ reb ]

& For more information, see “14 Shape Library and Picture Library”.
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9.4. Setting Label Text
Bit Lamp Object's Properties @I
| General I Security | Shape | Label |Prcﬁle|
Use label library
[ Corwert labels to bitmap images (Use bitmap font)
State : (1 1 (o]
Attribute

Font : Arial -

Color : - Size :

Align : Blink =

[ 1talic [ underline
Duplicate these attributes to
Movement
Content
[#] Tracking [ Duplicate this label to every state ]
o] [ canca |

Setting Description
Use label Select this check box to use labels for the object.
Use label ) ) )
. Select this check box to choose a label in Label Library.
library
Use bitmap Select this check box to convert the label text into bitmap
font format.

Label Library

Browse Label Library

& For more information, see “15 Label Tag Library

and Multi Language”.

Font

Select a font from the list. EasyBuilder Pro supports

Windows True-type fonts.

For cMT-SVR Series, if the font is followed by another font

enclosed by parentheses, the enclosed font is the one
used in iPad.

I__| WE!NTEK
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Font : w

Calor : 1::11-'. {Helvetica Neug)

. 0

Llizn ¢ | Aria] Narrow (Helvetica Meus)

Arial Narrow Bold (Helvetica Wene)
Aria] Tnicode WS (Heiti TC)
AmoPro-Bold (Helvetica Wene) B
AmoPro-BoldCaption (Helvetica Weve)
A moPro-BoldDizplay (Helvetica Mene)
AmoPro-BoldimText (Helvetica Nene)
ArmoPro-Boldiubhead (Helvetica Heue)
ArmoPro-Caption (Helvetiza Neus)

Color Select the font color.
Size Select the font size.
Align The text aligned
[Left] [Center] [Right]
111 111 111
222222 222222 222222
333333333 333333333 333333333
Blink Specify the way the text blinks. Choose [None] to disable
this feature or set the blinking interval to [1 second] or
[0.5 seconds].
Italic .
Use ltalic font. Italic Label
Underline .
Use Underline font. Underline Label
Movement Direction
Set the direction of the marquee effect. The directions
include: [No movement], [Left], [Right], [Up], [Down].
Continuous
Specify how the marquee effect is displayed.
If not selecting this check box, the next text appears only
when the previous text disappears completely.
If selecting this check box, the text will be displayed
continuously.
Speed
Adjust the speed of the text movement.
Content Set the content of the text. If [Label Library] is used, it will

automatically use the text defined in Label Library.

I__| WE!NTEK
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Tracking

If this check box is selected, when changing the position of
the text in one state, the text position in the other states

will also change in accordance.

Duplicate this
label to other
state

Duplicate the current text to the other states.

0 Note

B When Text/Comment object is used with Comment enabled, the text used as comment

will not appear on HMI.

9.5. Adjusting Profile Size

When an object is created and placed in the editing screen, double click it and select the

[Profile] tab to adjust the position and size of the object.

Bit Lamp Object's Properties @
[ General [ Secusity | Shape | Label | Profile |
Pozition
; K217 2 ¥ 208 :
Size
[] Keep widthheight ratio
Width : 50 2 Height : 50 2
Width (%) © 100 4| Height (%) : 100 :

Setting

Description

Position

Pinned

When this check box is selected, the position and the size
of the object cannot be changed.

[X] and [Y]

The coordinates of the position of the object in the editing

screen.

Size

Adjust the [width] and [height] of the object.
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10.User Password and Object

Security

This chapter discusses the protection for operations provided by setting up user passwords and
security classes.

LO.1.  OVOIVIBW ..ueiiiiieieee ittt e e e e e ettt e e e e e ettt e e e e e s e aanr ettt e aeeesesanbrreeeeaeeeessannsraneaaaens 10-2
10.2. User Password and Operable Object Classes ......cccovvccuiiiiieeeiiicccciieeeeee e, 10-2
10.3. Enhanced Security Mode and Control Address........cccccuvveieeeeiicccciiiieeeee e, 10-4
10.4. Enhanced Security Mode USABE......cuceviieiiiiiiiieiee e cccirttee e e e eecrvtree e e e e e e nareneee e 10-7
10.5. Object SECUrity SETtINGS...cciii i e 10-13
10.6. Example of Object Security SEttiNgS........oeeiiiiiii e 10-14
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10.1. Overview

This chapter discusses the protection for operations provided by setting up user passwords and
security classes. There are two authentication modes:

® General Mode

® Enhanced Security Mode

Each mode will be introduced later.

To set up the protection system, please:

1. Set user password and operable classes.

2. Set object class for objects.

An object belongs only to one security class. Setting the object class to “None” means any user

can operate this object.

10.2. User Password and Operable Object Classes

The security parameters can be found in [Edit] » [System Parameter Settings] » [Security]. Two

modes are available: General Mode and Enhanced Security Mode.
10.2.1. General Mode

Up to 12 sets of user and password are available. A password should be one non-negative
integer. There are six security classes: Ato F.
Once the password is entered, the objects that the user can operate are classified. As shown

below, “User 1” can only operate objects with class A or class C.

0 Note

B General Mode is not available for cMT-SVR Series.

System Parameter Settings @
Extended Memory | Printer/Backup Server | e-Mail | Recipes
Dievice Model I General | Systemn Jetting | Security | Font
@ General mode () Enhaced secwrity mode

Select operable classes for each user
Password range - 0 ~ 4294067205

i [ [
IDoEEoEf

gl L i e
sEEEEEEp
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10.2.2. Enhanced Security Mode

Up to 11 users can be set here. In addition, [Administrator] setting is provided. Administrator
has all privileges and can operate all object classes. User passwords must be alphanumeric
characters and each user can have up to 12 operable classes: A to L. (Up to 127 users can be
set in Administrator Tools. Please see “10.4 Enhanced Security Mode Usage” for more details.)

Enhanced Security Mode provides a [Control address] for users to manage the accounts

directly on HMI. Please see “10.3 Enhanced Security Mode and Control Address” for more
details. Alternatively, use USB Security Key to log in automatically. Insert the device in which

the key is saved to log in. Please see 10.4.3 Login / Logout Automatically with USB Security Key”
for more details.

System Parameter Settings @
Extended Memory | Printer/Backop Server | g-Mail I Recipes
Device I FModel | Creneral | System Betting | Security | Fant
(7 Feneral mode (@ Enhanced secrity mode
Select operable classes for each wser
[ e existing vser sccounts on HI
Mo, Enable  Secretusr Tser name Pazzyrord Clasz b =
1 E] [ nzrl
2 [l 0 v 2 =
k: = & nserd 3
4 [} (] nzerd 4
5 E] [ ] 5
fi [} (] Tzt fi
T 71 | - B 7 =1
4 1 3
Class Diescription -
Clazs &
Clam B
Claz C il
A dministrator
[ Secret uzer
ser name | admin Pazsyeord : 111111
Control address
Address Ly 1000
Froject password (EMTE file)
[] Enable Setting...
Execute anto logiogout when tsert an USE key toto HBI
Enable * Bimulation not supports this function
Statos address
PLC name : |Local HMI v | Ssetting...
Address ; [LW ~ |0 16-bit Unsigned
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10.3. Enhanced Security Mode and Control Address

The Control Address is used for login and account management. The Control Address can only
be assigned to LW register on Local HMI, and 20 consecutive registers will be used. To log in
using Control Address, please select to log in by [user name] or [user index].

Please set [user name] and [password] in [System Parameter Settings] » [Security] » [Enhanced

security mode] in advance.
10.3.1. Control Address Settings

When control address is set to LW-n, where n is an arbitrary number, the following addresses
will be designated:

Address Tag Name Description
LW-n (1 word) command Commands to be executed: Login, Logout,
Add/Setting/Delete Accounts, etc.
LW-n + 1 (1 word) command Displays the result of executing
execution commands.
result
LW-n + 2 (1 word) user index The index of accounts (used with Option
List Object).
LW-n + 3 (1 word) user Binary value. Level A = bit0O, Level B =
privilege bit1, ...
LW-n + 4 (8 words) user name Account name (Case-sensitive and only
allows letters and numbers).
LW-n + 12 (8 words) password Account password (Case-sensitive and
only allows letters, numbers, or special
characters).

After setting the [Control address], the relevant addresses can be found in [Address Tag Library]
» [Customized].For example, setting [Control address] to LW-0: (UAC stands for User Account
Control)

LW-0 = [UAC command]

LW-1 = [UAC command execution result]

LW-2 = [UAC user index]

LW-3 - [UAC user privilege]

LW-4 ~ LW-11 - [UAC user name]

LW-12 ~ LW-20 > [UAC password]

0 Note

B |n Enhanced Security Mode, if cMT-SVR Series model is used, the Control Address can only
be assigned to PLW register of Local HMI.
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10.3.2. Commands

10-5

Setting different values in LW-n [command] enables different commands:

Set Value Command Corresponding Address
1 Log in by user name Set [user name] and [password] first. After
entering the user name and password, the
system will check if they are valid in
[System Parameter Settings] » [Security] »
[Enhanced security mode].
2 Log in by user index Set [user index] and [password] first.
Please refer to 10.4.4 Enhanced Security
Mode with Option List Object.
3 Log out
4 Change the password Set [user name] and [password] first.
of current logged-in Please fill in the original password in [user
user name] and new password in [password].
5 Add an account Set [user name], [password] and [user
privilege] first.
6 Add a temporary Set [user name], [password], [user
account (minutes) privilege], and [user index] first. [user
index] is for specifying a time period (in
minutes), within this period the account is
valid. If O is specified, this account stays
valid until the HMI is powered off.
7 Delete an existing Set [user name] first.
account by user
name
8 Delete an existing Set [user index] first.
account by user index
9 Setting the privilege Set [user name] and [user privilege] first.
of an existing account
by user name
10 Setting the privilege Set [user index] and [user privilege] first.
of an existing account
by user index
11 Setting the password Set [user name] and [password] first.
of an existing account
by user name
12 Setting the password Set [user index] and [password] first.
of an existing account
by user index
13 Read the privilege of Set [user name] first. If the command
an existing account succeeds, [user privilege] can be displayed.
by user name
14 Read the privilege of Set [user index] first. If the command

an existing account
by user index

succeeds, [user privilege] can be displayed.
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15 Add a temporary Set [user name], [password], [user
account (days) privilege], and [user index] first. [user
index] is for specifying a time period
(number of days), within this period the
account is valid. If 0 is specified, this
account stays valid until the HMl is
powered off.
16 Add an expiring Set [user name], [password], [user
account (minutes) privilege], and [user index] first. [user
index] is for specifying a time period (in
minutes), within this period the account is
valid. 0 is an invalid value for this setting.
17 Add an expiring Set [user name], [password], [user
account (days) privilege], and [user index] first. [user
index] is for specifying a time period
(number of days), within this period the
account is valid. O is an invalid value for this
setting.
18 Remaining minutes Set [user name] first. If succeeded, the
for user name remaining time (in minutes) will be
displayed in [user index].
19 Remaining minutes Set [user index] first. If succeeded, the
for user index remaining time (in minutes) will be
displayed in [user index].
20 Remaining days for Set [user name] first. If succeeded, the
user name remaining time (number of days) will be
displayed in [user index].
21 Remaining days for Set [user index] first. If succeeded, the

user index

remaining time (number of days) will be
displayed in [user index].

@ Note

L—| WE!NTEK

Add a temporary account / expiring account: The difference between temporary accounts
and expiring accounts is that temporary accounts are not stored in the system and will be
invalid after HMI is turned off. Both temporary accounts and expiring accounts will be
automatically deleted when they are expired.

Delete the existing account: The currently logged in account cannot be deleted.
Offline/Online Simulation: Simulate using the account settings in the program. Any
modifications of the account during simulation will not be reserved for next simulation.
admin: Default administrator account, cannot be deleted, has all privileges and cannot be
changed.

System Register LW-10754: Displays current user name.

System Register PLW-10754: Displays current user name. (Only available for cMT-SVR)
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10.3.3. Command Execution Results

After the command is executed, the system will store the result code to control address LW-n +
1. The listed result codes below are shown in hexadecimal format.

Result Codes Command execution result

(0x001) Succeeds

(0x002) Invalid command

(0x004) Account exists (when adding a new account)
(0x008) Account not exists

(0x010) Password error

(0x020) Deny command

(0x040) Invalid name

(0x080) Invalid password character exists

(0x100) Invalid import data

(0x200) Out of validity range (when log in by USB Security Key).

The [Effective Time] can be set in Administrator Tools.

@ Note

B Users can add a new event in Event (Alarm) Log, and designate the [Read address] to LW-n
+ 1 [command execution result]. Open [Message] tab » [Text] » [Content] and specify the

message to be displayed in Event Display Object for showing command execution result.

10.4. Enhanced Security Mode Usage

10.4.1. Importing User Accounts

The user accounts can be set using other tools we provide, apart from the settings in [System
Parameter Settings] » [Security] tab. Administrator Tools can also be used to set user accounts.
Administrator Tools can be found in the installation directory. After the program starts, select

the [User Accounts] check box. Up to 127 accounts can be added.
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I3 Administrator Tools @
Save to USE Contents of the TEE data
8 Usst scoue
[=] TSE Security Key
= e-Mail SMTP Berver Settings
=] e-Mail Contacts
User Account Settings
Na. Secret  User name Paszword Class & ClssB Class C Class D ClasE Clas=F Clas
1 1 oo1001 001001 =] =] =] ] ] |
2 [ 002002 002002 =] =] =] |
b3 003003 003003 ] O o o I
4 [ 004004 004004 =] =] 0 0 I
5 005005 005005 [ = =] =] |
6 [ 00s008 006006 =] =] ] ] |
7 [ 007007 007007 =] [&] [&] |
I [ 00s008 008008 =] =] =] ] |
9 [ 009009 009009 =] =] =] ] ] |
10 [ 010010 010010 =] ] |
4| n +
Add ] l Remove Import... ] l Export...
Effective Time
[T Restrict the using terms
N N Bave to USB
013 F=H D2z 5~ (2013 A 021442
Help Topics

& For more information, see “36 Administrator Tools”.

The added accounts can be stored in USB disk or SD card and imported in HMI by a Function

Key Object. To do so, create a Function Key Object, and select [Import user accounts].
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Mew Function Key Object &

Generol | Secusity | Shape | Label |

Comument ;

[ ctivate after buttomn is released

Function mode

@ Import user accounts

) Use [USB Security Key] to Login
i Data position

) SD card @) UUSB disk
Account import mode

) Dverwrite @ Append

[ Delete file after importing user accounts

0K ] l Cancel l

b

@ Import neer dataTlz [T3B Security Keyv]

When finished, insert the external device to HMI, and press Function Key to import accounts. If
[Overwrite] is selected, the existing accounts will be overwritten with new accounts and
automatically log out after importing. If select [Delete file after importing user accounts] check
box, the system will delete the account data saved in the external device after importing. If the
[Effective Time] in Administrator Tools is specified, the importing can only be done in the time

limit specified. The imported accounts will not be deleted by system when the effective time
ends.

10.4.2. Login with USB Security Key

Instead of entering user name and password to login, a key can be used to do so. In EasyBuilder
Pro installation directory, launch Administrator Tools, select [USB Security Key] check box. The

account information uses the predefined data in [System Parameter Settings] » [Security].
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5
I3 Administrator Tools @
Save to USE Contents of the TSE data
= Tser Accounts
» [USE Security Key
=] e-Mail SMTP Berver Settings
=] e-Mail Contacts

USB Security Key

User name :  admin

Password:  essees

Confrm: essess

Effective Time
[T Restrict the using terms

N N Bave to USB
2013 7=H 021442 5 ~ 2013 7 H 031442

Help Topies

0 Note

B Please note that the user accounts used for USB Security Key must already exist in HMI.

C?For more information, see “36 Administrator Tools”.

USB Security Key can be stored in USB disk or SD card, and create a Function Key to log in by

USB Security Key as shown below:
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Mew Function Key Object ﬁ
General | Security | Shape | Label |
Conument :
[ ctivate after buttomn is released

Function mode

() Import user accounts
@ Use [USB Security Key] to Login

i Data position

) 5D card @ UsB disk
H
E 0K | [ Cancel ]
@) Import vaer datalTze [TSE Security Key)]

When finished, insert the external device to HMI, and press Function Key to log in using USB
Security Key. If the [Effective Time] in Administrator Tools is specified, the login can only be

done in the time limit specified. The system will log out automatically when the key expires.
10.4.3. Login / Logout Automatically with USB Security Key

As shown below, in [System Parameter Settings], select [Enable] check box for [Execute auto.

Login / logout when insert an USB key into HMI].
Execute auto loginlogout when inzert an USE key into HMI

Enable * Simmlation not supports this fonction
Statuz address
PLC name : | Local HMI - | Setting...
Address :ILW v] 0 16-bit Unsigned

This function allows automatic login / logout using an USB security key. Insert the USB disk in
which the key is saved to HMI to log in, and remove the USB disk to log out. The login / logout
status will be written into a designated address, the result codes of login / logout:

0x00: No Action

0x01: Login Succeeds

0x04: Login Fails

0x08: Login Succeeds

0x10: Logout Fails

I__| WE'NTEK EasyBuilder Pro V5.05.02
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& For more information about USB Security Key, see “36 Administrator Tools”.

0 Note

B When Auto Login / Logout is enabled, log in by [Function Key] object is not possible, but it
is still possible to log in / out with a designated control address.

B This function does not support On-line / Off-line simulation.

B Only the USB Security Key saved in USB disk is valid.

¥

= Click the icon to download the demo project that explains how to use USB Security Key to

log in / out. Please confirm your internet connection before downloading the demo project.
10.4.4. Enhanced Security Mode with Option List Object

Enhanced Security Mode uses Control Address LW-n + 2 as account index. With Option List
Object, account names and privileges can be displayed. Users can select whether or not to
display the account privileges and secret users in Option List. Secret users are set to be hidden
in [System Parameter Settings] » [Security] » [Enhanced Security Mode]; their account names
will be hidden in Option List if [Secret user] check box is not selected. If the control address is
set to LW-0, the monitor address for index of Option List is designated to LW-2.

[ Mew Option List Object ﬁ1
Crption List |Ma1:u1:uing | Security I Shape | Label |
Coumnent :
Attribute
Mode [Dmp-duwn List v] Background : hd |
Belectinn . v|
Directiomn : [Duwn ']
Somrce of tem data : [T_Tser oot ']
Sort Diisplay
L zending [ Descending Privilege [ Secret vser
Monitor address
PLC name : [Lor_al HMI vl Setting...
Address : [LW -2 16-bit Unsigned

X

Click the icon to download the demo project that explains more about Enhanced Security

Mode. Please confirm your internet connection before downloading the demo project.
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10.5. Object Security Settings

Mew Function Key Object &J

Interlock

Security | Shape | Label

Safetyr contml

Dizplay confinmation request Mam, watting thme (s2c) ;10

Tz interlack function

Hide when disabled
[ Crawed label when disabled
@ Enable when Bit iz ON ) Enable when Bit iz OFF

Min. press ime (sec) : 0O

PLC name : |Local HMI - | setting...

Address : ’LB

ey restriction
Cibject class - [Cla,ss . h
[] Disable protection permanently after initial activation
[7] Displacy warning message if acces: dended
[] Make invizible while protected

Setting

Description

Safety control

[Min. press time (sec)]

Press and hold the object for longer than the [Min. press
time] set here to activate the object.

[Display confirmation request] After pressing the object,
a dialog appears for operation confirmation. If the
response to this dialog comes later than the set [Max.
waiting time (sec)], this dialog disappears automatically

and the operation will be canceled.

Please confirm the aperation

0K | Cancel |

Interlock

When this check box is selected, the specified Bit address
is used to enable or disable the object. As shown, if LB-0
is ON, the object is enabled.

I__| WE!NTEK
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Hide when disabled

When the specified Bit is OFF, hide the object.
Grayed label when disabled

When the specified Bit is OFF, the label of the object

turns gray.

[ooe ]

For details on interlock bit address setting of Set Word

and Numeric objects, see Chapter 13.4 or 13.9.

User
restriction

Set the security class of the object to be operated by an
authorized user.

Object class

“None” means any user can operate this object. Only
account “admin” can operate “Administrator” object
class.

Disable protection permanently after initial activation
Once the permitted class of the user matches that of the
object, the system will stop checking the security class
permanently, that means, any user can operate this
object freely after it is unlocked.

Display warning message if access denied

When an unauthorized user attempts to operate the
object, a warning dialog (Window no. 7) appears. The

content of the message in the dialog can be modified.

-

Fassword Protected! Access Denied If

{9 =

Make invisible while protected

e

When the user's privilege does not match the object

class, hide the object.

10.6. Example of Object Security Settings

The following shows an example of setting object security class:

L—| WE!NTEK
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1. Create a project, go to [System Parameter Settings] » [Security] » [General] to enable 3
users:

User 1 = Operable class: A

User 2 = Operable class: A, B

User 3 = Operable class: A, B, C
2. Design Window no. 10 as shown:

User name : r‘E#?##;*# | L8218
Password : rEi#lf#i‘if |1W922f?

bit 75 bit?
Currentstatus : A1 1111111111111 | cwszzz

" Logout 169950

SB_0

Class A Button
SB_1

‘Class B Buiton

8B 2
‘Class C Button |

Create two [Numeric Input] objects:

[LW-9219] User no. (1~12), Length = 1word

[LW-9220] For entering user password. Length = 2 words

Create a [Numeric Display] object:

[LW-9222] Displays the status of current user. (16-bit Binary)

Create a [Set Bit] object

[LB-9050] logout

Create three [Set Bit] objects:

Each set to different classes but all select [Made invisible while protected].

3. After setting, please save and compile the project and execute off-line simulation. The
below shows how it works when simulating.

Before entering the password, it displays

User name - | 1 |M92;9 “0000000000000000”, which means that
Password - | 0 |£W922:7 the user operable object class is “None”.
brie bt [Class A Button] ~ [Class C Button] objects
Current status - | 0000000000000000 | Livezzz
are classified from “A” to “C” and selected
Logout LBIOSO

[Made invisible while protected]; therefore

they are hidden at this moment.
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Enter User 1 password “111”.
sername [ 1| v Since User 1 is only allowed to operate class

Password : | 111 | Lwezz0

A objects, [Class A Button] object appears for

bit 15 bit0
Currentsistus : | 0000000000000001 | ¢#422 operating. [LW-9222] bit O turns to “1”
Lagout | 5% means that user can operate class A objects.

Class A Button

Enter User 3 password “333”.

Username - | 3 |1W92m Since User 3 is allowed to operate class A, B,
Password - | 333 |mm C objects, [LW-9222] bit 0 ~ bit 2 turns to “1”,
= o means that user can operate classA~ C
Current status - | 0000000000000111 | tmezzz
objects.

Logout L59650

Class A Button

Class B Button

L

Class C Button

Click [Logout] button to log out, the

Username: | 3 Lwszig

[

system will return to the initial state, and

Password - | 333 | twez0

current user can only operate class “None”
bit15 bitd

Current status - | 0000000000000000 | Lwezzz (0] bJ ects.

chcu{ LB9050

L

@ Note

B Password input: If the password is incorrect, [LB-9060] will be ON; if the password is
correct, [LB-9060] will be OFF. All user passwords (User 1 to User 12) can be obtained
from system registers [LW-9500] ~ [LW-9522], 24 words in total.

B Changing password directly on HMI: When [LB-9061] is set ON, the system will read data
in [LW-9500] ~ [LW-9522] to update user password. The new password will be used in
future operations. Please note that the user operable object classes will not be changed

due to the change of password.
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11.Index Register

This chapter explains how to use Index Register.

110, OVOIVIBW ..ueiiiiieieee ettt e e ettt e e e e e ettt e e e e e s e bttt e e e e e s e anbsbeeeeaeeeesaannnrraneaaaens 11-2
11.2. Examples of INdeX REGISTOI ......cceicuiiiiieieee et 11-2
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11.1. Overview

EasyBuilder Pro provides Index Registers for changing addresses flexibly. With Index Registers,
user can change the object’s read/write address directly on HMI without changing its settings.
There are 32 Index Registers, divided into 16-bit and 32-bit.

Address @
PLC name : [LOCE| HMI v]
Device type : | LW-3002 (32bit-float) : input high limit b

Address & ||\ 5501 (16bit) : address index 1

LWw-9202 (16hit) : address index 2
LW-3203 (16bit) : address index 3
LW-3204 (16bit) : address index 4
LW-3205 (16bit) : address index 5
LW-9206 (16bit) : address index &
LW-9207 (16bit) : address index 7
LW-3208 (16bit) : address index 8
LW-3209 (16bit) : address index 9
LW-3210 (16bit) : address index 10
LW-9211 (16bit) : address index 11
Tag Library... Lw-5212 (16hit) : address index 12
LW-3213 (16bit) : address index 13
LW-3214 (16hit) : address index 14
LW-3215 (16bit) : address index 15
LW-3219 (16bit) : user no. {1~12)
LW-9220 (32bit) : password
LW-3222 (16bit) : classes can be operated for current user (bit 0:A, bit 1:B,bit
LW-3230 (32bit) : address index 16
LW-3232 (32bit) : address index 17
LW-3234 (32bit) : address index 138
LW-9236 (32hit) : address index 19
LW-9238 (32bit) : address index 20
LW-3240 (32bit) : address index 21
LW-3242 (32bit) : address index 22
LW-3244 (32bit) : address index 23
LW-5246 (32bit) : address index 24
LW-9248 (32bit) : address index 25
LW-3250 (32bit) : address index 26 52

Address format :

m

L}

The corresponding address of 16-bit Index Register 0 to 15: LW-9200 (16bit) to LW-9215 (16bit)
The maximum offset range is 65536 words.

The corresponding address of 32-bit Index Register 16 to 31: LW-9230 (32bit) to LW-9260
(32bit)

The maximum offset range is 4294967296 words.

When using [Index register], the address is designated by the following equation:

The constant set in [Address] + the value in the chosen Index Register.

0 Note

B Index Registers work for the Word registers. For Bit registers, adding 1 to the value in the
Index Register, the offset is 16 bits.

11.2. Examples of Index Register

The following explains the way to designate the register while Index Register is used.

If not selecting [Index register] check box and set address to [LW-10]. The system will directly
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read / write LW-10.

Address

PLC name : [L"G' HMI

Device type : [Lw

Address: 10 [ system tag
Address format : DDDDD [range : 0 ~ 10799]

[T Index register

Tag Library... [

QK

J |

Cancel

If select [Index register] check box and set [Index] to [INDEX O (16-bit)]. The system will read /

write [LW(10 + value in Index Register 0)].

If the data in [LW-9200] is “5”, the designated address is [LW(10+5)] = [LW-15].

Address

PLC name : [L"G' HMI

Device type : [Lw

Address: 10 [ system tag

Address format : DDDDD [range : 0 ~ 10799]

Index : |INDEX 0 (16-bit) - Index register

Tag Library... [

Ok

Here’s a demo project shown as an example:

Demo Project - Index Register

Index Function of Word

[\& WEINTEK

EasyBuilder Pro V5.05.02
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Example 1
The following shows an example of using a Word register and select [Index register]. If the
value in [LW-0] is O, in [LW-10] is 3, and in [LW-20] is 6, the result is:

Index Function of Word

If the value in Index 0 (LW-9200) is 10, then [LWO + Index 0] = read [LW-10] = 3.

Example 2
The following shows an example of using a Bit register and select [Index register].
If the state of [LB-16] is ON, and the state of [LB-32] is OFF.

Since 1 Word = 16 Bit, adding 1 in Index Register, the offset is 16 bits.
Index Function of Bit

If Index 6 (LW-9206) is set to 2, then switch [LB-0 + Index6] reads LB-32 which is in OFF state.
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Index Register

0 Note

B When using Index Registers for Bit register, the offset is 16 bits. For example, if the Bit
register is LB-0, and set the value in Index Register to 1, then LB-16 will be activated. If set

the value in Index Register to 2, then LB-32 will be activated.

i. Click the icon to download the demo project. Please confirm your internet connection.
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Keyboard Design and Usage

12.Keyboard Design and Usage

This chapter explains how to design and use keyboard in EasyBuilder Pro.

12.1.
12.2.
12.3.
12.4.
12.5.

OVBIVIBW ...ttt ettt e e e ettt et e e e s e sttt e e e e e s e s anbrbbeeeaeeeesaannnreebeaeeessessnnnneens 12-2
Steps to Design a Popup Keyboard.........coo i 12-2
Steps to Design a Keyboard with Direct WindOW .........occccviiiiiieiiiicicireeeee e 12-5
Steps to Design a Fixed Keyboard on SCreen.........ueeevvvveeccviiieeee e 12-6
Steps to Design @ UNICODE Keyboard .........oocccvviieeeeri et 12-7
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12.1. Overview

Numeric Input and ASCII Input objects need keyboard as an input tool. Both numeric keyboard
and ASCII keyboard are created with Function Key object. Apart from the keyboards provided
by EasyBuilder Pro, you can create the keyboard if needed.

The types of the keyboards are:

® Popup Keyboard (with or without title bar)
® Fixed Keyboard
® UNICODE Keyboard

0 Note

B cMT Series uses the built-in keyboard of iPad which cannot be customized. Please skip this

chapter if cMT Series is used.

12.2. Steps to Design a Popup Keyboard

1. Create and open a window for the new keyboard. For example, set to “window no. 200”.

Windows 4
| Object st -
- 199 -
Mew M
.. 201 =
Open
.. 303
. 203 Close
204 Delete
- 203 Settings
.. 206 -

2. Adjust the height and width of “window no. 200” and create a variety of Function Key
objects in [ASCII/UNICODE mode].

GPO -
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Set one of the Function Key objects as the [Esc] key.

LRCININICODE mode
) [Enter] () [Backspace] ) [Clear] @ [Ex]
) [Delets] ) [Left] ) [Right]
(7 [ARCII] / [UNICODE]

Set another Function Key object as the [Enter] key.

ASCILTINICODE mode
@ [Enter] () [Packspace] () [Clear] (7 [Ese]
() [Delete] ) [Ledt] () [Right]
(7 [ASCII] / [UNICODE]

The rest are mostly used to enter numbers.

ASCIIATNICODE mode
() [Enter] () [Backspace] () [iZ1ear] ) [Esc]
() [Delete] () [Left] () [Right]

@ [ARCIN/ [UNICODE] |1

3. Select a suitable picture for each Function Key object and place a picture object at the
bottom layer as a background.

=SS

4. Select [System Parameter Settings] » [General] » [Keyboard] » [Add] to add “window no.
200”. Up to 32 keyboards can be added.

Lcacp e ==

Window no. 1 200. Keyboard -

[ OK ] ’ Cancel

5.  After the keyboard window is added, when you create Numerical Input and ASCII Input
objects, “200. Keyboard” can be found in [Data Entry] » [Keyboard] » [Window no.]. The
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[Popup position] is for designating the display position of the keyboard on the HMI screen.

The system divides the screen into 9 areas.

KEevboard
Tz & popup kevpad
Hide title bar
Festart the kevpad if input valve is ot of range
Window no. | 200. Keyboard -

Popup positio
Trelative to HMI screent

a0
o®0
@00

6. Select “200.Keyboard”. When you press Numerical Input or ASCII Input objects on the
screen, “window no. 200” will pop up. You can press the keys on the keyboard to enter
data.
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12.3.

Steps to Design a Keyboard with Direct Window

1. Create a Direct Window object and set a read address to activate it.
In [General] » [Attribute] select [No title bar] and the correct [Window No.].

Direct Window Object's Properties

General | Profile |

=l

Comument :

Read address

PLC name : [Loml HMI

v] Setting...

Address : [LB -

Auttribute

SO TS T

Window No. [EIJEI. Kexyboard

z)

2.  Open the [Profile] tab to set the same size as the created keyboard window.

3. Create a Numeric Input object, and don’t select [Use a popup keypad]

Direct Window Object's Properties @
Profils
Position
[ Pinned £ 233 = v 134 2
Size
7] Keep widthheight ratio
Width : 300 = Height : 200 :
Wadth (% 100 = Height (%) 100 =

check box.

Mumeric Input Object's Properties

General | Dats Entty | Numeric Format | Security | Shape | Font | Pofile |

()

Mode : | Touch -

Input order
[] Enable

Kevhoard

] sz a popup keypad

I__| WE!NTEK
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4. Create a Set Bit object, set address to [LB-0] and set [Set style] to [Set ON]. Overlay it on

the Numeric Input object. Pressing the Numeric Input object will open the keyboard
window.

Mew Set Bit Object =

Generel | Secusity | Shape | Label |

Commment :

TWrite address

PLC name : [Local HMI v] Setting...

Address : [LB vl 1]

[] Wrrite after button is released

Attribute
Setstyle : [Set ON -]

5. Add Set Bit objects on the [Enter] and [ESC] Function Key objects respectively. Set address

to [LB-0] and [Set style] to [Set OFF]. In this way when pressing either [Enter] or [ESC] key
will close the keyboard window.

12.4. Steps to Design a Fixed Keyboard on Screen

You can also place a fixed keyboard on the screen instead of popup keyboard or Direct Window.
This type of keyboard can’t be moved or closed.

1. Create a Numeric Input object, in [Data Entry] » [Keyboard] don’t select [Use a popup
keypad] check box.

2. Use Function Key objects to design the keyboard and place it on the screen.

3. Press the Numeric Input object and enter a value with Function Key objects directly.
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12.5. Steps to Design a UNICODE Keyboard

The following steps explain how to create a UNICODE keyboard with Function Key objects.

1. Place an ASCII Input object on the window and select [Use UNICODE] check box.

2. Create Function Key objects as shown in the following figure, and an [Enter] key. A simple
UNICODE keyboard is created.

New ASCIInput Object =
General | Data Entry | Secusity | Shape | Fomt |
Description : ASCIUNICODE mode
< EU [Enter] [Backspace]
[T Mask ¥/] Uss UNICODE B NICOD E_ O [Delste] O [Left]
[ Reverse highflow byte / @ [ASCII]/ [UNICODE] o
Read address FK_0 a e
oL e [ = '“ - ] ASCIIUNICODE mode
*|Local HML : 0. [Enter) ) [Backspace]
A1 gt romm o
Address (=25 FK 2 @ [ASCII)/ [UNICODE] B
- ')’ ~ ASCI/UNICODE mode
PLC name : [L"Cﬂ HML '] [Enter] [Backspace]
Device type : [LW '} FK_3 5 O [Delete] O [Left]
Address: 0 (7] System tag @ [ASCII])/ [UNICODE] ¥
Address format : DDDDD [range : 0 ~ 10799] FK—4 En t e I—
[l index register ASCIIUNICODE mode
[Entex] () [Backspace]
[Deletz] [Left]
No. of word: 8
© [ASCI)/ [UNICODE] &
—c—

@ Note

B You can group up the elements of the designed keyboard and save to Group Library for
future use.
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13.0bjects

This chapter explains how to use different objects.

13.1.
13.2.
13.3.
13.4.
13.5.
13.6.
13.7.
13.8.
13.9.

13.10.
13.11.
13.12.
13.13.
13.14.
13.15.
13.16.
13.17.
13.18.
13.19.
13.20.
13.21.
13.22.
13.23.
13.24.
13.25.
13.26.
13.27.
13.28.
13.29.
13.30.
13.31.
13.32.

2T 1= o1 o PP PPPPPPPPRS
WOrd Lamp .eeeeeeiieeeee e
S Bit.eiiiiiiieeietee e e
SEtWOId ...
FUNCLION KEY .eevvrivviiiiiiiiineeeeeeeeeeeeeeeeseeeseeeeeseseseeseene
Toggle SWItCh .....eeeviiiieei e,
Multi-State SWItch ......coovviiiiiiiiieee e
SHABE et

MoVing Shape .....ccovvieeiiii e
ANIMAtion ...
Bar Graph...ccco oo
Meter Display.....ccccoveeeeeeiieiccieeeeee e
Trend Display «.cccccevveeeeeeii e
History Data Display.....cccccoeecvviiveeeeeeececiiieeeeeeea,
Data Block Display .....ceeeeeeevcciviieieeee e,
Q2 1o |
Alarm Bar and Alarm Display.......ccccecvvvveeeeeeeeiecnnns
Event Display.....ccccovvieeeeeiiecceeeeee e
Data Transfer (Trigger-based) ......cccccevvveeeeiiiieeennnns
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13.33.
13.34.
13.35.
13.36.
13.37.
13.38.
13.309.
13.40.
13.41.
13.42.
13.43.
13.44.
13.45.
13.46.
13.47.
13.48.
13.49.
13.50.

RECIPE VIBW ettt re e e e e e e ettt e e e e e e e e e e et e e s e e eeesaeannaeeaeas 13-179
FIOW BIOCK ...ttt sttt e e e s s e e e s sareeeesaas 13-185
(0] o= -1 {[o] o 1 o= ST 13-189
(60]00] oTo 31 21U o] o PR PRSP PPPTPPPPIN 13-201
Circular Trend DiSPlay ....uueeeeeeee it e e e e e e e e e s ennraeees 13-204
PICEUNE VIBW ... ettt e e e e e st e e e e s e e s nanr e eeeeens 13-213
FIlE BIOWSE ...ttt e et e st e e st e s ettt e e s sabeeeessareeeesans 13-215
e oo a4 e Yo o R PURURR 13-218
PIE CRArt oot e e st e e e arree e e 13-222
A0 ST oo Yo Lo B 1 o - 1Y SRR 13-224
) T 0T - o U= SRR 13-226
DatabaSe SEIVEN ... . iiiieieiiee ettt e e s st e s s e e s s b e e e s eareeeeeaas 13-228
(D3 =Y o o Lo Yot | P 13-232
DAY o T o Yol BT 11V 1 o ¥ - PR 13-235
PDF REAEN ...ttt sttt ettt e e e sttt e e s st e e e s abee e e s sabeeeessnreeeesans 13-240
L o 11T PO UPPPPPPRRUPPRPRNt 13-242
VINC VIBWET ...ttt ettt ettt e e e e e s ettt e e e e e e e s abbeb et eeeeeesaaannbbeeeaaeeesasans 13-244
Barcode Scanner (ANAroid CamEra) ...ccccuveeeeeieeiiiiiiiiieeieee et eeesarrrereee e 13-248
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13.1. BitLamp

13.1.1. Overview

Bit Lamp object displays the state of a designated bit address. If the bit state is OFF, the State O
shape will be displayed. If the bit state is ON, the State 1 shape will be displayed.

"OFF" State "ON" State

13.1.2. Configuration

¢

Click the Bit Lamp icon on the toolbar to open a Bit Lamp object property dialog box. Set up

the properties, press OK button, and a new Bit Lamp object will be created.

General Tab

New Bit Lamp/Toggle Switch Object ==

General | Security | Shape | Label |

Comment :

@ Bit Lamp ) Toggle Switch

Read address

PLC name : [Local HMI A4 ] Settings...

[] Invert signal

Blinking

Mode : [Nune v

["|Hide picture/shape if no corresponding picture for current state

o) o
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Objects
Setting Description
Comment User can describe the information of the object.

Bit Lamp / Toggle Switch
Switch between Bit Lamp and Toggle Switch features.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the [Bit
Lamp] object. Users can also set address in [General] tab while
adding a new object.

Invert signal

Reverses the display of ON / OFF states. For example, if [Invert
signal] check box is selected, when the designated bit is OFF, the
object displays ON state.

Blinking

The appearance of the object may alternate between states when
the bit is ON or OFF.

Mode:

None

No blinking.

Alternating image on state 0

The appearance of the object alternates between State 0 and 1
when the bit is OFF.

Alternating image on state 1

The appearance of the object alternates between State 0 and 1
when the bit is ON.

Blinking on state 0

The State 0 appearance of the object will blink when the bit is OFF.
Blinking on state 1

The State 1 appearance of the object will blink when the bit is ON.
Hide picture/shape if no corresponding picture for current state
If selected, when there are not enough pictures to represent all the

states, hides the picture. Otherwise, displays the last state.

@ Note

B In[Label] tab, if select [ON=OFF (use state 0)] check box, both state 0 and 1 follow the

settings of state 0.

L—| WE!NTEK
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13.2. Word Lamp

13.2.1. Overview

Word Lamp object displays the state according to the value of a designated word register. Up to
256 states are available. When the value of the register is 0, State 0 appearance of the object is

displayed, and with the register value being 1 the object displays State 1, and so on.

Nurmeric Display (LW0) Word Lamp (LWO)
1 EZx3
Numeric Display (LW0) Word Lamp (L WO)
1 ExX

Numerie Display (LW0) Word Lamp (L W0)

1 BE=x

13.2.2. Configuration

Click the Word Lamp icon on the toolbar to open a Word Lamp object property dialog box. Set

up the properties, press OK button, and a new Word Lamp object will be created.
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Objects
General Tab
New Word Lamp/Multi-State Switch Object [=7]
General | Security | Shape | Label |
Comment :
@ Word Lamp () Multi-State Switch
Read address
PLC name : [Local HMI + | Settings...
Address:[Lw v|0 "~ [16-bit Unsigned
Attribute
[V Hide pictore/shape if no corresponding picture for current state
o) (o
Setting Description
Comment User can describe the information of the object.
Word Lamp / Multi-State Switch
Switch between Word Lamp and Multi-State Switch features.
Mode / Offset Word Lamp object offers the following three modes:

Value

The state is displayed according to the value in the designated word
address and plus the [Offset].

As shown below, if the value within LW-200 is 3, since the offset is
set to 3, the shape of state 6 is displayed. (value 3 + offset 3)

New Word Lamp Object

Read address

General | Security | Shape | Label
Comment :
PLC name : [Local HMI | setting...
Address : 1] 16-bit Unsigned

[\& WEINTEK
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LSB
Convert the value from decimal to binary. The least significant

active bit in a binary data word selects the state displayed.

Decimal | Binary Displayed state
0 0000 State 0 displayed. All the bits are 0.
0001 State 1 displayed. The least significant

active bit is bit 0.
State 2 displayed. The least significant

2 0010 active bit is bit 1.

State 1 displayed. The least significant
3 0011 active bit is bit 0.

State 3 displayed. The least significant
4 0100 active bit is bit 2.
5 0101 State 1 displayed. The least significant

active bit is bit 0.

State 2 displayed. The least significant
6 0110 active bit is bit 1.
State 1 displayed. The least significant
active bit is bit 0.
State 4 displayed. The least significant
active bit is bit 3.

7 0111

8 1000

Bit combination

Lamp state depends on the states of bit combinations, where PLC 1
represents the least significant bit (LSB), PLC 2 represents the next
LSB, and so on. Maximum number of bit is 4, for a total of 16
states. Changing [No. of states] in Attribute group box changes the
number of read addresses.

® Word Lamp () Multi-State Switch
Mode : | Bit combination v

Read address

PLC 1: | Local HMI w | Settings...
Address 1: || |0

PLC 2 : | Local HMI w | Settings...
Address 2: || w1

PLC 3 : | Local HMI w | Settings...
Address 3: || V(2

PLC 4 : | Local HMI w | Settings...
Address 4: || v|(3
Attribute

Mo. of states: |16 v

Change state by time

The state displayed changes on a time basis. The frequency can be
set.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the

L—| WE!NTEK
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[Word Lamp] object. Users can also set address in [General] tab
while adding a new object.
Attribute No. of states

The number of states is utilized by the object. The state is
numbered from 0, so the number of states minus 1 will be the state
number. If the value within the word register is > [No. of states]
defined in Attribute, the highest state will be displayed.

If the number of states is set to 8, the valid states will be 0, 1, 2, ...,
7. In this case if the word value is 8 or higher, the system will

display the state 7 shape.

Hide picture/shape if no corresponding picture for current state

If selected, when there are not enough pictures to represent all the
states, hides the picture. Otherwise, displays the last state.

@ Note

In [Label] tab, Language 1 determines the relevant settings of the font. For Language 2~8,

only the font size can be changed and other settings follow Language 1.

MNew Word Lamp Object =] New Word Lamp Object =]
General | Security | Shape | Label General | Security | Shape | Label
[ Use label [ Use label
[¥] Use label library Label tag : Label 0 - [¥]Use label library Label tag : Label 0 -
Label Library... Label Library. ..
State : |0 - S (o] [1] State: |0 v;”]@
Attribute Attribute
Font : | Arial Font : | Arial
Color : I | ~ Size : Color : Size :
[ 1talic Italic
Duplicate these attributes to Duplicate these attributes to
[ Every state ] [ Every language ] [ All Every state ] [ Every language ] [ All
Movement Movement
Direction : Direction : | No movement
Content Content
text
[Tl Tracking Duplicate this label to every state [ Tracking Duplicate abel to every state
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13.3. SetBit

13.3.1. Overview

The Set Bit object provides two operation modes: manual or automatic. Manual mode can

trigger a designated bit address to change the state between ON and OFF when the object is

touched. In automatic mode, the bit is automatically activated when a pre-defined condition

occurs; touching the button will not be effective.

13.3.2. Configuration

-

Click the Set Bit icon on the toolbar to open a Set Bit object property dialog box. Set up the

properties, press OK button, and a new Set Bit object will be created.

General Tab

Mew Set Bit Object (23]

Gereral | Security | Shape | Label

Comment

Write address
PLC name : | Local HMI +| [ Setting...
Address i[LB v] 0
[T wirite after button is released
Attribute
Setstyle : ‘smom "

Set OFF
Toggle

Macro Momentary
Periodic toggle

Execute maa Set ON when window opens
Set OFF when window opens
Set ON when window doses
Set OFF when window doses
Set OM when backlight on
Set OFF when backlight on
Set OM when backlight off
Set OFF when backlight off

o) (o

Setting

Description

Write address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the Set
Bit object. Users can also set address in [General] tab while adding
a new object.

I__| WE!NTEK

EasyBuilder Pro V5.05.02



13-10

Objects
Write after button is released
If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is
pressed. This function does not work with momentary buttons.
Mode / Offset Set style Description

Set ON Set ON the designated bit of the device.

Set OFF Set OFF the designated bit of the device.

Toggle Alternates the bit state each time pressed.

Momentary Holds the bit ON only while button is
pressed.

Periodical toggle | Set a designated bit ON and OFF at a set time
interval. Time interval can be selected; the
range is from 0.1 to 25.5 seconds.

Set ON when Set ON the bit within the window when the

window opens window opens.

Set OFF when Set OFF the bit within the window when the

window opens window opens.

Set ON when Set ON the bit within the window when the

window closes window closes.

Set OFF when Set OFF the bit within the window when the

window closes window closes.

Set ON when Set the bit ON when the backlight is turned

backlight on ON.

(N/A for cMT)

Set OFF when Set the bit OFF when the backlight is turned

backlight on ON.

(N/A for cMT)

Set ON when Set the bit ON when the backlight is turned

backlight off OFF.

(N/A for cMT)

Set OFF when Set the bit OFF when the backlight is turned

backlight off OFF.

(N/A for cMT)

Macro Set Bit object can trigger the start of a Macro routine when the

Macro has been created in advance.

For more information, see “18 Macro References”.

Trigger mode

If [Set style] is set to [Toggle], there is a further selection to make of
whether the macro operates after Off to ON, ON to OFF transition,

or at both of the changes of state.

@ Note

B In[Label] tab, if select [ON=OFF (use state 0)] check box, both state 0 and 1 follow the

settings of state 0.
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13.4. Set Word

13.4.1. Overview

The Set Word object provides two operation modes: manual or automatic. Manual mode can
change the value in a designated word address when the object is touched. In automatic mode,

the word register is automatically activated when a pre-defined condition occurs; touching the
button will not be effective.

13.4.2. Configuration

Click the Set Word icon on the toolbar to open a Set Word object property dialog box. Set up

the properties, press OK button, and a new Set Word object will be created.

General Tab

Mew Set Word Object (==

General | Sequrity | Shape | Label

Comment :

Write address
PLC name : [Lgcal HMI v] Setting. ..
Address : [L‘.I‘u' |0 16-hit Unsigned
[ write after button is released
Motification
Enable @ set ON (7 set OFF
Before writing [ After writing
PLC name : [Local HMI v] Setting. ..
Address :[LB v] 0
Attribute
Set Style : [Wrihe constant value -

Setvalue: 0

o) (o
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Setting Description

Write address Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Set Word object. Users can also set address in [General] tab while
adding a new object.
Write after button is released
If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is
pressed.

Notification If this check box is selected, it will notify a designated bit address
(setting ON or OFF).
Before writing / After writing
Set the state of the designated bit address before or after the
manual operation.

Attribute Set Style
Select the button action from the drop down list, see Example 2.
Dynamic limits
Set the [Bottom limit] and [Upper limit] by a designated register,
see Example 1.

Example 1
Set the [Bottom limit] and [Upper limit] by a designated register. When Dynamic Address is

LW-n, where n is an arbitrary number, the rule of setting Upper / Bottom limit is:

Content 16-bit 32-bit
Dynamic address LW-n LW-n
Bottom limit LW-n LW-n

Upper limit LW-n+1 LW-n+2

When Dynamic Address is LW-100, the rule of setting Upper / Bottom limit is:

Content 16-bit 32-bit
Dynamic address LW-100 LW-100
Bottom limit LW-100 LW-100
Upper limit LW-101 LW-102

Example 2

The available button actions are:

® Write constant value

Preset a register with the value entered. Each time when the button is pressed, it writes the
[Set value] to the designated register. Data format is as set by the [Write address]; it can be
16-bit BCD, 32-bit BCD, ...32-bit float. As shown below, when the button is pressed, preset the
register with 12.
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Attribute

Set Style @ | Write constant value 7

Setvalue @ 12

® Increment value (JOG+)
Increase value in register by a set amount in [Inc. value], each time when the button is pressed,
up to the [Upper limit]. As shown below, each button press increases the value in the register

by 1 until the value is 10.

Attribute
Set Style IIncrement value (J0G+) -
Inc. value : 1 Upper limit : 10

® Decrement Value (JOG-)
Decrease value in register by a set amount in [Dec. value], each time when the button is
pressed, down to the [Bottom limit]. As shown below, each button press decreases the value in

the register by 1 until the value is 0.

Attribute
Set Style : IDecrement value (10G-) -
Dec, value ; 1 Bottom limit: 0

® Press and hold increment (JOG++)

When the button is held longer than a set time in [JOG delay], it will increase the value in a
register by a set amount :[Inc. value] at a set rate :[JOG speed], to the [Upper limit].

As shown below, when the button is pressed, it increases the value in the designated register
by 1. When the button is held longer than 1 second, it increases the value in register by 1 every

0.5 second, till the value is 10.

Attribute
Set Style : |Press and hold increment (JOG++4) v
Inc, value : 1 Upper limit ; 10
JOG delay [1.0 gecond(z) v] J0G speed : [0.5 second(s) -

® Press and hold increment (JOG--)

When the button is held longer than a set time in [JOG delay], it will decrease the value in a
register by a set amount: [Dec. value] at a set rate: [JOG speed], to the [Bottom limit].

As shown below, when the button is pressed, it decreases the value in the designated register
by 1. When the button is held longer than 1 second, it decreases the value in register by 1

every 0.5 second, till the value is 0.
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Attribute
Set Style : | Press and hold decrement (10G--) -
Dec, value : 1 Bottom limit : 0
100G delay : [1.I:| second(s) v] 100G speed ; [U.E second(s) T]

® PeriodicJOG++

This automatic function increases the value in the register by a set amount: [Inc. value], at a set
rate: [Time interval], to the [Upper limit]. As shown below, the system will automatically

increase the value in the register by 1 every 0.5 second, till the value is 10. Then the value
returns to 0 and add 1 every 0.5 second again.

Attribute
Set Style : [Periudic J0G++ (up-=0-=up-=...} -
Inc. value : 1 Upper limit : 10
Time interval : | 0.5 second(s) ']

® Automatic JOG++

This automatic function increases the value in the register by a set amount: [Inc. value], at a set
rate: [Time interval], to the [Upper limit].then holds this value. As shown below, the system will

automatically increase the value in the register by 1 every 0.5 second, till the value is 10, and
then stop.

Attribute
Set Style : | Automatic J0G ++ (up to high limit) -
Inc, value: 1 Upper limit: 10
Time interval : [D.E second(s) T]

® Automatic JOG--

This automatic function decreases the value in the register by a set amount: [Dec. value], at a
set rate: [Time interval], to the [Bottom limit].then holds this value. As shown below, the

system will automatically increase the value in the register by 1 every 0.5 second, till the value
is 10, and then stop.
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Attribute
Set Style | Automatic JOG— (down to low limit) -
Dec, value : 1 Bottam limit ;10
Time interval : IU.E second(s) TI

® Periodic bounce

Increases the word address value to the [Upper limit] by a [Inc. value] at a set rate in [Time
interval], then decreases to the [Bottom limit] by the same value at the same rate. As shown
below, the system will increase the value in the designated register by 1 every 0.5 second, till
the value is 10, and then decrease the value by 1 every 0.5 second till the value is 0 whenever

the screen is active.

Attribute
Set Style ! | Periodic bounce (up->=down-=up-=...) -
Bottom limit @ 0 Upper limit : 10

Inc, value : 1

Time interval : ID.E second(s) TI

® Periodic step up

Step up to the [High limit] by [Inc. value] at a set rate in [Time interval], then reset immediately
to the [Low limit]. The action repeats whenever the screen is active. As shown below, the
system will increase the value in the designated register by 1 every 0.5 second, till the value is

10, and then reset to 0 and increase again, and the action repeats.

Attribute
Set Style : | Periodic step up (low to high...) v

Low limit : 0 High limit ; 10

Inc, value : 1

Time interval : ID.E second(s) V]

® Periodic step down

Step down to the [Low limit] by [Dec. value] at a set rate in [Time interval], then reset
immediately to the [High limit]. The action repeats whenever the screen is active. As shown
below, the system will decrease the value in the designated register by 1 every 0.5 second, till

the value is 0, and then reset to 10 and decrease again, and the action repeats.
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Attribute
Set Style : | Periodic step down (high to low...) -
Low limit: 0O High limit : 10

Dec, value : 1

Time interval : ||;|.5 second(s) "l

® Set when window opens / Set when window closes

Automatic function occurs whenever the screen is active. The value entered in [Set value] is set
into the word address when the action occurs. If [Set value] is set to 5, when the window
opens / closes, the system enters 5 into the designated register.

® Set when backlight on / Set when backlight off

Automatic function occurs whenever the backlight is active. The value entered in [Set value] is
set into the word address when the action occurs. If [Set value] is set to 5, when the backlight
turns ON / OFF, the system sets 5 into the designated register.

® CyclicJOG+

Each time when the button is pressed, increases the word address value to the [Upper limit] by
[Inc. value] then reset to the [Bottom limit]. As shown below, each time when pressing the
button, the system will increase the value in the designated register by 1, till the value is 10,

and then reset to 0 and increase again by pressing the button.

Attribute

Set Style © | Cydic J0G+ -

Bottom limit : 0 Upper limit: 10

Inc, value : 1

® Cyclic JOG-

Each time when the button is pressed, decrease the word address value to the [Bottom limit]
by [Dec. value] then reset to the [Upper limit]. As shown below, each time when pressing the
button, the system will decrease the value in the designated register by 1, till the value is O,

and then reset to 10 and decrease again by pressing the button.
Attribute

Set Style : |Cydic J0G- -]

Bottom limit @ 0 Upper limit: 10

Dec. value: 1
® CyclicJOG++
When the button is held longer than a set time in [JOG delay], it increases the value in a
register by a set amount in [Inc. value] at a set rate in [JOG speed], to the [Upper limit], then
reset to the [Bottom limit]. As shown below, when the button is held longer than 0.5 second,

increase the value in the designated register by 1 every 0.1 second, till the value is 10, and then
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reset to 0 and increase again by holding the button.

Attribute

Set Style : | Cycic J0G++

Bottom limit @ 0

Inc, value : 1

JOG delay @ 0.5 second(s) ']

® CyclicJOG- -

Upper limit: 10

JOG speed : [0.1 second(s) -

When the button is held longer than a set time in [JOG delay], decrease the value in a register

by a set amount in [Dec. value] at a set rate in [JOG speed], to the [Bottom limit], then reset to

the [Upper limit]. As shown below, when the button is held longer than 0.5 second, decrease

the value in the designated register by 1 every 0.1 second, till the value is 0, and then reset to

10 and decrease again by holding the button.

Attribute

Set Style : | Cydiic JOG—

Bottam limit : 0

Dec, value : 1

JOG delay @ |0.5 second(s) v]

Security Tab

Upper limit : 10

1OG speed : |0.1 second(s) "]

Set Word Object's Properties

General | Security Shape |Label | Profile |

CX=

Safety control

[T ] Display confirmation request

Interlock
Use interlock function

[T Hide when disabled
Grayed label when disabled

Max. waiting time (sec) : |10

Trigger if value 1s : 1

Min. press time (sec) :

© Bu @ Word

PLC: [Local HMI

- H Settings...

Address : [LW |1

User restriction

16-bit Unsigned

Object class : [Nene
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Setting

Description

Interlock

Use interlock function

When this option is enabled and [Word] is selected, whether
the object is operable depends on the condition of a word
address specified in [Trigger if value is:]. In the settings above,
the object is operable only when the value in LW-1 is greater
than 1.

Hide when disabled

The object is hidden when the specified condition does not
occur in the specified word address.

Grayed label when disabled

The label of the object turns gray when the specified condition
does not occur in the specified word address.

[ ]

Trigger if value is:

This setting is for specifying a trigger condition. The available
options are: >, <, ==, <>, >=, and <=. A tolerance value can be
set for conditions == and <>.

For example:

Hide when disabled
[]Grayed label when disabled

Trigger if valueis : | == w

Tolerance : | 1 |

When the value is the specified word address is greater than
or equal to 11, or smaller than or equal to 9, the object will be

hidden and is not operable.
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13.5. Function Key

13.5.1. Overview

The Function Key object can be used for several tasks, such as switching between windows,

keypad design, Macro execution, screen hardcopy, and setting USB security key.

13.5.2. Configuration

'_Fl

Click the Function Key icon on the toolbar to open a Function Key object property dialog box.

Set up the properties, press OK button, and a new Function Key object will be created.

General Tab

cMT Series

eMT, iE, XE, mTV Series

New Function Key Object

General | Security I Shape I Label

Comment :

Execute maco

() Sereen hard copy

MNotification

@) Change ful-screen window () Change common window
() Display popup window

Window no. : | 10, WINDOW_010

(7 Return to previous window () Close window

() Acknowledge all events(alarms)

[T Enable

Mew Function Key Object &3

General |Security | Shape ILabe\

Comment :

[ Activate after button is released

@) Change full-screen window () Change common window

() Display popup window

Window no. : | 50, Keypad 11 - Integer -
() Return to previous window () Close window
ASCII/UNICODE mode
() [Enter] () [Backspace] () [Clear] ) [Esd]
(0 [Delete] O Left] ) [Right]

() [AsC1]  [UNICODE]

Execute macro

() Window title bar

Hard copy screen to USB disk, SD card or printer
() Screen hard copy

MNotification
[]Enable
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Setting Description

Activate If this function is selected, the action is delayed till button is
after button released; otherwise, the action is executed once the button is
is released pressed.

Change Change full-screen window: Change to another base window.
window Change common window: Change common window.

Display popup window: A pop-up window displays in the base
window. If [Close this popup window when parent window is closed]
check box is selected, the pop up window will be closed when
change the base window to another window. Otherwise, a function
key in the pop up window is needed to close it.

@) Display popup window

Close this popup window when parent window is dosed

Style : IWiﬂ'. title bar 'I

Window no. : Ill, Window_011 'I

Return to previous window: If this is selected, the Function Key will
change from the current screen to the previous one displayed. For
example, when window no. 10 is changed to window no. 20, press
the function key to return to window no. 10. This function is only
available for base window.

Close window: Close any active pop-up windows, message windows

included.
ASCIl/ Configures the button as a keypad key, and the character it enters,
UNICODE via [Numeric] or [ASCII] objects.
mode Enter: Same as the keyboard’s “Enter” function.

Backspace: Same as the keyboard’s “Backspace” function.

Clear: Clear the value in the word register.

Esc: Same as the [Close window] function; it is used to close the
keyboard window.

Delete: Same as the keyboard’s “Delete” function, deletes the
number or character on the right side of the text cursor.

Left: Same as the keyboard’s “¢” key moves the text cursor to the
left side of the previous number or character.

Right: Same as the keyboard’s “-” key moves the text cursor to the
left side of the next number or character.

ASCII/UNICODE: Specify the character to be entered by this key.

Execute Select this check box to execute one of the Macros from the drop

Macro down list that has already been configured by users.
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C?For more information, see “18 Macro References”.
(@) Execute macro Macra [[ID:UUU] macra_0 v]
Window title Function Key defined can be used to move a pop-up window which
bar has no [window title bar] to a preferred position on screen. Select
the pop-up window and then click on a preferred position, the
window will be moved.
[ 1
FK-\I Alarn Status ] ‘
Select the window titie bar firstly. Touching the screen for the new position
the popup window will be maoved.
Hard copy Print the current window. Before using this function, choose a printer
screen to model in [System Parameter Settings] » [Model] » [Printer].
USB disk, SD If a monochrome printer is used, selecting [grayscale] can provide a
card or better print result, but the text may not be clearly printed. To
printer improve text printing, avoid using [grayscale].

Hard copy screen to 1USE disk, SD card or printer
Printer : |Hp PCL Series (USE) -

i@ Screen hard copy

|:| Rotate image 20 dearees Mode : [mlur "]

Screen hard

copy
(cMT Series)

Output current screen to iPad Photos.

Acknowledge
all events
(alarms)
(cMT Series)

Acknowledge all events once by pressing the Function Key.

Import user
data / Use
[uSB
Security Key]

A Function Key can be used to import the e-mail contacts or user

accounts set, also, to log in using USB Security Key.
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=)
Function mode
) Import e-mzil settings and contacts
® fimport iiser accounts
) Use [USB Security Key] to Login
Data position
) 5D card @ USB disk
Account import mode
) Overwrite @ Append
[T] Delete file after importing user accounts
[ 0K ] I Cancel
Data Position
Select the external device to store data from [SD card] or [USB disk].
Account import mode
If [Overwrite] is selected, the existing accounts will be overwritten
with new accounts in the external device after importing. If [Append]
is selected, HMI will append more accounts while the old accounts
still exist.
Delete file after importing user accounts
If select this check box, the system will delete the account data saved
in the external device after importing, this can prevent the account
data from leaking out.
Notification If this selection is enabled, it will notify a designated bit address to

set ON or OFF, each time the button is pressed.

@ Note

B [Overwrite] is the only option when importing the e-mail contacts. This means that all

existing contacts will be removed first, and then the new contacts are added.

& For more information, see “6 Window Operations”, “12 Keypad Design and Usage”, “36

Administrator Tools”.
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13.6. Toggle Switch

13.6.1. Overview

Toggle Switch object is a combination of Bit Lamp object and Set Bit object. The appearance of
the object is controlled by the ON / OFF state of the read bit address. As well, pressing the
button sets the value in the bit address according to the settings.

13.6.2. Configuration

A

Click the Toggle Switch icon on the toolbar to open a Toggle Switch object property dialog. Set

up the properties, press OK button, and a new Toggle Switch object will be created.

General Tab
New Toggle Switch/Bit Lamp Object (=2
General | Security | Shape | Label |
Comment :

") Bit Lamp @ Toggle Switch
[7] Read/Write vse different addresses

Read address

PLC name : [Local HMI v] Settings...
Address : [LB v ] 0

[ Invert signal

Write address :
[7] Wrrite when button is released

Attribute

Macro

Execute macro
[ OK ] [ Cancel Help
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Setting Description
Comment User can describe the information of the object.

Bit Lamp / Toggle Switch
Switch between Bit Lamp and Toggle Switch features.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the
[Toggle Switch] object. Users can also set address in [General] tab
while adding a new object.

Invert signal

Reverses the display of ON / OFF states. For example, if [Invert
signal] check box is selected, when the designated bit is OFF, the
object displays ON state.

Write address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the
[Toggle Switch] object. Users can also set address in [General] tab
while adding a new object. The address can be the same or
different from [Read address].

Write after button is released

If this function is selected, the action is delayed till button is
released, otherwise, the action is executed once the button is
pressed. This function does not work with momentary buttons.

Attribute Set style Description
Set ON Set ON the designated bit of the device.
Set OFF Set OFF the designated bit of the device.
Toggle Alternates the bit state each time pressed.
Momentary Holds the bit ON only while button is
pressed.
Macro Toggle Switch object can trigger the start of a Macro routine when

the Macro has been created in advance.

& For more information, see “18 Macro References”.
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13.7.1. Overview

Multi-State Switch

Multi-state Switch object is a combination of Word Lamp object and Set Word object. The

appearance of the object is controlled by the value of the read word address. As well, pressing

the button sets the value in the word address according to the settings.

13.7.2. Configuration

Oy

Click the Multi-State Switch icon on the toolbar to open a Multi-State Switch object property

dialog box. Set up the properties, press OK button, and a new Multi-State Switch object will be

created.

General Tab

cMT Series eMT, iE, XE, mTV Series
New Multi-State Switch/Word Lamp Object [=3]| | New Multi-State Switch/Word Lamp Object (==
General | Security | Shape | Label | General ‘ Security | Shape | Label
Comment : Comment :
() Word Lamp © Multi-State Switch () Word Lamp @ Multi-State Switch
Mod Offet: 0 Hods Ottt 0
[T Read/Write use different addresses [ Read/Write use different addresses
Read address Read address
PLC name : [Loczl HMI v] Settings... PLC name : [Local HMI v] Settings...
Address : [Lw v|o "~ [16-bit Unsigned Address : [Lw <0 "~ [16-bit Unsigned
Exrror handling...
Write address : Write address
[ Write when button is released
Attribute Attribute
Cyelical : [Disable | Cyelical : [Disable -
[ User-defined mapping [T User-defined mapping
Send notification after writing sucessfully Send notification after writing sucessfully
[T]Enable ["]Enable
G C) o
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Setting Description
Comment User can describe the information of the object.
Word Lamp / Multi-State Switch
Switch between Word Lamp and Multi-State Switch features.
Model / Different modes can be selected: [Value], [LSB].
Offset & For more information, see “13.2 Word Lamp”.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Multi-state Switch object. Users can also set address in [General]

tab while adding a new object.

Write address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
Multi-state Switch object. Users can also set address in [General]
tab while adding a new object.

Write after button is released

If this function is selected, the action is delayed till button is
released; otherwise, the action is executed once the button is

pressed.

Attribute

Switch style
Select the object’s operation mode, see Example 1.

User-defined mapping
The value placed in the write register of each selection, the action

taken when an illegal value is entered, and error notification to a

designated bit address can be set.

i

Mapping

State Value

2 (eror)

=

Set default

Input ilegal

(@) Remain current state () Jump to error state

Errar notification
Enable () 5etON @ Set OFF

v] Setting...

PLC name : [Local HMI

Remain current state

If an illegal value is entered, Multi-state Switch will remain at the
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current state.

Jump to error state

If an illegal value is entered, Multi-state Switch will jump to the
error state.

Error notification

If an illegal value is entered, automatically set the value placed in

the designated register.

Send
notification After the system successfully writes data to PLC, the designated bit
after writing address will be set On/Off.
successfully
Error handling The action taken when an illegal value is entered or notify a
(cMT-SVR designated bit address. This is similar to [User-defined mapping];
Series) the difference is the value corresponding to each state need not to
be preset.
Example 1
® JOG+

Increase the value of a designated register by 1 each time when pressing the button, till the
value equals to [No. of states]. A cyclic action can be enabled. As shown below, each time
when pressing the button, the state number will add 1 start from state 0, till state 4 ([no. of
state]-1), and returns to 0 and step up again.

Attribute
Switch style : [JDG+ v] Mo, of states : [5 v]
Cydical : [Enable v]
[ user-defined mapping

® JOG-
Decrease the value of the designated register by 1 each time when pressing the button, till the
value equals to 0. A cyclic action can be enabled. As shown below, each time when pressing the
button, the state number will minus 1 start from state 4 ([no. of state]-1), till state 0, and

returns to state 4 and step down again.

Attribute
Switch style : [JDG— v] Mo, of states : [5 vl
Cydical : [Enable v]
[T user-defined mapping
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13.8. Slider
13.8.1. Overview

Slider object is used to change the value in a designated word register address by moving the
slide on the screen.

13.8.2. Configuration

O

Click the Slider icon on the toolbar to open a Slider object property dialog box. Set up the
properties, press OK button, and a new Slider object will be created.

General Tab
New Slider Object [l
Gensral | Outline | Secusity | Shape |
Comument :
Write address
PLC name : | Local HMI ~| [ Setting...
Address :[LW ~|0 16-bit Unsigned
Hotification
[¥] Enable ) Bet ON (@ Ret OFF
[ Before writing After writing
PLC name : Local HMI ~| [ Ssettng...
Address i[LB v] 0
Watch address
Enzble
Address :[LW -0 16-hit Unsigned
o ] [ cance
Setting Description

Write address Click [Setting] to select the [PLC name], [Address], [Device type],

[System tag], [Index register] of the word device that controls the
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Slider object. Users can also set address in [General] tab while

adding a new object.

Notification

If enabled, the state of a designated bit address will be set to ON or
OFF.

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the bit device that controls the
notification settings. Users can also set address in [General] tab
while adding a new object.

[Before writing] / [After writing]

Change the state of a designated bit register before, or after the

slider is slid.
Watch When moving the roller, the new value written to the word register
address address can be displayed in real time.
Outline Tab
New Slider Object (=30
| Generel| Cratling |Secu.rit3,r | Shape |
Athribute
Direction : Resolution : 1
LowHigh limit : @ Constant () Address
Low limit: High limit : 100
[¥] Coarse increment Increment : 10
Slider button twpe
[ s pictore
- Width . 20
1l 7] [ o
Frame : w | [ Tromsparent
Backgromd w | [ Transparent
lat : w | [ Transparent
o) [ e
Setting Description
Attribute Direction

Select the direction of the slider. (Right, Up, Left, Down)

I__| WE!NTEK

EasyBuilder Pro V5.05.02



Objects 13-30

1] =]

right
1l
left ﬂ
up down
Resolution

Sets the value change in the word register for each step of the
Slider. For example, if set to 10, the register value changes by 10
points for each increment or decrement on the Slider.

Constant

Sets the range of the Slider. For example, If set [Low limit] to 5, and
[High limit] to 100, the Slider will enter values between 5 and 100.
Address

Set the [Low/High limit] by a designated register, see Example 1.
Coarse increment

Apart from moving the roller to change the value as in [Resolution],
if this option is selected, the word value will increase / decrease by

the [Increment] value each time the object is touched.

Slider button Use picture (cMT Series only)

type If this checkbox is selected, a picture can be selected from the
Picture Library to be the slider button.
Four default styles are offered here, and the width of the Slider
may be set.
Color
Colors of the frame, background, and slot may be chosen.

Slider button type Slot
1
Frame Background
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Example 1
Set the low or high limit by a designated register. When write address is LW-n, where n is an

arbitrary number, the rule of setting limits is:

Content 16-bit 32-bit
Address LW-n LW-n
Low limit LW-n LW-n
High limit LW-n+1 LW-n+2
When address is LW-100, the rule of setting limits is:

Content 16-bit 32-bit
Address LW-100 LW-100
Low limit LW-100 LW-100
High limit Lw-101 LW-102
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13.9. Numeric
13.9.1. Overview

Numeric object can be used to input or display the value of a designated word register.

13.9.2. Configuration

Click the Numeric icon on the toolbar to open a Numeric object property dialog box. Set up the

properties, press OK button, and a new Numeric object will be created.

General Tab

[\& WEINTEK

New Mumeric Object @
General | Data Entry | Mumeric Format | Security | Shape | Font |
Description :
Allow input
Read/Write use different addresses
Read address
PLC name : [Loml HMI v] Settings...
Address : [LW |0
Write address
PLC name : Local HMI +| [ Settings...
Address : [LW |1
Motification
Enable @) 5etoN @ Set OFF
Before writing [T After writing
PLC name :[Lcml HMI v] Settings...
Address =[LB v] 0
Motification on invalid input
Enable @ setOM () Set OFF
PLC name :[Loml HML v] Settings...
Address : [LB |1
o] [ cont
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Setting Description
Allow input If selected, the input features and relevant settings are enabled.
Read / Write
use different Set [Read address] and [Write address] differently.
address

Read address Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that displays the

value. Users can also select a tag defined in Address Tag Library..

Write address Select the [PLC name], [Device type], [Address] of the word device

that system writes to.

Notification If this check box is selected, it will notify a designated bit address
(setting ON or OFF).
Before writing / After writing
Set the state of the designated bit address before or after the
manual operation.

Notification If an illegal value is entered, automatically set the state of a

on invalid ) )

input designated register.

Data Entry Tab

cMT-SVR cMT3151
New Numeric Object @ New Numeric Object @
General| Data Entty | Nwmeric Format | Security | Shape | Font | General| Data Entry |Format | Security | Shape | Font |
Input order Input order
[/] Enable [] Enable
[7] Stop sequentisl input function after input
Input order: 2 [ Group
Keyboard
Use a popup keypad
() System keypad (@ Custom keypad
|| Hide title bar
D Restart the keypad if input value is out of range
Window no. : [50. Keypad 11 - Integer -
Popup position :
{relative to HMI screen} n
Hint = If the keyboard is an USB keyboard, on indirect/direct window, or on
the same window, please don't check "Use a popup keypad”.
Other options
|| Display lower and upper limits
|| Display current value
o) o o ) o ]
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eMT, iE, XE, mTV Series

Mew Mumeric Object

| General | Data Entry ‘ Numeric Format | Security I Shape I Font |

52 |

Input order

Enable

[7] 5top sequential input function after input

Inputorder: 1 = [ Group

Keyboard
Use & popup keypad
[ Hide title bar

[7] Restart the keypad if input value is out of range

Window no. : (50, Keypad 11 - Integer

Popup position: . - o
{relative to HMI screen} 5 @ ®

window, please don't check "Use a popup keypad™,

Hint : If the keyboard is an USB keyboard, on indirect/direct window, or on the same

13-34

Setting Description

Mode Touch

Used when data entry is initiated by touching the screen object.

Bit control

Used when data entry is enabled by turning ON a designated bit,

and entry ends when the bit goes OFF.

Allow input Specify a bit address that enables or ends data entry. The order of

bit address data entry is specified in [Input order] and an external USB

keyboard is needed for data entry. For cMT-SVR, use iPad’s

keyboard.

Input order Perform continuous input by setting [Input order] and [Group].

The criterion of searching the next input object:

® The range of [Input order]: 1 ~ 511, range of [Group]: 1 ~ 15.

If [Group] is not selected, its input order is 0.

® The system only searches for the objects within the same

Group.

® The lower number of order is entered before the higher

number of order.

For multiple objects within the same group and with the same
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input order, the object placed in the lower layer is entered first.

Keyboard Use a popup keypad

(For eMT, iE, If selected: A pre-designed pop-up keypad can be chosen by

XE, mTV selecting a check box, and selecting the relative position on the
Series, and HMI screen. When data entry is enabled, the pop-up keypad
cMT3151) displays in the selected position, and closed when data entry ends.

If this check box is selected in cMT3151 Keyboard settings, to use a
customized keypad, please select [Custom keypad].

If not selected: When data entry is enabled, the pop-up keypad is
not displayed. Users may:

® C(Create a custom design on the same screen window.

® Use a USB keyboard.

Hide title bar

Use a keypad without the title bar.

Restart the keypad if input value is out of range

When entering data, if the value entered is not within the valid
range, the system will automatically restart the keypad.

0 Note

B TheiPad’s keyboard is used to enter data for cMT-SVR. To use a built-in keyboard for
cMT3151, select [Use a popup keypad] check box in Keyboard group box, and then select
[System keypad].

&r To create a keyboard in current window, see “12 Keypad Design and Usage”.
Example 1
This example demonstrates how to use [Input Order] and [Group] to perform continuous input
in several Numeric objects. After entering data in one object, entry will be passed to the next
input order object which is in the same group.
1. Create three Numeric objects, and set [Input order] to 1, 2, and 3 respectively. Include
the three objects in [Group 1] as shown in the following figure.
LW-0

Input order
| Enable

Stop sequential input function after input

Inputorder: 1 = /| Group: 1 a

Input order
| Enable

Stop sequential input function after input

Input order : 2 = | Group i =
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Input order
| Enable

Stop sequential input function after input

Input order : 3 = V| Group 1

LW-0 —P W1 LW-2

Orderl Order2 Order3

g S

2.  When finish entering data in the last object, to end data entry of all objects, please select

[Stop sequential input function after input] check box.

Input order
| Enable

I | Stop sequential input function after input I

Input order : 3 = | Group 1
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Numeric Format Tab

13-37

cMT Series eMT, iE, XE, mTV Series
New Numeric Object == New Numeric Object (=2
-Gemlal _Dala Entry | Numeric Format | Security | Shape Font iLﬁTiﬁgE‘gyﬂ‘ Numeniz Format i@‘)’ @EE
Display Display
Data format © 16-bit Unsigned = [ Mask Data format : 16-bit Unsigned ~ « [ Mask
Number of digits Number of digits
Leftof decimal Pt.: 4 2 Right of decimal Pt.© = Leftof decimal Pt.: 4 S
Sealing Display format
[¥] Enable Troncated digits: n
Test... == Preview conversion result Format ;. #kk WM
X Use star "*" to represent each digits. Number of "*" = [Left of decimal Pt] -
[ Drmamie scales [Truncated digits]
Enginsering low : 11 Enginsering high : 9993 Scaling
Method :[Nome o]
Other options
[ Displayr lower and upper limits
[ Display previous value
Limits
@ Direct () Dryaoradr: lits
PLC low: 0 PLC high : 0008 Lebrats
Tnputlow : |0 Tnput high : [0000 @ Direct *) Dymamic limits
PLClow: PLC high: 9999
[ 722 alarm color .
Inputlow : 0 Input high : |9900
[7]Use alarm color
Cancel Help Cancel Help
Setting Description
Display Data Format
Set the data format of a designated word register. The selections
include: BCD, HEX, Binary, Unsigned, Signed, Float. 16-bit uses 1
word where 32-bit uses two words.
Mask
If selected, any values entered will be hidden by displaying them as
%k %k sk k
Number of Left of decimal Pt.
digits The number of digits before the decimal point.
Right of decimal Pt.
The number of digits after the decimal point.
Display If [Enable] check box is selected, the [Allow input] feature in General
format tab will be disabled. Each “*” sign represents each digit that will be

“uxn

displayed in the Numeric object. Apart from signs, extra texts

can be entered in the [Format] field, for example: kg.

uxn

The numeric value represented by sign will be displayed from
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Objects
the highest digit to the lowest in the Numeric object.
Truncated digits
Specify the number of digis to be truncated, from the lowest digit to
the highest.
The number of “*” signs = [Left of decimal Pt.]-[Truncated digits]
Please see the following examples:
Display Format @
Example 1
Read data = 31255 (5 digits, unit : grams)
[Left of deicmal Pt.] = 5, [Truncated digits] = 0 => Number of "*" = 5 stars are required.
We can use "**kg***g", and the result will be "31kg255g"
Example 2 : Change [Truncated digits]
Read data = 31255 (5 digits, unit : grams)
[Left of deicmal Pt.] = 5, [Truncated digits] = 2
=> Number of "*" = 3 stars are required and last two digits will be truncated.
We can use "**kg*00g", and the result will be "31kg200g"
Example 3
Read data = 255 (5 digits, unit : grams)
[Left of deicmal Pt.] = 5, [Truncated digits] = 0
=> Number of "*" = 5 stars are required.
We can use "**kg***g", and the result will be "00kg255g"
Note : The text aligment only uses [Leading zero] mode when enables [Display format] function.
Exit
Scaling Interpolation

If this check box is selected, [Engineering low] and [Engineering
high] boxes appear. Values entered in these boxes correspond to the
display range required. The setting also requires [Input low] and
[Input high] in the limits section. See Example 2.

Test: Preview the result of Interpolation. See Example 2.

Dynamic scales: Set the [Engineering low] and [Engineering high] by
a designated register. See Example 4.

Macro subroutine (Not available for cMT Series)

The value read from or written to the register can be computed by
macro subroutines selected in [Read conversion] and [Write
conversion]. The macro subroutines should be diefined in Macro
Function Library. To use this feature, see “13.9.2.1 The rule of using

Macro subroutine”.
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Other options Display lower and upper limits
(For cMT If selected, when entering a value, the range
Series) is displayed near the object.
Display previous value Range: 0 to 9999
If selected, when entering a value, the value Current value: 5

before update is displayed near the object.

Limits This section allows users to apply display limits to the values held in
the input register. The color when the register value is outside limits
can be set.

Direct

Sets the limits by entering values in [Input low] and [Input high]. If
the value entered is outside the limits, the value in the register
cannot be changed.

Dynamic limits

Set the limits by a designated register, see Example 5.

Use alarm Low limit

color When the value in the register is outside the [Low limit], display
digits by the color set.
High limit
When the value in the register is outside the [High limit], display
digits by the color set.
Blink

When the value in the register is outside either limit, the digits flash.

13.9.2.1. The rule of using Macro Subroutine

® There must be a return value and exactly one parameter.
Examples:

sub char test (shorta) // (Correct)

sub test (chara) // (Incorrect, no return value.)

sub char test (char a, char b) // (Incorrect, two parameters.)

® Use the Macro data type that corresponds to the object’s data format.

The mapping is as follows:

Macro Data Type Numeric Object Data Format

short 16-bit Signed

Int 32-bit Signed

unsigned short 16-bit BCD, 16-bit HEX, 16-bit Binary, 16-bit Unsigned
unsigned int 32-bit BCD, 32-bit HEX, 32-bit Binary, 32-bit Unsigned
float 32-bit Float
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For example, if the data format of the numeric object is 16-bit Unsigned, only the
corresponding Macro data type: unsigned short, is available.

Examples:

sub char test(unsigned short a) // (Correct)

sub char test(chara) // (Incorrect)

® Supports only the local HMI address.

Examples:
GetData(var, "Local HMI", LB, 0, 1) // (Correct)

GetData(var, "MODBUS RTU", 0x, 0, 1) // (Incorrect)

® The following system defined functions are unable to be invoked:

ASYNC_TRIG_MACRO, SYNC_TRIG_MACRO, DELAY, FindDataSamplingDate,
FindDataSamplingindex, FindEventLogDate, FindEventLogindex, INPORT, INPORT2, OUTPORT,
PURGE, TRACE

® The following statements are not supported:
For-Next, While-Wend

Example 2
If [Interpolation] is selected, the scaling equation is as the following:
If A indicates the original data and B indicates the displayed data:
B = [Engineering low] + (A - [PLC low]) x Ratio
where, Ratio = ([Engineering high] - [Engineering low]) / ([PLC high] - [PLC low])
As shown below, the original data is 15, after conversion, 40 will be displayed.

Braling
Method : | Interpolation -
[ Test.. | == Preview conversion result
Drvmamic seales
Engineering low : 10 Engineernng ugh : 50
Limits

@) Durect Drymaride Linits

PLC low : PLC high: 20

Input low : |10 Inputhagh: | 5f

Click [Test] button to preview the result of Interpolation. Enter a value in [PLC] field as shown in

the following figure, for example, enter value 15, and the result, which is 40, will be displayed.
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Conversion Test @
Mumber of digits
Left of decimal Pt. : 4 = Right of decimal Pt. : =
Engineering high Engineering low
HMI Engineering low PLC PLC low &l - 10
40 = |10 +( 15 - |0 I x
20 - 0
PLC high PLC low

o 15
S Y Y Y

Hedll PLC

[ Apply ] [ 0K l [ Cancel

Example 3

If the numeric format selected is not Float and decimal point is used, the decimal place of the

converted result will not be adjusted automatically, please adjust [Engineering high] to

correctly place the decimal point of the result gained in [Interpolation] mode. Please see the

illustration below.

1. Create two Numeric objects, set [Right of decimal Pt.] to 1 and select [Interpolation]

method for one of the objects as shown in the following figure.

Data Entry | Numeric Format | security | shape | Font

Mew Mumeric Object | EL

Display
Data format :  16-bit Unsigned - [TIMask
Mumber of digits
Left of decimal Ft. : 4 = Right of dedimal Pt. : 1 =
Scaling
Method : | Interpolation -

] Dynamic scales

Engineering low : 0 Engineering high : 200

Limits
(@) Direct () Dynamic limits
PLClow: g PLC high: 100
Inputlow : | o Input high : | 200

2. Enter value “123”, the object set to [Interpolation] displays “246.0”

instead of “24.6".

Original Value 123

Converted Value 246.0
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3.

following figure.

13-42

To move the decimal point one place to the left, adjust [Engineering high] as shown in the

Mew Numeric Object

Data Entry | Mumeric Format | security | shape | Font

(2]

Lisplay
Data format :  16-bit Unsigned

MNumber of digits
Left of decimal Pt. : 4

Scaling

[[Mask

-

= Right of decimal Pt. : 1

Method : | Interpolation

[ bynamic scales

Engineering low : 0

Converted Value

Example 4

Engineering high : 20

Original Value

123

24.6

If [Interpolation] is selected, set the [Engineering low] and [Engineering high] by a designated

register. When Dynamic Address is LW-n, where n is an arbitrary number, the rule of setting

[Engineering low] and [Engineering high] is:

Content 16-bit 32-bit
Dynamic address LW-n LW-n
Engineering low LW-n LW-n
Engineering high LW-n+1 LW-n+2
When address is LW-100, the rule of setting limits is:

Content 16-bit 32-bit
Dynamic address LW-100 LW-100
Engineering low LW-100 LW-100
Engineering high LW-101 LW-102

Example 5

Set the limits by a designated register. When [Address] is LW-n, where n is an arbitrary number,

the rule of setting limits is:

Content 16-bit 32-bit
Address LW-n LW-n
Low limit LW-n LW-n
High limit LW-n+1 LW-n+2
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When address is LW-100, the rule of setting limits is:

Example 6

Content 16-bit 32-bit

Address LW-100 LW-100
Low limit LW-100 LW-100
High limit LW-101 LW-102

The following demonstrates how to use [Macro subroutine] for scaling when configuring
Numeric object.

The following two macros are used, one for [Read conversion] and one for [Write conversion].

Read Conversion

sub short read(unsigned short a)
short b
b=a+10

return b

end sub

Write Conversion

sub short write(unsigned short a)
short b
b=a-10

return b

end sub

1. Create two Numeric objects: NE_O and NE_1 and use the same control address. Select
[Macro subroutine] for NE_1.

NE_O NE_1

cr (With Macro conversion)

(Without Macro conversion)
E
Numeric Object's Properties

=0
F
General | Data Entry | Mumeric Format |5ec|,|rit5-I I Shape | Font | Proﬁ|e|

Display
Data format: 16-bitUnsigned  w [T Mask

£

Mumber of digits
Left of decimal Pt. : 4 =

Scaling

Method : [Macro subroutine v]

Read conversion : [read v]

Write conversion : ’write ']

2. Enter 0in NE_O then NE_1 will execute [Read conversion]. The value gained will be 10.
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NE_O NE_1
(Without Macro conversion)  (With Macro conversion)
0 10
Read Conversion Write Conversion
sub short read{unsigned short a) sub short write{unsigned short a)
short b short b
b=a+10 b=a-10
return b return b
end sub end sub

3. Enter 80in NE_1, [Write conversion] is executed and the value gained will be 70. NE_O

displays 70.
NE_O NE_1
(Without Macro conversion)  (With Macro conversion)
70 80
Read Conversion Write Conversion

sub short read{unsigned short a) sub short write(unsigned short a)

short b short b

b=a+10 b=a-10

return b return b

end sub end sub

0 Note

B |f executing [Read conversion] and [Write conversion] by the same numeric object, the
value entered in this object is computed by the Macro subroutine of [Write conversion]
first, and then the result is computed by the Macro subroutine of [Read conversion]. In
Example 5, if the subroutine of [Write conversion] is set to b=a-20, then entering 80 in
NE_1 will get 60 after [Write conversion] and then the object displays 70 after [Read

conversion].
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Security Tab

Numeric Object's Properties @

General | Data Entry | Format | Security [Shape | Font [ Profile |

Interlock
|| Use interlock function ) Bit @ Word

[ Hide when disabled
Grayed label when disabled

Trigger if value 1s : 1

PLC : (Looal HMI v ][ Settngs.. |
Address : 1 16-bit Unsigned

User restriction

Object class = [Nonc -

Setting

Description

Interlock

Use interlock function
When this option is enabled and [Word] is selected, whether
the object is operable depends on the condition of a word

address specified in [Trigger if value is:]. In the settings above,

the object is operable only when the value in LW-1 is greater
than 1.

Hide when disabled

The object is hidden when the specified condition does not
occur in the specified word address.

Grayed label when disabled

The value in the object turns gray when the specified
condition does not occur in the specified word address.

Trigger if value is:

This setting is for specifying a trigger condition. The available

options are: >, <, ==, <>, >=, and <=. A tolerance value can be

set for conditions == and <>.

For example:

[+] Hide when disabled

[ Grayed label when disabled
Trigger if value is : | ==

Jm

Tolerance : | 1 |

When the value is the specified word address is greater than

or equal to 11, or smaller than or equal to 9, the object will be

hidden and is not operable.

L—| WE!NTEK
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Font Tab
New NMumeric Object @
|Genara\ | Data Entry | Numeric Format | Security IShape| Font |
Attribute
Font: Arial -
Color : I | ~ Size :
Content
Setting Description
Color When the value is within the limits, display digits using color set in
this tab.
Align Left: Align the number to the left.
Center: Align the number to the center.
Right: Align the number to the right.
Leading zero: The number is preceded with leading zeros when the
number of digits is less than that set.
Center
Leading zero
Size Set the font size.
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13.10. ASCII

13.10.1. Overview

ASCII object can be used to input or display ASCIl or UNICODE characters held in designated

word registers.

13.10.2. Configuration

Click the ASCll icon on the toolbar to open an ASCIl object property dialog box. Set up the

properties, press OK button, and a new ASCII object will be created.

General Tab

New ASCH Object =]
General | Data Entry | Security | shape | Font |
Description :
Allow input
[Fmask []use UNICODE
[C]reverse highflow byte
Read address
PLC name : [Loml HMI v] Settings...
Address : [LW |0
Motification
[#]Enable (©) SetON @ Set OFF
Before writing [T After writing
PLC name :[Lcml HMI v] Settings...
Address =[LB v] 0
o) (ot

[\& WEINTEK
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Setting Description

Allow input If selected, the input features and relevant settings are enabled.

Mask If selected, any values entered will be hidden by displaying them as
****_

Use UNICODE Select this check box to display data in UNICODE format. If not
selected, the characters are displayed in ASCIl format. This feature
can be used with the [Function Key] object that uses
[ASCII/UNICODE].

Reverse Normally an ASCII code is displayed in “high byte”, “low byte”

high/low byte order. Reverse selection makes the system display ASCIl characters

in “low byte”, “high byte” order.

ABCD I BADC I

The left object is in normal form, and
another is high/low bvte reversed.

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that displays
characters. Users can select a defined address tag from Address Tag

Library, or set address in [General] tab while adding a new object.

Address @
PLC name : [L0C3| HMI ']
Device type : [LW ']
Address : O [ system tag

Address format : DDDDD [range : 0 ~ 10799]

[ tndex register

No. of word : 1

C—

No. of words

Select the maximum number of words to be displayed.

@ Note

B An UNICODE character uses 1 word, and an ASCII character uses 1 byte. Therefore 1 word

can be used as 1 UNICODE character or 2 ASCII characters. (1 word equals to 2 bytes)
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Font Tab
Mew ASCI Object =]
| General I Data Entry I Security | Shape | Font |
Attribute
Font : Arial -
Color : I |~ Size :
Content
AA
OK ] [ Cancel
Setting Description
Attribute The font, size, color, and alignment can be set.
Align

Left: Align the text to the left.
Center: Align the text to the center.
Right: Align the text to the right.
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13.11. Indirect Window

13.11.1. Overview

Indirect Window object opens the pop-up window assigned by a designated word register.
There are two ways to use Indirect Window object: The first is to use the profile of Indirect
Window object, and let the pop-up window be resized and displayed in the defined profile; the
second is to automatically resize the window according to the size of the pop-up window to be
displayed. To close the pop-up window, assign 0 to the designated word register. The difference
between Direct Window and Indirect Window is that Direct Window is controlled by a bit
register, while Indirect Window is controlled by a word register.

13.11.2. Configuration

123

Click the Indirect Window icon on the toolbar to open the object property dialog box. Set up
the properties, press OK button, and a new Indirect Window object will be created.

General Tab

cMT Series eMT, iE, XE, mTV Series
New Indirect Window Object @ MNew Indirect Window Object ==
General General
Description :
Comment :
Read address Read address
PLC name : | Lgcal HML - Setting...
PLC name : [Local HMI v |[settng... [ I )
Address : 0 16-bit Unsigned ress | 0 d
Attribute
Style : |No title bar -
[¥] Use window no. offset Offset: |-10 - Use window no. offset Offset: |-10 -
Auto, adjust window size Aigrment: | @ Auto. adjust window size Mignment: | @
{relative to object display region} _ D {relative to object display region} _©
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Setting

Description

Read address

Click [Setting] to select the [PLC name], [Address], [Device type],
[System tag], [Index register] of the word device that controls the
pop-up window. Users can also set address in [General] tab while
adding a new object.

Attribute Style
Set the display style of the pop-up window. There are two styles:
® No title bar
The pop-up window has no title bar and cannot be dragged.
® With title bar
The pop-up window has a title bar that can be dragged to move the
window.
Use window Sets the offset of the window number for selecting the pop-up
no. offset window. The window number of the pop-up window is calculated

by the value in the word register added to the offset. For example,
assume the value in the register is 20 and offset is 5, the pop-up

window number will be 25.

Auto. adjust

window size

Automatically resize the Indirect Window and align the pop-up
window to the preset region.

Alignment

Sets a reference point of the pop-up window from one of the five
positions on the screen. For example, if the lower-right region is
selected, the lower-right corner of the pop-up window is aligned to

the lower-right region of the Indirect Window. See Example 1.

Example 1

Here is an example of using Indirect Window. The setting is shown in the following figure, set

the address to LW-0 which assigns the window number. Create window no. 11 and 12 first.

1. Create an Indirect Window object, set address to LW-0, and select [Auto. adjust window

size].
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2. Select the region where the window is to be displayed.

Indirect Window Object's Properties @

General |Profile

Comment :

Read address

PLC niame : Local HMI +| [ Settng...
Address ; 0 [16-bit Unsigned

Attribute

Style : | With tile bar -

[[]Use window no. offset

Auto, adjust window size Alignment: ()

{relative to object display region} ! D i
) @

3. Enter value 11 in LW-0, the pop-up window displayed is window no. 11.
4. Enter value 12 in LW-0, the pop-up window displayed is window no. 12.
5. Enter value 0 in LW-0, the pop-up window is closed.

Popup Window No.| 11 | Popup Window No.| 12 |

<- The frame of Indirect Window <- The frame of Indirect Window

Window11

To close the pop-up window, apart from entering 0 in the designated word register, another

way is to place a Function Key object in the pop-up window, and set the key to [Close window].
0 Note

B At most 24 windows can be displayed simultaneously at run time.

B The system does not allow opening the same window with two Direct (or Indirect)
windows in one base window.

B |f the pop up window has monopoly property enabled, then when the window pops up,

all background windows may not be operated until the monopolizing window has been
closed.
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13.12. Direct Window

13.12.1. Overview

Direct Window object defines the position and size of a pop-up window location on a window.
When the content of the bit register is changed, the window will pop up at the predefined
location. The display area for the pop-up window is limited by the size of predefined location.
Restoring the value of the bit register closes the pop-up window. The difference between the
Direct Window and the Indirect Window is that Direct Window object has a predefined
window number, and is controlled by a bit register, while Indirect window is controlled by a

word register, and the value of the word register determines the window displayed.

13.12.2. Configuration

Hrd

Click the Direct Window icon on the toolbar to open a Direct Window object property dialog
box. Set up the properties, press OK button, and a new Direct Window object will be created.

General Tab
cMT Series eMT, iE, XE, mTV Series
New Direct Window Object @ New Direct Window Object =]
| General [ General
Comment : Comment :
Trigger : [ON v] Trigger : [ON vl
Read address Read address
PLC: [Local HMI vJ Settings... PLC: [Local HMI v] Settings...
Address: (LB v|0 Address: LB v|0
Attribute Attribute
Style : [No title bar v
Window No. : [11, Window_011 v Window No. : [11, Window_011 =
[V] Auto. adjust window size Alignment : [V] Auto. adjust window size Alignment :
{relative to object display region} {relative to object display region}
o C)
OK [ Cancel Help oK Cancel I Help
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Setting

Description

Read address

Click [Setting] to select the [PLC name], [Device type], [Address],
[System tag], [Index register] of the bit device that control the
window popup. Users can select a defined address tag from
Address Tag Library, or set the address in [General] tab while
adding a new object.

Attribute

Style

Define the pop-up window style. Two styles are available, [No title
bar] and [With title bar].

Window no.

Set the pop-up window number.

Auto. adjust

window size

Automatically resizes the Direct Window and align the pop-up
window to the preset region.

Alignment

Sets a reference point of the pop-up window from one of the five
positions on the screen. For example, if the lower-right region is
selected, the lower-right corner of the pop-up window is aligned to
the lower-right region of the Direct Window. See Example 1.

Example 1

Create window no. 11 which can be controlled by a Toggle Switch with address LB-0.

1. Create a Direct Window object and set read address to LB-0.

2. Inthis example, the reference point for alignment is set to the lower-right region.
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New Direct Window Object @
General

Comument :

Trigger: {ON ']

Read address
PLC : [Local HMI v |[ Settings... |
Address: [LB v|0

Attribute
Style : No title bar v/
Window No. : }llA Window_011 >

V| Auto. adjust window size Alignment :
{relative to object display region}

I OK H Cancel ) \ Help |

3.  When LB-0’s state is ON, window no. 11 will show.

Con

Fast Sel

4. When LB-0’s state is OFF, window no. 11 will be hidden.

Fast Sel
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0 Note

B A screen can simultaneously display up to 24 pop-up windows including System Message
Window, Direct Window and Indirect Window.

B The system does not allow opening the same window with two Direct (or Indirect) Windows
in one base window.

B If the pop up window has monopoly property enabled, then when the window pops up, all

background windows may not be operated until the monopolizing window has been closed.
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13.13. Moving Shape

13.13.1. Overview

13-57

Moving Shape object defines the states and moving distance of an object. The state and the

location of the object depend on consecutive registers.

13.13.2. Configuration

o

Click the Moving Shape icon on the toolbar to create a Moving Shape object. Set up the

properties, press OK button, and a new Moving Shape object will be created.

General Tab
Mew Moving Shape Object ==
General | Shape | Label
Comment :
PLC name : [Loml HMI v]
Read address
Address : |y - | 100 16-bit Unsigned
Attribute
Mode : [K axis only -
Display ratio
Limit address
Limit from register
Setting Description

Read address

Click [Setting] to configure the [PLC name], [Device type],
[Address], [System tag], or [Index register] of the word devices that

control the display of object’s state and moving distance. Users can
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also set the address in [General] tab while adding a new object.

Attribute Select the object’s movement mode and range. See “13.13.2.1
Illustration of Modes” in the following part.

Display ratio The size of shape in different states can be set individually as
shown in the following figure.
Ratio : 1 Ratie : 12 Ratie : 14 Ratie : 16

oo R site P state 2 F state 3

Limit address The object’s moving range can be set by adjusting the data in the

designated register, see Example 1.

Example 1
Supposed that the object’s moving range is limited by register LW-n, the addresses in the

following table are used to limit the moving range.

Data format 16-bit 32-bit

[Min. X] address LW-n LW-n

[Max. X] address LW-n+1 LW-n+2

[Min. Y] address LW-n+2 LW-n+4

[Mas. Y] address LW-n+3 LW-n+6
13.13.2.1. lllustration of Modes

Available modes are: (Assume Read Address is LW-n)

® Xaxisonly

The object is only allowed to move along the X-axis. The moving distance ranges from [Min. X]
to [Max. X].

Attribute
Mode : |X axis only v
Mo. of states : [s =
Min. X: 0 Max. X: 600
Data format 16-bit 32-bit
Object state LW-n LW-n
Moving distance on X-axis LW-n+1 LW-n+2

® Y axisonly
The object is only allowed to move along the Y-axis. The moving distance ranges from [Min. Y]
to [Max. Y].
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Attribute

Mode : [‘F axis only -
Mo. of states : [3 -

Min.¥: 0 Max. ¥ : 480

Data format 16-bit 32-bit

Object state LW-n LW-n

Moving distance on Y-axis LW-n+1 LW-n+2

® X&Yaxis

The object is allowed to move along the X-axis and Y-axis. The moving range in X and Y
directions is defined by [Min. X], [Max. X] and [Min. Y], [Max. Y] respectively.

Attribute

Mode : X &Y axis

)

Mo, of states : [3

Min.X: 0 Max. X @ &00

Min.Y: 0 Max. Y : 480
Data format 16-bit 32-bit
Object state LW-n LW-n
Moving distance on X-axis LW-n+1 LW-n+2
Moving distance on Y-axis LW-n+2 LW-n+4

For example, if the object’s read address is LW-100 and the data format is [16-bit Unsigned],

LW-100 is used to control the object’s state, LW-101 is used to control the object’s moving

distance on the X-axis, and LW-102 is used to control the object’s moving distance on the Y-axis.

The following figure shows that the object’s read address is LW-100 and initial position is (100,

50). To move the object to the position (160,180) and change its state to State 2, assign 2 to
LW-100, 160-100 = 60 to LW-101, 180-50 = 130 to [LW102].

(100, 50)

.

Lwi100 Lwio1 Lwioz
o [ 1 1
State X Offset Y Offset

(100. 50)

I Lwio0o Lwi1o1 Lwioz

2

| [ 60 130 |

(160, 180)_n=+ postion

State

X Offset Y Offset
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® X axis w/ scaling
The object moves in X-axis only with scaling. Suppose that the value of the designated register
is DATA, the system uses the following equation to calculate the moving distance on the X-axis.

[Scaling high]-[Scaling low]

Displ =(Data-[Input low])x
isplacement=(Data-[Input low]) [Input high]-[Input low]

Data format 16-bit 32-bit
Object state LW-n LW-n
Moving distance on X-axis LW-n+1 LW-n+2

® Y axis w/ scaling
The object is for Y axis movement with scale, and the equation to calculate the moving
distance on the Y-axis is the same as the one in [X axis w/ scaling].

Data format 16-bit 32-bit
Object state LW-n LW-n
Moving distance on Y-axis LW-n+1 LW-n+2

® X axis w/ reverse scaling
This works in the way as [X axis w/ scaling], but the moving direction is in reverse.
® Y axis w/ reverse scaling
This works in the way as [Y axis w/ scaling], but the moving direction is in reverse.
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13.14. Animation

13.14.1. Overview

Animation object is defined by a pre-defined point set and states. Animation object will then
move to a given point in a given state defined by designated registers. The object state and
position depend on current value of two consecutive registers. The first register controls the

state of the object and the second register controls the position along the predefined path.

13.14.2. Configuration

&

Click the Animation icon on the toolbar. First, create the pre-defined path. Move the mouse to
each moving position, and click the left button to define positions one by one. When it is done,

right click on the screen, set up the properties, press OK button, and a new Animation object
will be created.

AN D position o &

positian i $

gasitiand 8

position 3 #
pOsition £ %

To change the object’s attributes, double click on the object to open Animation Object’s
Properties dialog box.
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Objects
General Tab
Animation Object's Properties @
General | shape |Label | Profile
Comment :
Attribute
Position & @) Controlled by register (7 Based upon time interval
Read address
PLC name : [ Local HMI v [ Setting...
Address : o] 16-bit Unsigned
—
Setting Description
Attribute No. of states

Configure the number of states for this object.

Controlled by register

Use the designated registers to control the object’s state and
position. See Example 1.

Based upon time interval

The object’s state and position will change from time to time. [Time

interval attributes] is used to set the time interval for states and

positions.
Time interval attributes
Position speed : 10 * 0.1 second(s)
Image state change : ['ﬁme—based v] Backward cyde
Image update time @ 5 *0.1second(s)

Position speed: The speed of movement. The unit is 0.1 second.
Supposed that [Speed] is set to 10, the object’s position will change
each second.
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Image state change: Determines how state changes, either
[Position dependent] or [Time-based]. If [Position dependent] is
selected, the object state will change when position changes. If
[Time-based] is selected, the object position will change based on
[Position speed] and the object state will change based on [Image
update time].

Backward cycle: Assumed the object has four positions: position 0,
position 1, position 2, and position 3, and [Backward cycle] is not
selected. When the object moves to the last position (position 3),
the next position will be back to the initial position 0, and repeat.
The moving path is shown as follows:

position 0 - position 1 - position 2 - position 3 - position 0 >
position 1 - position 2...

If [Backward cycle] is selected, when the object moves to the last
position (position 3), it will move backwards to position 2, position
1 and then the initial position 0, and start over again. The moving
path is shown as follows.

position 0 - position 1 - position 2 - position 3 - position 2 >
position 1 - position O...

Example 1
The object’s state and position are determined by the registers, and the addresses must be

configured correctly, as in the following table:

Data format 16-bit 32-bit
Object state LW-n LW-n
Object position LW-n+1 LW-n+2

For example, if the designated register is LW-100 and the data format is [16-bit Unsigned], then
LW-100 represents object’s state, LW-101 represents position. In the picture below, LW-100 = 2,
LW-101 = 3, so the object’s state is 2 and position is 3.

pasitian &
pasitian 4

pasition i pasition 4

Lwioo @ 2 | Ltwiwor | 3 |

pasitian 2
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Profile Tab
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ion Object's Prop

General | Shape | Label | Profile

Position
[T Pinned X
Size
[T Keep width/height ratio
Width :
Width (36) :
Shape rectangle size
Width :

Trajectory

r 191 ~

191 ~

aRER

100

a4 ~

Position 0

Height :

Height (%) :

Height :

1 56

100

1147

aRER

[ ook

| [ Cancel

Setting

Description

Shape rectangle size

Set the size of the shape.

Trajectory

Set the position of each point on the moving path.

@ Note

B Since multiple pictures might be used by an [Animation] object, [Set to original dimension]

will not return all pictures to the original size.

I__|_ WE!NTEK

EasyBuilder Pro V5.05.02



Objects 13-65

13.15. Bar Graph

13.15.1. Overview
Bar Graph object displays data as a bar graph for visualization.

13.15.2. Configuration

it

Click Bar Graph icon on the toolbar to open Bar Graph dialog box. Select properties, click OK
button, a new Bar Graph object is created.

General Tab
New Bar Graph Object [
Comment :
Read address
PLC name | Local HMI | [ setting..
Address: 1] 16-bit Unsigned
Setting Description
Read address Click [Setting] to Select the [PLC name], [Device type], [Address],

[System tag], and [Index register] of the word devices that controls

how the bar graph displays.
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Objects
Outline Tab
New Bar Graph Object @ New Bar Graph Object
| Genersl | Onutline [Secu.rity [ Shape | ‘ Geneml} Outline | Secusity [ Shape |
Type Type
@ Bar () Circular @ Bar
Attribute Attribute
ote:(fomal %] Dimsion:[Gp : Voto ol ¥ A (BT
Min.: 0 Max.: 10 Min.: 0 Max.: 10
Bar width ratio (%) : 100 2 Hole Radivs (%) : 0 £
Colox/Style ColorfStyle
[V] Transparent [V] Transparent
o: — | Bosye: ) o —| Bt )
Target indicator Target indicator
[V] Enable Color : G v [V] Enable Color : G v
Targetvalue : Tolerance : Targetvalve : Tolerance :
Alarm indicators Alarm indicators
Low limit: 0 High limit: 10 Low limit: 0 High limit: 10
Loweolor: [ v Highcolor | p—— v Loweolor: [ lw Highcolor ! p— v
Dymamic target/alarm/zero(span) Dymnamic targetfalaxm/zero (span)
[T Enable [ Enable
(o ] (o ]
Setting Description
Type Choose either [Bar] or [Circular].
Attribute Mode

Choose either [Normal] or [Offset]. If [Offset] is selected, an

original value [Origin] must be entered for reference.

Direction / Degree

Bar: Determine the bar graph direction. Available options are [Up],
[Down], [Right], and [Left].

Circular: Determine the circular bar graph direction. Available

options are [Clockwise] and [Counter clockwise].

Degree
Direction
(@) Clockwise
Degree
Full circle
Start: 0

=)

() Counterdodkwise

[ QK ][ Cancel ]

If [Full circle] is selected, set the start degree.

If [Full circle] is not selected, set the start and end degree.
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Objects
Zero / Span
The percentage of filling can be calculated by the formula, see
Example 1.
Bar width ratio (%)
The ratio of bar to object width. The figure below shows two ratios,
100% and 50%.
100% 50%
Hole Radius (%)
The ratio of the radius of the hole to the radius of the whole
circular bar graph. The figure below shows two ratios, 0% and 50%.
0% 50%
Bar Set the bar’s frame and background color, bar style, and bar color.
color/style See the picture below.
Frame
Background
Bar
Bar style
Target When the register value meets the condition, the color of filled
indicator area will change to the target color, see Example 2.
Alarm If the register value is larger than [High limit], the color of filled
indicators area will change to [High color]. If the register value is smaller than
[Low limit], the color will change to [Low color].
Dynamic When [Enable] is selected, the [Low limit] and [High limit] of [Alarm

taget/alarm
/zero(span)

indicator] and the [Target Value] of [Target indicator] will use
designated registers, which is shown in their respective fields see
Example 3.
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Example 1
The percentage of filling can be calculated by the following formula:
Register value — [Zero]

Percentage of filling = [Span] — [Zero] x 100%

Assume [Offset] is selected. If (Register value — [Zero]) is greater than 0, the bar will fill up from

[Origin]. If (Register value — Zero) is less than 0, the bar will be drawn below [Origin].

For example, [Origin] is 5, [Span] is 10, and [Zero] is 0.

For different value in read address, it will display as below:

If the value at read address is 4: If the value at read address is 8:
high limit = 10 :m high limit = 10 :m
__ & —_——
origin = 5-------- — s origin = 5-------. — 5
_— —s
low limit =5 — fow limit=5 1,
4 8
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Example 2

When the register value meets the following condition, the color of filled area will change to
the target color.

[Target Value] - [Tolerance] < Register value < [Target Value] + [Tolerance]

Assume [Target Value] is 5 and [Tolerance] is 1. As shown below, if the register value is equal to
or larger than 4 (=5-1) and equal to or less than 6 (=5+1), the filled area’s color of the bar will

change to the target color.

Target value = 5
Tolerance = 1

(%]
(&)

Example 3

If [Dynamic target/alarm] is enabled, [Low limit] and [High limit] of [Alarm indicator] are
defined by designated registers as shown in the following table. Furthermore, if [Dynamic
zero/span] is used, [Zero], [Span] and [Origin] will be defined by designated registers. Assume

the address is LW-n, the limits are:

Data format 16-bit 32-bit
Alarm Low Limit LW-n LW-n
Alarm High Limit LW-n+1 LW-n+2
Target LW-n+2 LW-n+4
Zero LW-n+3 LW-n+6
Span LW-n+4 LW-n+8
Origin LW-n+5 LW-n+10
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13.16. Meter Display

13.16.1. Overview
Meter Display object displays the value of word register with a meter.

13.16.2. Configuration

O

Click the Meter Display icon on the toolbar to open the Meter Display dialog box. Set the

object’s attributes and then click OK to create a new Meter Display object.

13.16.2.1. eMT, iE, XE, mTV Series

General Tab
New Meter Display Object [==3a]
General | putine | Limits | Security | Shape |
Comment :
Read address
PLC name : | Local HML ~| [ Setting...
Address :’LW -| 0 16-bit Unsigned
Setting Description
Read address Click [Setting] to select the [PLC name], [Device type], [Address],

[System tag], and [Index register] of the word devices that controls

the Meter Display object.
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Outline Tab
Mew Meter Display Object [23a]
| General | Outine | Limits | security | shape|
Degree
Start degree: 0 $ End degree : 360 £
Background
Background: [ /v Profile: [ v
Full cirde [7] Transparent
Tick marks
[¥] Enable
Color : I | ~ [¥] Coordinate
Main scale : 4 = Sub. scale: 2 =
Length: 10 $
Pointer
Arm style... Frame: [ ||w
Inner : [ v
width: 4 - Length : &0 =
Pin point
Radius: 7 =
ners [ v| Frame : I
@) Cirde () Rectangle
o) Lo
Rarnge mark Tick mark
Corrdinate
Pointer
Pin point
Setting Description
Degree Sets the object’s start degree and end degree measured clockwise

from the 12 o’clock position. The angle range is 0 to 360 degrees.
The following shows meters of different settings.
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® [Start degree] =290° ® [Start degree] = 120°
[End degree] = 70° [End degree] = 240°
® [Start degree] = 40° ® [Start degree] = 225°
[End degree] = 140° [End degree] = 315"

Background

Sets the object’s background color and profile color.

Full circle

When selected, the object will display the whole circle. Otherwise, the
object will only display a partial circle in the defined degree range, as
shown in the following figure.

Full eirele non-full eirele

Transparent

When selected, the object will not display the background and profile
color.

Tick marks

Configures the number of tick mark and color.

Pointer

Configures pointer’s style, length, width, and color.

Pin point

Configures the style, radius, and color of the pin point.
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Limits Tab
Mew Meter Display Object (==
| General I Outline | Limits |5ec|,|rit§-I | Shapel
Value
Zero: 0 = Span: 100 =
Range limits
[¥] Enable
Low _v| Mid : v| High : I~
Width : 3 =
[T use user-defined radius
Dynamic limits
PLC name : [Local HML ~| [ setting...
Address:[Lw -~ 0 16-bit Unsigned
Scale label
[¥] Use scale label
Font: Arial -
Color : | Size :
Right of decimal point: 0
o) (o
Setting Description
Value Sets the object’s display range. Meter Display object will use the
value of [Zero] and [Span] and the value of register to calculate the
pointer’s position. See Example 1.
Range limits Configures the values of [Low limit], [High limit], their

corresponding display colors, and the width.

7\

Use user-defined radius
Configures the radius to display range limits.

For example, set to 80: Set to 30:
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0.0 0.0
75.00 ! 25.00 75.00 ! 25.00

Dynamic Limits

The low limit and high limit are set by registers. See Example 2.

Scale label Select the attribute of scale label on Meter Display.
MD_D
Seale label
[¥]se scale lahel
Fomt: Arial -

No. of decimal : 0

Example 1: Pointer position calculation

Set object’s display range. Meter Display object will use the value of [Zero] and [Span] and the
value of register to calculate the pointer’s position. For example, supposed that [Zero] is O,
[Span] is 100, when the value of register is 30, [Start degree] is 0, and [End degree] is 360, then
the degree indicated by the pointer is:

{ (30 —[Zero]) / ([Span] — [Zero]) } * ([End degree] - [Start degree]) =

{(30-0) /(100 -0)} * (360 — 0) = 108

Pointer will be pointing at 108 degrees.

Example 2: Dynamic Limits
The low limit and high limit are set by the register.

Suppose the address is LW-n, the following table shows the read address of low limit and high

limit:
Content 16-bit 32-bit
Low limit LW-n LW-n
High limit LW-n+1 LW-n+2

For instance, when address is LW-100, the rule of setting limits is:
Content 16-bit 32-bit
Low limit LW-100 LW-100
High limit LwW-101 LW-102
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13.16.2.2. cMT Series

General Tab

13-75

Low Limit

Pin Point

gL

Indicator

New Meter Display Object [===al
General | Security
Style : [,
Angle: |70 210°~150°
Enable animation
Value
Minirnurm
Maximum : 100
Read address
PLC name : | Local HMI +| [ Setting...
Address:’Lw ~| 0 16-bit Unsigned
Indicator | Range limit | Scale
Pointer
Pin point
Coc [ o
Scale

3 TiCk Marks

==>High Limit

Setting Description

Style

Three options are available: [Custom], [Style 1], and [Style 2]. Click

on the text to configure the properties. If [Custom] is selected, set

the properties such as [Pointer], [Pin point], [Background picture],

etc.
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Setting Click the button of [Style 1] or [Style 2] to set the style of meter.
Settings (=25
Background
Rotation :
[ ok || cencel |
Outline
The following is the outline of Style 1 when [Full circle], [Half
circle], or [Quarter circle] is selected.
\ / / (R— [l
The following is the outline of Style 2 when [Full circle], [Half
circle], or [Quarter circle] is selected.
Rotation
Rotates the background picture clockwise according to the angles
set.
Color
Sets the color of the background picture of meter.
Angle Sets the range to label the scale, 0° to 360° clockwise or
counterclockwise from the twelve o’clock position.
Full circle
If selected, the full circle is drawn according to the selected
direction and the start angle. The limits are determined by the
value set in [Minimum] and [Maximum] field under [Value].
Enable If selected, the pointer slides to the designated position when the
animation read value changes; if not selected, the pointer directly points to
the designated position when the read value changes.
Value Sets the lower and upper limits of the meter.

Read address

Displays the value in meter according to the value in the designated
word register.

Indicator

Sets the style of pointer and pin point. If [Custom] is selected, the
direction of the pointer must points upward to correctly display.
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Range limit Sets the colors to indicate different ranges.
Dynamic limits
The low limit and high limit are decided by the register. See
Example 2 above.

Scale Sets the number of main and sub scale, the color of tick marks and
scale label.
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13.17. Trend Display

13.17.1. Overview
Trend display objects draw curves of the data recorded by Data Sampling object.

13.17.2. Configuration

2

Click the Trend Display icon on the toolbar to open a Trend Display object property dialog box.

Set up the properties, press OK button, and a new Trend Display object will be created.
13.17.2.1. eMT, iE, XE, mTV Series

General Tab

17:32:41 12/03/06

| | 0 | e | |

Description

Go to the earliest sampling data.

Go to the previous time interval.

i Click to stop auto-scrolling. When the new sampling data is
generated, the display does not scroll, nor is the new data outside

the display range displayed.

Click to start auto-scrolling. The display scrolls as the new sampling

data is generated.

Go to the next time interval.

R

Go to the latest sampling data.
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Trend Display Object's Properties @
Generel | Trend | Channel | Shepe | Profile |
Comument :
Data, Sampling Object fndex :
Te e
Mote @ if no. of charmels iz changed, wou must resst HMI's data samplings |1
Refresh dats antomatically
£ axis time range - () Pixgl @ Time
Defanlt distance : 60 soond ()
Drynarde X axis thne range
FLC name : [Local HML v] Setting...
Address : [LW |10
History comtrol
PLC narme :[Local HMI v] Setting...
Address i[LW -~ |0 16-bit Unsigned
Watch line
Enable
PLC name :[Loca' HMI v] Setting...
Address i[LW - |20
Tivne stamap output
Enable
PLC name i[LocaI HMI v] Setting...
Address :[LW ~| 30
Setting Description
Data
Sampling Select a Data Sampling object as the source data.
Object index
Trend type Select the mode of data source, either [Real-time] or [History].

Real-time

In this mode, the display object shows all sampled data since the
HMI started. The maximum number of records that can be sampled
is set in [Max.data records] (Real-time mode) of the Data Sampling
object. When the sampling data exceed this setting, the earlier
data will be deleted.To show older data, use [History] mode.

[Hold control]: Suspends the update of Trend Display. However, It
does not stop the sampling process of Data Sampling object.
History

In this mode, the data comes from the history data files stored on
HMI. . The history data files are sorted by dates and each is given
an index. The system uses [History control] to select the history
data files that are created on different dates.

The system sorts the history data of sampling data by date; the
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latest file is record O (typically the data sampled today), the second
latest file is record 1, and so on. If the value of designated register
in [History control] is n, the Trend Display object will display data
record n.

Here is an example to explain [History control]. If the designated
register is LW-0, and the sampling data files available are
pressure_20061120.dtl, pressure_20061123.dtl,
pressure_20061127.dtl, and pressure_20061203.dtl, and it is
2006/12/3 today, based on the value of LW-0, the sampling data

file which will be selected by [Trend Display] is shown as follows:

Value of LW-0 Selected sampling history data
0 pressure_20061203.dtl
1 pressure_20061127.dtl
2 pressure_20061123.dtl
3 pressure_20061120.dtl
If use with Option List object and select data source as [Dates of

historical data], the history data will be sorted by date and
displayed in Option List object, see “13.29 Option List”.

Pixel

[Distance] is used to set the distance between two sampling points,

as shown in the following figure.

12/03/06

— Ffzo pixels
| /
\ /( N /

"\/ point 0 point 1

b | | wn | e | e |

Time

[Distance] is used to set the X-axis in unit of time, as shown in the
following figure.

L. 20 seconds
N

12/03/06 /\
A /I \ A A
A AR VAVi==A
A STV ]V \
vV \ V

b | | o || |

Select [Time] for [X axis time range] and go to [Trend] » [Grid] and
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enable [Time scale]. Please refer to [Time scale] in the later section.

Dynamic
distance
between data
samples/
Dynamic X
axis time
range

Designate a 32-bit word register for adjusting the distance between

two sampling points (select Pixel), or the time unit represented by

X-axis (select Time). If no value is entered, the default value will be

used.

Refresh data
automatically

If selected, every time when opening the window on which the

Trend Display object in history mode is placed, the display is

automatically refreshed once per second. Please note that:

The refresh status can be observed from the control button of
Trend Display object.

Showing 2l button: The automatic refresh feature is
enabled.

Showing ] button: The automatic refresh feature is
disabled.

When scrolling to the previous data, the automatic refresh
feature is disabled, the 1 button is shown.

If [Refresh data automatically] check box is selected, when
change back to the window, the display is refreshed, ignoring
the control buttons. For example, select [Refresh data
automatically], and scroll to the previous data, the automatic
refresh feature is disabled. In this case, changing to another
window and then change back will still refresh the display.

If [Refresh data automatically] check box is not selected when
building the project, the feature can still be enabled by
pressing 1 button on HMIL. In this case, the automatic
refresh feature is disabled, that is, even when change back to

the current window, the display will not be refreshed.

Hold control When the register is set ON, suspend the update of Trend Display. It
does not stop the sampling process of Data Sampling object. This
setting is available only in Real-time mode.

Watch line Use the [Watch line] function to display a “watch line” when user

touches the Trend Display object. It will also export the sampling

data at the position of watch line to the designated word device

and use Numeric objects to display the results, as shown in the

following figure.
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Wateh line

12/03/06

a2
\V;

A VAN
S A 8 A

| | o | | |

| 4 | LWw300

[Watch line] can also export sampling data with multiple channels.

The system will consecutively write each channel to the specified
address and the following addresses, in the same order as in [Data
Sampling] object. The address assigned to [Watch line] is the start
address, and sampling data for each channel will be exported to
the word devices starting from “start address.” If the data format of
each channel is different, the corresponding address of each
channel is arranged from the first to the last. If the watch register is
LW-300, watch function will export each channel’s data to the

following addresses:

Register | Channel Data format
LW-300 0 16-bit Unsigned (1 word)
LW-301 1 32-bit Unsigned (2 words)
LW-303 2 32-bit float (2 words)
LW-305 3 16-bit Signed (1 word)

Time stamp

output

Time stamp output

Suppose the address is set to LW-n, then:

If enabled, the system will use the time of the first sampling data as
“time origin”, and write the time stamp of the most recent sampled
data (relative to “time origin”) to [LW-n+2].

When clicking on the curve, the time stamp of the closest sampled
point will be written to [LW-n].

Clear real-time data address (Data Sampling object) will clear the
time origin as well.

Time stamp is recorded in seconds.

@ Note
[ ]

LW-n and LW-n+2 are both in 32-bit format.

B LW-nis for both real-time and history mode, whereas LW-n+2 only applies to real-time

mode.

B This function is available upon enabling [relative time mode] in [Trend] tab.
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13.17.2.2. cMT Series

General Tab

The Trend Display on cMT Series combines Real-time mode and History mode. Drag left to
scroll the Trend Display to view history data and drag right to view the latest sampling data.

Pinch two fingers together to zoom out Trend Display or spread them apart to zoom in.

/

Zoom In Zoom Out

C?For more information about how sampling data is saved, see “8 Data Sampling”.
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Mew Trend Display Object @
Comment :
Data Sampling Object index :
Mote : if no. of channels is changed, you must reset HMI's data samplings 1!
X axs tme range @ () Milimete @) Time
Distance : g second(s)
Watch line
Enable
PLC name : Local HMI ~ [ Setting...
o (o

Setting Description
Data
Sampling Select a [Data Sampling] object as the source data.

Object index

Millimeter

See 13.1.2.1.

Time

See 13.1.2.1.

Watch line

See 13.1.2.1.
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Trend Tab
Trend Display Object's Properties @
| General | Trend |Channel I Shape I Proﬁle|
|:| Transparent
Frame : I | ~ Background : -
Show scroll controls
Grid
[¥]Enable Color : N | ~
¥-axis interval : 4 | second(s) Y-axis: 4 = division(s)
Time scale
[¥] Enable
Color : | ~ Size :
Time/Date
Relative time mode
@ Time (T HH:MM:SS () HH:MM @ 55555
(71 55555 (Leading zero)
[@Date @ MMDDNY O DDMMAYY O DD.MMYY () YY/MM/DD
Color : |GG ~
Setting Description
Frame /
Select the color of frame and background.
Background
Show scroll Enable or disable the scroll control as shown in the following figure.
controls
M | ] e | M|
Grid Set the number of dividing lines and the line color. The number of

divisions depends on the setting in General tab.

X-axis interval

The number of vertical grid lines.

® Select [Pixel] / [Millimeter] in General tab:

Select how many sampling point will be included between two
vertical grid lines.

® Select [Time] in General tab:

Select the time range between two vertical grid lines.

Y-axis interval

The number of horizontal grid lines.
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Time scale Select [Enable] check box to display the time scale along the x axis.
o

“IMMDDAYY

/1 \ N
/ 7 o

[ I\
/ V

Format
The available time scale formats: HH:MM or HH:MM:SS.
Font / Color / Size

Select the font, font color, and font size of the time scale.
The default font size is 8.

Time / Date The time of latest sampling data will be marked on the top left
corner of the object. This group box is used to set the time display
format and font color.

Channel Tab

Mew Trend Display Object @

| General | Trend | Channel | shape |

Data sampling object

Channel Display Description Data tvpe ¥ aale
p 0 16-bit Tnsigned 16-bit Tnsigned  None
Channel

Pen property

[] pynamic limits

Zero: 1 Span: 100

Channel visibility contral

Enable
PLC name : [Loml HMI v] Setting...
Address : 1] 16-bit Unsigned
Display channel when the corresponding bit is :
D oN @) OFF
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Setting

Description

Y scale

Set Y-axis to be Main Axis or Aux. Axis. See “Y Scale Tab” for more
information.

Channel  Display  Description Data type Y scale

True chamel A 16-bit Unsigned Aux, Axis
True channel B 16-bit Unsigned Main Axas
True channel C 16-bit Unsigned Aux. Axis

[N Iy S Iy )

Channel

Configure each sampling line’s format and color. At most 64
channels could be configured.

Dynamic limits

® Not selected:

[Zero] and [Span] are used to set the low limit and high limit of
sampling data. If the low limit is 50 and the high limit is 100 for one
sampling line, [Zero] and [Span] must be set as [50] and [100], so
that all the sampling data can be displayed in the trend display
object.

® Selected

The low limit and the high limit are read from the designated word
devices, as shown below. When address is LW-n , the register’s
address:

Data Format 16-bit 32-bit
Low limit LW-n LW-n
High Limit LW-n+1 LW-n+2
For example, if LW-100 is used here, the low limit and the high limit

will be read from:
Data Format 16-bit 32-bit
Low limit LW-100 LW-100
High Limit LW-101 LW-102

A typical usage of this is to zoom in and zoom out of Trend Display.

(Not available for cMT Series). See Example 1.

Channel
visibility
control

If [Enable] is selected, the bits of the assigned word register will be
used to show/hide each channel. The first bit controls the first
channel, and the second bit controls the second channel, and so
on. For example, suppose there are 5 channels and LW-0 is used,
channels which will be shown given the states of the control bits

are:

Channel Control Bit State Displayed
1 LW_bit-000 OFF YES
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2 LW_bit-001 ON NO
3 LW_bit-002 ON NO
4 LW_bit-003 OFF YES
5 LW_bit-004 OFF YES

Note on using this feature: Each control bits are not reserved for
the channel. If a particular channel is not displayed, the control bit
is assigned to the next displayed channel. For example, if the third
channel of the 5 channels is not displayed, only 4 channels will be
displayed in Trend Display, and the used control bits will only be:
LW_bit-000~003.

Example 1

The example explains how to zoom in or zoom out Trend Display. The feature described is not
available for cMT Series.

In Channel tab select [Dynamic limits] check box. If the [Address] is set to LW-n, then LW-n

controls the low limit where LW-n+1 controls the high limit.

Dymamic limits

FLC name : [Lucal HMI v] Setting...

Address : [LW v] 0

Set [Address] to LW-0 and create two Numeric objects for entering the low / high limit. The
address that controls the low limit is LW-0; the address that controls the high limit is LW-1.
Let’s suppose the data is between 0 and 30; set the [Low limit] to 0 and the [High limit] to 30,

the trend curve is displayed as shown in the following figure.

17:01:50 081213

Low limit

o
High limit

[ |

To zoom out the Trend Display, enter a value greater than 30 in [High limit] as shown in the

following figure.

17:01:50 08112113

Low limit

o]

High limit
V\/\ —
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To zoom in the Trend Display, enter a value less than 30 in [High limit] as shown in the following

figure.

Y Scale Tab

17:01:50 0812113

eMT, iE, XE, mTV Series

Low limit

]

High limit

H

[ Trend Display Object's Properties @‘
| General | Trend | Channel | ¥ Scale | Security | Shape | Profile |
Data sampling object
Channel Display Description Data type ¥ seale
1 Troe channel & 16-bit Unsigned Aux. Axis
2 Troe channel B 16-bit Unsigned Main Axis
3 Troe channel C 16-bit Unsigned Aux. Axis
Scale font
Font:
Color: G v Size:_
PLCname:[Loca]HMI vJ[ Settings... ]
address:lw. x| o
Display channel’s ¥-scale when the corresponding bit is :
) ON @ OFF
Dynamic main axis
[7] Enable
pLC name:ILoca| HMI v] Settings...
Address:so § iiﬁ-blt Unsigned
Setting Description
Y scale Set Y-axis to be Main Axis or Aux. Axis, or set none to hide Y-axis.
Scale font Select the font, font color, and font size of the scale.
Dynamic To show or hide Y-scale. If the control address is LW-50, then the
Y-scale . . . .
isibilit first axis is controlled by LW _Bit 5000, and the second axis is
visibility
controlled by LW_Bit 5001, and so on.
Dynamic To change the main axis. If writing 1 into LW-80, the main axis will
main axis

be Channel 1; if writing 2 into LW-80, the main axis will be Channel,

and so on.
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The scale along the Y axis of a specific channel can be displayed. To enable Y Scale, [Grid]

should first be enabled in [Trend] tab. Y Scale can be configured on the iPad as shown in the

following steps.

1. Tapthe button on the upper right corner of Trend Display object.

2. Tap [Trend Display Setting] » [Y Scale].

3. Select the channels.

I__| WE!NTEK
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Option

Begin Date

Ended Date

Trend Display Set
Channel Visibility

Y Scale

ting

Reset to project default

Y Scale

Y Scale
Channel 1
<7 Channel 2
77 Channel 3
<7 Channel 4

57 Channel 5
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13.18. History Data Display

13.18.1. Overview

History Data Display object displays data stored by Data Sampling object. It differs from Trend
Display in that History Data Display object uses a table to display data. In case when the trend

display shows history data from today, the display will refresh once per second. The following is

Ch_Eﬂ
0

an example of a history data display object.

=
&
o|lo|o|ololo|lo|o|o|o|=

e | e ) e ) o ) o ) e | e | e |
w
Lu

—

No. | Time| Date |C
3577 121:52 |16/09/07
3276 |21:52 |16/09/07
3575 121:52 |16/09/07
3574 121:52 |16/09/07
3273 |21:52 |16/09/07
3572 121:52 |16/09/07
3571 121:52 |16/09/07
3270 121:52 |16/09/07

3569 [21:92 [16/09/07

‘?tll:.ﬂﬂ 21-R2 1 1RINGiN7
4

o) ) e} e | e ] e ] ] ) e

13.18.2. Configuration

Click the History Data Display icon on the toolbar to open a History Data Display object
property dialog box. Set up the properties, press OK button, and a new History Data Display

object will be created.
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General Tab

New History Data Display Object (=3

General | Data Format | Title | Shape|

Data Sampling Object index : ’1. v]
Grid
Enable
Color : NS |~ | Columninterval : 5 =
Profile color
D Transparent
Frame : I | ~ Background : -
Text
Font: Arial - Size
Time:
[#] Time HH:MM - Color : GGG | v
Date

[¥]pate DD/MM/YY - Color : G| ~
[¥] sequence no. Color : I | ~

() Time ascending @) Time descending

History control

PLC name : Local HMI ~| [ setting...
Address:[Lw - | 200
) e=
Setting Description
Data
Sampling Select a Data Sampling object as the source data.
object index
Grid Shows grids between rows and columns.
Color

Change the color of grids.
Column interval

Change the width of each column. The figures below are the

examples.
MNo. [Time [ Date [ChO]Chi1 Ch.Eﬂ Mo Time Date j
3667 |21:57 [16/09/07[ 1 0 0 3667 2157 16/09/07
3666 |21:57 [16/09/07[ 1 0 0 3666 2157 16/09/07
3665 |21:57 [16/09/07[ 1 0 0 3665 2157 16/09/07
3664 |21:57 [16/09/07[ 1 0 0 3664 2157 16/09/07
3663 [21:57 [16/09/07[ 1 0 0 3663 2157 16/09/07
3662 |21:57 [16/09/07[ 1 0 0 3662 2157 16/09/07
3661 |21:57 [16/09/07[ 1 0 0 3661 2157 16/09/07
3660 [21:56 |16/09/07[ 0 0 0 3660 2156 16/09/07
3659 [21:56 |16/09/07[ 0 0 0 3659 2156 16/09/07
2RRA [21-5R8 [HRNQINT n n n ARR2 21-RR 4RINQINT v
l | _>|J K | LI_‘
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Profile color Change the color of frame and background. Use [Transparent] to
hide frames and background.
Time / Date Enable or disable showing the time and date and configure its
format.
Time ascending
Put earlier data at the top and the latest data at the bottom.
Time descending
Put the latest data at the top and the earlier data at the bottom.
2:)5:3';\)" The history files are sorted by date and each file is given an index.
(eMT, iE, XE, The latest one is assigned index O (in most cases: today), the
mTV Series) second latest file is assigned index 1, and so on. [History Control] is

used to specify the history data to be shown.

0 Note

B When using cMT-SVR, use the filter icon in the upper-right corner of History Data Display

object on iPad to select the date and display the data.
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Data Format Tab

Mew History Data Display Object

Data Format | Title Shape

Channel : | Channel 0 ~ Channel 7

Channel 0 [16-bit Unsigned ]
Left of dedmal Pt. : 4

Channel 1 [16-bit Unsigned ]

[ Cisplay

Channel 2 [16-bit Unsigned ]

[ pisplay

Channel 3 [16-bit Unsigned ]
Left of decimal Pt : 4

Right of decimal Pt. : 0 =

ng zero .

Right of decimal Pt. : 0 =

ng zero L _____Ihg

o) o

13-94

Setting

Description

Channel

Each History Data Display object can display up to 64 channels.
Check [Display] to select the channels to be shown on the screen.
In the figure above, there are 4 channels (channel 0 to channel 3) in
the Data Sampling object, and only Ch.0 and Ch.3 are selected. The
data formats are shown next to channel name. The data format of
each channel is decided by the corresponding Data Sampling

objects. The result is shown below:

MNo. | Time Date | C

(=]

5272 |22:43:09 |16/09/07

N

5271 [22:43:08 | 16/09/07

5270 [22:33:42 | 16/09/07

5269 |22:33:41 [16/09/07

5268 [22:33:40|16/09/07

5267 [22:33:39|16/09/07

5266 |22:33:38 [16/09/07

5265 |22:33:37 [16/09/07

5264 [22:33:36 | 16/09/07

=] ] el e fome] o] fme] el | N PSP

R2R2 199-22-2K [MRINGINT

A

When display [String] format in History Data Display object, there

are two additional options:
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Channel 1 [Bteing - 5 waord (2)]
charecterno.: 4 |&] | [C]UNICODE

[¥] Display Center + || [C] Reverse hightlow byte —_—

® Display in [UNICODE] mode
® Reverse high byte and low byte data and then display.

Title Tab
m
| General | Data Format | Title | Shape |
[¥] Use title
Title background
[ Transparent Color : [ | ~
Title name Title | Lavel library | Label tag [~
Mone
Mone e
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone
Mone il
(o< [ conce
Setting Description
Use title Enable or disable title, which is marked as shown below:
4" No. | Time Date | Ch.0
5272 (224309 [16/00/07| 4
5271 |22:43:08 |16/09/07| 2
.Ila-ltli g Transparent
ackgroun . .
g When selected, hide the background for title area.
Color
Set the background color of title.
Setting Defines the text to be shown on the title.

Label Tag Library can be used for title in order to display the title in
multiple languages. Click [Setting] and select [Use label library].
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Title Setting

Title : | Mo,

Label tag: Mo, label

Use label library

Ok

Cancel

@ Note

B During off-line simulation, if the format of sampling data has been changed, please delete

previous data records in C:\[EasyBuilder Pro directory]\HMI_memory\datalog to prevent

the system from misinterpreting the old data records.
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13.19. Data Block Display

13.19.1. Overview

13-97

Data Block is a combination of several word devices with continuous address, where the X axis
of Data Block Display object represents the address and the numbers on the Y axis represent
the data values in the corresponding address. Data Block Display object can display multiple
data blocks. For example, it can display two data blocks LW-12~LW-15 and RW-12~RW-15 in
trend curves simultaneously. It is very useful to observe and compare the difference of trend

curves.

LW11
LW12
LW13
LW14
LW15

13.19.2. Configuration

created.

L—| WE!NTEK

Display Control

oo [1] w

LW12 LW13 LW14 LW15

/
~

| e | >

The display result

Click the Data Block Display icon on the toolbar to open the property dialog box. Set
Q up the properties, press OK button, and a new Data Block Display object will be

EasyBuilder Pro V5.05.02



executing the operation below, the system will reset the control
word to zero.

Enter “0” = No action (default)

Enter “1” = Draw (Without clear first)

Enter “2” = Clear

Enter “3” = Redraw

No. of data address

If control address is LW-n, then LW-n+1 stores the number of word

Objects 13-98
General Tab
New Data Block Display Object =
General | Display Area | Shape
Comment :
Mo, of channel : 4§ =
Cursor line
[¥] Enable Color : I | ~
PLC name :[Loml HMI v] Setting. ..
Address i[LW v] i}
Control address
PLC name : Local HMI ~| [ Setting...
Address i[LW v] 0
Mo. of data address : | L : 10 + 1 [T] offset to start address
Data storage start address :
PLC name : | Local HMI =] [ Setting...
Address:[LW -~ | 12 16-bit Unsigned
Lirnit
Min.: 0 Max. © 32767
o) (o
Setting Description
Comment Description of the object.
No. of Set the no of channel for this object. Each channel represents one
channel data block. The maximal number of channels is 12.
Cursor Line If enabled, when user touches the [Data Block Display] object, it
will display a vertical cursor line on it, and store the data on the line
to the designated registers. See Example 1.
Channel Select the channel to be configured.
Control Specify the control address also the data source.
address Control address is used to control and clear the drawn curve. After

I__| WE!NTEK
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devices in each data block, i.e. the number of data. The maximum
value is 1024.

Data storage start address

If [Offset to start address] is enabled, the [Offset value storage
address] will be set as [Control address] + 2.

If select 16-bit data format, the address for each data will be start
address, start address + 1, start address + 2 and so on.

If select 32-bit data format, the address for each data will be start
address, start address + 2, start address + 4 and so on.

For more information about control address, see Example 2 to 5.

Limit Set the minimum and maximum limit for the curve.

@ Note

B The system can draw at most N curves, where N = 32 divided by the number of channel.
Example 1
How to use watch (Cursor Line) feature

Use “Watch” function to check the value of any point of the curve. When the user touches
[Data Block] object, it will display a “cursor line”, and the system will write the index and value
of that data on the cursor line to the designated address.

Data Format Index Value Channel 1 Value Channel 2 Value
16-bit Address Address + 1 Address + 2
32-bit Address Address + 2 Address + 4

When watch address is set to LW-n, the value written into LW-n represents the channel index
number to be called up. (Start form 0)

Channel 1 Channel 2 Watch
16 bit BCD 32 bit unsigned address
s0l Watch indicator 1 | Control 1 | Control +0 3 Index

-

No. of Data 7 | No. of Data +1 10 16 bit BCD

40
/\/_\_' 30 | Data 1 40 | Data 1 +2 32 bit
30 40

20 | Data 2 50 | Data 2 +3 unsigned
20 10 | Data 3 30 | Data 3 +4
10| S 10 | Data 4 40 | Data 4 .

] ] ] ] ] 10 | Data 5 40 | Data 5
10 | Data 6 30 | Data 6
10 | Data ¥ 30 | Data 7

@ Note

B [Data Index] is a 16 bit unsigned integer. When the designated register of cursor line is 32
bit device, it will be stored in the bit 0-15.

B |f the channel to be viewed has no data, “0” will be displayed, as shown below. In the
example, there is no data in channel 1, when the cursor points at Data 4, “0” will be

displayed as shown below.
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Channel 1
16 bit BCD

40 /v

'_\_' Data 1
0 Data 2
20 Data 3
10 |- Data 4
] ] ] ] ] Data 5

Data 6
Data 7

B [f thereis less data in Channel 1, “0” will be displayed, as shown below.

Channel 1
16 bit BCD

20 | Data 2

20 10 | Data 3

10 Data 4
! ! ! ! ! Data 5
Data 6
Data 7

50 |-
40

_\— 30 | Data 1
30 \

Example 2
How to show a data block

50 Watch indicator Control

No. of Data

Watch indicator 1 | Control

3 | No. of Data

Channel 2
32 bit unsigned
1 | Control +0
7 | No. of Data +1
40 | Data 1 +2
50 | Data 2 +3
30 | Data 3 +4
40 | Data 4
40 | Data 5
30 | Data 6
30 | Data 7

Channel 2
32 bit unsigned
1 | Control +)
7 | No. of Data +1
40 | Data 1 +7
50 | Data 2 +3
30 | Data 3 +4
40 | Data 4
40 | Data 5
30 |Data 6
30 | Data 7

Watch
address

3

0

40

Watch
address

3

0

40

Index

16 bit BCD

32 bit
unsigned

Index

16 bit BCD

32 bit
unsigned

1. Write the number of data to [No. of data address], i.e. “Control address+1”

2. Store the data consecutively beginning at [Data storage start address].

3. Write “1” to [Control address] to draw the curve without cleaning the plot. All previous

curves will not be erased.

4. The system will write “0” to [Control address] after marking the plot.

Word Address

Last displayed graph

1

7

20

30

10

20

20

40

30

Control

No. of Data

Data 1
Data 2
Data 3
Data 4
Data 5
Data 6
Data 7

Data 1

Display

]

@ Note

B Do not change the content of [Control address], [No. of data address] and [Data storage

start address] between step 3 and step 4 above as doing so might cause error for the

trend curve plot.

L—| WE!NTEK
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Example 3
How to clear the graph

13-101

1. Write “2” to [Control address], all the trend curves will be cleared.

2. The system will write “0” to [Control address] after the trend curve is cleared.

Word Address

Last displayed graph

2

7

20

30

10

20

20

40

30

Clear
Control

No. of Data

Data 1

Data 2

Data 3

Data 4

Data 5 ] ] ] ] ] !
Data 6 Clears the previous
w1 {?;::L"i:‘::::?‘;:::':;;h

does not display.

Example 4

How to clear the previous trend curve and display new one

1. Write the number of data to [No. of data address], i.e. “control address+1”

2. Store the data consecutively beginning at [Data storage start address].

3. Write “3” to [Control address], the previous trend curves will be cleared and the new

content in data block will be plotted on the screen.

4. The system will write “0” to [Control address] after the trend curve has been plotted.

Word Address
Last displayed graph 3 | Control Redraw screen
7 | Mo. of Data
40

20 | Data 1

30 |Data 2

10 | Data 3 Data 1

20 | Data 4

20 |Data 5

40 [ Data 6 Clears the previous
graph display, then uses

30 [Data? the current data to
display the graph again.

Example 5
How to use offset mode

If [Offset to start address] is selected, [Control address], [No. of data address], and [Offset

value storage address] will use 3 consecutive addresses.

For example, assume the total number of channels is 3 (start from 0 to 2), and the [Control
address] are LW-0, LW-100, and LW-200, respectively. Then, the other addresses will be set as

follows: (In the example, format 16-bit Unsigned is used and [Offset value storage address] are

all m).
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Item Channel 0 Channel 1 Channel 2
Control Address LW-0 LW-100 LW-200

No. of data LW-1 LW-101 LW-201
address

Offset value LW-2 (=m) LW-102 (=m) LW-202 (=m)
storage address

Data 1 LW-0+m LW-100+m LW-200+m
Data 2 LW-1+m LW-101+m LW-201+m

13-102

The following figure on the left shows the result when offset mode is not used while the figure

on the right shows the result when offset mode is used.

No offset settings Has offset settings

Designated Designated

address Control address Control
+1 | No. of Data (n) +1 | No. of Data (n)
+2 Data 1 +2 Offset (m)
____________ Data (n) to be
displayed on the
____________ graph +m Data 1
+(n+1) Datan ) [TT777 T Data (n) to he
: displayed on the
____________ graph
+(m+n-1) Data n

@ Note

[y

When [Control address] is set to LW-n, [No. of data address] and [Offset value storage
address] are as follows:

Data Type 16-bit 32-bit
Control address LW-n LW-n
No. of data address LW-n+1 LW-n+2
Offset value storage address LW-n+2 LW-n+4

If the control registers are 32-bit devices, only bit 0-15 will be used for control purpose, bit
16-31 will be ignored. (as illustrated below)

32 bit device
31 16 13 0
+0 0 Control
+1 0 No. of Data
+2 0 Offset

When the value in [Control address] is not zero, the system will read [No. on data address]
and [Offset value storage address].

It is recommended to use [Offset to start address] for data block display with multiple
channels and the same device type. As shown in the following figure, The control words of
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channel 1 is located from LW-n, the control words of channel 2 is located from LW-n+3,

and so on.

Display Area

Address

Control
No. of Data (n)
Offset (m)

Control

No. of Data (n)

Offset (m)

Channel 1's
data (n)

Channel 2's
data (n)

Channel 1

Channel 2

Data Block Display Object's Properties

| General | Display Area | shape | Profile

Enable scroll switch

Profile color

D Transparent

Grid

Channel

Pen property

=

Frame : w | Background :

Enable Color :

Horiz.: 5§ | division(g) Verti,

Color: || ~ Width :

Data samples : | 50 - Samples to scroll @ 10 =

I

5 %+ division(s)

[ OK ] [ Cancel

13-103

Setting

Description

Description

Data samples

Configure the maximal number of data samples (points) to be

displayed.
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13-104

Samples to scroll

Configure the number of data samples being scrolled.

Enable scroll switch

Clicking

Clicking

-

-

>

displays the previous or next data point.

displays the first or the last data point.

Profile

Set the color of the frame and background of the object.

Transparent

Hides the background. Color selection will not be available.

Grid

Set the number of horizontal and vertical divisions shown by grid.

Channel

Set the color, width and style of each curve.
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13.20. XY Plot

13.20.1. Overview

XY Plot object is used to display values for two variables (x,y) for a set of data, where the data

comes from word registers. Up to 32 channels can be displayed simultaneously. This object

facilitates data observation and analysis. Additionally, negative numbers can be displayed as

well.

13.20.2. Configuration

Click the XY Plot icon on the toolbar to open a [XY Plot] object property dialog box.

General Tab

XY Plot Object's Properties (===
General |[‘.li5|:v|a\-I Area | Shape | Proﬁle|
Comment :
Direction : Right | Mo.ofchannels: 2 =
Control Address
PLC name : ’Loml HMI v] Setting. ..
Address i[LW v] 10
Mo. of data address :
Read address
PLC name : [Loml HMI ']
Separated address for ¥ and ¥ data
¥ data
PLC niame : | Local HMI
Address :’LW ~| 100 16-bit Unsigned
Y data
PLC name | Local HMI
Address i[LW ~ | 200 16-bit Unsigned
Limits
[ bynamic limits
X axis
Low: 0O High: 32767
Y axis
Low: 0O High: 32767
o) [ cans

I__| WE!NTEK
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Setting

Description

Direction

There are four selections, right, left, up or down.

Right Up Down

Right direction Left direction Up direction origin—,

R

arigin =" = origin arigin= * Diown direction

No. of

channels

Set the number of channels for observation.

Control
address

Controls the operation of all channels simultaneously. When the
[Control address] is LW-n, assigning values to LW-n will issue
commands to XY plot according to the table below. Meanwhile,
LW-n+1 | controls the number of data points plotted. After
operation, the [Control address] will be reset to 0.

Control | Value Result
address

LW-n 1 Plots point on XY curve.

(The plotted points are kept.)

2 Clears all XY curves.

3 Clears then plots new XY curve.

LW-n+1 Any

Controls the number of data points plotted.
number

No. of data address
Controls the number of data points. Each channel can plot up to
1023 points.

Channel

Select a channel to configure.

Read Address

PLC name

Select a PLC which will be the source of [X data] and [Y data] and
designate a read address.

The format of the data register blocks used for the display channels
depends on whether [Separated address for X and Y data] and/or

[Dynamic limits] has been selected. See Example 1.

Dynamic

limits

® When not selected (See Example 2)

The Low and High limits can be set by entering constants. The Low
and High limits are used for calculating X and Y range in
percentage.

® When selected (See Example 3)

A zoom effect can be created by changing the Low / High Limits.
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Example 1

13-107

The format of the data register blocks used for the display channels depends on whether

[Separated address for X and Y data] has been selected, and if [Dynamic limits] has been

selected. The following explains the situations where 16-bit register is used:
® [f [Separated address for X and Y data] is not selected, and set [Read address] to LW-n:

Select [Dynamic limits]

Not select [Dynamic limits]

X data Y data X data Y data
Low Limit LW-n LW-n+2 Constant Constant
High Limit LW-n+1 LW-n+3 Constant Constant
1" data LW-n+4 LW-n+5 LW-n+0 LW-n+1
2" data LW-n+6 LW-n+7 LW-n+2 LW-n+3
3" data LW-n+8 LW-n+9 LW-n+4 LW-n+5
4™ data LW-n+10 LW-n+11 LW-n+6 LW-n+7

® |If [Separated address for X and Y data] is selected, and set [X data] to LW-m, [Y data] to

LW-n:

Select [Dynamic limits] Not select [Dynamic limits]

X data Y data X data Y data
Low Limit LW-m+0 LW-n+0 Constant Constant
High Limit LW-m+1 LW-n+1 Constant Constant
1% data LW-m+2 LW-n+2 LW-m+0 LW-n+0
2" data LW-m+3 LW-n+3 LW-m+1 LW-n+1
3" data LW-m+4 LW-n+4 LW-m+2 LW-n+2
4™ data LW-m+5 LW-n+5 LW-m+3 LW-n+3

Example 2

When [Dynamic limits] is not selected, the Low and High limits can be set. The Low and High

limits are used for calculating X and Y range in percentage.

Read Address Value — Low Limit

Scale (%) =

High Limit — Low Lmit

If [Separated address for X and Y data] is not selected and the address is LW-n, the

corresponding limits are retrieved from the addresses as shown in the following table.

Data format 16-bit 32-bit
X axis low limit LW-n LW-n

X axis high limit LW-n+1 LW-n+2
Y axis low limit LW-n+2 LW-n+4
Y axis high limit LW-n+3 LW-n+6
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Example 3

If [Dynamic limits] is selected, a zoom effect can be created by changing the setting of Low /

High Limits.

In the following example, XL=X low limit, XH=X high limit, YL=Y low limit, YH=Y high limit, and

XY, XY1, XY2 are three XY data. When changing the high limits of X and Y axis, the result is
shown below:

| | £ | O S

LW100 control  LW101 display number

L 1]

Original
~
[0 Y50 Jo Yoo}
Y XY2 XY XY XY2
I I | ECEE 5N | SR B EN | ECE 5 | O P
LW100 control  LW101 display number LW100 control  LwW101 display number

L ] CH D

Change the high limit of Y axis to 25. Change the high limit of Y axis to

(zoom in) 100 (zoom out)

C?For more information, see “13.17 Trend Display”.

0 Note

[y

For cMT Series, on the screen of the visualization device directly pinch two fingers

together to zoom out or spread them apart to zoom in.

13-108

X and Y data can be set to different formats. For example: If X data uses 16-bit unsigned, Y

data uses 32-bit signed, please note the address setting.
When using a Tag PLC, such as AB tag PLC, X and Y must be in the same format. When

using different formats a warning will be shown.
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Objects
Display Area Tab
XY Plot Object’s Properties
- Display Area | Shape IProﬁIe
Profile color
|:| Transparent
Frame : — v |
Curve
Pen property
Color - m— | width:
Maker
@ Line ) Point () %-axis projection () Y-axis projection
Reference line
Limit from PLC
PLC name : [Loml HMI v] Setting...
Address :[LW - | 500 16-bit Unsigned
Reference line 1 20 I
[] Reference line 2 40 I
[¥] Reference line 3 ) | — vI
[¥] Reference line 4 20 [ vl
o] oo ]
Setting Description

Profile color

Select the color of the frame and the background, or select

[Transparent] check box to hide the frame and background.

Curve For each channel select the properties of color, width, and line
style.
Maker There are four different types of XY plot. The result is shown below:

Dot n

[\& WEINTEK
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A-Axis Projection

Y-Axis Projection

See Example 4.

Reference line

Up to 4 horizontal reference lines can be shown on the graph. Fill in

high, low limits and Y axis percentage values. Different colors can

be selected for each reference line.

If [Limit from PLC] is selected, designate a register to be the read

address of reference line.

Example 4

The curve shown in the following figure is drawn with 7 points numbered from PO to P6.
The steps the system draws the X-axis Projection are:

1. Calculates the two points in X-axis — (Xo, 0) and (X, 0).

2. Link all the points in the order of (Xg, 0), PO... P6, (Xs, 0) and returns to (Xo, 0) at last.

3. Fill out all enclosed areas.

e
[}
L]

0 Note

Enclosed region
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Enclosed region

B XY Plot can be drawn repeatedly up to 32 times:
1 channel=>»32 times
2 channels=»16 times

The way to calculate: 32 divided by the number of channels.
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13.21. Alarm Bar and Alarm Display

13.21.1. Overview

Alarm Bar and Alarm Display objects are used to display alarm messages which are defined in
Event (Alarm) Log objects. When the trigger conditions are met, events or alarms will be
displayed as they occur in chronological order in Alarm Bar or Alarm Display object.

Alarm Bar scrolls all alarm messages in one single display line, whereas Alarm Display shows

alarm messages in multiple lines.

Ii)3'_—‘For more information, see “7 Event Log”.

I {When LW T >= 10) 13:21:06 Event 0 (when LWO

Alarm Bar - Displays alarm messages in one scrolling line.

13112106 13:21:28 Event 2 (when LB10 = ON)
13112106 13:21:28 Event 3 (when LBff = ON)
13i12i06 13:21:38 Event 0 (when LWO == 100)
13112106 13:21:28 Event 1 (When LW 1 >= 10)

Alarm Display — Displays alarm messages in multiple lines.

13.21.2. Configuration

= 3

Click the Alarm Display or Alarm Bar icon on the toolbar to open the object property dialog box.

Set up the properties, press OK button, and a new object will be created.
General Tab

The difference between these two objects is that Alarm Display allows an [Acknowledge

address] and a [Scrolling control address] to be set.
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Mew Alarm Display Object @

General | Alwn | Secvrity | Shape | Font |

Comment :
Acknowled ge address
PLC name :[Local HMI v] Settings...
Address i[LW ~ |0 16-hit Unsigned
Enable acknowled ge function

Serolling control addres:

[¥] Enable
PLC name :[Local HMI v] Settings. ..
Address :’LW v] i} 16-bit Unsigned
[ Ok ] I Cancel
Setting Description
Enable If selected, the [Acknowledge value] selected for the associated
acknowledge event, specified in Alarm (Event) Log » Message tab will be written to
function the [Acknowledge address] designated in Alarm Display. For more

information, see “7 Event Log”.

Acknowledge value for Event/falarm Display object
Acknowledae value ;11

Scrolling If enabled, the value in the designated control address indicates the
control number of lines to be scrolled down. The minimal value is 0, which
address indicates the first line.

0 Note

B When using cMT-SVR, press and hold the event on the screen to acknowledge an event;

drag a finger on the screen to scroll.
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Objects
Alarm Tab
Alarm Bar Alarm Display
New Alarm Bar Object @ New Alarm Display Object @

Alarm iSecuxityléhape ]Font

| General | Alsrm | Security | Shepe | Font |

Include categories: 0

Color

[7]  Event trigger date
[¥]  Event trigger time
[¥]  Event message

thru 255

Scroll speed : [Speed 5 =

[7] Transparent [7] Transparent
Frame : —— v Background : v Frame :  — v Background : v
Grid
[¥] Enable Color : v
Format Format
Sort Sort
() Time ascending @ Time descending ) Time ascending @ Time descending
Order & Characters Order & Characters
Display itemns Display items Display chars

{see Event (4larm) Log object} Include categories: 0 thrn 255  {see Event {Alarm) Log object}

Color

» 7] | Eventtrigger date 1]

= ; - Event
\1} Event trigger time 1] B ; Eﬁe;;aneu;;azge
[V] Event message 20
7] Occurrence comt 1]
B [¥] Elapsed time 0 B

*If "Display chars" is 0, it means that the system will display all of characters.
* The colwmn width is equal to "Display chars” multiplied by the width of a %"

Date : [MM/DD/YY | Time: [HEMM:S ~ Date : [MM/DDAYY ~v| Time: [HEMM:S ~
==

Alarm Display object has extra settings compared to Alarm Bar object: [Occurrence count] and

[Elapsed time]. The table below introduces the settings shared between these two objects.

Setting Description

Include Events in the selected category will be displayed. The categories are

categories set in Event (Alarm) Log object.
For example, if the category is set to “2 to 4” here, only events in
categories 2, 3, 4 will be displayed. For more information, see “7
Event Log”.

Scroll speed This selection is only available for Alarm Bar. Select one of the
speed settings at which the messages scroll.

Format Time ascending

Latest alarm is placed last in the list (the bottom).

Time descending

Latest alarm is placed first in the list (the top).

Display order

Select the items to be displayed and use the up and down arrow
buttons to adjust the display order of the alarms.

Date

I__| WE!NTEK

EasyBuilder Pro V5.05.02



Objects

Displays the date tag with each alarm message. The four formats of
date tag:

MM/DD/YY ~ DD/MM/YY ~ DD/MM/YY ~ YY/MM/DD
Time

Displays the time tag with each alarm message. The four formats of
time tag:
HH:MM:SS » HH:MM ~ DD:HH:MM ~ HH

Security Tab
Alarm Bar Alarm Display
New Alarm Bar Object @ New Alarm Display Object @
[Alarm | Security [Shape | Font | [ General [ Alam | Secusity |Shape | Font |
Interlock
[] Use interlock function
[7] Hide when dissbled
© Enable when Bitis ON ) Enable when Bitis OFF
PLC : [Local HMI [ Settings...
User restriction | User restriction
Object class : | Class : Administrator v Objectelsss : [Class : Administrator >
Make invisible while protected [ Make invisible while protected
o JCaw |
Setting Description
Interlock When [Use interlock function] check box is selected,

whether the object is operable is determined by the

state of a designated Bit address. As shown in the above

settings, if LB-0 is ON, the object is operable.
Hide when disabled

When the designated Bit is OFF, the object will be

hidden.

User
restriction

Set the security class of the object to be operated by an

authorized user.
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Object class

“None” means any user can operate this object. Only
account “admin” can operate “Administrator” object
class.

Make invisible while protected

When the user's privilege does not match the object
class, the object will be hidden.

When this check box is deselected in Alarm Display
object settings, the unauthorized user can see the Alarm
Display object, but cannot trigger the object or make any
change.

This check box is greyed out in Alarm Bar object settings.

Font Tab

Set the font size or select [ltalic].

New Alarm Bar Object (==

Alarm |Shape Font

Attribute

Italic

The font, color, and content of the alarm messages displayed in Alarm Bar and Alarm Display

objects are set in Alarm (Event) Log object:

L—| WE!NTEK

Event (Alarm) Log @
General | Message
Text
Content : Event 1: press once to acnowledge -
[ usze label library Label Library...
Font: Arial -
Color : I | ~

EasyBuilder Pro V5.05.02
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13.22. Event Display

13.22.1. Overview

13-116

Event Display object is used to display event messages which are defined in Event (Alarm) Log

and have met a trigger condition. The triggered events are displayed in the chronological order.

Event Display object displays: the date and time the event occurs, the time the event is

acknowledged, the time the event returns to normal, the event message, the occurrence count,

and the elapsed time. Multi-lined messages can also be displayed.

812013106 2200345 Event 3 (when LB11 = ON) -
6 rsiiEme T zmemas T Event 1 (When LW § 5= 10)
5 12/13/06 22:03:12 Event 0 {when LW0 == 100)
4 12/113/06 22:02: 57 Evant 3 (when LB11 = ON) =
3 12/13106 22:02: 56 22:03:04 Event 2 (when LB10 = ON)
2 1211306 2202856 220258 Fvanf 1 iWhan LW 1 5= 10) ﬂ
i Q72710 f4:32:86 14:32:57 14:32:5% Eventi
IWos<2 |
____________________________________________________________________________ Muiti-text

13.22.2. Configuration

Click the Event Display icon on the toolbar to open an Event Display object property dialog box.

Set up the properties, press OK button, and a new Event Display object will be created.
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General Tab

13.22.2.1. eMT, iE, XE, mTV Series

Mew Event Display Object @

Creneral |Event Dizplay I Security | Shape | Font |

Comment :
Mote:
Real-time
Historr
Acknowled ge add e
PLC name :[Loal HMI v] Settings...
Address :[LW ,] 0 16-hit Unsigned
Control addyess
PLC name ilLoml HMI v] Settings. ..
Address : [LW -0 15-bit Unsigned
Enable event managerment

Serolling control addres:

[¥] Enable
PLC name i[LoaI HMI v] Settings. ..
Address :’LW v] i} 16-bit Unsigned
[ OK ] [ Cancel
Setting Description
Mode The available modes are: [Real-time] and [History].

® Real-time
All the events triggered since HMI starts up are displayed.

® History
The system reads the event log in HMI memory and displays
them. The content can be updated by changing window. In case
when the trend display shows history data from today, the

display will refresh once per second.

Acknowledge When in Real-time mode, and an event is acknowledged by touching

address an active display line, the [Acknowledge value] specified in Event
(Alarm) Log object, Message tab, is output to the [Acknowledge
address] of Event Display object. For more information, see “7 Event

n

Log”.

I__| WE'NTEK EasyBuilder Pro V5.05.02



13-118

Objects
Acknowledae value for Eventfalarm Display object
Admowledge value : 11
History When in History mode, and if:
Control ® [Enable reading multiple histories] is not selected

Daily event log files can be displayed. A history control address can
be designated. The value in the designated register is used as an
index to select historical files.

Index value 0 displays the latest file.

Index value 1 displays the second latest file.

Index value 2 displays the third latest file, and so on.

If control address to LW-100, and four data log exist with dates:

EL 20100720.evt, EL_20100723.evt, EL_20100727.evt, and
EL_20100803.evt.

Each index value in the control word corresponds to a record
according to the table below:

Value in LW-100 The corresponding record
0 EL_20100803.evt
1 EL_20100727.evt
2 EL_20100723.evt
3 EL_20100720.evt

® [Enable reading multiple histories] is selected

Displays a list of events triggered in multiple days. If [History control]
address is set to LW-n, the LW-n to LW-n+1 form a range of log
selection. Please note that the control address leads to different
results in “Number of days” mode and in “Index of the last history”
mode.

Number of days

Display range is determined by the value in control address. [LW-n]
marks the number of days from today as the start date of display,
and [LW-n+1] marks the number of days preceding the start date,
inclusive of the start date, as the end date.

Example: If today were 2010/6/10, and the value in LW-n is 1,
LW-n+1 is 3, then the data range will start from 1 day from today
(LW-n = 1), which is 20100609 (yesterday) in this case, and include
data for the preceding 3 days, inclusive of 20100609. As a result, the
data displayed should be 20100607~20100609. Since 20100607 does
not exist in this example, the data displayed will be from 20100609
and 20100608.

[EIEL_20100604 No.4 IKE EVT
[=EEL 20100605 No.3 6KB EVI
FE1EL_20100608 No.2 1TKB EVI
[EIEL_20100609 4KE EVT
F=TEL_20100610 No.0 12KB EVI

Index of the last history
The value in control address [LW-n] marks the index value of the
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record to start, and the value in [LW-n+1] marks the index value of
the record to end. If LW-n = 1, and LW-n+1 = 3, the data displayed
will include data No.1, No.2, No.3.

[ EL_20100604 No.4 1KB EVT
No.3 6KE EVT

No.2 17KE EVT

[EIEL_20100609 No.1 4KE EVI
[EIEL_20100610 No.0 12KB EVT

Please note that the value in [LW-n+1] must be greater than the
value in [LW-n], to form a valid range.

The maximum size of data that can be displayed is 4MB; the
exceeding part will be ignored.

The following shows how data will be stored when the data size is
too big.

5 history data, each 0.5MB - Data displayed: 8 x 0.5MB

5 history data, each 1MB -> Data displayed: 4 x 1IMB

5 history data, each 1.5MB - Data displayed:

2 x 1.5MB+1 x 1MB (partial)

Control Enable event management

address If this check box is selected, writing a specific value into register
LW-n and LW-n+1, where n is an arbitrary number, will control [Event
Display] object with different commands as shown below:

Address | Value | Command
LW-n 0 Display all events.
1 Hide [Confirmed] events.
2 Hide [Recovered] events.
3 Hide [Confirmed] or [Recovered] events.
4 Hide [Confirmed] and [Recovered] events.
IW-n+1 |1 Delete a single selected event.
Scrolling If enabled, the value in the designated control address indicates the
control number of lines to be scrolled down. The minimal value is 0, which
address indicates the first line.

In the following figure, there are 10 events recorded in the object,
and value 3 is set at the control address. The upper event object
displays the events in time ascending order, and begins at the 4t
event; on the other hand, the lower one displays the events in time
descending order, and begins at the 7" event.

4 18:48:19 Test Event
5 18:48:19 Test Event
event LBO 6 18:48:20  TestEvent
7 18:48:20 Test Event
8 18:48:20 Test Event
Scrolling
Control
7 18:48:20 Test Event
6 18:48:20 Test Event
5 18:48:19 Test Event
4 18:48:19 Test Event
3 18:48:19 Test Event
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If [Scrolling control address] is enabled, the scroll bar cannot be used
for scrolling, but still shows the relative position of the content. If the
control address holds a value that is larger than the total number of

lines, the display will stroll to the end.

13.22.2.2. cMT-SVR Series

Event Display Object's Properties =3

General |E\rent Display I Shape I Font | Proﬁlel

Comment :

Acknowledge address

PLC name : [Loml HMI v] Setting...
Address :[Lw v] 0 16-hit Unsigned

For cMT-SVR, all the events occur are displayed and updated in real-time.
Press the filter icon in the upper-right corner of the object and set the start and end date. If the

dates are not set, all the events are displayed.
< July 2013 >

2 11:55:04 Event 2 9 |10 |11 |12 |13 | 14
1 11:55:04 Event 0 m Q ||15|16 |17 |18 (19 |20 | 21
starts 22 123 |24 |25 |26 |27 | 28
06/07/2013 4
29 |30 (31 |1 |2 |3 |4
ends
08/07/2013 ’ 5 6|7 8|9 |1011
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cMT Series eMT, iE, XE, mTV Series
New Event Display Object @ New Event Display Object @
| General | Event Display | Secwity | Shepe | Font | | Generel | Event Display | Secwity | Shape | Font | Empty Wamning|
Include categories : 0 thrn 255  {see Event (Alarm) Log object} | Include categories: 0 thru 255  {see Event (Alanm) Log object}
Acknowled ge style :
Max. eventno. : 200
Color Color
[7] Transparent [7] Transparent
Frame : [ v Background : v Frame : [ v Background : v
Selectbox: N | v
Acknowled ge Acknowled ge
Text: v Background : v Text: v Background : v
Retum to normal Retum to nommal
Text: I v Background : v Text: I v Background : v
Grid Grid
[¥] Enable Color : v [¥] Enable Color : v
Format Format
Sort Sort
) Time ascending © Time descending Time ascending
Order & Characters Order & Characters
Display items Display items Display chars
7] Sequence no. [T Sequence no.
[7] Event trigger date [7]  Event trigger date 1]
[¥] Event trigger time [¥] Event trigger time 1]
7] Acknowledge time [T Acknowledge time 1]
7] Retum to normal time [7] Retorn to normal time 0
[¥] Eventmessage [¥] Eventmessage 20
[7] Occurrence count 1]
[7] Elapsed time 1]
*If "Display chars" is 0, it means that the system will display all of characters. *If "Display chars" is 0, it means that the system will display all of chavacters.
* The column width is equal to "Display chars” multiplied by the width of a %' * The column width is equal to "Display chars” multiplied by the width of a %'
Date : [MMDDAYYY  »| Time: [HEMM:SS - Date : MMDDAYY | Time: [HEMM:S -
Setting Description
Include Events in the selected category will be displayed. The categories are
categories set in Event (Alarm) Log Object.
For example, if the category is set to 2 to 4 here, only events in
categories 2, 3, 4 will be displayed. For more information, see “7
Event Log”.
Acknowledge Select [Click] or [Double Click] to acknowledge each single event.
style When an event occurs the user can tap the event line once or twice
to acknowledge the new event.
When acknowledged, the text color of the event will change to the
selected color, and the acknowledge value associated with that
event will be sent to the register designated in [Acknowledge
address]. If the address is set to LW-100, and the acknowledge
value is set to 31, when user acknowledges the event, value 31 is
written to LW-100.
This can be used in conjunction with Indirect Window object so
that when an event is acknowledged, the corresponding message
window is displayed.
Max. event The maximum number of events to be displayed in this Event
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no.

Display object. When the number of the displayed events equals to
the set maximum number, the new coming event will overwrite the
latest event.

Color

Different colors indicate different event states, such as
acknowledged, returns to normal, or selected. The system draws a

highlight box around the latest selected event.
Acknowledge

6 13:12:19
5 1312:18

Event 1 (When LW 1 >= 10)
Event 2 (when LB10 = ON)

3 1312:15 Event 2 (when LB10 = ON)
2 1312:14 Event 1 (When LW 1 >= 10)
1. 1x12:14 Event 0 (when LWO0 == 100}

Sequence no. Return to normal Select box

History background (eMT, iE, XE, mTV)

When using Event Display object and select History mode, the
background color of the history record can be customized.

New Event Display Object (==

[Gemm}‘ Event Display | Secwity | Shape | Font | Empty Waming|
Include categories: 0 thro 255  {see Event (Alarm) Log object}

Color

o >

Grid

Displays a grid of rows and columns in the object. The color of the
grid lines can be selected.

Format

trigger date  trigger time notification time return to normal time

0 12/114/06 15:26:21 15:26:31 15:26:36 Event 0 (when LV

2 12114106 15:26:48 Event 2 (when LE

Time ascending

Latest event is placed last in the list (the bottom).
Time descending

Latest event is placed first in the list (the top).
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Order & Characters
Select the items to be displayed and use the up and down arrow
buttons to adjust the display order of the events.
Date
Displays the date tag with each event message. The four formats of
date tag:
MM/DD/YY ~ DD/MM/YY ~ DD/MM/YY ~ YY/MM/DD
Time
Displays the time tag with each event message. The four formats of
time tag:
HH:MM:SS ~ HH:MM ~ DD:HH:MM ~ HH
Security Tab
New Event Display Object @
1G@]E\Fmbwpl;y} Security | Shape [ Font lEmpty Warning |
Interlock

[¥] Use interlock function

[V] Hide when disabled

© Enable when Bit is ON _) Enable when Bit is OFF

PLC : (Local HMI v [ Settings...
User restriction
Object class : [C]as:-‘\-‘- inistrator v
[T Make invisible while protected
[ OK Jil Cancel Help
Setting Description
Interlock

When [Use interlock function] check box is selected,
whether the object is operable is determined by the
state of a designated Bit address. As shown in the above
settings, if LB-0 is ON, the object is operable.

Hide when disabled

When the designated Bit is OFF, the object will be
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hidden.

User Set the security class of the object to be operated by an
restriction

authorized user.

Object class

“None” means any user can operate this object. Only
account “admin” can operate “Administrator” object
class.

Make invisible while protected

When the user's privilege does not match the object
class, the object will be hidden.

When this check box is deselected, the unauthorized
user can see the Event Display object, but cannot trigger
the object or make any change.

Font Tab

In Real-time mode: Users may select Italic font and set the font size. The font is displayed
according to the setting in Event Log object.
In History mode: Users may select Italic font and set the font size, font and color, or tick the

[Font from label library] check box.

Attribute
Font : | Arial] v

Color : EG— Size : |16 v

[ Font from label library
[ tadic

Empty Warning

New Event Display Object
| Genersl | Event Display | Secusity [ Shape | Font | Empty Waming |

[V] Use empty waming
No alarm occurred.

Use label libraxy

Font : [Aﬁ,al v]

Color : |G :| Size : |12 v

[ Italic

When [Use empty warning] is enabled, the text displayed when no event has occurred can be

specified.
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13.23. Data Transfer (Trigger-based)

13.23.1. Overview

Data Transfer (Trigger-based) object can transfer values from the source register to the

destination register. The data transfer operation can be activated by changing the state of the

designated bit register, or by manually pressing the object.

For cMT Series, only touch trigger mode is available.

13.23.2. Configuration

I=

Click the Data Transfer (Trigger-based) icon on the toolbar to open the property dialog box. Set

up the properties, press OK button, and a new Data Transfer (Trigger-based) object will be

created.

General Tab

eMT, iE, XE, mTV Series

cMT Series
MNew Data Transfer (Trigger-based) Object 3
General | Security I Shape I Label
Comment :
Source address
PLC name :[MODBUS RTU v] Setting...
Destination address
PLC name : Local HMI ][ Setting...
Attribute
Mo. of word : 1

New Data Transfer (Trigger-based) Object @
| General | Secusity [ Shape | Label |
Comment :
Source address
PLC : [MODBUS RTU v [ Settings...
Destination address ‘
PLC : [Local HMI ~ [ Seftings..
Address: [Lw v |0 [
|
Attribute |
No.of word : 1
Mode : Trigger mode : | ON->0OFF v
Trigger address [
PLC : [Local HMI ~ [ Settings..
Notification
(¥ Enable ) SetON © Set OFF
[¥] Follow (set ON when data transfer starts)
PLC : [Local HMI ~ [ Settings..
o ) (o ]
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Setting Description
Source
Data Transfer object reads the data from [Source Address].
address
Destination
Data Transfer object writes the data to [Destination Address].
address
Attribute No. of words
The number of words to be transferred from [Source Address] to
[Destination Address]. The unit is word.
Mode
Touch trigger
Press the object to activate data transfer operation.
External trigger
The data transfer operation is activated when the state of the
designated bit address changes.
There is a further selection to make of whether the data transfer
operation is activated after Off to ON, ON to OFF transition, or at
both of the changes of state.
Trigger
Specify a bit address for [External trigger] mode.
address
Notification When enabled, the system will set the designated address ON or
OFF when it’s ready for data transfer.
Follow

The notification bit will reset to its original state once the system

starts data transfer.

0 Note

B When using Data Transfer Trigger Based object, place the control bit addresses in the
same window in order to trigger Data Transfer. If the Data Transfer Trigger Based object is
placed in the common window, when the state of the control bit addresses placed in any

window changes, Data Transfer is triggered.
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13.24. Backup

13.24.1. Overview

Backup object can transmit recipe data (RW, RW_A), event log, recipe database, sampling data,
and operation log to an external device (SD card, USB disk), in a specified time range or format.
For example, when the event log is saved in a SD card, a USB disk can be inserted when HMI
power is still ON, and use Backup object to copy the data into USB disk from SD card, and then
remove USB disk without turning off HMI power. The data saved in USB disk can be used on PC
for analyzing. When the system is backing up, the state of system register [LB-9039] is set ON.

With [e-Mail] option, information can be sent to configured email contacts.

13.24.2. Configuration

B

For eMT, iE, XE, mTV Series, click Backup icon on the toolbar to open a [Backup] object

property dialog box. Set up the properties, press OK button, and a new Backup object will be
created.

For cMT Series, click Backup icon on the toolbar to open a [Backup] object managing dialog box,
click [New] to open a [Backup] object property dialog box. Set up the properties, press OK

button, and a new Backup object will be created.
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General Tab

cMT Series eMT, iE, XE, mTV Series
Mew Backup Object [=]
General |Security | Shape | Label
Comment :
Source
I RW CIRW_A Redpe database
(@) Historical event log Histarical data sampling
Backup | =3 |
— Operation log
General
Comment
Backup position
SDL_IFCE . (@) 50 card () USB disk e-Mail
@ RwW CIRW_A Recipe database
Remote printer backup server
Historical event log Historical data sampling
Mote : Use LW-9032~3039 to change the backup folder name.
Mote : Use [Remote printerbackup server] to store data to a remote PC. Enable the
server in [System Parameter] [Printer/Backup Server] settings.
Backup position
50 card @ UsB disk eMail Save format
Format : [eMT30[]D SERIES Event Log File (*.evt) -
Mote : Use LW-9032~3039 to change the backup folder name.
Mote : Use [Remote printerbadkup server] to store data to a remote PC. Enable the R
server in [System Parameter] [Printer Backup Server] settings. ange i i
Start: @ Today () Yesterday
Within @ All (max. 90 days) -
Trigger
Mode : | Touch trigger -
Trigger address
PLC name 5[Lcca| HMI v] [ Setting... ]
*B-9039 indicates the status of file backup activity (backup in process if status is ON)
Setting Description
Source [RW], [RW_A], [Recipe database], [Historical event log],

[Historical data sampling], [Operation log]
Select one from the above for the source. When backing up
[Historical data log], use [Data Sampling object index] to select the

one to back up.

Backup Select the destination where the source files will be saved to.
position SD card / USB disk
The external device connected to HMI.
If using cMT series, SD card and USB disk can only save [RW],
[RW_A], and [Recipe database].
Remote printer/backup server (eMT, iE, XE, mTV Series)
To select this, enable MT remote printer/backup server at: [Menu]
» [Edit] » [System Parameters] » [Printer/Backup Server].
Please note that [Operation log] backup can only be saved to

Remote printer/backup server. To save into a SD card or USB drive,
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please use the control address of Operation Log object.

&

E-mail

For more information, see “26 EasyPrinter”.

To use e-mail, go to [System Parameters] » [e-Mail] tab to configure
first. And then go to Backup object » [e-Mail] tab to configure the
recipient address, subject, and message.

Save format

Select the desired format to back up the file.

eMT, iE, XE, mTV Series:

® HMI Event Log File (.evt) / HMI Data Log File (.dtl)

® Comma Separated Values (.csv)

When back up event log in .csv format, open the csv file in EXCEL.
The BOM (Byte Order Mark) can be added to the file header so that
the .csv file containg non-ASCII strings can directly be opened in
EXCEL. The title, export time, occurrence count, and elapsed time
can be included or omitted in the backed-up .csv file.

Storage format
Format : [Comma Separated Values (*.csv) v
il ﬁgg%?gdm(?tﬁe Order Mark) to file header for EXCEL can interpreting non-ASCII
(V] Include title [V Include export time
(V] Include occurrence count (V] Include elapsed time

The [Event] column is included in the backup file to indicate the

type of the event.

A B | ¢ [ b | E |
Event |Category Date Time | Message
2013/7/4) 16:12:11 Event A
2013/7/4) 16:12:12 Event A
2013/7/4) 16:12:33 Event B
2013/7/4) 16:12:36 Event B
2013/7/4| 16:12:37 Event B
2013/7/4) 16:12:37 Event B
2013/7/4) 16:12:39 Event B
2013/7/4] 16:12:40 Event B

[=J0 SR R = ]
oo oo oo s

0 = Event is triggered

1 = Event is acknowledged

2 = Event returns to normal

EasyConverter can be used to easily convert HMI Event Log File
(.evt) and HMI Data Log File (.dtl) to .xls or .csv format.

® SQLlite Database File (.db)

cMT Series:

® SQLite Database File (.db) (Only for backup to e-mail)

® Comma Separated Values (.csv)

Range

Historical data sampling

Select a number of files. For example, if [Start] is set to [Current],
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and [Within] is set to [5 file(s)], the latest five files in memory will
be backed up.

Historical eventlog
Select a number of days. For example, if [Start] is set to [Yesterday],
and [Within] is set to [2 day(s)], the files obtained yesterday and
the day before yesterday will be backed up. Select [All] to save all
files, and the maximum is 90 days.
Trigger Mode
(eMT, iE, XE, There are three ways to activate Backup function.
mTV Series) Touch trigger
Touch the Backup object to activate backup operation.
External trigger (bit)
Register a bit device to trigger the backup operation.
Select whether the backup operation is activated after Off to ON,
ON to OFF transition, or at both of the changes of state.
External trigger (word)
Users can specify the number of days to backup data using [Trigger
address]. [Trigger address] usage (suppose LW-n is used):
LW-n: Will start to back up when the value changes from 0 to 1.
LW-n+1: The start date of backup.
LW-n+2: The number of days for backup. (The maximum: 90 days).
Syntax [&=]
LW :o
Set 1 to trigger backup activity
LW:0+1
Define backup start day
0 : today
1 : yesterday
2 : the day before yesterday
n :and so on
LW:0+2
Define backup range
Unit : day, max. value : 90
—
Trigger When the state of the designated register is set ON, the backup
address operation is activated. When the backup operation is done, the
(cMT Series) state of the designated register is set OFF.

@ Note

B All history files should have been saved in memory, either HMI memory, USB disk or SD
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card. Otherwise, the Backup object will not work.

B The maximum number of days for backup is 90 days. (Not including cMT Series)

Ii)3'_—‘For cMT Series, see “7 Event Log” and “8 Data Sampling” that explain the mechanism of

synchronizing data to external device.

Advance Tab

Backup Object's Properties @
| Geners | Advence [Seouity | Shae | Label | Profie |
Serial number (range : 00000 ~ 65535)
(V] Enable

Source

PLC name : [Local HMI v ] Settings...

Address : lLW v|0

* For example, when serial number is 123 :
A data sampling file - 20140407 dtl will be backed up to 2014040700123 41l
An event log file - 20140407 evt will be backed vp to 2014040700123 evt.

Options
[¥] Remove old files after backup

Setting Description

Serial number If enabled, when backing up history files, a user-defined, 5-digit
serial number can be appended to the end of the file name of the
history data backup.

The serial number is determined by the value in the designated
source address. After backup, the value of this LW address will
automatically increment by 1.

The range of the serial number is 065535

For example, if the serial number is 123, the appended 5 digits will
be 00123.

A data sampling file -20140407.dtl will be backed up as
2014040700123.dtl.

An event log file -20140407.evt will be backed up as
2014040700123.evt.

Options Remove old files after backup
If selected, the old history files will be removed after backup.

@Note

B cMT Series does not support Advance settings.
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e-Mail Tab
Backup Object's Properties @
[ General | Advance | Security | Shepe | Label | Profile | e-Mail |
[V] 4dd txt extension to the filename to skip the anti-virus detection
Recipients
Subject
Subject : -
Use label library
Message
Opening : -
Use label library
Ending : 7
Use label library
Label Library.. | [Language | -
[ OK J [ Cancel Help
Setting Description
Add .txt
extension to If selected, when sending backup data as an email attachment, the
the filename filename extension .txt will be added to the file name. This
to skip the prevents the mail server or anti-virus software from blocking
anti-virus emails.
detection

Recipients,
Back up the email address of the recipients, the subject of the

Subject, .
email, and the message content.

Message
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13.25. Media Player

13.25.1. Overview

13-133

At the first time using Media Player object in the project, download the project to HMI via
Ethernet. EasyBuilder Pro installs Media Player driver automatically.
Media Player object plays video files with controls such as seek, zoom, and volume adjustment

to provide maintenance instructions or procedures on video so as to enable on-site operators

to perform tasks efficiently.

13.25.2. Configuration

=

Click the Media Player icon on the toolbar to open a Media Player object property dialog box.
Set up the properties, press OK button, and a new Media Player object will be created.

General Tab

Mew Media Player Object [=
General | preview
Comment :
Control address
Enable
PLC name : Local HMI ~ ][ Setting...
] T
Command : (LW : 0 Status ¢ |[LW:0 +3
Parameter 1:|LW:0+1 File index : [LW :0 +4
Parameter 2: (LW :0 +2 Start time : LW :0 +5
End time : |[LW:0 +6
Update video playing time
Update period : Playing time : [LW :0 +7
Ext. device
() 5D card @ USE disk Folder name @ video
Attribute

|:| Auto. repeat

* 05 version 2012, 11,12 or later support media player only |

Background : NG  ~

[ oK H Cancel ]

Setting Description
Control ® Selected
address Designate a word register to control the object operations.
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® Not selected

No manual control. Video will be played automatically when the
designated window opens.

Command (control address + 0)

Enter a value in the Command register to designate which action is
executed.

Parameter 1 (control address + 1)

Enter a value in Parameter 1 associated with each command action.
Parameter 2 (control address + 2)

Enter a value in Parameter 2 associated with each command action.
Status (control address + 3)

Indicates the status or errors.

File index (control address + 4)

The file number in the designated folder. It is recommended to file
the video name with a number.

Start time (control address + 5)

The start time of the video (second). 0, normally.

End time (control address + 6)

The end time of the video (second). (The time length of the video)
Update video playing time

If enabled, the elapsed playing time of video will be written into
[Playing time] register at a rate set by [Update period] in seconds.
Update period

Update period of [Playing time], range from 1 to 60 (second).
Playing time (control address + 7)

The elapsed playing time of video (Second). Normally between
start time and end time.

Ext. device

Play video files in SD card / USB disk.

Folder name

The folder name of video files stored in SD card or USB disk. Files
must be stored in root directory. Subdirectories won’t be accepted.
(For example, “example\ex” is an invalid directory.)

[Folder name] cannot be empty, must be alpha-numeric, and all in
ASCII character.

Attribute

Auto. repeat

When finish playing all the video files, replay from the first file.
Ex: Video 1 > Video 2 > Video 1 > Video 2

Background

The background color of the object.

0 Note

B The data format for control address is 16-bit Unsigned or 16-bit Signed. If using 32-bit
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Unsigned or 32-bit Signed, only the previous 16 bits will be effective.

Control command

The following are the settings of different commands.
® Playindex file

[Command] =1

[Parameter 1] = file index

[Parameter 2] = ignore (set 0)

0 Note

B Files are stored with file names in ascending order.
B If the file cannot be found, [Status] bit 8 is set ON.
B Please stop the playing video before switching to another.

® Play previous file
[Command] =2
[Parameter 1] = ignore (set 0)

[Parameter 2] = ignore (set 0)

0 Note

B If [File index] is zero, the same file is replayed.
B If the file cannot be found, [Status] bit 8 is set ON.

® Play next file
[Command] =3
[Parameter 1] = ignore (set 0)
[Parameter 2] = ignore (set 0)

B |f there are no more files, the index O file is played.
B If the file cannot be found, [Status] bit 8 is set ON.

® Pause / Play Switch
[Command] =4
[Parameter 1] = ignore (set 0)

[Parameter 2] = ignore (set 0)

® Stop playing and close file
[Command] =5
[Parameter 1] = ignore (set 0)

[Parameter 2] = ignore (set 0)
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® Start playing from the designated time
[Command] =6
[Parameter 1] = target time (second)
[Parameter 2] = ignore (set 0)

0 Note

B Parameter 1 (target time) must be less than the ending of time or it plays the last second.
® Forward

[Command] =7

[Parameter 1] = target time (second)

[Parameter 2] = ignore (set 0)

@ Note

B Going forward to the designated second in [Parameter 1]. If the video is paused, the
forwarding action will be started by playing.

B When the designed time is later than the end time, it plays the last second.

® Backward
[Command] =8
[Parameter 1] = target time (second)
[Parameter 2] = ignore (set 0)

0 Note

B Going Backward to the designated second in [Parameter 1], if the video is paused, the

backward action will be started by playing.

B When the designed time is earlier than the beginning time, it plays from beginning.

® Adjust volume
[Command] =9
[Parameter 1] = volume (0 ~ 128)

[Parameter 2] = ignore (set 0)
ﬁNote

B Default volume is 128.
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® Setvideo display size
[Command] = 10
[Parameter 1] = display size (0 ~ 16)

[Parameter 2] = ignore (set 0)

0 Note

B [Parameter 1 =0] : Fit video image to object size.
B [Parameter 1 =1~ 16]:Magnification from 25% ~ 400% in 25% increments where 1 = 25%,
2=50%, 3 =75% and so on.

® Status (control address + 3)

When playing a video the system sets [File Open (bit00)] and [File Playing (bit01)] to ON. If the
file cannot be found, or an invalid command is entered, the Command Error bit 08 is set ON. If
the file format is not supported, or a disk I/O error occurs, during playback (for example, USB
disk unplugged), the File Error bit 09 is set ON.

15 09 08 02 01 00 i
|Reserved(a|lO) ]0[0] |0 0]

00: File Opened / Closed (0 = closed, 1 = opened)

01: File Playing (0 = not playing, 1 = playing)
08: Command Error (0 = accepted, 1 = incorrect)
09: File Error (0 = accepted, 1 = incorrect)

0 Note

B The figure shows the status value associated with each state:
Stop =0, Pause = 1, Playing = 3

Playing

play command

(1,2,3) stop command toggle pause command
() (4)
Finish playing
Stop < Pause
stop command (5)

B [Command], [Parameter 1], and [Parameter 2] are write addresses. All others are read
only.
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Preview Tab

Users can test whether the video format is supported by using the preview function.

New Media Player Object Lx

General | Preview

Play I I Stop I I ==

Setting Description

Forward << /

Go forward or backward of the video. (in minutes)
Backward >>

Play / Pause Select to start playing video or pausing.

Stop Stop playing and close the video file. To test another video, please

stop playing the current video first.

Load Select a video to preview.

0 Note

B Only one video file can be played at one time.

B If [control address] is not enabled and [Auto. repeat] is not selected, after finish playing
the first file, the system will stop playing and close the video file.

B If [control address] is not enabled, the system will find the first file in the designated
folder and start to play (in ascending order of the file name).

B |f the file can be previewed, the format is supported. If the video image quality is poor,
please adjust the resolution.

B The supported formats: mpeg4, xvid, flv...etc.

&..u Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.26. Data Transfer

13.26.1. Overview

Data Transfer object has similar function compared to Trigger-based Data Transfer object. They
transfer the data from source to destination register. The difference is that Data Transfer object
transfers data based on time schedule, and is able to transfer data in bits.

When using cMT Series, Data Transfer object is divided into two modes: [Time-based] and [Bit
trigger]. In these two modes, the system automatically detects the state of the designated bit
register and executes data transfer. [Time-based] mode is the same as described earlier, where
[Bit trigger] mode transfers data when the state of the designated bit register changes. For the

detail of [Bit trigger] mode, see “13.26.2.2 Data Transfer Bit Trigger”.

13.26.2. Configuration

Click Data Transfer icon on the toolbar to open the Data Transfer management
dialog box. Click [New] and configure the properties. All the defined Data Transfer

can be viewed from the dialog box as shown in the following figure.
eMT, iE, XE, mTV Series

Data Transfer

Time-based

0: MODBUS RTU : 0x-1] -> [Local HMI : LB-0], Mode : Bit, Time interval=3.0 second(s), transfer length=1 bit(s

MODBUS RTU : 3%-1] -> [Local HMI : LW-0], Mode : Word, Time interval=3.0 second(s), transfer length=1 word(s

Hew... Delete Settings... Exit
I ) | J | [ e |

cMT Series

Data Transfer

Time-based | Bit trigger

0: MODBUS RTU : 0x-1] -> [Local HMI : LB-0], Mode : Bit, Time interval=3.0 second(s), transfer length=1 bit(s

MODBUS RTU : 3%-1] -> [Local HMI : LW-0], Mode : Word, Time interval=3.0 second(s), transfer length=1 word(s

Hew... ] [ Delete ] l Settings...
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13.26.2.1. Data Transfer Time-based

General Tab

Click the [New] button in the Data Transfer management dialog box.

Data Transfer (Time-based)

General ‘

Comment :

Attribute

Addresstype : | Wond - Interval : 3.0 second(s) -

No.of word : 1

[7] Active only when designated window opened

Source address

13-140

PLC : [MODBUS RTU ~ |[Seftings...
Address : [4)(—'] 1
Destination address
PLC: [Lom HMI ~ |[ Seftings...
Address : [LW v |0
Notification
[V] Enable Set ON © Set OFF
[ Follow {set ON when data transfer starts)
PLC: [LocalHMI v] Settings...
Address: (LB +|0
[ OK ] [ Cancel ] | Help
Setting Description
Attribute Address type

Select the data type, either [Bit] or [Word].
No. of bits /No. of words

When [Bit] is selected in [Address type], set the number of bits
transferred each time when data transfer is triggered.
When [Word] is selected in [Address type], set the number of

words transferred each time when data transfer is triggered.

Interval

Select the time interval of data transfer, for example, when 3
seconds is set, the system will transfer data every 3 seconds.
Specifying a short time interval or a big number of data to transfer
may cause an overall performance of system decrease. Therefore, it

is recommended that users choose a longer time interval and a

smaller amount of data to transfer.

When a short interval is inevitable, be aware of the interval must
be longer than the data transfer operation. For example, if the data

transfer operation takes 2 seconds, set the interval longer than 2

seconds.
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Objects
Source .
Data Transfer object reads the data from [Source Address].
address
Destination ) ) o
Data Transfer object writes the data to [Destination Address].
address

Notification

When enabled, the system will set the designated address ON or
OFF when it’s ready for data transfer.

Follow

The notification bit will reset to its original state once the system

starts data transfer.

13.26.2.2.

General Tab

Data Transfer Bit Trigger

Click the [New] button in the Data Transfer management dialog box, and open [Bit trigger] tab.

[ New Data Transfer (Trigger-based) Object
General | Security | Shape | Label |
Comment :
Source address
PLC : [MODBUS RTU - [ Settings...
Address : [4x v 1 7
Destination address
PLC: Local HMI v |[ Setings...
Address [LW v|0 o
Attribute
No.of word : 1
Trigger address
PLC : [Lacal HMI - [ Settings..
Address : [LB v|0
Notification
[7] Enable ©) SetON © Set OFF
["] Follow {set ON when data transfer starts)
PLC: [LocalHMI v] Settings...
Address : [LB v] 0 -
[ o ][ conce
Setting Description
Source .
dd Data Transfer object reads the data from [Source Address].
aadress

[\& WEINTEK
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Destination
Data Transfer object writes the data to [Destination Address].
address
No. of word Set the number of words transferred each time when data transfer
is triggered.
Trigger Set the register that controls data transfer and select the trigger
address mode.
Trigger mode
Trigger data transfer when the state of the designated register
changes from Off to ON, ON to OFF, or at both of the changes of
state.
Notification When enabled, the system will set the designated address ON or
OFF when it’s ready for data transfer.
Follow

The notification bit will reset to its original state once the system
starts data transfer.
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13.27. PLC Control

13.27.1. Overview

PLC Control object can execute commands when it is triggered.

13.27.2. Configuration

Click the PLC Control icon on the toolbar to open the PLC Control Object management dialog
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box. To add a PLC Control object, click [New], set up the properties, press OK button and a new

PLC Control object will be created.

PLC Control Object

1 [Local HMI : LB-8999] == Sound control : OFF->=0N, PLC no response (67 k)
2 [Local HMI @ LW-100] == Change window (clear data after window changed)
3 [Local HMI : LW-110] == Write data to PLC (current base window ID)

4: [Local HMI: LW-120] == General PLC control

5: [Local HMI: LW-120] => Change window (clear data after window changed
5 g

-]

Delete ] ’

Settings... ]

Click [New] and the following dialog box appears. See “13.27.2.1 Type of Control”.

@ Note

B The [PLC Control] and [Backlight Control] options are not available for cMT Series.

[\& WEINTEK

PLC Control

Comment :

PLC name : [Loal HMI

Attribute

Type of control : | Change window
Change window
[¥] active only w Write data to PLC (current base windaw ID)
General PLC control
[T urn on back Back light control {write back)
. Back light control
[Tl use windew r ooy contral
Execute macro program
Trigger address  Screen hardcopy

PLC name :  Local HMI
[ oK J [ Cancel ]
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13.27.2.1.

Type of Control

® Change window
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PLC Control

Comment :

PLC name : [Local HMI

Attribute

Type of control : [Change window

Active only when designated window opened

4. Common Window v]

[ Turn on badk light

[ Use window no. offset

Trigger address

Clear data after window changed

Address : | Lw v] [i} 16-bit Unsigned
[ OK. ] [ Cancel ]
Setting Description

Active only when
designated

window opened

Allow this operation only if a particular screen is displayed.

Turn on back light

The backlight is turned ON when the window object is
changed. (Not available for cMT Series)

Clear data after

window changed

Reset the value at trigger address to zero when the window
object is changed. If [Use window no. offset] is selected, this

option will only show when a negative offset is used.

Use window no.
offset

Select the check box and select a window offset, the new
window no. to change to will be the value in [Trigger address]
plus the offset. For example, if [Trigger address] is LW-0 and
offset is set to -10. When the value in LW-0 is 25, the system
will change to window no. 15 (25-10=15). The range of the
offset is -1024 to 1024.

0 Note

B If [LB-9017] is set ON, the write-back function will be disabled, the new window number is

not written back into a designated address.

Place a valid window number in the designated trigger address to change the base screen to

the new window number. The new window number is written back into the designated

address.

For example, if current window is window no. 10, and [Trigger address] is set to LW-0,

When LW-0 is changed to 11, the system will change the current window to window no. 11,
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and then write 11 to LW-1.
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When the window is changed, the new window number is written back into the address that is

calculated by [Trigger address] and the data format, as shown in following table.

Data Format Trigger address Write address
16-bit BCD Address Address + 1
32-bit BCD Address Address + 2
16-bit Unsigned Address Address + 1
16-bit Signed Address Address + 1
32-bit Unsigned Address Address + 2
32-bit Signed Address Address + 2

® Write data to PLC (current base window)

Each time the base window is changed, the new window number will be written into the

[Trigger address]. If [Use window no. offset] is selected, the window number of the base

window plus the window number offset will be written into the [Trigger address].
® General PLC Control (eMT, iE, XE, mTV)
Transfer word data blocks from PLC to HMI, and vise-versa, and the transfer direction is

controlled by the value in the [Trigger address].

Value in Action

[Trigger address]

1 Transfer data from PLC register 2 HMI RW register
2 Transfer data from PLC register > HMI LW register
3 Transfer data from HMI RW register - PLC register
4 Transfer data from HMI LW register - PLC register

Four consecutive word registers are used as described in the following table:

Address Purpose Description

[Trigger Determine the The valid values are listed in the

address] direction of data above table. When a new control

transfer code is written into the register,

HMI will start to transfer. After data
transfer is finished, the value will
be set to 0.

[Trigger The size of data The unit is word.

address] +1

to transfer.

[Trigger
address] +2

Offset to the

start address of

o_n

Assume the value is “n”, where n is

an arbitrary number, the start
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PLC register address of PLC register is [Trigger
address + 4 + n].
Take an OMRON PLC as an
example:
If [Trigger address] uses DM-100,
[Trigger address + 2] will be
DM-102. If the value in DM-102 is
5, the start address of data source
would be DM-109 (100 +4 +5 =

109).
[Trigger Offset to the Take OMRON PLC as an example:
address] +3 start address of If set [Trigger address] to DM-100,
LW or RW [Trigger address + 3] will be
memory in HMI DM-103. If the value in DM-103 is

100, the start address of memory
in HMI is RW-100 or LW-100.

Example 1

To use PLC Control object to transfer 16 words data in OMRON PLC, starting from address

DM-100, to the HMI address, starting from RW-200. The setting is shown below:

1. Firstly, create a PLC Control object, set [Type of control] to [General PLC control], and set
[Trigger address] to DM-10, that is, to use the four sequential registers start from DM-10
to control data transfer.

2. Confirm the data size and the offset addresses.

Set DM-11 to 16, since the number of words to transfer is 16 words.
Set DM-12 to 86, which indicates the address of data source is DM-100 (100=10+4+86).
Set DM-13 to 200, which indicates the destination address is RW-200.
3. Set DM-10 according to the direction of data transfer.
If set DM-10 to 1, the data will be transferred from PLC to HMI RW register,
If set DM-10 to 3, the data will be transferred from HMI RW register to PLC.

® Back light control (write back) (eMT, iE, XE, mTV)

When [Trigger address] is turned ON, HMI backlight will be turned ON/OFF and [Trigger
address] will be turned OFF. Any touch on the screen will turn the backlight on.

® Back light control (eMT, iE, XE, mTV)

When [Trigger address] is turned ON, HMI backlight will turn ON/OFF and the state of [Trigger

address] will not be changed.
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® Sound control

When the state of the designated [Trigger address] changes, the HMI will play the sound
selected from the sound library. There is a further selection determines whether the sound is
played after Off to ON, ON to OFF transition, or at both of the changes of state.

® Execute macro program

Select a pre-defined Macro from the drop-down list. When the state of the designated [Trigger
address] changes, the selected Macro is executed. There is a further selection determines
whether the Macro is executed after Off to ON, ON to OFF transition, or at both of the changes
of state. If select [Always active when ON], the macro will be executed repeatedly. (The
shortest time interval between runs is 0.5 second.)

® Screen hardcopy

PLC Control

Comment :
PLC name : |Loca| HMI v|
Attribute
Type of contral ; |5creen hardcopy Y|

Active only when designated window opened

Rotate image 90 degrees

Trigger address

PLC name : | | ocal HMI Setlings...

Address : | g |0

Screen hardcopy

Trigger mode : | oFF-=0N -

Source window for print

@ Current baze window Window no. from register Designate window no.
Printer & | SD card v|
+ | Customized filename handling Settings...
[ OK ] | Cancel |

When the state of the designated [Trigger address] changes, print the selected screen. If select
[SD card] or [USB disk] as [Printer], a “hardcopy” folder will be generated in the selected
external device for saving the printed screen in JPG format. The name of the JPG files starts
from yyyymmdd_0000.

To print the screen using a printer, go to System Parameter Settings » Model tab and set the
printer.

To print the screen using a remote printer, go to System Parameter Settings » Printer/Backup
Server tab and configure the parameters.

There are three options to specify the source window for hardcopy:
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Current base window

Print the base window currently opened.

Window no. from register

Print the window designated by the value in a designated word address.

Designate window no.

Directly select a window to be printed.

Customized File Handling

This feature can be used to customize naming of the folders and the JPG files.

Setting

Description

Folder name

The folder name can be an alphanumeric name, and
certain half-width symbols are allowed:
l@#S%"&()_+{}-=;",.

The folder name can also be specified by a naming syntax.
Dynamic format

The folder names can be set by a designated word
address, or by a naming syntax indicating the current
system time. The syntax can be specified by selecting
time buttons or entering the syntax in Format field. The
length limit is from 1 to 25.

Note: Up to 10 layers of folders can be created. The
exceeding layers will be ignored.

File name

The way to specify a file name is similar to specifying a
folder name.
Note: If the file name already exists, the system will add
“_0001” to the file name as a serial number. The numbers
of the later files add up until “_9999”. The files after
“9999” will be ignored.
For example, if the three file names exist: “A.jpg”,
“A_0001.jpg”, “A_0003.jpg”. When trigger screen
hardcopy with the same file name, the coming files will
be named in this order: “A_0002.jpg”, “A_0004.jpg”,
”A_0005.jpg”, and so on.

@ Note

B The [Printer] setting is not available for cMT Series. The window hardcopy file is saved in

iPad Photo folder.
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A background printing procedure is performed when the printed window is not the
current base window.

If the hard-copied window is a background window, its [Direct Window] and [Indirect
Window] objects will not be printed.

When using a dynamic format name, the system will use a “_”" sign as a substitute for
invalid symbols.

When using a dynamic format name, if screen hardcopy is triggered without specifying
the format first, the system will save the file in the default directory, which is:

hardcopy\yymmdd_0000.JPG
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13.28. Scheduler

13.28.1. Overview

Scheduler object turns bits ON/OFF, or writes values to word registers at designated start times.

It works on a weekly basis.

13.28.2. Configuration

o

Click the Scheduler icon on the toolbar to open the Scheduler management dialog box, click
[New] to open the Scheduler property setting dialog box.

Scheduler

The following two demonstrations explain the usage of Scheduler.
Example 1
A motor is scheduled to power - ON at 9:00 and power — OFF at 18:00, Monday to Friday.
We are using LB-100 to control the motor state. LB-100 will be set ON at 9:00 and OFF at 18:00.
1. Click the Scheduler icon on the toolbar to open the Scheduler management dialog box,
click [New].
2. In[General] tab, select [Bit ON] in [Action mode] and set [Action address] to LB-100.

Scheduler @
General | Time Set | Prohibit

Comment : Scheduler 1

"] Power-OM start/fend action
Action mode

@ Biton ©) Bit OFF ©) Word write
Action address
PLC name : |Local HMI ~| [_setting...

3. In[Time Set] tab, select [Constant].
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Scheduler

| General | Time Set | prohibit |

@ Constant _) Address

[ setting on individual day
Start

9 = HE =

End
Enable termination action

18 = 0 +

: HE )
[sun Mon Tue Wed

HE

2| (HH:MM:55)

[¥]Thu

S| (HH:MM:55)

Fri [[sat

4. Enter [Start] time as 9:00:00 and select Monday to Friday. Do not select [Setting on

individual day].

5. Enter [End] time as 18:00:00 and select [Enable termination action] check box.
6. Click [OK], a new Scheduler object will be created on the [Scheduler] list.

Example 2

A thermal heater is scheduled to heat up to 90°C at 08:00 and cool down to 30°C at 17:00,
Monday to Friday. LW-100 is used to store the set point value.

1. Click the Scheduler icon on the toolbar to open the Scheduler management dialog box,

click [New].

2. In [General] tab, select [Word write] in [Action mode] and set [Action address] to LW-100.

3. Select [Constant] for [Word write value settings] and enter 90 in [Start value].

Scheduler

General | Time Set | Prohibit

X5

Comment : Scheduler 2

Action mode
) BitON

Action address

|| Power-ON startfend action

7 Bit OFF

@ Word write

PLC name : ILgca| HMI

v] Setting...

Word write value settings
@ Constant

Start value : ag

End value : 3p

4. In[Time set] tab select [Constant].

Address 1 |Lw | 100

) Address

16-bit Unsigned

Enter [Start] time as 8:00:00 and select Monday to Friday. Do not select [Setting on

individual day].

6. Enter [End] time as 17:00:00 and select [Enable termination action] check box.

Return to [General] tab and enter 30 in [End value].

8. Click [OK], a new schedule object will be created on the [Scheduler] list.
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Objects
General Tab
Scheduler @
General | Time Set | Prohibit
Comment : Scheduler 2
Power-0N startfend action
Action mode
() Bit ON () Bit OFF @ Word write
Action address
PLC name : [Local HMI v] Setting...
Address :[LW | 100 16-bit Unsigned
Word write value settings
(@ Constant () Address
Start value : ap
Setting Description
Power ON Execute the defined action when the HMI is powered ON.
start/end ® Enabled
action When HMI is powered ON within the scheduled time range, the

start action will be performed automatically. When HMl is powered
ON outside the scheduled time range, the termination action will

be executed.

Inside scheduled range

Start time Power ON End time

[’ [ i

| n I_l

|

|

|

!

Start action Termination action
Outside scheduled range
Power ON Start time End time

S| S

Termination action Start action Termination action

® Disabled

When the HMI is powered ON at a time later than the start time,
the start action will not be performed, but the termination action
will be performed. When the termination action is not defined, the

scheduled range is not recognized and no action is performed.
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Action mode

Choose the action to do at the given time.

Bit ON

At the start time, set the designated bit ON. At the end time, set
the designated bit OFF.

Example: Start time : 09:00:00 End time : 17:00:00

Start time End time
ON : : '
09:00:00 12:00:00 17:00:00
Bit OFF

At the start time, set the designated bit OFF. At the end time, set
the designated bit ON.
Example: Start time : 09:00:00 End time :17:00:00

Start time End time
N 5 e
_I : I_
OFF : : :
09:00:00 12:00:00 17:00:00
Word write

The [Write start value] entered here is transferred to the
designated [Action address] word register at the start time. At end
time, the [Write end value] entered here is written to the [Action
address]. The valued can be entered manually or be set by using
[Address] mode. In [Address] mode, the value in the specified
address is the start value where the value in [Address + 1] is the
end value.

Example: Device address: LW-100

Start time: 09:00:00 End time: 17:00:00

Write start value: 10 Write end value: 0

Use register: If control address is LW-n, then enter 10 in LW-n and
enter 0 in LW-(n+1).

LW-100 10 LW-100 0

09:00:00 17:00:00
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@ Note

B Onlyisan [End time] is set in the [Time set] tab will the [Write end value] box appear.

Time Set

Specify start time and end time. [Constant] allows specifying a date or period and time.

[Address] allows controlling the time by the designated address.

[T setting on individual day

End
[|Enable termination action

Start
9 o0 o0 = (HH:MM:55)
[ sun Man Tue Wed Thu Fri

[T sat

Scheduler @ Scheduler
General | Time Set | prohibit General | Time Set | prohibit
@ Constant () Address () Constant (@ Address

Time setting address

PLC name :[Lccal HMI

v] Setting...

Control : Lw @ 0
Status: w0 +1
Actionmode : [y . +2
Start time {day) : Lw:0 +3
Start time (hour) @ [LW : 0 +4
Start time (minute) @ LW 0 +5
Start time (second) @ LW : 0 +6&
End time (day): Lw:0+7
End time (hour) : LW :0 +8
End time (minute) : LW :0 +2

End time (second) : |Lw : 0 + 10

® Constant
Setting on individual day

If [Setting on individual day] is selected

The same start time and end time can be assigned to different days of the week.

I__| WE!NTEK

Scheduler @I
General | Time Set | prohibit
@ Constant () Address
Setting on individual day
Start
] = : o o 0 2| (HH:MM:53)
) 5un @ Mon () Tue iwed O Thu () Fri () 5at
End
Enable termination action
17 = : |0 H : o | (HH:MM:55)
() 5un CIMon @ Tue CiWed () Thu () Fri () 5at

Start action
09:00

Termination action

Monday |-I

Tuesday
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@ Note

B Start and end time must be entered.

13-155

B Start and end time must be on a different time, or same time but different day.

If [Setting on individual day] is not selected

Start time and end time entered must start and end within 24-hours.

0 Note

Scheduler @
General | Time Set | Prohibit
@ Constant Address
Setting on individual day
Start
9 = o0 = 0 = (HH:MM:5S)
Sun V| Man V| Tue Wed Thu Fri Sat
End
/| Enable termination action
17 : 0 o0 F| (HH:MM:55)

Monday

Start action

Termination action

09:00 17:00

Tuesday

B Start time and end time must be on a different time, different day.

B [f an end time is earlier than a start time, the end action will occur in the next day.

Start date: Monday
Start time: 22:00

End time: 01:00

® Address

Monday Tuesday
o ——
22:00:00 01:00:00

The scheduler object retrieves the start/end time and day of week information from word

registers, enabling all parameters to be set and changed under PLC or user control.

Designated as the top address in a block of 11 sequential registers which are used to store time

setting data.

The format of the 11 word registers should normally be 16-unsigned integer. If a 32-bit word

address is chosen, only bits 0-15 are effective, and bits 16-31 should be written as zero.

The following describes each register.

Control (Time setting address + 0)

When [Control] bit is ON, the HMI will read and update [Action mode], [Start time], and [End

time] values.
15

‘ Reserved (0 fixed)

Bit 0: no action 1: read times/action mode

L—| WE!NTEK
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@ Note
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B HMI will not regularly read the data from [Action mode] (address + 2) to [End time]

(address + 10). Please turn [Control] ON when the settings are changed.

Status (Time setting address + 1)

When the read operation is completed, Bit0O of this register turns ON. If time data read is out

of range or incorrect in any way Bit01 turns ON.

15

02 01 00
Bit

Reserved (0 fixed)

Bit 00: Status bit: Read operation completed. (0: reading or reading not started. 1:

reading completed.)

Bit 01: Error bit: Start or end time format incorrect. (0: corrected 1: error)

@ Note

B After the scheduler reads the data and the status is turned ON (The value in [Address + 1]
= 01), the control bit must be turned OFF (address = 0). The status bit and error bit will be
turned OFF (1->0) at the same time.

Control Bit
(PLC to HMI)

Data in Registers

(PLC to HMI)

Status Bit
(HMI to PLC)

Error Bit
(HMI to PLC)

1 |6 1 |
DN 1 1
L : <> L :
L) 1] L 1
OFF - . -
D22 LT L2
HMI confirms that Control Bit HMI confirms that Contral Bit:
issetON 1 isget OFF ! ! !
; | : | | | \
—— 3 Read Data . - - - %7 3 ReadData >
Lo 4 v o Vo
| HMI turns Status Bit ON = o
ON P 5[ 1 |8 o
Lo ! P o
DFF ] : : ¥ : [ : i
Lo Lo N
o a 4 o R
i ] ] i i 1
i Error Bit turns ON when 7 | X . |
| Ernor ocours : ' ' k . X
ON Vo |5 B N
Pl : e b
1 L L 1 1
OFF

= Communication delays

L—| WE!NTEK
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Action mode (Time setting address + 2)

Enable/disable [Enable termination action] and [Setting on individual day]. Whatever the
[Enable termination action] bit is, all the time data, from [Control] to [End time (second)], will
be read.

15 02 01 00

it

Reserved (0 fixed) | 0|0 ‘

Bit 00 Enable termination action (0: Disabled 1: Enabled)
Bit 01 Setting on individual day (0: Disabled 1: Enabled)

@ Note

B If [Enable termination action] is OFF, all 11 registers are still read but end time is ignored.
B [f [Setting on individual day] is ON, make sure that all start end times are entered. If more
than one start / end day bit is ON, and error will occur.

Start/End Day (Start Day: Time setting address + 3, End Day: Time setting address + 7)

Designates which day of week is used to trigger the start or end action.
15 07 06 05 04 03 02 01 00 Bit

| Reserved (0 fixed) I Sat I Fri lThu |wgd lTue ]ManlSur |

Bit 00 Sunday (0: not used 1: used)

Bit 01 Monday  (0: not used 1: used)

Bit 02 Tuesday  (0: not used 1: used)

Bit 03 Wednesday (0: not used 1: used)

Bit 04 Thursday (0: not used 1: used)

Bit 05 Friday (0: not used 1: used)

Bit 06 Saturday (0: not used 1: used)
Start/End Time (Start Time: Time setting address + 4 to + 6, End Time: Time setting address +
8 to + 10)
Hour: 0 — 23 Minute: 0 — 59 Second: 0 - 59

Values outside these ranges will cause error.

@ Note

B 16-bit unsigned integer format must be used; BCD format is not supported here.
B Endtime depends on [Action mode] (address + 2). [Enable termination action] (Bit 00)
and [Setting individual day] (Bit 01) are related:

Setting individual day Enabled Disabled
Enable termination action Enabled Enabled Disabled
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Prohibit tab

Scheduler @
General | Time Set | Prohibit

Prohibit
| Use prohibit function

PLC name : ||_0ca| HMI - | Setting...
Address : |1 -0

Before the scheduled action is performed, the HMI will read the specified bit state. If it is ON,

the scheduled start/end action will be skipped. Otherwise, it will be performed normally.

@ Note

L—| WE!NTEK

Up to 32 scheduler objects are allowed.
A time schedule applies one action only when the start time is reached.

User set OFF
Start time End time
Action: Set Bit
oN e
Start time: 08:00:00
End time: 08:20:00 ofFF = |~ ‘
07:50:00 08:00:00 18:10:00 18:20:00

[Write start/end value] and [Prohibit] bit is read only once before start action. After that,
even to change the state of [Prohibit] bit or [Write start/end value], the end action and
the value written will not be affected. Also, to read data of [Write start/end value] and
[Prohibit] bit, there is a delay of start action due to the communication.

Each time RTC data is changed, scheduler list entries that possess both start and end
times will be checked for in-range or out-range conditions. For in-range, the start action
will occur. If the end action is not set, the new range is not recognized, the action will not
occur.

If several Scheduler objects are set to the same start time or end time, the action is
performed in ascending order of the schedule number.

In [Time Set] » [Address] mode, the system will read [Control] word regularly. The length
of the period depends on the system.

In [Time Set] » [Address] mode, when start time and end time is out- range, error occurs
in the set action time. (Note: BCD is not an acceptable format)

In [Time Set] » [Address] mode, the action will not start up until the first time the time
data is successfully updated.
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13.29. Option List

13.29.1. Overview

13-159

Option List object displays a list of items that the user can view and select. Once the user

selects an item, the corresponding data will be written to a word register.

There are two forms of this object — [List box] and [Drop-down list]. The [List box] lists all items

and highlights the selected one. The [Drop-down list] normally displays only the selected item.

Once the object is pressed, the system will display a list (which is similar to list box) as shown in

the following figure.

13.29.2. Configuration

Listbox

14 Apr. 2009
13 Apr. 2009
12 Apr. 2009
11 Apr. 2009
10 Apr. 2009
09 Apr. 2009

Drop-down list

14 Apr. 2009 |

14 Apr. 2009

14 Apr. 2009
13 Apr. 2009
12 Apr. 2009
11 Apr. 2009
10 Apr. 2009

Click the Option List icon on the toolbar to open an Option List object property dialog box. Set

up the properties, press OK button, and a new Option List object will be created.

L—| WE!NTEK
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General Tab

New Option List Object (23]

Option list | Mapping | Security | shape [ Label |

Comment :
Attribute

Background : -
Selection : | INEG_G_— |

Source of item data : [Predeﬁne v]

Monitor address

- ] Setting...

16-hit Unsigned

PLC name : [Local HMI

[ write when button is released

Send notification after writing sucessfully

][ Cancel ]

13-160

Setting

Description

Attribute

Mode: The list style, either [List box] or [Drop-down list].

Item no.: Set the number of items for the object. Each item
represents a state displayed in the list and the corresponding value
will be written to the [Monitor address].

Background: Set background color.

Selection: Set background color for the selected item.

Source of item data: There are 4 sources available: [Predefine],
[Dates of historical data], [Item address], and [User account]. See
13.29.2.1..

Monitor
address

The corresponding value of the selected item will be written to
[Monitor address].

Write when button is released

If this check box is selected, the selected item value will be written

to [Monitor address] after the button is released.

I__| WE!NTEK
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Send
notification Set On/Off the designated bit address after successfully writing
after writing data to PLC.

successfully

0 Note

B For cMT Series, the [Dates of historical data] and the [write when button is released]
selections are not available.

13.29.2.1. Source of item data

® Predefine

The list is manually defined in [Mapping] tab.

The number of items can be adjusted by [Item no.], and each item represents one state. Each
item has a corresponding value which will be written to [Monitor address].

® Dates of historical data
This selection is not available for cMT Series.

Mew Option List Object @

Crptiom List |Mappi.ng | Security I Shape I Label |

Cornment :
Attribute

- .
Zelection MG |

Source of item data [Dates of history data - ]

Enable [delete history files] function

Monitor address

PLC name : ’Local HMI v] Setting...

Address i[LW v] 15 16-bit Unsigned

[ Write when bution is released
Ttem date from dates of historizal data

Type : Dite : | MM/DDAY -

Diata Sampling object : [1 - - ]
Control addres:
PLC name : ’Local HMI v] Setting...
Address i[LW |0

[Address] : set 1 to delete the selected history data

Send notification after writing sucessfully
[ Enable

Option List object can be used with historical data display objects, such as Trend Display object,
History Data Display object and Event Display object to control which history file should be

I__| WE'NTEK EasyBuilder Pro V5.05.02



Objects

13-162

shown. The figure below is an example of Option List used with Trend Display.

<N\

06/11/09 (g
Qﬂnﬂn WA AMAAARAAAR
oenooo [ | AN LWF\&“K RN B W
06/09/09 \ RIRVIYIN Hy
06/08/09 rhwjl‘&m mﬁ\h\l 1\ Vﬁ%'{lﬁm{ Qﬂ I Nﬁ}.*ﬁ
06/06/09 ﬂ
T/ 13:14:18 13:14:38 13: 14 58 13:15:18 13:15:38 13:15:58 13:16:18
LERL] LAY
Setting Description
Type Two options are available: [Event (Alarm) log] and [Data sampling].
Date Set the date format. YYYY means a four digits year (EX: 2012), YY
means a two digits year (EX: 12), MM means month and DD means
day.
Data Select which Data Sampling object is displayed when [Type] is [Data
Sampling Sampling], and it should be the same as the [Data sampling object
object index] configured in [Trend Display] or [History Data Display].
Enable
[delete If selected, a control address can be set. Writing “1” to this address
history data] will delete the history data of the specified date.
function

@ Note

B In [Dates of historical data] mode, since the system automatically reads the historical data

and finds the date information, it is not necessary to configure in the [Mapping] tab.

B The error message displayed in Option List can be modified in [Mapping] tab.

Tteim

p O fermor)

® [tem address

Walue

Ttem data

Errox! |

The list will be read from the given [Item address] and controlled by [Control address]. The

following options will be available:
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Option List Object's Properties |El
Option list |Mapping I Security | Shape | Label | Proﬁle|
Comment :
Attribute
Mode : Background : -
Selection : | INEEG v
Source of item data : [Item address V]
Monitor address
PLC name : | Local HMI +| [ Setting...
Address :’Lw ~ |0 16-bit Unsigned
[ vurite when button is released
Control address
PLC name : [Local HMI v] Setting...
Address ; [LW v] i}
[Address] : set 1 to update item data [Address] + 1:item count
Item address
[T reverse highflow byte The length of each item : 5 WORD(s)
[[Junicope
PLC name : [Local HML v] Setting...
Address i[LW - |0
Setting Description
Control [Address]: If the value at this address is changed to 1, the option
address list would be replaced by items defined at [Item address]. After

updating, the value will be restored to 0.

[Address + 1]: Define the number of items in [Iltem address].

Item address

Assign the item address
UNICODE

The item will use UNICODE characters, such as Chinese characters.

The length of each item

Define the number of letters for each item, the unit is Word.

0 Note

B The UNICODE characters used here should be used by Text object, so that EasyBuilder Pro
will compile the needed fonts and download these fonts to HMI, then the UNICODE

letters can be correctly displayed.

B [The number of items] multiplied by [The Length of each item] must be less than 1024

words.

B The system automatically disables [Mapping] tab in [Item address] mode.
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® User account

If [Enhanced Security] mode is enabled, [User account] would appear in the [Source of item
data] and it lists the names of users.

Option List Object's Properties [==2]

Option list |Mapping I Security | Shape | Label | Proﬁle|

Comment :

Selection : NG

Source of item data : ’User account v]

Attribute

Sort Display
[ Ascending ] bescending [T privilege [ secret user

Monitor address

PLC name : ’Local HMI v] Setting...
Address i[LW -0 16-bit Unsigned

[ write when button is released

Setting Description
Sort Select the sorting method from [Ascending] of [Descending].
Display If [Privilege] is selected, the privileges for each user will be

displayed in option list.

If [Secret user] is selected, even though it is defined to be hidden in
[System parameter settings] » [Security] » [Enhanced Security], the
users will still be displayed in [Option List].

@ Note

B The address that controls user index is [Control Address +2 (LW-n+2)] which is set in

[System Parameters] » [Security] » [Enhanced Security].
Mapping Tab

This table displays all available states/items, their item data and values. To change the number
of available items, please go to [Option list tab] » [Attribute] » [Item no.].
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New Option List Object (=34
[Optonist| Mapping |Security | Shape | Label |
Ttem Value Ttem data =
0 0 Black Coffee
1 1 Latte B
2 2 Black Tea
3 3 Cappuccing
4 4 Vanilla Latte
5 5 Mattya.
6 6 Green Tea
7 7 OoLong Tea
8 g Fruit Tea
9 9 Scented Tea
10 (exyor)
Import item data from recipe record... ]
Error notification
[T]Enable
Setting Description
Item The system lists all available items. Each item represents a state
that will be displayed in the list. This field is read-only.
Value Here user can assign value for each item, basing on the following
two criteria:

For reading: If the value in [Monitor address] is changed, the object
selects the first-matched item. If no item is matched, the status
goes to error state and signals the notification bit register (if
requested).
For writing: The system writes this value to [Monitor address] when
user selects an item.

Item data Text displayed for each item. The Option List object displays the
text of all items in the list for users to review and select.

Import item This feature is enabled when select [Recipe-Selection] as [Monitor
data from address]. Click [Import item data from recipe record] to open the
recipe record [Recipe Records] setting dialog box. Select [Item data source], the

data belonging to the selected column will all be imported to
Option List object.

Recipe Records @
Repes: T S =)
SarcodE 5

Ttem Coffes oo |caores

1 BlckCoffee 225 0 Coffee. A

2 Late 150 0 =

3 ElackTea 0 120 s

4 Cappuccino 150 0 vl

5 Vanilla Latte 150 0 Sugar

6 Mattya 0 0 Tea

7 GrenTea 0 120 1

8 OcLong Tea 0 120 g

9 FitTea 0 100 15

10 Scented Tea 0 120 3

O P —T— y

[osor. | mor. | o)

Before importing, the number of items in Option List changes
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according to the number of items defined in Recipe Records.
After importing, modifying Recipe Records will not change the

content of Option List.

Error state

On error state, the list box removes the highlight to represent no
item is selected and the drop-down list displays the data of error
state. Only the drop-down list uses error state, list box is not able to
use error state.

For example, item number 8 is the error state when specifying 8 in
[Item no.]. (The first item number is 0)

Set default

Reset all values or states to default. That is, set O for item 0, 1 for
item 1, and so on.

Error

notification

The system will set ON/OFF to the specified bit register when error
is detected. The signal of the bit register could be used to trigger a
procedure for correcting the error by using objects such as Event
Log, Alarm Bar, or pop-up window.
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13.30. Timer

13.30.1. Overview

Timer object is a switch that can be used to control the mode to count time. The modes are
explained later. Timer object uses the following 6 variables:

Timer Variable Type Description

Input bit (IN) Bit The main switch of Timer.

Measurement bit (TI) Bit Turns ON when the Timer begins
counting time.

Output bit (Q) Bit Activated when the Timer finishes
counting time.

Preset time (PT) Word Presets a time before the Timer
begins counting time.

Elapsed time (ET) Word Displays the elapsed time.

Reset bit (R) Bit Resets the elapsed time (ET) to 0.

13.30.2. Configuration

L

Click the Timer icon on the toolbar to open the property dialog box as shown in the following
figure.

Timer @
Timer
Description @
Input bit (IM)
Mode : [On delay - PLC name : Local HMI ][ setting...
Time base : [0‘ 1 second(s) V] L T
Qutput bit (Q)
PLC name  Local HM ] [Setting... ]
m—| s o
TI— PT | PT Measurement bit (TT)
PLC name :[Lgal HMI v] Setting...
o T o
Elapsed time (ET) Preset time (PT)
Enable | Constant preset time
PLC name ¢ Local HMI PLC name i[LoaI HMI v] Setting...
Address : 1] 16-bit Unsigned Address : 10 16-bit Unsigned
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0 Note

B [Constant preset time] is only available for cMT series.
If use cMT Series, clicking the Timer icon on the toolbar will open the Timer managing window,

click [New] to configure.

Timer

[ Mew... ] [ Delete l [ Settings...
® Ondelay
Mode Register

Input bit (IN): The main switch of Timer.

I — Measurement bit (TI): Turns ON when the Timer
begins counting time.

TI— PT PT

s T Output bit (Q): Turns ON when the Timer finishes
Q counting time.
1 2 3 4 5

Preset time (PT): Presets a time before the Timer

begins counting time.

Elapsed time (ET): Displays the elapsed time.

Description

Period 1: When the IN turns ON, Tl turns ON and the ET starts counting. The Q remains OFF.
Period 2: When the ET equals to the PT, the Tl turns OFF and the Q turns ON.

Period 3: When the IN turns OFF, the Q turns OFF and the ET is reset to 0.

Period 4: When the IN turns ON, the Tl turns ON and the ET starts counting. The Q remains
OFF.

Period 5: Turns IN OFF before the ET reaches the PT, the Tl turns OFF, and the ET is reset to O.
Since the ET doesn’t reach the PT, the Q remains OFF.
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® Off delay
Mode Register
Input bit (IN): The main switch of Timer.
IN Measurement bit (TI): Turns ON when the Timer
- | | pr | | PT begins counting time.
Output bit (Q): Turns OFF when the Timer finishes
Q— counting time.

Preset time (PT): Presets a time before the Timer

begins counting time.

Elapsed time (ET): Displays the elapsed time.

Description

Period 1: When the IN turns ON, the Tl remains OFF and the Q turns ON, the ET is reset to 0.
Period 2: When the IN turns OFF, the Tl turns ON and the Q remains ON, the ET starts
counting.

Period 3: When the ET equals to the PT, the Q and Tl turn OFF.

Period 4: When the IN turns ON, the Tl remains OFF and the Q turns ON, the ET is reset to 0.
Period 5: When the IN turns OFF, the Tl turns ON and the Q remains ON, the ET starts
counting.

Period 6: Turns the IN to ON before the ET reaches the PT, the Tl turns OFF, the Q remains
ON, and the ET is reset to O,.

® Pulse
Mode Register
Input bit (IN): The main switch of Timer.
IN —I - Measurement bit (TI): Turns ON when the Timer
nLllex PT begins counting time.
— Output bit (Q): Turns ON when the Timer begins
Q— e counting time and turns OFF when the Timer

finishes counting time.

Preset time (PT): Presets a time before the Timer
begins counting time.

Elapsed time (ET): Displays the elapsed time.

Description

Period 1: When the IN turns ON, the Tl and Q turn ON simultaneously, and the ET starts
counting.

Period 2: When the ET equals to PT, the Tl and Q turn OFF simultaneously. Since IN is turned
OFF when counting time, the ET is reset to 0.

Period 3: When the IN turns ON, the Tl and Q turn ON simultaneously, and the ET starts
counting.

Period 4: When the ET equals the PT, the Tl and Q turn OFF simultaneously.
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® Accumulated ON delay

Mode Register
" | | I_ Input bit (IN): The main switch of Timer.
Measurement bit (TI): Turns ON when the Timer
L Al IqPTFI A begins counting time.
|_| Output bit (Q): Turns ON when the Timer finishes
Q ] counting time.
1 2 3 45 6 7 Preset time (PT): Presets a time before the Timer

begins counting time.

Elapsed time (ET): Displays the elapsed time.
Reset bit (R): Resets ETto 0

Description

Period 1: When the IN turns ON, the Tl turns ON and the elapsed time ET starts counting, the
Q remains OFF.

Period 2: When the IN turns OFF, if the ET doesn’t reach the PT, the Tl turns OFF, and at the
same time the Q remains OFF. The ET is in the retentive state.

Period 3: When the IN turns ON, the Tl turns ON. The timer measurement starts again and
the ET starts counting from the kept value. The Q remains OFF.

Period 4: When the ET reaches the PT, the Tl turns OFF and the Q turns ON.

Period 5: When the IN turns OFF, the Q turns OFF. Turning ON the reset bit R will reset the ET
to 0, and then the reset bit turns OFF.

® Accumulated OFF delay

Mode Register
— - Input bit (IN): The main switch of Timer.
'“'I_I_ T Measurement bit (Tl): Turns ON when the Timer
Ll PT J PT 1l begins counting time.
R . LT Output bit (Q): Turns OFF when the Timer finishes
Q- L] counting time.

1€ 3% 3 6 ¥ aisie Preset time (PT): Presets a time before the Timer

begins counting.

Elapsed time (ET): Displays the elapsed time.
Reset bit (R): Resets ET to 0

Description

Period 1: When the IN turns ON, the Tl remains OFF and the Q turns ON.

Period 2: When the IN turns OFF, the Tl turns ON and the Q remains ON. The ET starts
counting.

Period 3: When the IN turns ON, the Tl and Q remain ON, and the ET is in the retentive state.
Period 4: When the IN turns OFF again, the ET starts counting from the kept value.

Period 5: When the ET equals to the PT, the Tl and Q turn OFF simultaneously. Turning ON
the reset bit R will reset the ET to 0, and then the reset bit turns OFF.
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13.31. VideoIn

13.31.1. Overview

The eMT, XE, and mTV Series HMI models provide the Video Input feature. By installing a
surveillance camera, user can monitor the site on HMI. The video images can be stored in
external devices and then analyzed on PC. This feature can be utilized in different places for
monitoring, such as vehicles or buildings.

eMT, XE, and mTV Series: Support USB camera video input.

eMT, XE Series: Support IP camera video input.

eMT3120A/eMT3150A: Not only support USB camera video input but also NTSC and PAL
analog video systems. For hardware, HMI provides 2 channels for Video Input. User can freely

switch the channel, and capture real-time images even when Video Input is paused.

13.31.2. Configuration

Click the Video In icon on the toolbar to open the property dialog box. Set up the properties,
press OK button, and a new Video In object will be created.
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General Tab

Analog Video Systems USB Camera

New Video In Object @ Video In (USE Camera) Object's Properties
General General | profile
Comment : Comment :
Input channel : 1 - Encode format: NTSC -
Capture add
Capture address apture address
Use capture function Use capture function
PLC rame : [Local M1 <) [ setings ) PLC name : Local HML -] [sestng...

sdessila o ,7 addessilis  ~]o

Storage medium
Storage medium

_ _ @ 5D card
() 5D card (@) USE disk
Record time
Before: 1 5| seconds After: 1 % seconds

Contral address

Use contral function

Control address

[]Use control function

PLC name :[Lgml HMIL v][ Setting... ]

Startfstopinput: LW : 0
Pause : LW:0 +1

* 05 wersion 2014.01, 16 or later support USE camera only !

IP Camera

New Video In (USB/IP Camera) Object

General Secuxigl

Comment :

) USB Camera @ IP Camera
RTSP:# 192.168.1.1490ive sip

Capture address
Use capture function
PLC : [Logal HMI [ Settings...
- — o
Storage medivm
© USB disk
Control address
[7] Use control function
PLC : [Local HMI [ Settings...

] —L T o

Start/stop input : LW-0
Pause : LW-1

*USE Camera requires OS version 20140624 or later.
*IP Camera requires OS version 20160201 or later.

==
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Setting Description

Input channel Select the Video Input channel from channel 1 or channel 2.
(Analog video systems)

Encode .

Select the format from NTSC or PAL. (Analog video systems)
format
RTSP Enter the IP camera’s RTSP address.
Capture Select [Use capture function] check box and configure the settings.
address Capture address

Designate the address that triggers image capturing.
Storage medium

Designate the storage device.

System Storage Device

Analog video | Select SD card or USB disk to save the captured
system images. The images of channel 1 will be saved in

“VIP1” folder in the chosen storage and so on.

USB Only saves the captured images in SD card.

Camera

IP Camera XE Series: Captured images can be saved in USB
drive.

eMT Series: Captured images can be saved in SD

card.

Record time
Set a period of time to capture the images.
System Method

Analog video ® The longest period can be set from 10
system seconds before triggering [Capture address]
to 10 seconds after triggering.
® The time interval of image capturing is once
every second.
® The captured .jpg file will be named in the
following format:
Before or after [Capture address] is
triggered: YYYYMMDDhhmmss.jpg
The moment that [Capture address] is
triggered: YYYYMMDDhhmmss@.jpg
For example, set [Record time] “Before” and
“After” to “5” seconds. When the state of [Capture
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address] changes from OFF to ON, the system will
start capturing one image per second, from 5
seconds before the triggering time to 5 seconds
after the triggering time, which is 11 images in
total including the one captured at the triggering
moment.
USB Only the image of the triggering moment is
Camera captured. The name format:
YYYYMMDDhhmmss.png.
IP Camera Only the image of the triggering moment is
captured. The naming format:
YYYYMMDDhhmmss.png.
Control Use control function
address If enabled, enter certain value to the control address and the

following addresses can control Video Input object. For example, if
the designated control address is LW-n (n is any address), enter
certain value to the designated addresses will execute commands

as the following table.

Address | Value | Command
LW-n 0 Stop displaying image

1 Open channel 1 and display the
image on HMI

2 Open channel 2 and display the
image on HMI

3 Open channel 1 but don’t display the
image on HMI (Capture function
operable)

4 Open channel 2 but don’t display the
image on HMI (Capture function
operable)

W-n+1 |1 Pause / resume the video

LW-n+2 | 1~100 | Adjust the contrast ratio
(Analog video systems)

LW-n+3 | 1~100 | Adjust the brightness
(Analog video systems)

® After changing the value in [Control address (LW-n)], the

system will keep the new value.

® After changing the value in [Control address + 1 (LW-n+1)],

the system will execute the command and then reset the
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value to 0.

® [f [Use control function] check box is not selected, the system
will play the image of the selected channel.

® [f [Display adjustment] check box is selected, the contrast
ratio and brightness can be adjusted. (Analog video systems)

® The USB Camera / IP Camera is controlled by LW-n (value O or
1) and LW-n+1.

0 Note

About analog video systems:

B Only one channel can be opened at a time.

B Real-time images can still be captured when Video In is paused.
B Recommended analog video systems and resolutions:

1:1 50%
NTSC 720 x 480 360 x 240
PAL 720 x 576 360 x 288

About USB Camera:

B When the USB Camera is disconnected during video playing, video will not resume when
camera is connected again. If [Control address] is used in the project, please use the
control address to stop and restart video. If [Control address] is not used, switch to
another screen and then return, or restart HMI in order to resume the video.

B The maximum size of Video In object of eMT3070A is 340*240, as for eMT3105P,
eMT3120A, eMT3150A, XE, and mTV Series, the maximum size of Video in object is
640*480.

B When using a USB Camera, the display resolution of the run-time video is determined by
the resolution supported by the USB Camera that is closest to the size of the object. The
resolution supported by the USB Camera may not be identical to the size of the object.
Therefore, it is good practice to adjust the size of object according to the actual resolution
of the video.

B When using a USB Camera, the right and bottom edge of the Video In object will keep a
distance of 50 pixels away from the window edge to prevent the run-time video from
exceeding the window.

B When using a USB Camera, the background color of Video In object is black. If the
resolution of the run-time video is smaller than the object, the empty area is colored
black. Therefore, it is good practice to adjust the size of object according to the actual
resolution of the video. The tested and available USB Cameras are: Logitech C170,
Logitech C310, Logitech C910, LifeCam VX-2000.

B The OS versions that support USB Camera:

Model OS Version (or later)
eMT3070A 20140116
eMT3105P, eMT3120A, eMT3150A 20140701
XE Series 20140624
mTV 20140807
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About IP Camera:

B A RTSP address is required for using IP camera. The RTSP address can be found in the
configuration tool of the IP camera, or possibly from an online repository.

B When the IP Camera is disconnected during video streaming, video will not resume when
the camera is connected again. If [Control address] is used in the project, please use the
control address to stop and restart video. If [Control address] is not used, switch to
another screen and then return, or restart HMI in order to resume the video.

B When using an IP camera, the display resolution of the run-time video will be same as
that of the object drawn in the EasyBuilder Pro project. If the actual video resolution is
different from the size of the object, the resolution will be adjusted to fit the object,
which may cause distortion of video image. Therefore, it is good practice to adjust the size
of object according to the actual resolution of the video.

B Use the IP cameras that comply with ONVIF standard, and use RTSP for video streaming.

B To ensure the quality and smoothness of the video, and not to affect HMI’s general
performance, adjust the settings of IP camera when video lags or high CPU loading is
observed. As the project complexity and hardware specs vary from one case to another,
please fine-tune the video parameters accordingly.

B Recommended video specification:

Resolution 960x544 (max.)
Format H.264, MJPEG
Refresh Rate 15 fps
Transmission Speed 800kbps (max.)

4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.32. System Message

13.32.1. Overview

If objects use [Display confirmation request] or [local HMI supports monitor function only] is

turned on/off, the corresponding messages configured here will be displayed in pop-up

message boxes.

13.32.2. Configuration

Click the System Message icon & on the toolbar to open the setting dialog box.

System Message

System Message

Confirmation reguired
Dialog size : @ small ) Middle ) Large

Message : Please confirm the operation

Use abel library
OK: OK
Use fabel library
Cancel : Cancel
Use fabel library

Font : Aril
Deny write-command
Message : The system is being prohibited from writing device registers!
Font: Arial
Use abel library

Allow write-cormmand

Message : The system is now allowed to write device registers.

13-177

Font : Arial
Use fabel library
0K ] [ Cancel
Setting Description
Dialog Size Select the size for pop-up window and texts.

Confirmation
required

If an object uses [Display confirmation request], this message
would pop up when the object is used. [Message] shown on
confirmation dialog box, and the text label of the 2 buttons, [OK]
and [Cancel], can be set. Please use the same font for the labels of

[Message], [OK] and [Cancel]. Additionally, only when selecting
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[Label Library] for [Message], the use of Label Library for [OK] and
[Cancel] buttons can be enabled.
Deny Displays when system tag LB-9196 (local HMI supports monitor

write-command

function only) is turned ON.

Allow
write-command

Displays when system tag LB-9196 (local HMI supports monitor

function only) is turned OFF.

0 Note

B cMT-SVR does not support adjusting dialog size and using system tag LB-9196.
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13.33. Recipe View

13.33.1. Overview

Recipe View object can be used to display a specific recipe. All items and values of the recipe

can be viewed by using this object.

13.33.2. Configuration

Click the Recipe View icon on the toolbar to open a Recipe View object property dialog box. Set

up the properties, press OK button, and a new Recipe View object will be created.

General Tab

cMT Series eMT, iE, XE, mTV Series
New Recipe View Object @ Mew Recipe View Object @
General | shape I Font General | shape I Font
Comment : Comment :
Reripe table Recipe table
Title Title
|:| Transparent |:| Transparent
Color : — Color :  E—
Profile Profile
|:| Transparent I:‘ Transparent
Frame : — | Background: [ v | Frome: |~ | Badground: [ v
Grid
Enable
Color: [ 1| 'l
Selection control
Color: [l
Default sort method Default sort method
Enable Enable
() Ascending (@ Descending () Ascending @ Descending
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The name of each part of the Recipe View object is shown in the following figure.

13-180

Title-
Green Part
bl
Selection
11.11 66.66 1111 AAAA  +— control-
profile- 22.22 77.77 2222 BBEB Pink Part
Frame and 33.33 88.88 3333 CCCC
Background color ||44.44 99.99 4444 DDDD
55.55 /'12.34 5555 EEEE
Grid-
dividing line
Setting Description
Recipe table Choose the recipe name or look for other recipes from the
drop-down list.
Title The item name assigned in [System Parameter Setting] » [Recipe].
Transparent
If selected, the title row has no shading; the color selection is not
available.
Profile The frame and background color of the object can be set.
Transparent
Select to hide the background, the color selection is not available.
Grid The dividing lines between columns and rows.
(N/A for cMT) Enable
Select to show the grid.
Selection
Control Change the shading color of the selected row.
(N/A for cMT)

Default sort
method

Configure how the records are sorted. [Ascending] and
[Descending] can be selected.

@ Note
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There are 4 system registers that can be used to view/update/add/delete recipe database:

Selection

Current selection of record in Recipe View object, and it is numbered from zero. If the first

record is chosen, the value of Selection will be 0. When the value of Selection is changed,

the corresponding values will be updated, such as “No”, “Timer_1", “Timer_2", as shown

in the following figure.
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Show the number of records in current recipe.

Command

Objects 13-181
Murmeric Input Object's Properties @
General | Data Entry | Mumeric Format I Security | Shape | Font | Proﬁ|e|
Description @
M readpvirite use different addresses
Read address
PLC name : | Local HMI ][ setting...
Address : [RECIPE o
v Recipe_Solar » | ¥ Selection
Count
Command
Result
Mo
Motification )

[FlEnable Timer_1
Timer_2
Timer_3
Timer_4
Speed

L |
Count

Enter certain value will send command to the selected record.

Enter “1”: Add a new recipe record next to the currently selected one.

Enter “2”: Update the selected recipe record.
Enter “3”: Delete the selected recipe record.
Enter “4”: Delete all recipe records.

Result

View the result of executing commands.

Displays “1”: Command successfully executed.

Displays “2”: The selected record does not exist.

Displays “4”: Unknown command.

Displays “8”: Records reach limit (10000 records), no new records can be added.

C?Please go to [System Parameter Settings] » [Recipes] tab to create the recipe data

before using Recipe View object. See “5 System Parameter Settings”.

@About creating recipes, see “24 Recipe Editor”.

L—| WE!NTEK

EasyBuilder Pro V5.05.02



Objects

Example 1
In this example, a recipe database is created to be displayed by Recipe View object. When you

13-182

select a recipe record on Recipe View object, the value of [Selection] and the corresponding

values will change accordingly. When finish designing, you can modify the recipe database by

entering a value in [Command].

1.

2.

Simple Recipe View & Recipe Database

Mo Marne [ Timer_1 Timer 2| Timer_3| Timer_4
i] Mercury 10 1 11 12 26500
1 Yenus 20 1 21 22 33500
2 Mars 30 2 32 35 41500
& Jupiter a0 g 23 26 50.500
4 Saturn a0 B fato] 90 60500
System Registers:
Selection:‘ 2 | Count:‘ 3 |Command:‘ o |Resu1t:‘ L |
Selected records: (modify here)
No. Name:
| 2 | |Mar5 |
Timer_1: Timer_2z: Timer_3: Timer_d: Spesd:
ERE [ 32 ||ss | |a1500
Create a recipe as shown in the following figure.
Systern Parameter Settings [==]
Device I Model I General I System Setting I Security | Font |
Extended Memory I Printer Backup Server &-Mail | Recipes
Redpes List :
Recpes (/A  Iemname Demtype Size Displaywi.. DecimslPt Aligam..
1. Recipe._Solar No 16-bitT. 1 5 0 Align left
Waime ARCIT m 8 1} Aligmn laft
Timer 1 33-bitE. 2 a 1} Aligm right
Timer 2 33-bitE. 2 a 1} Aligm right
Timer 3 33-bitE. 2 a 1} Aligm right
Timer 4 33-bitE. 2 a 1} Aligm right A
Speed I3-bitBL. 2 a 3 Aligm right
v

Use Recipe Records to create a number of records as shown in the following figure.
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Recipe Records &=
Redpes : m Delete
[ pa )
o  Hame Timer 1 Timer 2 Timer 3 Timer 4 Speed
1 0 Mexcury 10 1 11 12 6.5 A
201 Verms 20 1 21 22 335 v
3 2 Marz 30 2 32 35 415
4 3 Tupiter 50 3 53 56 50.5
54 Batum 80 5 a5 90 60.5
[ Export... ” Import... ] [ OK ] [ Cancel ]

3. Create a Recipe View object and use the recipe database created in the preceding steps.

4. Create 4 Numeric objects using registers “Selection”, “Count”, “Command”, and “Result”.

5. Create corresponding input objects for “No”, “Name”, “Timer_1", ..., “Timer_4", “Speed”.
For example, “Name” is an ASCII item with size “10”. Create an ASCII object and set device
type to “RECIPE” » “Name”.

Read address

PLC name | | Local HMI w Setting. ..

Address 1 |RECIPE

6. The project is then completed.

7. As shown above, “Mars” is selected and the corresponding items are also updated. There
are 5 records so the “Count” displays “5”. Try selecting different rows of the Recipe View
object. Fields “Name”, “Timer_1", ...will change accordingly.

8. Try the following operations:

® Add:

To add current data as a new record, enter “1” in “Command”.
® Update:

To update recipe database, enter “2” in “Command”.
® Delete:

To delete the selected record, enter “3” in “Command”.
® Sort the items.
® C(Click the title to change the order.

I__| WE'NTEK EasyBuilder Pro V5.05.02



Objects 13-184

Example 2

In this example, [RECIPE_Bit] can be used to read / write individual bits of Recipe data.
Although BOOL type items cannot be added to Recipe Database, individual bit access of 16bit /
32bit data is possible.

As shown in the following figure, select [RECIPE_Bit] for the read address of Bit object and
point to the target item, and then the available Bit selections will be displayed. In this manner,

Recipe Database can be used to record, read, and write bit data.

Recipes List :
Recipes H.‘.‘ F Tt namme Diata tpe Jize Display width Decimal Ft. & 1i et
e ie ‘ e 16-bit Unsigned |1 5 ] Align left
B 2-bit Unstgned 2 5 0 Align left
z 32-bit Unsigned 2 5 1} Align left
Read address
PLC name ! | Local HMI w | Settings...
Address | | RECIPE_Bit vl Helechon-0 -
myRecipe » Selection »
[_IInvert signal Count »
Command 3
Result 3
| A v 0
B 2 1
C » 2
3
Fil
5
B
7

= oo
(=]

[ 'y
o P =

Y
%]

I__| WE'NTEK EasyBuilder Pro V5.05.02



Objects 13-185

13.34. Flow Block

13.34.1. Overview

Flow Block object displays the flow status of the blocks in the pipe or the status of the
transportation lines. Unlike Moving Shape object which requires a precise measurement
between two points when drawing a straight line provided by users, the blocks flow at a fixed
interval in a horizontal or vertical straight line.

The features of Flow Block:
® Each section of the Flow Block must be a horizontal or vertical straight line and the blocks

flow at a fixed interval within it.
® Dynamic speed and direction adjustment (Speed and direction can be controlled by a

designated register.
® Security mechanism (Interlock), which hides Flow Block when the status of designated bit

is invalid.

13.34.2. Configuration

i

Click on the Flow Block icon on the toolbar or select [Objects] » [Flow Block] to create object.

General Tab
Flow block Object's Properties
[ General ;Ouiirirne lWSecurityrj
Comment :
Flow speed
[T Reverse direction
[7] pynamic speed
Flow speed : [5 -
Setting Description
Reverse The blocks flow in the direction the object is drawn (the blue
direction arrow). If select this check box, the blocks flow in the opposite
direction.

Flow-direction

=
-

—

-~
Reversedirection
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Dynamic Read address

speed The direction and speed at which the blocks flow can be controlled
by a designated register. The valid rage is -25 to 25. When a
negative value is entered, the blocks flow in a reversed direction.
Setting
Displays the address and format of the designated register. [System

register], [Index register], and [Tag Library] can be set here.

Flow speed 25 flow speed levels, the valid range is 0 to 25 when [Dynamic
speed] is not selected. A larger value indicates a faster speed.

Outline Tab

For setting the outline property of Flow Block. The following illustration shows each item.

Pipe Background Color

PipeBorder Widt

Pipe

) Width
Pipe
Border
Color

Block " Block Block Block
Inter-  Length Width Color
val
Flow block Object's Properties (=2
[ General | Outline | Security|
Pipe
Width: |23 -
[¥] Border
Width: |2 v
Color : | G |- |
Background
Color: [+
Block
Width: |15 -
[¥] Dymamic color
PLC : Local HMI [ Settings...
No.  Color - New
% |
1 [mEiiisi |=
2 Omom |
3 [OcOe0ed [
4 @ m
5 [ 8080ff
6 I {0000 2
[ OK ] [ Cancel 1 Help
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Setting Description
Pipe Sets the properties of the pipe within which the blocks flow. The
background color, border width and color can be set. When the
[Border] check box is selected, the background color must be set.
Block Sets the properties of blocks. Width, length, interval and color can
be set here.
Dynamic Allows dynamic color change. Nine customized colors, numbered
color from O to 8, are allowed. The color is selected by entering a value in

the designated register. Entering a value greater than the largest
color number changes the Flow Block to the last color in the list.

@ Note

If both [Reverse direction] and [Dynamic speed] check boxes are selected in [General] tab,
when entering a negative value in the designated register of dynamic speed, the blocks
flow in the direction the object is drawn.

To avoid the pipe lines from overlapping when drawing a turn, there is a minimum width
planned at each turn. As shown in Fig. 34.1, the sign on the cross cursor defines the

minimum width. Fig. 34.2 demonstrates that each turn is drawn in the minimum width.

£

(Fig. 34.1) (Fig. 34.2)

The valid range of the length, width, and height of the Flow Block can be adjusted
according to the size of the object drawn and the size of the window.

As shown in the following figure, when the size of the Flow Block is larger, the valid range
is restricted to prevent the flow block from exceeding the window size. When the size of

the object is smaller, the adjustment range will be larger.

To prevent the flow block from overlapping itself, when the distance between two lines is
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shorter (Section A), the valid range is restricted. When the distance is longer (Section B),

the adjustment range will be larger.

Example 1

The demonstration below shows how to use [Dynamic speed] to control the direction and

speed of Flow Block by a designated word register.

1. Create a Flow Block object and select [Dynamic speed] check box. Set [Address] to LW-0,
and set the format to 16-bit Signed.

Flow block Object's Properties 22

General | Qutiine | Security

Comment ;

Flow speed
Reverse direction
| Dynamic speed
Read address
PLC name : |L0ca| HMI - | | Setting...
Address :||_l,a\.,l v| 0 16-bit Signed

2. Create a Numeric object, set [Address] to LW-0. The high limit is 25, and the low limit is
-25. The format is 16-bit Signed.

@ Direct Dryaic limits
PLC low @ -2% PLC high: 2%
Inputlow : | -25 Input high: |25

3. Execute simulation or download the project to HMI. When entering a positive value in
LW-0, the blocks flow in the direction the section is drawn. A larger value indicates a faster
speed. When a negative value is entered, the blocks flow in a reversed direction, and the

smaller value indicates a faster speed. When 0 is entered, it stops flowing.

in Click the icon to download the demo project. Please confirm your internet connection.
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13.35. Operation Log

13.35.1. Operation Log Settings
13.35.1.1. Overview

Operation Log records user’s operation steps and displays the record in real-time. When an
error occurs, use operation log to analyze the problem. The backup tables can be used to

review the process in order to resolve the errors.

OperationLoc

emT =000

Operation Log

Operation Log Object Can
be created on your project
screen, for reviewing data
when an error occurs.
Current User : admin

ID: Admin PW: 111
ID: Leo  PW:222
ID:Joy PW:333

After selecting the capsule to pack and
the label, run A1 machine, the process
is all recorded in Operation Log View.

Note:
To change the capsule or label,
please turn OFF A1 machine.

03/05M13  18:17:47 full privilege 10 TS0 A1 Power
03/0513  18:17:46 full privilege 10 TS O A1 Power
4

13.35.1.2. Configuration

&,

Select the objects to be recorded. Click [Objects] on the main menu, point to [Operation Log],

click [Operation Log Settings], and then select [Enable operation log function] check box.
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Operation log 23 |
Enable operation log function
Object W= Enable Comment il
[ 5:FLC Response [
2F|FK 0 =]
= 6 : HMI Connection
2F|FK 0 =]
= 7 : Password Restriction
2F|FK 0 =]
= 8 : Storage Space Insufficient
2F|FK 0 =]
= 10 WINDOW_010
LED O
SW_n Laginl
aw_1 Log out
ERoLn Tser ID
HSB D Green Label il
R =T | =2l Pad T ahal
1 [ | +
[ Select all ] [ Discard all ]
Storage settings
Maximum record no. in HMI memory
External devices for synchronization / backup
75D card ] usE disk
Behavior when HMI space is insufficent
(@) Stop saving operation log
= Synchronize to external device. If the device does not exist, erase the oldest
~ records.
Control address
PLC name : |Local HMI + | setting...
Address : 10 16-bit Unsigned
[ oK ] [ Cancel ]
Setting Description
Object When Operation Log is enabled, the objects with write function are
listed in the setting dialog box sorted by window numbers.
[Filter]: By clicking = icon, the objects with write function are
listed. Users can filter out the objects that need not to be recorded,
and the log displays only the selected objects.
Enable The selected objects are recorded by Operation Log.
Comment The description of the object as shown in the following figure.

Set Word Object's Properties

General |Securit5-I I Shape | Label | Proﬁlel

(2]

Comment : Login
Write address

Address : LW-100 16-bit Unsigned

[T wirite after butgn is released

=10 WINDOW_010

LED &)

SW_0 Login

AW Logout
EHoL_0 User ID
WlSB D Gireen Label

k=1 =2l Pad T ahal

4| [

PLC name : [Loml th\ - | Setting...
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Select all

Selects all the listed objects. If [Filter] is used, clicking [Select all]

only selects the objects in the list.

Discard all

Discards all the selected objects. If [Filter] is used, clicking [Discard
all] only discards the objects in the list.

Storage
settings

Sets the way the records are stored.

Maximum record no. in HMI memory

Sets the maximum number of records that can be stored in HMI
memory.

External devices for synchronization / backup

Stores backup data to SD card or USB disk.

Behavior when HMI space is insufficient

When HMI memory space is insufficient, two options are provided:
[Stop saving operation log]: Stops saving new records in order to
keep the earlier records.

[Synchronize to external device]: Stores the Operation Log to the

external device. When the device does not exist, the HMI clears the

oldest records in its memory.

Control
address

Entering different values in the control address sends
corresponding commands to Operation Log and returns the result
of executing the command.

If control address is LW-n (where n is an arbitrary number), the
address that returns the result of executing the commend is
LW-n+1.

Control address (LW-n):

(1): Clear all records.

(2): Copy the records to the USB disk.

(3): Copy the records to the SD card.

(4): Copy the records to the USB disk and clear the records in HMI
memory.

(5): Copy the records to the SD card and clear the records in HMI
memory.

Execution result (LW-n+1):

(0): Processing.

(1): Execution succeeded.

(2): The device does not exist.

(3): The record does not exist.

(4): Unknown error.

L—| WE!NTEK

EasyBuilder Pro V5.05.02



Objects
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B Operation Log can only record the operation of the objects that are manually triggered.
Objects that cannot be manually triggered are not recorded, such as Time Based Data

Transfer object.

B When running off-line or on-line simulation, Operation Log is stored under EasyBuilder
installation directory: HMI_memory\operationlog\operationlog.db

B Triggering Macro with a Set Bit object generates two records, the triggering of bit and the
triggering of Macro.

13.35.2. Operation Log View

13.35.2.1.

Overview

Operation Log View can be used to review the Operation Log.

13.35.2.2.

Configuration

Before using Operation Log View, please follow the steps described in the preceding

part to finish Operation Log Settings. Click [Objects] on the main menu, point to

[Operation Log], and then click [Operation Log View].

General Tab

I__| WE!NTEK

Operation Log View Object's Properties =]
General | Title | Shape | Profile
Comment :
Title
|:| Transparent
Profile
|:| Transparent
Grid
Enable
Selection control
Font
o) [ cans
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Title
i
-~
03/04/13 15:15:.07 full privi 10
03/04/13 | 15:15.07 full privilege 107 1™ M
03/04/13 15:15:.06 full privilege 10 | Selection
03/04/13 | 15:15:00 full privilege 10 1
03/04/13 15:14:55 full privilege 10 |1 Control
] 03/04/13 15:14:55 full privilege 10 |1
Profile 02/26/13 | 18:50:21 full privilege 10 |1
02/26/13 | 18:50:18 full privilege 10 [1
Frame & 02/26/13 | 18:50:15 full privilege 10—
Backeround 02/26/13 18:50:09 full privilege 10 |
ackgrou 02/26/13 | 18:50:07 full privilege 10 1w
4 | »
Grid

Setting Description

Title Sets the color of the title row.

Transparent: If selected, the title row will be transparent. The color
selection is not available.

Profile Sets the color of the frame and background of the object.
Transparent: Hides the frame and background. The color selection
is not available.

Grid Sets the color of the dividing lines between the columns and rows.
Enable: If selected, displays the grid, otherwise, hides the grid.

Selection
Sets the color of the selected row.

control

Font Sets the color, font, and font size of the text displayed in Operation

Log View object.
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Title Tab

Operation Log View Object's Properties @

| General | Title |5hape | Pmﬁle|

Title mame Title:

Sort
() Time ascending (@) Time descending

Order & Characters

Display itemns Displaych..
Date

Time

User name
Class

Tl i e
Cbject Name
Comument
Action
Address

| »

m

Information
User name

EEEEEEEREE
oo oo ooooo

If "Display chars”is 0, it means that the system will display all of characters.

o ) [ o ]

Setting Description

Title Sets the title displayed in Operation Log View object.

Sort Sorts the records in time ascending or descending order.

Display order Sets the order of the displayed item. If [Display chars.] is O, all

characters are displayed.

Date / Time Sets the format of date and time displayed in Operation Log View
object.

13.35.3. Operation Log Printing
13.35.3.1. Overview

Operation Log Printing can generate an Operation Log sheet by printing out using a printer or
by saving as JPEG file into an external device. Before using this function, please go to Operation
Log Settings to finish the settings.
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13.35.3.2.

=

Select “Enable [Operation Log] printing” check box and click [Settings] button to open the

Configuration

Operation Log Printing dialog box.

General Tab

[\& WEINTEK

Printing Manager

[~]Enable [Operation Log] printing

(=]

Settings...

oK ] [ Cancel

Operation Log Printing

General |Layout | Content

Comment :
Printer

Device : [SD card

Qrigntation

(@ Horizontal

Font

() Vertical

Name : [ il

Size : |Middle

Range

Within : 1000

Trigger address

Type: () Date

@) Record

record(s)

PLC name : [Loml HMIL

- | Setting...

Address l[LB

-

Preview

] [ Cancel
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Setting

Description

Printer

Select the device to save the Operation Log sheet. If a printer is
selected, the paper size should be A4. If an external device is
selected, the Operation Log sheet is saved as a JPEG file. The
system generates a folder named "operationlogsheet", and the files
saved in the folder are named "print date_sequence number". For
example, the first JPEG file saved on 2013/05/08 is named

130508 0000 and so on.

Orientation

Sets the layout of the Operation Log sheet to be horizontal or
vertical.

Font

Sets the font and the font size to of the Operation Log sheet. The
following table lists the corresponding size.
Size Title Content
Large 20 pt. 16 pt.
Middle 16 pt. 12 pt.
Small 12 pt. 8 pt.

Range

Sets the range of the Operation Log to be included in the sheet.
Date

Sets the range by date, counted from the start day through the
number of days entered. The maximum available range is 30 days.
Record

Sets the range by the number of records. The maximum available
range is 10000 records.

Trigger
address

Sets the register to control Operation Log Printing. When the
register is set ON, it starts printing. When the printing is done, the
register is set OFF automatically.

Preview

Preview the result before generating the Operation Log sheet.
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Layout Tab

=

Operation Log Printing

General | Layout | Content

"~ Titl
[7]Printed on all pages Itie

Operation Log Report -

Fl [’

Use label library Header ‘

Header
[#]Frinted on all pages

€MT3000 Series -
Demo created by EasyBuilder Pro

- 5
Use label library Content

Footer
|¥]Printed on all pages

Weintek Labs. , Inc -
Professional in Human Machine Interface

Pl »

Use label library
Footer

Date/Time
Display print time

Date : [MM/DD/YY -] Tme: [HH:MMiss -]

Page Number Date/Time

The layout of each part is shown in the above figure.

Setting Description

Title Sets the content of the title. The title is limited to one line.
Printed on all pages
If selected, the title is shown on each page; otherwise, the title is

shown on the first page.

Header Sets the content of the header. The header can have 5 lines in
maximum.
Printed on all pages
If selected, the header is shown on each page; otherwise, the

header is shown on the first page.

Footer Sets the content of the footer. The footer can have 5 lines in
maximum.
Printed on all pages
If selected, the footer is shown on each page; otherwise, the footer

is shown on the last page.

Date/Time If selected, the date/time the in the sheet is shown on the
lower-right corner of each page; otherwise, the date/time is not

shown.

Page number Shown on each page.
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Content Tab
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Operation Log Printing

General | Layout | Content

Tifle same Tifle

gt NamBM Oboct Noms
Camament . Comnent

BRI Action
TSI Addrss

Tnfosmafion . Informeton

Sort

() Time ascending @ Time descending

Order & Characters

Diisplayr dtems
Date

Time

Clas
Window
Cibject Name
Comument
Action
Address
Information

EEEEEEEEE

Date : |MMDD/YY v | Time: |HH:MM:5S v

Display chars Dizplay order

10
10

Date

Time

B Class
Window

Object Mame

Iﬂ Comment
Action

Address

Information

|

O

) i) (o

Setting

Description

Title

Sets the title displayed.

Sort

Time ascending

The latest record is placed at the bottom.

Time descending

The latest record is placed at the top.

Date/Time

Sets the format of date and time displayed.

13.35.3.3. Demonstration

Example 1

The following demonstration explains how to create an Operation Log project.

1. Create a Toggle Switch object and a Numeric object on window number 10.

2. Go to Operation Log Settings; enable the Toggle Switch object and Numeric object on

window number 10.
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Cibject

W= Enable Comument

= 5:PLC Response
=F|FK_0

= & HMI Connection
=F|FK_0

= 7 Pazsword Eestriction
=F|FK_0

= 8 : Storage Space Insufficient
=F|FK_0

= 10 WINDCW_010

IEEEEO O @ O O

Login
Logout
Taer ID

(rreen Label
Pad T ahal

UL

3. Create an Operation Log View object and finish relevant settings.

4. Run off-line simulation; trigger Toggle Switch and Numeric object. Operation Log is

displayed by Operation Log View object.

@ Toggle

5

Numeric Input

03/05/13
03/05/13
03/05/13
03/05/13
03/05/13

18:52:38
18:52:35
18:52:35
18:52:34
18:52:34

Toggle Switch  Toggle Local HMI
Toggle Switch  Toggle Local HMI
Toggle Switch  Toggle Local HMI

LW-10

LB-0

Numeric Input  Setword Local HMI :
:LB-0
:LB-0
:LB-0
Toggle Switch  Toggle Local HMI :

write 5

bit set OFF
bit set ON
bit set OFF
bit set ON

¥

= Click the icon to download the demo project. Please confirm your internet connection.

Example 2

Upload Operation Log to PC by using Utility Manager or use Backup object to send the file by

email.

® Upload by Utility Manager
1. Open Utility Manager, click [Upload].
2. Select [Operation log], enter file name and HMI IP, and then click [Upload].
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[¥ Operation log

Upload

eMT3000 Series.

I~ Project

I~ RW

™ RW_A

[~ Recipe database

Ci\Usersluser\Desktop\Operation Log file.db

I~ Data log
[~ Eventlog

I~ Extend Memory (EM)

Browse.

Connection
¥ Ethemet " USE cable
ﬂ P Mame ﬂ
IP: 1192.168.1.100 A
Upload | ‘ Settings. ‘ Exit

Send the sheet by e-mail

1. Open [System Parameter Settings] » [e-Mail] tab. Set e-mail server and the address of

recipient and sender.

position] select [e-Mail].

Mew Backup Object

General Securitylshape Label | e-Mail

£

Comment :
Source
CIRW

CIRW_A () Recipe database

() Historical event log

@ Operation log

Backup pasition

Historical data sampling

Mote : Use LW-9032~3039 to change the backup folder name.

15D card () USE disk

Remote printer/backup server

server in [System Parameter] [Printer/Backup Server] settings.

Trigger

Mode : | Touch trigger -

Mote : Use [Remote printer/backup server] to store data to a remote PC. Enable the

Create a Backup object, under [Source] select [Operation log], and under [Backup

& For more information about e-Mail settings, see “5 System Parameter Settings”.
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13.36. Combo Button

13.36.1. Overview

Combo Button can execute multiple commands. The former way was to overlay multiple
objects in the same position, and the commands are executed in the order of the layer of the
objects. This takes time to test the order when planning the project. Combo Button allows
users to easily set multiple commands with one object, and freely adjust the order of executing
commands.

The following are the features of Combo Button:

® Executes multiple commands.

® Allows adjusting the order of executing multiple commands.

® Displays the state in Bit or Word Lamp.

13.36.2. Configuration

=

Click the Combo Button icon on the toolbar to open a Combo Button object property dialog
box. Set up the properties, press OK button, and a new Combo Button object will be created.
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Objects
General Tab
Combo Button Object's Properties @
General | Security | Shape | Label | Profie |
Lamp
Mone
Bit lamp
Word lamp
Actions
r“be constan Set style:
A Delay (50 ms) Write address
E] Change window {11. Win [Local v v]
LB |0
(]
Add -
Setting Description
Lamp The mode to display the state of a designated bit or word register.

None: Not using lamps to show states.

Bit Lamp

Displays the state of a designated bit address.

[Invert Signal] Reverses the display of ON / OFF states. For example,
if [Invert signal] check box is selected, when the designated bit is
OFF, the object displays ON state.

Word Lamp

Displays the state according to the value of a designated word
register.

[No. of state]: The number of states used by the object. The state is
numbered from 0, so the number of states minus 1 will be the state
number. If the value in the word register is > [No. of states] defined
in Attribute, the highest state will be displayed.

If the number of states is set to 8, the valid states will be O, 1, 2, ...,
7. In this case if the word value is 8 or higher, the system will

display the state 7 shape.
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Actions

There are four types of actions: [Delay], [Set Bit], [Set Word], and

[Change window]. A combo button can execute up to 20 actions.

Al v

Change the order of the actions.

Copy E Paste |E Delete

Copy, paste, or delete the selected actions.

Add

Delay
Delays the action for a few seconds. A combo button can set one
[Delay] action only.

Set Bit

Sets the designated bit ON or OFF.
Set style Description
Set ON Set ON the designated bit of the device.
Set OFF Set OFF the designated bit of the device.
Toggle Alternates the bit state each time pressed.
Momentary Holds the bit ON only while button is pressed.

Set Word

Sets the value in the designated register.

Set style Description

Write Writes a constant value to the designated
Constant )

Value register.

JOG+ Increases value in register by a set amount in

[Inc. value] each time when the button is

pressed, to the [Upper limit].

JOG- Decreases value in register by a set amount in
[Dec. value] each time when the button is
pressed, to the [Bottom limit].

:?yr)tamic Sets the Upper / Bottom limit by a designated
imits

register.

When Dynamic Address is LW-n, where n is an
arbitrary number, set upper limit when using
[JOG+], and bottom limit when using [JOG-].

Change Window
Switch to the designated window. A combo button can only set one
[Change Window] action, and this action is always the last one

executed.
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13.37. Circular Trend Display

13.37.1. Overview

Circular Trend Display object draws the trend curve of Data Sampling in a polar coordinate
system, where y-axis represents the radial coordinate and the x-axis represents the angular

coordinate. The way to use this object is similar to using Trend Display object.

051513 15:13

™

Y

15:58 15:28

15:43

M| «|@ LA

13.37.2. Configureation

@

Click the Circular Trend Display icon on the toolbar to open the property dialog box. Set up the

properties, press OK button, and a new Circular Trend Display object will be created.
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General Tab

13-205

Circular Trend Display Object's Properties =]
General |Trer1d | Channel I Shape IProﬁIe|
Comment :
Mote @ if no. of channels is changed, you must reset HMI's data samplings !!
Distance : haur(s) Start position : |Up -
Dynamic X-axis ime rangs
PLC name : ’Loml HMI v] Setting...
Address i[LW - | 100 16-bit Unsigned
Zoom injfout
Enable
PLC name : [Loal HMI v] Setting...
Address :[Lw - | 200 16-hit Unsigned
Hold control
Enable
PLC name i[Loml HML v] Setting...
Address :[LB |0
Watch line
Enable
PLC name i[LoaI HMI v] Setting...
Address : ’LW - | 300
Time stamp output
Enable
PLC name :[Loal HMI v] Setting...
Address : [LW v] 400
o) (o)
Setting Description

Data Sampling

Selects the data source for drawing the trend curve.

Type

Selects the type of the trend from [Real-time] or [History].
Real-time

In this mode, it displays a fixed number of sampling data
from the moment HMI starts to present. The number of
sampling data is determined by the [Max. data records
(real-time mode)] setting of Data Sampling object. If the
number of sampling data exceeds this number, the earlier
data will not be displayed. To display earlier data or the
data in other days, please select [History] mode.

[Hold control] address can be used to pause refreshing the
display. This only stops displaying new data in the Circular
Trend Display object, and the data is still being sampled by

[y
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Data Sampling object.

History

In this mode, it displays the sampled data sorted by date.
Select the data source from [Data Sampling], and then use
[History control] address to view the records of different
dates.

Note

If [Show scroll control] check box in Trend Tab is not
selected, the earlier data cannot be viewed when
exceeding the specified [Distance].

For example: Set [Distance] to 1 (hour.), then sampling data

earlier than one hour is not displayed.

Refresh data If enabled, the window in which the Circular Trend Display
automatically object (in history mode) is placed will be refreshed once
per second.

® The scroll controls can be used to check the refresh
status.
If M putton is displayed, the Circular Trend Display
will be automatically refreshed.
If 21 putton is displayed, the Circular Trend Display
will stop being refreshed.
® Scrolling backward and viewing earlier data will
disable [Refresh data automatically]. The button
displayed is 1 at this moment.
® If [Refresh data automatically] is selected, the display
is refreshed when change back to this window,
regardless of the use of scroll controls.
Example: If [Refresh data automatically] is selected,
scrolling to the earlier display stops auto-refresh. At this
moment change to another window and then change back,
the Circular Trend Display is still refreshed.
If [Refresh data automatically] is not enabled when
building the project, to enable it directly on HMI, simply
press > 1 Please note that auto-refresh remains disabled

after window change.
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Distance

Defines the time length that the circle represents, the unit

is hour, the range is 1 to 24 (hours).

Start position

The position from where to start drawing the trend curve.
(Up) (Right)

14:27:06 051513

14:26:46 051513

=
=

~

14:15

15:00 14:30 14:45
Q—y

14.45 14:30

o\

(Down) (Left)

14:27:36 051513 14:27:56 051513

14:45 14:30

14:30 5:00 14115 14.45

&

Dynamic X-axis

time range

If selected, a word register can be designated to control the
time length of Circular Trend Display. The unit is hour. If no

value is entered, the distance is set to default.

Zoom in / out

Enlarge or reduce the size of the object. The maximum size
is 10 times larger. If 0 is entered in the designated register,
the effect equals entering 1, the object remains the original

size.

Hold control

When the register is set ON, suspend the update of Circular
Trend Display. It does not stop the sampling process of
Data Sampling object. This setting is available only in

Real-time mode.

History control

History data is sorted by date. The system uses [History
control] to select the history data that are created in
different dates and then displays it by Circular Trend
Display object.

If the value of the designated register in [History control] is
0, the Circular Trend Display object displays the latest

[y
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record. If the value is 1, the second latest record is
displayed and so on. This setting is available only in History
mode.

If use with Option List object and select data source as
[Dates of historical data], the history data will be sorted by
date and displayed in Option List object, see “13.29 Option
List”.

In the following example, when history control address is
set to LW-0, and there are 4 sampling data: 20061120.dtl,
20061123.dtl, 0061127.dtl, 20061203.dtl. The
corresponding data selected by the value in history control

address is as the following list.

Value in LW-0 The sampling data displayed
0 20061203.dtl
1 20061127.dtl
2 20061123.dtl
3 20061120.dtl

Watch line

Displays a watch line when user touches the Circular Trend
Display object, and the sampling data at the position of the
watch line is output to the designated register. To display
sampling data with multiple channels, the system
consecutively writes the data of each channel to the
designated word register and the following registers. If the
data format of each channel is different, the channels are
sorted by the data format of its corresponding register.

In the following example, when watch address is set to
LW-0, and there are 4 sampling data, the format of each
data is: 16-bit Unsigned, 32-bit Unsigned, 32bit Signed, and
16-bit Signed. The corresponding watch address is as the

following list.

Channel Data Format Data Length | Watch Address
0 16-bit Unsigned 1 Word LW-0
1 32-bit Unsigned 2 Words LW-1
2 32-bit Signed 2 Words LW-3
3 16-bit Signed 1 Word LW-5

Time stamp output

If selected, the system will start counting time from the

first data sampled, and output the elapsed time counted of
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the latest data sampled to the register designated in [Time

stamp output + 2]. When pressing a point on the trend

curve, the relative time of the nearest data sample is then

output to [Time stamp output address].
Note
The format of the register designated in [Time stamp

output] and [Time stamp output + 2] must be 32-bit. [Time

stamp output + 2] is only available for Real-time mode

while [Time stamp output] is available for Real time mode

and History mode.

Trend Tab

I__| WE!NTEK

Circular Trend Display Object's Properties =]
| General | Trend |Channel I Shape IProﬁIe|
Profile
[ show scroll controls
Grid
[Enable color: I [~
Y -axis : division(s)
Time scale
Channel scale
[ Enable
Time [Date
Time @ HHMM:SS () HH:MM
Date @ MMODNY (D DDMMAY D DDMMYY D) YYMMDD
o ) [ o
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Time/Date < osts1s

10:38 /

13-210

0953
—>Frame

——> Background

Grid

)

)/ 1008=—> Time Scale

>Channel Scale

10:23

| wm l ]

Scroll Control

Setting

Description

Profile

Frame

Sets the color of the frame of the object.
Background

Sets the color of the background of the object.
Show scroll controls

The scroll controls are displayed for scrolling to view
the sampling data of other time range. The
minimum scrolling unit is determined by the setting
of [Distance] in General tab. If [Show scroll controls]
check box is not selected, the earlier data cannot be
viewed when exceeding the specified [Distance].
For example: Set [Distance] to 1 (hour.), then

sampling data earlier than one hour is not displayed.

Grid

Sets the number and the color of the dividing lines.
Y-axis

Sets the number of divisions on Y axis.

Font size

Sets the size of the font which labels the time scale
or channel scale.

Time scale

If enabled, displays the time scale. When the time
length is longer than 1 hour, the scale division is 1

hour. When the time length is set to 1 hour, the scale
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division is 15 minutes.

Channel scale

If enabled, displays the channel scale. The color of
the font which labels the channel scale corresponds

to the setting of the trend curve of each channel.

Time / Date Time
Sets the display format of time.
Date
Sets the display format of date.

Channel Tab
Circular Trend Display Object's Properties @
| General | Trend | Channel | shape | Profie |
Data sampling object
Channel Display  Description Diata tvpe
y 0 16-bit Unsigned 16-bit Unsigned
1 16-bit UTnsigned 16-bit Unsigned
2 16-bit Tnsigned 16-bit Unsigned
3 16-bit Unsigned 16-bit Unsigned
4 16-bit Unsigned 16-bit Unsigned
Channel
Pen property
[ ynamic limits
Zero: 100 Span : 1000
Channel visibility contral
[¥] Enable
PLC name : | Local HM v | setting...
Address :’Lw ~ | 250 16-bit Unsigned
Display channel when the corresponding bit is :
TIOM @ OFF
] [one
Setting Description
Channel Sets the style and the color of the trend curve, and

the upper and lower limit of data that can be drawn
on the trend curve. Up to 8 channels are supported
simultaneously.
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Not selecting [Dynamic limits]
The upper and lower limits of the data are set by
constants.

Selecting [Dynamic limits]

The upper and lower limits are set by the designated
register. When the address is LW-n, the
corresponding addresses are as the following list.
Data format |16-bit 32-bit
Lower limit  |[LW-n LW-n
Upper limit  [LW-n+1  [LW-n+2

Channel Visibility
Control

If [Enable] is selected, the bits of the designated
word register will be used to show/hide each
channel. First bit (Bit-0) controls the first channel;
second bit (Bit-1) controls the second channel, and
so on.

Display channel when the corresponding bit is:

If [ON] is selected, when the corresponding bit is
OFF, the channel is hidden. If [OFF] is selected, when
the corresponding bit is ON, the channel is hidden.
In the following example, the control address of
channel visibility is set to LW-0 and each channel
shows when the corresponding bit is OFF. If there
are 5 channels, the visibility of the channels is as the

following list.

Channel | Control address | Bit state | Display
0 LW_bit-000 OFF YES
1 LW_bit-001 ON NO
2 LW_bit-002 ON NO
3 LW_bit-003 OFF YES
4 LW_bit-004 OFF YES

L—| WE!NTEK
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13.38. Picture View

13.38.1. Overview

13-213

Picture View object plays slideshow of picture files saved in an external device such as a USB

drive or SD card.

13.38.2. Configuration

Lo!

Click the Picture View icon on the toolbar to open the property dialog box. Set up the

properties, press OK button, and a new Picture View object will be created.

General Tab

Picture View Object's Properties @
General | Security I Profile
Comnrment :
Crotline
Bickground ol
Font : [.ﬂ,rial - ]
[ Display with original size when a pictore size iz smaller than the object size.
File position
@ 2D card (7 USE disk
Diirectory
Dy folder path
Address : [LW |0 20 word(s)
File slection
Specify file from address (hide toolbar)
Address : ’LW - ] i} 20 word(s)
* Filenames must contain only ASCI characters. Unicode is not supported.
[ QK ] [ Cancel Help
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Setting Description

Outline Sets the toolbar position, background color, and text font
of the Picture View object.
Hide delete button
If selected, the delete button will not be displayed on the
Picture View object toolbar. The delete button is used to
delete the picture currently viewed.
Display with original size when a picture size is smaller
than the object size.
If selected, when the size of the picture is smaller than the
Picture View object, this setting helps to prevent distortion
caused by enlarging the picture.

File position Select the file source of the picture files from [SD card] or
[USB disk].

Directory The directory where the picture files are saved.

Dynamic folder path
Designate folder path by a local address.

File selection

Specify file from address (hide toolbar)
If enabled, the displayed picture is designated by a file
name in a local address, and the toolbar will be hidden.

@ Note

B The file name must be all in ASCII characters, and the Unicode characters are not

supported.

B The supported picture formats are: .jpg, .bmp, .gif, .png.

L—| WE!NTEK
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13.39. File Browser

13.39.1. Overview

File Browser object can display files and folders saved in the SD card or USB disk. Apart from
browsing for the files in the external devices, the name of the file and the file path selected in

File Browser object can be written to the designated address.

13.39.2. Configuration

S,

Click the File Browser icon on the toolbar, or select Tools » File Browser to open a File Brower

object property dialog box and set up the properties.

General Tab
New File Browser Object @
[ General lOutline [ Security I Shepe |
Folder path address
[V] Enable
PLC: [Local HMI v] Settings...
Address : [LW v|0 [ “D0word(s
File name address
[V] Enable
PLC : [Local HMI - [ Seftings...
Address: [LW ,J 0 20 word (5)
Full {folder + file name) address
[] Enable
PLC: [Local HMI [ Settings...
Address : [LW .q 0 20word(s)
Control address
[V] Enable
PLC : (Local HMI v [ Settings...
Address : [LW v 0 22word(s)
Command : LW-0
0 :none, 1 : delete, 2 : rename
Result: LW-1
0 : success, 1 or more : error
New file name : LW-2
OK ] [ Cancel
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Setting Description
Folder path address Current directory.
File name address The file name of the currently selected file.
Full (folder + file The full directory and file name of the currently
name) address selected file.
Control address Designate the control address used for deleting a
file or changing file name in File Browser.
Command: Control Address
0: None
1: Delete
2: Rename
Result: Control Address+1
0: Success
1 or more: Error
New File Name: Control Address +2
Outline Tab

[\& WEINTEK

[ New File Browser Object &
| General | Outline | Security | Shape |
File position : () $D card © USE disk
File type : [All files v
Font
[ Axial -
Color : | G :l Size : [12 v
Background
[ Transparent
Cotor:
Color
Grd: [ :l Select box : [j@
(o ][ conce
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Setting Description

Folder position Select the position of the file from SD card or USB
disk.

File type Select all files or only CSV file to be displayed.

Font / Background

/ Col Set the attributes and font of the object.
olor

@ Note

B The file name and the directory of the selected file will be written to the designated

address, but changing the contents of the designated address will not change the selected
file in the File Browser.

B The system will read the folder path address and file name address when the HMI is
restarted or when an external device is inserted to the unit. If valid data is can be read
from the designated address, the system will then automatically navigate to the
appropriate directory and highlight the file according to the data read. If [Folder path
address] is not enabled, the data at Full (folder + file name) address will be read.
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13.40. Import/Export

13.40.1. Overview

With Import/Export object, Recipe Database or String Table can be imported or exported.

13.40.2. Configuration

Click the Import/Export icon on the toolbar to open the Import/Export Object management
dialog box. To add an Import/Export object, click [New], set up the properties, press OK button
and a new Import/Export object will be created.

New... Delete Setfings... Exit
E J | | B |
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General Tab

mporyErpon =
Creneral
Diescription :
Tupe [Recipe databage v]
Recipe : [Recipe v]
File position : @ UZE disk
Control address
PLC : [Local HML - ][ settings...
Address : [LW v] 100 16-bit Unsigned
Comtral : LW-100
0 :None, 1 : Import, 2 : Export {(no overwrite), 3 - Export
Statos: LW-100+ 1
0 :Idle, 1 : Busw
Result: LW-100+ 2
1 : Success, 4 or more : Enor
File name address
[ Include folder path
PLC : [Local HMI - | settings...
Address : [LW v] 20 20 word(s)
Folder path address
PLC: [Loml HML v] Settings...
Address : [LW v] i} 20 word(s)
o) Lo
Setting Description
Type Select the file source from Recipe Database or

String Table.

File position

Select the external device from SD card or USB disk

for import/export.

Recipe

Select the recipe. This option is hidden when select
String Table.

Control address

Designate the control address used for performing
import/export, or displaying the result.

Control: Control Address

Recipe Database:

0: None

1: Import

2: Export (no overwrite)

3: Export

String Table:

0: None
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1: Delete

2: Import

4: Export (no overwrite)

5: Export

Status: Control Address+1
0: Idle

1: Busy

Result: Control Address +2
1: Success

4: The file already exists, no overwriting.
Other: Error

File name address

The name of the imported/exported file. If [Include
folder path] is selected, the full directory and file
name will be included at this address.

Folder path address

The directory of the imported/exported file.

Example 1

The following is an example on recipe export/import settings.

Field Setting

File position USB disk

Recipe Recipe_A (or other recipe)
Control address LW-100

File name address LW-200

Folder path address LW-250

A W INR

Create two ASCII Input objects. Set address to LW-200 and LW-250 respectively.
Enter the file name in LW-200: 2015_recipe.csv

Enter the folder path in LW-250: Setting

Use a Set Word object to write value 3 to LW-100. Then, Recipe_A will be exported to the

USB disk, in the “Setting/2015_recipe.csv” file.

@ Note

B When performing “Export (no overwrite)” command, if the target file already exists, the

export operation will be canceled, and the result value will be set to “4”.

The following lists the result values and the information.
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Result (HEX) Information

Ox1 Success.

0x4 File already existed and will not overwrite.

0x100 Data contains non-numeric data.

0x101 Path contains invalid string “.”.

0x102 Communication error while updating Recipe DB.

0x103 Error while reading Recipe DB information from
project file.

0x200 General exception.

0x201 General status error.

0x202 Import to unknown database type.

0x203 Error while validating Recipe DB table definition.

0x204 Error while validating Recipe DB table data.

0x205 Error while writing Recipe DB table definition.

0x206 Error while writing Recipe DB table data.

0x300 File error: Unknown error.

0x301 File error: Empty file name.

0x302 File error: The external device does not exist.

0x303 File error: Invalid file name (directory or special
files), or a folder with the same name already exits.

0x304 File error: Unable to remove file.

0x305 File error: Open file stream error.

0x306 File error: Unhandled BOM.

0x307 File error: Error while parsing CSV file (incorrect
formats).

0x308 File error: Insufficient space on the external device.

0x400 Database general exception.

0x401 Database error: Unable to open table.

0x402 Database error: Unable to get rows.

0x403 Number of columns in CSV file and in Recipe DB do

not match.

[\& WEINTEK
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13.41. Pie Chart

13.41.1. Overview

The Pie Chart object draws a pie chart that is divided into slices to illustrate numerical

proportion, according to the value of the designated read address.

13.41.2. Configuration

€

Click the Pie Chart icon on the toolbar to open the property dialog box. Set up the properties,

press OK button, and a new Pie Chart object will be created.

General Tab
[ Pie Chart Object's Properties M
General | Security | Profile
Hole ]
Bordercolor: ] ___'
Data display
Style : [Value v]
Font: [Arial -
Right of decimal Pt. :
Read address
PLC name : Local HMI + [ Settings...
Text color : _ : Background color : || :
Pattern color : Pattern style : | [E
——]—
Setting Description
Angle Set the [Start degree] of the chart. Choose the Chart

to be [Clockwise] or [Counter clockwise].

If [Full circle] isn’t selected, then [End degree] must
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be set.
r ~
Degree @
@ Clockwise () Counterdodwise
Start degree : 0 End degree : 0
(i ircle

Hole

Set the size of the hollow circle in the center of Pie
Chart.

No. of channels

Set the number of channels to be displayed in the
chart. The range is from 2 to 16.

Border color

Set the color of the border.

Data display

The [Style] can be set as [None], [Value] and
[Percentage]. The [Font] and [Size] are for the text
on the chart. For Value Style, the [Right of decimal
Pt.] can set the value on the chart to be displayed
with the decimal point. The [Right of decimal Pt.]

option is only available for [Value] style.

Read Address

The address is for channel 1. The following
consecutive addresses are for the rest of the
channels. For example, if the Read Address is LW-0,
then the Read Address for channel 2 is LW-1;
channel 3 is LW-2...and so on.

Channel

Set the [Text color], [Background color], [Pattern
color], and [Pattern style] of the selected channel.
The [Background color] is for the [Pattern style] that
has background. If the [Pattern style] doesn’t have a
background, then the [Background color] doesn’t

need to be set.
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13.42. 2D Barcode Display

13.42.1. Overview

13-224

The 2D Barcode Display object transfers the information from the read address into QR Code or

Aztec Code.

13.42.2. Configuration

ke

Click the 2D Barcode Display icon on the toolbar to open the property dialog box. Set up the
properties, press OK button, and a new 2D Barcode Display object will be created.

General Tab

Mew 2D Barcode Display Object

General | Security

Comument :

Mode [QR code v]

Comection level : [H (30%) - Defanlt v]

Color . —

[T nieode

Read address

PLC : [Local HMI ~ | Settings..
Bddress : [LW ~ |0

Length: 15 word (z)

Setting

Description

Mode

Supports QR code and Aztec code.

Correction level

2D barcodes have error correction capability to restore data

if the barcode is dirty or damaged.
QR code

Four correction levels are available: L, M, Q, and H. The data
restoration rate is listed below. (The data restoration rate for
total codewords. Codeword is a unit that constructs the data

area.)

Correction Level
7%
15%
25%
30%

TOL|m

Aztec code

Aztec code supports error correction levels from 5% to 95%.
Specifying a higher correction value results in a larger printed

symbol and increases accuracy.
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Color Set the 2D barcode color.

UNICODE By default, the 2D barcode is generated via ASCIl encoding. If
this check box is selected, the 2D barcode is generated via
UNICODE encoding.
For characters that are not ASCII defined English alphabets or
numbers, for example, Chinese or Korean characters, please
select the Unicode check box.

Read address The 2D Barcode Display object will display the 2D barcode
generated from the information entered by the read address.
The word length limit: 1 ~ 1024.
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13.43. String Table

13.43.1. Overview

13-226

By pre-configuring the texts and their corresponding numbers in the String Table, the text can

be changed dynamically on HMI. String Table can also be used in a multi-language

environment.

13.43.2. Configuration

S

Click the String Table icon on the toolbar to open the property dialog box. Set up the properties,
press OK button, and a new String Table object will be created.

String Table @
Section
([zD:000] Digits vJ[ Newsection || Delete Section
Description : Digits
String Table
String ID Langvage 1 Language 2 Langvage 3 Language 4 Langvage 5 Language 6 Langvage 7 Langvage 8
i 2 i T
2 3 three 2
New Delete [ exportcsvrie.. |[ ImportcsvFie.. |
[ Export EXCEL Fie... | [ Import EXCEL Fie... |
[ 0K H Cancel H Help I
Setting Description
Section A list of all the existing String Tables.
[New Section] Add a new String Table.
[Delete Section] Delete the selected String Table.
New Add a new string in the table.
Settings Set the content of the selected string.

Export CSV File...

Export all the existing String Tables as a *.csv file.

Import CSV File...

Import *.csv file into the String Table.

Export EXCEL File...

Export all the existing String Tables as a *.xIs file.

Import EXCEL File...

Import *.xIs file into the String Table.

0 Note

B The font of multiple languages in the String Table must be specified in Label Text Library.
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Example 1
1. Create a String Table using the same settings as the preceding figure.
2. Create a Text object, select [Use string table] check box. In String ID group box, select

[Dynamic] and set read address to LW-0.

New Text Object @
Text | Security |

Use label library | Label Libraxy... |

V| Use string table \ String Table... '

Section : | [1D:000] Digits v
String ID
V| Dymamic
PLC : Local HMI v |[ Seftings.. |
Address ’LW -1 0 16-bit Unsigned

3. Create a Numeric object, set address to LW-0.
4. When the value in LW-0 is 0, the No. 0 string is displayed; when the value in LW-0 is 1, the
No. 1 string is displayed.
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13.44. Database Server

13.44.1. Overview

Database Server object enables HMI to connect the MySQL database server in PC, allowing the

user to send sampled data or event log to the MySQL database server in PC.

13.44.2. Configuration

AP

Click the Database Server icon on the toolbar to create a Database Server object. Or, click

[Object] » [Database Server] in the menu.

MNew... ” Delete ” Settings...
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General Tab
Setting Description
IP Enter the IP address of the database.
Port Enter the port number of the database.
Username Enter the username for connecting the database.
The maximum is 32 words.
Password Enter the password for connecting the database.
The maximum is 32 words.
Database name Enter the name of the database for collecting
historical data.
Address Tab
Setting Description
Status address LW-n: Displays the connection status of Database
Server.
Value Description
0 Not attempting to connect to
database.
1 Failed to connect to database.
2 Connection succeeded.
LW-n+1: Error indicator.
Value Description
0 No error
1 or more An error occurred
Control address LW-n: Controls the operation of Database Server.
Value Description
0 Ready
1 Start
2 Stop
3 Update

LW-n+1: Sets the IP address of the database.
LW-n+5: Sets the port number of the database.
LW-n+6: Sets the username for connecting database.
LW-n+22: Sets the password for connecting
database.

LW-n+38: Sets the name of the database for
collecting historical data.

® |f sampled data is successfully synchronized to the SQL database, three tables will be

generated in the database, and the sampled data is saved in * _data table.

Table Description

<HMI NAME> <DATALOG NAME> data Saves data sampling
<HMI NAME> <DATALOG NAME> data format System folder

<HMI NAME> <DATALOG NAME> data section System folder
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® When synchronizing event log, the three tables generated in the database are listed as
the following table, and the event log is saved in *_event table.
Table Description
<HMI NAME> event Saves event log
<HMI NAME> event_log System folder
<HMI NAME> event_update_time System folder
® If the content of data sampling / event log, such as data format or event message, is
changed and downloaded to HMI, please delete the tables listed above first, and then the
new content will thus be effective.
Example 1
1. Create a Database Server object, set Status Address to LW-0, and Control Address to
LW-10.
Database Server \EI Database Server @
General | Address General | Address
Comment - Htatos address
PLC : [Local HMI - ][ settngs...
IF: 127 X 0 0 1 Address @ | Ly -0
Port: 3306 Status - LW-0
I — (0 Stopped, 1 : Disconnected, 2 : Connected )
b - Errox : LW-0+1
e L (0 Svceess, 1 or more : Emor )
Diatabase name © gatshes
Control address
[¥] Enable
PLC : |Local HI ~ [ settngs...
Address : miv 10
Command : LW-10
{0:Mone, | - ¥tart, 2 Stop, 3 Update )
1P LW-10+ 1 {4 words)
Port: LW-10+ 5
Username : LW-10+ 6 {16 words)
Password : LW-10 + 22 {16 words)
Database name : LW-10 4 38 (16 words)
OK Cancel Help OK Cancel Help

2.

Control Address to LW-80, to update or clear HMI historical data.

Data Sampling Object

Comment :
Sampling mode

@ Time-based

Read address

*) Trigger -based

Sampling time interval :

PLC : [Local HMI

= |[ settings... |

Address : Ly - | 100
Data Record
Data Format ...

Datalength : 1word(s)

Hold address
[ Enable

Control address

Enable

PLC : [Local HMI
Address : | Lw - |80

History files
Enable
Name : Datalog

~|[_settings...
16-bit Unsigned

["]Sync. to SD card ["Sync. to USB disk

Syne to database

Enable || Display history from database

Database : |1, 127.0.0.1 'I

Create a Data Sampling object, in [Sync. to database] group box select [Enable], and set
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3. If the database is successfully connected, the status indicator LW-0 displays 2 (connection
succeeded), and the error indicator LW-10 displays 0 (no error).
4.  Write 2 in LW-80 (sync. data). Open SQL database, the data can be found in table <HMI

NAME>_<DATALOG NAME>_data.

Table Action Records @

[] hostname_datalog_data E F= @ X 6
[] hostname_datalog_data_format [ i #= f@ > 1
[7] hostname_datalog_data_section | = 0 g.e T s 0
3 table(s) Sum i

L—| WE!NTEK
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MyISAM

MYISA
MYISAM
MyISAM

Collation Size  Overhead
utfé_unicode_ci 2.1 KB
utfd_unicode_ci 2.0 KiB
utfd_unicode_ci 1.0 KiB
utf8_unicode_ci 5.2 KiB 0B

EasyBuilder Pro V5.05.02



Objects 13-232

13.45. Dynamic Scale

13.45.1. Overview

Dynamic Scale offers customizable tick marks and scale labels and can be used together with

objects such as Trend Display, Bar Graph..., etc.

13.45.2. Configuration

a5
Sl

Click the Dynamic Scale icon on the toolbar to open a Dynamic Scale object property dialog box.
Set up the properties, press OK button, and a new Dynamic Scale object will be created.

General Tab
New Dynamic Scale Object =
General
s
Tick Mark | Scale Label
Color : i:ﬂ Radius : - D
Main scale
Sub scale
s gt ———{]
(o ][ conce
Setting Description
Style Select the style from [Circular], [Horizontal], or [Vertical]. If select

[Circular], set the [Direction] and [Degree].
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Degree (S
Direction
(@) Clockwise () Counterdodkwise
Degree
[¥] Full cirdle
Start: 0
ok || cancel
Direction

Select from [Clockwise] or [Counterclockwise].

Degree

If [Full circle] is selected, set the start degree.

If [Full circle] is not selected, set the start and end degree.

Degree

Tick Mark Select the color of the tick mark, and set the number of ticks for the
main and sub scale (major and minor tick mark).
For [Circular] style, the length of the major and minor tick mark, and
the radius of the circular tick mark can be set.

Scale Label Displays major tick labels.
Circular
Mew Dynamic Scale Object @
Ceneral
Sty :
Seale Label
Use scale label
Font : [Arial v]
Size

Right decimal Pt. : ¢ EI
Radius: - D

[ Dynamic limits

Min.: 0 Max. : 100

[ ok ][ cancel |

Set the font, font color, font size, and decimal point of the scale
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label.

Set the radius start from the center of the object to the position to
place the scale label.

Virtical / Horizontal

Mew Dynamic Scale Object E

Creneral

Scale Label
Use scale label
Font: [Arial v]

Left decimal Pt. : 4 EI Right decimal Pt. : g EI

7] Dynamic limits

Top: 0 Bottom: 100

o) (oo ]

Set the font, font color, font size, and decimal point of the scale
label.
Set the position to display the scale label.

The Max. and Min. limits of the scale label can be specified. If
[Dynamic limits] is selected, the Max. and Min. limits can be set by
the designated word addresses.

Min., ¢ LwW-0 Max, LW-0 +1
PLC : [Loﬁl HMI v] Settings. ..
Address : [LW - |0 | |1E—bit IUnsigned
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13.46. Dynamic Drawing

13.46.1. Overview

Dynamic Drawing object enables drawing a shape in a specified region on HMI screen at run
time. The shape can be a line, a rectangle, a circle, or a dot. By setting the Attributes Addresses,

the style and the color of the shape can be customized.

13.46.2. Configuration

S

I:I_.:'

Click the Dynamic Drawing icon on the toolbar to open a Dynamic Drawing object property
dialog box. Set up the properties, press OK button, and a new Dynamic Drawing object will be
created.

General Tab

Dynamic Drawing Object's Properties [i_‘
| General [Color | Profile |
Clear address
PLC: {Local HMI v] Settings...

Address : { LB v ] 0

Attributes address

PLC : [Local HMI ~ [ Settings...

Address : [LW v] 0

LW-0+0: shape
(0: none, 1: line, 2: rectangle, 3: circle, 4: dot )
LW-0+1: arrow/shape style (more )
LW-0+2: line/fill style { more )
LW-0+3: innercolor
LW-0+4: interior pattern color (rectangle, circle)
LW-0+5: 1
LW-0+6: y1
LW-0+47: 2 (circle radiug)
LW-0+8: y2

* (x1, 1) : start point (line, rectangle), center (circle)
{x2, ¥2) : end point {line, rectangle)

[ OK ][ Cancel } Help
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Setting Description
Clear Address

Attributes Address

Clears the drawing.

Changes the attributes in the drawing.

Entering different values in different Attributes Addresses brings different effects, as shown in
the following table.

Attributes Attributes Attributes Attributes Attributes Attributes
Address Address+0 Address+1 Address+2 Address+3 Address+4
Default 0 Ones Tens Customizable Customizable
0: Non-arrow 0: Small 0: Solid line
1: Single-ended arrow (Hollow) | 1: Large 1: Dashed line
2: Double-ended arrow (Hollow) 2: Dotted line
Line 1 3: Single-ended arrow (Solid) 3: Dash Dot line Line color
4: Double-ended arrow (Solid) 4: Dash Dot Dot line
5 and up: Solid line
with thicknesses greater
than 2
0: Hollow Drawn in Line mode Interior pattern
Rectangle 2 Rectangle color
1: Solid Drawn in Pattern mode color
0: Hollow Drawn in Line mode Interior pattern
Circle 3 Circle color
1: Solid Drawn in Pattern mode color
Dot 4 Dot color
Attributes Attributes Attributes Attributes Attributes Attributes
Address Address+0 Address+5 Address+6 Address+7 Address+8
Default 0
Line 1 Start point X Start point Y End point X End point Y
Rectangle 2 Left-top point X Left-top point Y Right-bottom point X Right-bottom point Y
Circle 3 Center point X Center point Y Radius
Dot 4 Dot X Dot Y
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The values in [Attributes Address+2] represent different Line or Pattern styles, as shown in the

following table.

Line mode Pattern mode

| i | e | e
AEICEd
B EEE
(8] B E [1E]
24 [25] 28]

Color Tab

Drawing Object's Properties

| General | Color | Profile |

Color

I 000000
O] sttt
0] tofot0
[ c0c0c0
W 7t
[ s080tt
I 10000
[ £t££00
[ 20it00

o

Delete

CO&.IU\U!-IE\»ND—-DZ

o J [ conce

Setting Description

New Adds a color to be used in the drawing.

Delete Deletes the selected color.
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Example 1
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The following demo project demonstrates how to dynamically draw an arrow or a circle on HMI

screen. To build the project, follow these steps:

1. Create a Dynamic Drawing object, set Clear Address to LB-0, and Attributes Address to

LW-O0.

2. Create a Toggle Switch object, set address to LB-0, and select Toggle as switch style, for

clearing the drawing.

3. Create 9 Numeric objects, set addresses to LW-0~LW-8, for specifying the attributes in the

drawing.

4. Run simulation or download the project to HMI to see the result. By entering 1 in LW-0, a

line is drawn, and entering different values in LW-1~8 can change the style, the color, and

the position of the line.

Demo Project - Dynamic Drawing

-> Dynamically changing pattern on HMI!
-> Drawing line/rectangle/circle/dot in specified region!

5. Press Clear Pattern button, and enter 3 in LW-0, a circle is drawn, and entering different

Fast Sel

Clear
Pattern

Attributes + 0: shape
(0: none, 1: line, 2: rectangle, 3: circle, 4: dot)

Attributes + 1: arrow/shape style
Attributes + 2: line/fill style

Attributes + 3: inner color

Afttributes + 4: interior pattern color
(rectangle circle)

Attributes + 5: X1
Attributes + 6: Y1
Attributes + 7: X2(circle radius)

Attributes + 8:Y2

values in LW-1~8 can change the style, the color, and the position of the circle.
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Demo Project - Dynamic Drawing
-> Dynamically changing pattern on HMI!
-> Drawing line/rectangle/circle/dot in specified region!

Clear
Pattern

Attributes + 0: shape
(0: none, 1: line, 2: rectangle, 3: circle, 4: dot)

Attributes + 1: arrow/shape style
Attributes + 2: line/fill style

Attributes + 3: inner color

Attributes + 4: interior pattern color
(rectanglecircle)

Attributes + 5: X1

Attributes + 6:Y1

Attributes + 7: X2(circle radius)

Fast Sel - Attributes
@ Note

B Before using Attributes Address, please define [Attributes Address + 1] ~ [Attributes
Address + 8]. The system will reset the Attributes Address, after it is used.

B [f the drawing is not cleared, the new drawing will overlap the previous one, and the
maximum acceptable number of drawings in a Dynamic Drawing object is 1000.

B The maximum number of line styles is 19, which means the maximum thickness of a solid
line is 16. The style numbers that exceed 19 will be displayed as 19.

B  Find the color number in Color tab.
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13.47. PDF Reader

13.47.1. Overview

PDF Reader object enables viewing of PDF documents on HMI.
Please note that this object is currently available only for cMT3151 model, with OS version
20160301 and later.

13.47.2. Configuration
Tl

Click the PDF Reader icon on the toolbar to create a PDF Reader object. Or, click [Object] »
[PDF Reader] in the menu.

General Tab
New PDF Reader Object ==
General
Comment :
Background color : | Transparent EI
File position
(@) 5D card () UsB disk
Path
PLC: Lacal HvI
Address : [LW > |10 20 word(s)
Fage control
[¥] Enable
PLC : [Local HMI
Address : [LW *|0
LW-0 Current page
LW-1 Total pages
*PDF Reader requires OS5 version 20160301 or later.
o) Com
Setting Description
File position Select the position where the PDF file is stored.
Path The directory of the PDF file stored in the external
device.
Page Control Change the displayed page by entering its page
number.
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@ Note

B PDF Reader can only run on cMT3151, and cannot be opened using simulation mode or
cMT Viewer.

B The PDF files protected by passwords or restrictions cannot be read using PDF Reader.

CPU loading may rise when multiple PDF Reader objects are opened simultaneously.
B When entering a page number in the Page Control register under multi-page view mode,

the specified page will be opened in single-page view.

=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.48. Table

13.48.1. Overview

Table object allows users to draw a table in the editing window, and customize the border, grid,
and pattern of the table.

13.48.2. Configuration
=

Click the Table icon on the toolbar to create a Table object. Or, click [Draw] » [Table] in the
menu.

General Tab

[ New Table Object )

General

Divisions
Vertical : 3 P

Horizontal : 3 b

sy

*Spacing : Free
The row width and colunn width can be
adjusted freely.

Border

Line type : [

Soid ne -

Line width : 1 ey

Line type : [

Line width : 1 =

Pattern style : [ Pattern... ]

Interior color : || | B

—— e

i (s

Setting Description

Preview Window Displays the settings result.

Vertical Sets the number of columns in the table. Range:
1~255
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Horizontal

Sets the number of rows in the table. Range: 1~255

Spacing

The available options are [Equal] and [Free]. When
[Free] is selected, the user can manually adjust the
column width or row height in the editing window.

Border

Sets the type, width, and color of the border. [Line
width] setting is available only when Solid line type
is selected. The range of width is 0~8. The line will
become invisible when the width is set to 0.

Grid

Sets the type, width, and color of the grid. [Line
width] setting is available only when Solid line type
is selected. The range of width is 0~8. The line will
become invisible when the width is set to 0.

Fill

Sets the pattern style and color.
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13.49. VNC Viewer

13.49.1. Overview

VNC Viewer can run on HMI to control a PC or a device remotely. VNC server must be installed
on the remote device to be connected. On HMI the user can monitor and control the remote
device.

13.49.2. Configuration

i

Click on the VNC Viewer icon on the toolbar or select [Objects] » [VNC Viewer] to open the
settings dialog box. Configure the parameters and click OK; a VNC Viewer object will be
created.

General Tab

New VNC Viewer Object (=23

| General | Control Security |

Comment :

IP: 192 . 168 . 0 . 1

Port: 5900
[V] Defanlt password

Password :

Title bar
[V] Ensble

Use label library

Label Library...
* Only ARCII is available. Font setting has no effective.

* Supported OF version : 20160418 or later

[ OK ] [ Cancel l Help
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Setting Description

IP Enter the IP address of the remote device to be
connected.

Port Enter the port number of the remote device to be

connected.

Default Password

Enter the VNC password to log in the VNC server of
the remote device. If Default Password is enabled,
when connecting the remote device, VNC Viewer
will automatically use the password specified here
to login, and the user doesn’t need to enter the
password.

Title bar

Enable

When [Enable] is selected, a field shows for entering
the caption in the title bar. The caption is limited to
ASCII characters, and the font cannot be customized.
The caption can be selected from Label Tag Library.
Only when the title bar is enabled can the VNC

Viewer window be moved or resized by dragging.

@ Note

VNC Viewer requires OS version 20160418 or later.
VNC Viewer is applicable for eMT/iE/XE Series and cMT3151 HMI models.
VNC Viewer cannot be simulated in on-line simulation mode.

When [Default password] is selected, HMI’s Virtual Keyboard can only be called out

manually. If [Default password] is not selected, the Virtual Keyboard can pop up

automatically.
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Control Tab

13-246

New VNC Viewer Object [ 53

| General | Control | Security

[¥] Enable
PLC: Local HMI v [ Settings..
Address : [LW v|0 [
Status : LW-0

0 : stopped, 1 : running, 2 : failed to connect
3 : authentication exror, 4 : server disconnection error
5 : security exror
Command : LW-1
0 :none, 1 :start, 2 : stop
IP : LW-2 (4 words)
Port: LW-6
Default password : LW-7
0 : disable, 1 : enable
Password : LW-8 (16 words)
Title bar : LW-24
0 : disable, 1 : enable
Title bar name : LW-25 (16 words)

[ OK J [ Cancel Help
Setting Description
IP A set of word addresses can be specified to control

VNC Viewer as well to display the connection status.
Control address: Shows the connection status
0: Stopped

1: Running

2: Failed to connect

3: Authentication error

4: Server disconnection error

5: Security error

Control address + 1: Command

0: None

1: Start

2: Stop

Control address+2~+5: IP

Control address+6: Port Number

Control address+7: Default Password
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0: Disable

1: Enable

Control address+8: Password (16 words)
Control address+24: Title bar

0: Disable

1: Enable

Control address+24: Title bar name (16 words)

0 Note

B The allowable value range that can be entered in Control Address+6 is 0~99. The actual
Port Number will be the value entered in Control Address+6 plus 5900. For example, if the
user enters 1 in Control Address+6, the actual Port Number will be 5901. However, if the
user enters 100 in Control Address+6, the value will not be added by 5900, and the actual
Port Number will be 100.

B In VNC Viewer, to use the HMI built-in Virtual Keyboard, please tap the Focus button on
the Virtual Keyboard first, and then tap VNC Viewer screen. This will change the input

target.
Vol koyboard [
1 2 3 ‘ 4 3 ‘ [ ‘ 7 o] ‘ 9 ‘ 0 ‘ = ‘ = ‘ BackSpace
q W e r t Y u i o P [ ] h
a =3 d f q h J k. 1
Caps z * ® " b n n o o £ Return
Esc 123 “ —> Focus

Iil Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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13.50. Barcode Scanner (Android Camera)

13.50.1. Overview

By connecting an Android device (phone/tablet) equipped with a camera to an HMI
(cMT-SVR/cMT3151) using cMT Viewer installed on the Android device, the camera can be
used to scan 1D or 2D barcodes.

13.50.2. Configuration

—1

||
L=

Click the Barcode Scanner icon on the toolbar to create a Barcode Scanner object. Or, click
[Objects] » [Barcode Scanner] in the menu.

General Tab

Barcode Scanner (Android Camera) Object's Properties @

General | Security | Profile |

Comment :

Control address

PLC : [Local HMI ~ |[Setings...

Address : [LW v|0

Command : LW-0
(0 :none, 1 : start and cleax, 2 : stop, 3 : clear )
Execution status : LW-1

(0 :none, 1 : success, 2 or more : exroxr code )

Data length : LW-2
Status address
PLC: [Local HMI v [ Settins...
Address : [LB v} 0 '

Camera Status : LB-0
(0:off,1:0n)
Running Status : LB-1
(0 : stopped, 1 : scanning )

Barcode address
PLC : [Local HMI v [ Settines...
Address : [LW +| 10 20words)
V| Use Unicode
Read byte limit
[V]Enable Limit: 10 |2 Bytes

[ OK ] [ Cancel [I]
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Setting

Description

Control address

Control address: Gives Command to Barcode
Scanner.

0: None

1: Start and Clear

2: Stop

3: Clear

Control address + 1: Shows Execution Status.
0: None

1: Success

2 or more: Error Code

Control address + 2: Shows data length scanned.

Status address

Status address: Shows camera status is On / Off.
0: Off

1: On

Status address + 1: Shows whether scanning is
ready.

0: Stopped

1: Ready for scanning

Barcode address

The address that stores the data read, UNICODE is
allowed.

Read byte limit

If the data read exceeds this setting, the execution

status turns to 2 (error code).

L—| WE!NTEK
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Security Tab
Barcode Scanner (Android Camera) Object's Properties 1?[
[ General | Security | Profile |
Sound Library
Library Name Size
[Project] » 0 Beep 0k
{ OK ] [ Cancel
Sound
[¥] Enable Sound Libraxy... Sound Index : Default
Play
—]
Setting Description
Sound If Enable is selected, when data is read, a sound is

emitted. The supported sound file format is .wav.

0 Note

B Barcode Scanner is currently supported on cMT-SVR and cMT3151 models. Barcode
Scanner cannot be opened using simulation mode or cMT Viewer.

B Supports: EAN/UPC, Code 128, Code 39, Interleaved 2 of 5 and QR Code.

B On the device, if other applications are also using the camera, or the camera is locked,
cMT Viewer may not operate properly.

B |nthe project, when multiple cMT Viewer devices are connected, since the same address
is shared between the devices, the devices will simultaneously scan if they are displaying

the same window with Barcode Scanner.
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Example 1
The following demo project shows how to scan QR code using a tablet.

1. Atthe beginning, the display is dark.

Barcode Scanner with Android Camera

Control address

Command

Start Stop Clear

Execute Status
Length (in Byte)

Status address

Ccamera @D Scanning

Barcode address

Data [ I

o | !
Unicode o000 0000 Jf 0000 | 0ooo | oooo | --

2. Tap Start button, the status of Scanning turns ON, the display turns bright, and is ready for

scanning.

Barcode Scanner with Android Camera

PR N SRee s g g AR
[ e Control address

-A:*:.’.‘.'uu: 2aat rd

=
Bucose scam v Anpoxd Camerd Command

ontrol aa3Tss

Start Stop Clear

Execute Status
Length (in Byte)

Status address

camera @D scanning €D

Barcode address

Data [ ]

o | !
Unicode 0000 0000 Jf 0000 | oooo | oooo | --

3. When a QR code is read, the Execute Status turns 1, and the QR code is captured, its
content will be displayed in Barcode Address group box. Unicode is also supported.
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Barcode Scanner with Android Camera

Control address

Command

Start Stop Clear

Execute Status
Length (in Byte)

Status address

Camera @D Scanning

Barcode address

Data ?Jeintek ]

Data iNelmek ]
Unicode 0957 J0o65 || o069 | oose | oo7a | --

4. If the size of the data read exceeds the maximum allowable size set in Read Byte Limit (10
bytes in this project), the Execution Status turns to 2 (error code). The exceeding part will
still be displayed in the ASCII objects in Barcode Address group box, since the data length
displayed depends on the ASCII object settings (20 words in this project).

Barcode Scanner with Android Camera

Control address

Command

Start Stop Clear

Execute Status
Length (in Byte)

Status address

Camera @D Scanning

Barcode address

Data barcode scanner ]

Data barcode scanner ]

Unicode 5067 Jloo61 | 0072 | 0063 | ooeF | -

5. After changing to another page, Scanning turns OFF, the parameters are reserved. The
parameters will be cleared when next time Start button is tapped, or Clear button is

tapped.

I__| WE'NTEK EasyBuilder Pro V5.05.02



Objects 13-253

Barcode Scanner with Android Camera

Control address

Command

Start Stop Clear

Execute Status
Length (in Byte)

Status address

Ccamera @D Scanning

Barcode address

Data barcode scanner ]

Data barcode scanner ]

Unicode o062 | 0061 | 0072 | 0063 | ooerF | --

=4 Click the icon to download the demo project. Please confirm your internet connection

before downloading the demo project.
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14.Shape Library and Picture
Library

This chapter explains how to build Shape Library and Picture Library.
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14.1. Overview

EasyBuilder Pro provides Shape Library and Picture Library for visual effects on objects.

Picture Manager provides two modes: [Project] and [Library]. Pictures in [Project] mode will be
stored in .emtp project file. Pictures in [Library] mode will be stored in EasyBuilder Pro libraries,
or the user-defined directory.

Each Shape or Picture includes up to 256 states. This chapter explains how to build Shape
Library and Picture Library.

& For more information about using libraries while creating an object, see “9 Object General
Properties”.

14.2. Building Shape Library

Shapes are vector graphics constructed by lines, curves or polygons. A Shape can have more
than one state, and each state includes two parts: frame and inner, as shown in the following
figure.

State 0 State 1

Frame

Inner

14.2.1. Shape manager

An object can use frame, inner or both. Click [Call up Shape Library], and the [Shape manager]

dialog box appears.

E B MES

[Call up Shape Library |
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Shape manager

Project | Library

[buthan4

)

nhﬂed
- ﬁmh&s :
bjects : 0 .

nhﬂed

- —
ﬁb]eds 1] [E]

- —
ﬁb_]eds 1] [E]

pnﬁﬂed @ |:|
Eiahes =2
ﬁbjeds :0 [E]

nhﬂed

74 74
phiects:0 ) perecs:0 (@)
6 &
@2 - @
Ferm——— T X [ Delete ] [ Clean ]
Background : v| [ oK. ] [ Cancel ] [ Help ]
Setting Description
Project The Shape edited here will be saved in .emtp. Up to
1000 Shapes can be added.
Library The Shape edited here will be saved to the library

directory on PC and will not be saved to .emtp
project file.

New library

Include existing .plb shape library files or create a
new one. To create an empty library, enter a new
file name and click [Open]. Up to 40 library files can
be added.

Unattach library

Exclude current library.

[E] Copy to project

Copy the selected Shape to [Project]. Only the
shapes that do not belong to the System Libraries
can be copied. Shapes in System Frame/System
Button/System Lamp/System Pipe cannot be

copied.

Background

Select and preview the background color of the
Shape. The color is only displayed in [Shape
manager] dialog box, and is not displayed when

placing the object in the screen.

Place

Add the selected Shape to window. Only available

for libraries that are not in the system.
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More options

Set the color and style of [Inner], [Frame], and
[Pattern].

@

Move the Shape to the previous / next state.

Copy

Copy the selected Shape.

Paste

Paste the copied Shape.

=

Insert transparent

Insert a blank state after the selected state.

state

Delete Delete the selected state of the shape.
Clean Delete all the states of the selected shape.
OK Confirm to save the edited Shape.

Cancel Cancel the editing event.

Help Open help files.

0 Note

B The color of [Inner] and [Frame] can be selected in Shape Library. The selection of [Pattern

Style] is only available in System Frame / System Button Library.

Bit Lamp Object's Properties

=3

| Genersl | Secwity| Shape | Label | Puofile |

Shape

[ Shape Library. . | @it e
Tnner N
Frame hd

Interior pattermn : - | Pattern Style. .

[

Duplicate thes attributes to every state ]

B cMT-SVR Series supports using

I__| WE!NTEK

gradient patterns in [Pattern Style], as follow:
B

Pattern Style

© Solid
Left to right =

Top to bottom :

] P &

Top-left to bottom-right :

[ I

Top-right to bottom-left :

o ] -

Radil :

O [ s

@ Gradient
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14.2.2.

The following explains how to create a new Shape Library and add a Shape with two states into

the library.

1. Click [New library] and enter the name of the new Shape Library.

2. Click [Open], a popup dialog appears; click [Yes] to create the file.
3. A new Shape Library [new_lib] is added in [Shape manager]. This library is empty as

Steps to Build Shape Library

Open

Loak in:

L
<P

Recent Places

Desktop
w=al
Libraries

LY

=

Computer

@

Network

. library

Mame

picture
shape
sound

L |arrowd.plb
L | arrow2.plb
L |arrow3.plb
|| buttonl.plb
|| button2.plb
|| button3.plb
buttond.plb
dinl.plb
frame.plb

oioel .olb
n

File name:

Files of type:

4

m

= @0

Preview not available.

new_lib

[shape iibrary (*plb)

-]

[ Cancel ]

shown in the following figure.

Shape manager
[newflib v]
@ @
Bates:o Fats:0
o @ prso [
73 @
Btates:0 Btats:0
s @ o @
73 @
Brates:0 Brats:0
ST e @
@ @
Background : - |

==

A
v

)

[

Ok

][ Cancel ][ Help

]

4. Add a state to the selected Shape. First, use the drawing tools to draw a frame and inner

in the window and select the frame to add to the Shape Library.
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EasyBuilder Pro : EMTP2 - [10 - WINDOW_010]

\E‘ Eile Edit Yiew QOption Draw Objects Library Tools Window Help

DEE s &% G 481 REEIRSTEHLAS
L3

BE v X 10 - WINDOW_010 x
| Object st -
~ 3 : Fast Selection -
4 : Common Windo
5-PLC Response
6 : HMI Connection
7 : Passward Restrici
8 : Storage Space In

- §:Backup
- *10 : WINDOW_010

(56, 81) - (157, 149) MT3105 (300 x 600} idth: 102 | Height: 69

WHAEEE 2 HE]
N M OO AE QA QG e 0 e LR R S B O

¥=223 Y=10

=1 EER 5

- X

3

b

CAP NUM SCRL

5. Click [Save to Shape Library] button in the toolbar, select [new_lib], and select a number

in this library. The selected number is highlighted yellow.

6. Save the Shape as [Frame], select [Insert], and click [Save].

Inner

| Display

Frame

/| Display

Save to library

Save as

@ Frame Inner

Insert options :

@) Insert Replace

Save

Setting Description
Inner Displays the inner of the Shape.
Frame Displays the frame of the Shape.

Save to library Save as Frame
Saves the Shape as a frame.
Save as Inner

Saves the Shape as inner.
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Insert

Inserts the Shape to be a new state.

Replace
Replaces a state with this Shape.

Save Saves the settings above.

7. The following shows that a state of the Shape is added, and is defined as a frame.

]
v]

=

8. Create the shape to be saved as inner. Select the shape drawn in the window.

EasyBuilder Pro - EMTP2 - [10 - WINDOW_010]

\:| File Edit View Option Draw Objects Library Tools Window Help
DEE & B ST W L RETFLDLTEHGS S A
R S e QO AR |09 A" Q0 - e E g B L

£E * X 4 10 - WINDOW_010 X
[Object st -
- 3 : Fast Selection -
4 : Common Windo
5:PLC Respanse
6 : HMI Connection
7 : Password Restrici
- 8 :Storage Space In

- 9:Backup
- *10 : WINDOW_010

< m b

TE | 5 | e « I

<MT3105 (800 600} Nidth : 99

188, 85) - (286, 150)

WwHAEEER JaaH]

Height: 86 X=262 Y=11

B8 EcB 53

- 88X

3

CAP NUM SCRL

9. Click [Save to Shape Library] button in the toolbar, select [new_lib], and select the same

number as in creating the frame in this library. The selected number is highlighted yellow.

10. Save the Shape as [Inner], select [Replace], and click [Save].

L—| WE!NTEK

Shape manager
Project | Library
[mew.ib - g8
1] 1 -
@ - @
Etates =1 Etabes 10
Ebjects 10 |:| Ebjecis 10 ‘7|
2 3
@ - @
Etates 10 Etabes 20
Ebjects ] |7| Ebjecis 10 ‘7|
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Inner

Display

Frame

Display

Save to library

Save as:

© Frame © fner
Insert options :

() Insert @ Replace

11. A state of a Shape can include [Inner], [Frame], or both. The state 0 of the Shape shown in

the following figure includes both frame and inner. Click [OK], the state 0 of the Shape is

created.

]

L]
[
)

12. Follow the steps of creating state 0 and insert a new state set to state 1 as shown in the

following figure. The Shape now has two states, click [OK] to finish setting.

Shape manager

[mew_lib ']
— —

s @ @

(2] )

prs @) P @

74 73

P @ @

(2] )
[T EE— [T

Background: v |

[ More options... ]

Inner.Frame E]
Inner, Frame
[ ok [ cancel ][ Hep

J

Inner

Display

Frame

Display

Save ta library

Save as :
) Frame
Insert options :

() Insert

@) Inner

(@) Replace

Save

[\& WEINTEK
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14.3.

14.3.1.

Building Picture Library

Picture manager

Click [Call up Picture Library] button in the toolbar and the [Picture manager] dialog box

appears.

=

=B FHS]

[iZall up Pictore Libeary |

Pictures manager

Project | Library

o] 1

pooog | 72— @é

[E5)
= Qooee

il -,’
. ][5 ]6 ] ss Joer
oooog =1 gepeg =t +—4—
CEEE el 1 e rr— l—'lléllluu
- - : : 4
E— —e [HOSEES
T T [ Bwpoat || Modfy |
i i | O\P 267x207 [
. i ; Eéﬁé 166482 bytes (&
@ @ |- i (W)
Com ] 1 =
T Feems 7 |[ _nNew ][ peete [ clean |
More pictore libravies. . Background : I:Hvl [ oK. i [ Cancel ] I Help ]
Setting Description
Project The Picture edited here will be saved in .emtp. Up
to 1000 Pictures can be added.
Library The Picture edited here will be saved to the library

directory on PC and will not be saved to .emtp

project file.

New library

Add the existing .flb picture library files.

To add a new library that does not exist, enter a
new file name and click [Open], an empty library
file is created. Up to 40 library files can be added.

[\& WEINTEK
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Unattach library

Delete the current library.

[E] Copy to project

Copy the Picture to [Project].

Background

Select the background color of the Picture. The
color is only displayed in [Picture manager] dialog
box, and is not displayed when placing the object in
the screen.

More picture

Log in to Weintek Official Website to download

libraries more libraries.
Export Export the selected Picture.
Modify Modify the settings of the selected Picture.

Move the Picture to the previous / next state.

Copy

Copy the selected Picture.

Paste

Paste the copied Picture. The Picture copied to the
clipboard can be imported to the library by pasting.

D Insert

transparent state

Insert a blank state after the selected state.

New Add a new Picture.

Delete Delete the selected Picture.
Clean Delete all the Pictures listed here.
OK Confirm to save the edited Shape.
Cancel Cancel the editing event.

Help Open help files.

@ Note

I__| WE!NTEK

The supported picture formats are .bmp, .jpg, .gif, .dpd, .svg and .png. When adding a gif

animation file in Picture Library, the loop times of this animated Picture can be set.

Resolution:| 214 ® 15
Size: 10430 Bytes

LT L]

Loops
O GIF default [ Infinite |

(® Customized

Background v L,,,,,,,,,,,;

EasyBuilder Pro V5.05.02
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14.3.2. Steps to Build Picture Library

The following example explains how to create a new Picture Library and add a Picture with
two states into the library.
1. Click [New library] and enter the name of the new Picture Library.

o
Lookin: || library - F e E
I= MName B o
':'_‘3‘ | picture ‘j
Recent Places | shape =
1 |/ sound
- | background flb
Desktop | button_typel0.flb
e || button_typel0_64.flb X .
M;;J [ button_typet1flb Prevview not available.
Libraries || button_typel2 flb
|| button_typel3.flb
E;,',I,g || button_typela.fib
Computer | button_typel5 flb
. | buttonl.flb Il
Q_E . butto':l 32.flb ;
Network
File name: new_lib A Open
Flesoftype: | picture lbrery (“flb) v] [ Cancel |

2. Click [Open], a popup dialog appears; click [Yes] to create the file.
3. A new Picture Library [new_lib] is added in [Picture manager]. This library is empty as
shown in the following figure.

Pictures manager
Project | Library
lnew_\lh ']
0 1 -
@ M @43
Ftates 0 Fmtes 0
F bjects : 0 @ Fh]ans 0] [E]
. — ] —
73 | 74|
Flahes 10 Fmtes 10
W@ W[@] Export Modify
& L =
@ r @ :
Ftates :0 Fmtes 0
F bjects : 0 @ Fh]ans 0] [E]
3 7
" ;
Eereen Ermtaeon S New Delete Clean
More pictore libranes. . Background : I:Hvl I oK I [ Cancel ] i Help I

4. Draw the two pictures below to represent state 0 and state 1 respectively.

5. Select [new_lib], and select a number in this library. The selected number is highlighted

yellow.

[\& WEINTEK

EasyBuilder Pro V5.05.02




Shape Library and Picture

6. Click [New], and select the picture for state 0.

Library

7. When the following dialog box is shown, select [Enable] check box to use transparent

color. Set to RGB (121, 121, 121), the corresponding color in the picture below will be

transparent. Or, click on a desired area with mouse to be the transparent area, the system

will show the RGB of the clicked area automatically.

Open

Loak in:

L
=
Recent Places

Bl Desktop

Libraries

o | | System Folder

- @2 E

user
3} System Folder

o Network
L- System Folder

| W
| File folder

P 2 bmp
Bitmap image
293 KB

=5

-
! [ | Computer
=SS System Folder
Desktop
- E EN
4 File folder
-_I:UJ r
Libraries 1.bmp
Bitmap image
i 29,3
Computer
@
Network
File name: 1bmp
Files of type:

Al image files

7]

[ Cancel ]

Background : hd

Resclution: | 100 X 100
Size : 30054 Bytes

Transparent color

121 121 [121 W~

8. To set transparent color, select [Enable] check box first, and then click an area in the

picture. The RGB value of that area is shown and it will be transparent. The displayed

picture is shown as in the preceding figure.

9. The Picture of state 0 is created. Follow the steps of creating state O to create state 1 by

clicking [New] as shown in the following figure.

I__| WE!NTEK
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Pictures manager @
Project | Library
[new_lib ']

a 1 -
| 2 [ 2 O
thhes 12 Ftahes 10
Fbjects: 1 [@] Fbjects 0 [@]

2 3
[ 74 [ 74
Ftahes 10 Ftahes 10
fobiects : 0 ) fobiects : 0 ) [ Ewort J[ wmodfy |

BMP 100x100

a 5 0 30054 bytes E]
| 2 | 2 B BMP 100x100 [ L]
Ftahes 0 Ftahes 0 9 30054 bytes
Fbjeds 0 @ Fbjeds 0 @ _

] 7 E:]
[ 74 [ 74
e Fereeon T [ mew |[ opelete ][ cean |

More picture librardes. . Background : I:Hvl [ oK i [ Cancel ] I Help I

10. When finished, a complete Picture is created, click [OK]. In [Picture manager] dialog box it

14.3.3.

shows that the newly added Picture Number 0 is a bitmap picture with two states.

Steps to Import Picture by Pasting

The following example explains how to import a Picture into the library by pasting the picture

from the clipboard.

1.

2.

Copy the following picture to the clipboard.

e

WE!NTEK

Click the Paste icon on the right side.

o

@ &
tates s 1 pates:z
7
@ F4)
@ ]
tates : 1 tates: 0

More pictre libraries

[\& WEINTEK
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3. The Pictur can be easily imported to the library.

0 Note

Foe [
Project | Library
T T s
—‘_ﬁ W ‘ u Fmeds: 1
4 5 '
2 3]
e == || WEINTEK
Fh]eds i1 Fb]ads i1
3 7
R S S
Z £ BMP 500x500 :
tates : 2 tates : 2 W!T:'l:u 1000054 bytes @
fbiects 11 P 1 i '
8 9
@ @
| Fatesit R ftates 1 1
Pra | WONTEK P =]
= New [ Delete |[ cen ]
Mors pisture libraries —L.4 R

B Transparent color can only be set for .bomp, .dpd, and .jpg picture files.
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Label Tag Library and Multi-Language

15.Label Tag Library and
Multi-Language

This chapter explains how to build and use Label Tag Library.

15,0, OVEIVIBW ..ueiiiiiiieee ittt e e e e e ettt e e e e e ettt e e e e e s e anreeeeeaeeeseaanbrbeeeeaeeeessannnrraneeaaens
15.2. Label Tag Library Manager.......ceccccuieeeiciieeeeecieee e e ettre e e et e e e e stae e e e s satae e e s enraeeeenanneeeas
15.3. Steps to build Label Tag Library ...ttt
15.4. Using Label TAg LIDIary ..ooeee oottt e e e e e srvrr e e e e e e e e s nnareneea e
15.5. Settings of MUIti-LaNGUAEE ......cceciiuiiieieieee ettt e e rae e e e aaeea s
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Label Tag Library and Multi-Language

15.1. Overview

15-2

The Label Tag Library feature enables a multi-language environment. When multiple languages

are required, users can create the Label Tag Library and then select a suitable label in the

project. The project will display the corresponding language in runtime based on the settings.

EasyBuilder Pro supports up to 24 different languages simultaneously. This chapter will explain

how to create and use the Label Tag Library.

15.2. Label Tag Library Manager

Click [Library] » [Label] on the toolbar and the [Label Tag Library] dialog box appears.

Label |Font

ﬁ

Language no. : 24

Stateno. @ 31 'ED@@@@

Mo. | Label tag name | No. of states | Language 1 | Language 2 | Langnage 3 | Language 4 | Language 5 | Language 6 | Language 7 | Language 8 | Language 9 | Langu:

3

[ Mew.. |[ settings... Decte || Deletcal [ savelabelFic... |[  LoadlabelFie... |
[ Copy ] paste | ExportExcaLFie... || importExceL Fie... |
(o I con
Setting Description

Language no.

Specifies the number of languages used in a project.

State no.

Indicates the current state. Each Label has a maximum
of 256 states (state no. 0 ~ 255). The state no. is
determined by [Language no.]. If less than 3 languages
are used, the maximum state no. is 256. If more than
4 languages are used, divide 768 by the language
number to get the maximum state no..

For example, the number of languages is 24, then
there are only 768/24 = 32 states.

New

Adds a new Label.

Settings

Sets the selected Label.

Save Label File

Saves all Labels in .Ibl format.

Load Label File

Loads the existing .Ibl file to the Label Library.

Export EXCEL File

Saves all Labels in .csv, .xls, or .xIsx format.

Import EXCEL file

Loads the existing .csv, .xls, or .xIsx file to the Label
Library.

[\& WE!NTEK
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0 Note

15.3.  Steps to create Label Tag Library

Please follow the steps to create a Label Tag Library.

15-3

Unicode is not supported when importing and exporting an Excel file.

1. From the Library menu, click [Label]. The Label Tag Library dialog box appears. Click [New]

to specify the name of the Label and the number of states to be displayed by this Label.

Label name : Label 0

No. of states : 1

2. Click [OK] and a new label is added to the Label Tag Library. Select the label and click
[Settings] to edit its content.
(GbelTag Gy T =
Mool (ot ]
Language no. : 24 -
sateno. i 1 -AHGCUEEEEEE

Me. | Label tag name | Mo. of states| Language 1 | Language 2 | Language 3 | Language 4 | Langvage 5 | Language 6 | Lenguage 7 | Language 8 | Langvage 3 | Longw:

[ new ][ settngs.. |[ beete [ Deleteal [ savelsbelFile... [ LoadLabelFie... |

[ Copy. Il Paste ] [ Export ExceL File... || Import ExceL File... |

= el ] [ reo ]
3. Edit the corresponding language content.
[labelTag Comtent T ==
Label Content Settings
Label name :  Label_0 Stateno.: 0 - @ @ B @ @
Language 1 Language 2 Language 3 Language 4 Language 5 Language &
how are you P - s = A A
Language 7 Language 8 Language 2 Language 10 Language 11 Language 12
Language 13 Language 14 Language 15 Language 16 Language 17 Language 18
Language 19 Language 20 Language 21 Language 22 Language 23 Language 24
Lo ]

[\& WE!NTEK
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4. Select [Label Tag Library] » [Font] to view each label which contains different fonts for
different languages. You can also enter the font description in the Comment field.
Label Tag Library [=3a)
Font

No. & Font Comment -

p 1 Lrial = B
2 Arial Black
3 Arial Bold
4 Batang
5 Browallia New
[i} Browallia New Bold
7 Calibri
8 Calibri Bold i
9 Combria 3
10 DamnPenh
11 Dawid
12 David Bold
13 Ehrima
14 Ehrima Bold
15 Estrangelo Edessa
16 FrankRuehl
17 Franklin Gothic Med un b
18 FreesiallPC
19 Gabrinla
an Cantami i

ok | [ cancel Help
15.4. Using Label Tag Library

When there are defined labels in the Label Library, the labels can be found in the object’s

[Label] tab. Select [Use label library] check box, and select the label from the pull-down list

[Label tag].

==l

MNew Bit Lamp Object
General I Security | Shape | Label
[T use label
[¥] Use label library Label tag : | EEENE I : ]
Label 0
[7] Convert labels to bitmap images (Use bih‘nap
State [ 3 @)
Attribute
Font : | Arizl
Color : - Size :
. . sk
[ 1talic [T underline
Duplicate these attributes to
[ Every state ] [ Every language ] [ All
Movement
Content
text
[ Tracking Duplicate this label to every state
o] [

I__| WE!NTEK
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When a tag is selected, the content of the selected tag is shown in the [Content] field in its
corresponding font style. Please note that from Language 2 to Language 24 can only be set the
Font [Size], the others such as [Color], [Align], [Blink], etc. will follow the settings of Language
1.

15.5. Settings of Multi-Language

When displaying the texts in multiple languages, the system register “[LW-9134]: language
mode” should be used too.

The value of [LW-9134] is ranged from 0 to 23 (cMT Series is from 0 to 7). Different values
correspond to different languages.

If not all languages are selected to compile and download, [LW-9134] will work differently.
For example, user defines 5 different languages in the Label Library:

1: English, 2: Traditional Chinese, 3: Simplified Chinese, 4: French, 5: Korean

If only Language 1, Language 3, and Language 5 are selected to compile then the
corresponding values of [LW-9134] are:

0: English, 1: Simplified Chinese, 2: Korean

Please follow the steps to use multiple languages.

1. Create a Text/Comment object and select [Use label library] checkbox.

New Text/Comment Object 3

[ Text/Comment | Secuﬂ& |

| Use as comment (not shown on HMI)

[V] Use label library Label Library...
[ Use string table [ Sting Table...
Label tag : [Label 0 ~| (0001

| Convert labels to bitmap images (Use bitmap font)

Attribute

Font: | Arial

Color: G| v Size : |16 v

N — Blok fone )

|| Ttalic | Underline
Duplicate these attributes to
| Every language
Movement
Direction : | No movement v
Content [¥] Preview with actual font size
text
[ OK l [ Cancel [ Help
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2. Create a Numeric Input Object and use the system register [LW-9134].

3.

Mew MNumeric Input Object

[l

General | Data Entry | Numeric Format | Security | Shape | Font |

Description :

[T Read\irite use different addresses

Read address

PLC name : [ng3| HMI

v] Setting...

Address :[LW-QlSA{leit) : language mode

x)

When compiling, select the defined languages.

Compiling

Project name : |C:\Users\user\Desktop\EMTP1.emtp

EXOB file name : |C:\Users\user\Desktop\EMTP1.exob

EXOB password : (used in decompiler)

Select the knguages used on the HMI

[] Decompilation is prohibited

Startup language after redownloading the project : |Language 1 -

Language 1

Language 7
Language 13
Language 19

Language 2
Language 8
Language 14
Language 20

Language 3
Language 9
Language 15
Language 21

MNote : A maximum of 8 languages can be selected simultaneously.

Language 4
Language 10
Language 16
Language 22

Language 5
Language 11
Language 17
Language 23

Language &
Language 12
Language 18
Language 24

0 error(s), 0 warning(s)

succeeded

Macro size 1 14 bytes -
Address tag size 1 10 bytes

Label tag size 1 40 bytes

Total size 1 4237582 bytes (4.04M)

Free space 1 62871282 bytes (59.96M)

| m._ |

Double click error messages to modify the attributes of relative objects !

)Buid ot fies

4. The simulation is shown as followed: If the value of [LW-9134] is changed, the content of

LW9134 : language mode | O

LW9134 : language mode | 2

LW9134 : language mode | 4

the Text object will be changed.

English

8] {4 FF 3 (SIUPLE)

=0 4 (KOREAN)

[\& WEINTEK
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0 Note

B For cMT Series, at most 8 different languages can be downloaded to the HMI.
B When selecting the HMI model: cMT, [LW-9134] is used to change the language mode on
cMT model, while [PLW-9134] is to change the language mode on iPad.

¥

=1 Click the icon to download the demo project that illustrates how to use the Option List

object to switch between multiple languages. Please confirm your internet connection before
downloading the demo project.

I__| WE'NTEK EasyBuilder Pro V5.05.02
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16.Address Tag Library

This chapter explains how to build and use Address Tag Library.

16.1.  OVEOIVIBW ..ueiiiiieiiei ettt e e e ettt e e e e s ettt et e e e e e s e anr et e eeeeeesesanbseeeeeeeeeessannnrraneaaanns 16-2
16.2. Building Address Tag LIDrary.........ueeeeeie et e e e e erene e e 16-2
16.3. Using Address Tag LIDrary .....cceeiiiieeei ettt e e e e e e nnree e e e e 16-4
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16.1. Overview

16-2

Generally it is recommended to define the commonly used addresses in Address Tag Library

when starting to build a project. It not only avoids accidental reuse of addresses but also

improves project readability.

16.2. Building Address Tag Library

Click [Library] » [Tag] on the toolbar and the [Address Tag Library] dialog box appears.

Address Tag Library M
@ User-defined tags () System tags
Ho. Addyess tag name PLC name Addre.. Address Read/W... Data type Comment
i g0 . Jloabm |8t |80 JRead/ | | |
4| m L2
* Edit system_tag.xml to customize categories of system tags
’ New... ” Delete ” Delete Al ” Settings... ]
| saveTagFle.. || Load TagFie.. || BeortExceL.. || importexceL.. |
| Bopotcsv.. || ImportCsv.. | [¥luse UTF format to export CSV fie
Setting Description
Customized Displays user-defined address tags.
System Displays system registers. The registers listed cannot
be deleted or changed.
New Adds a new address tag. Please see the steps next
page.
Settings Sets the selected address tag.

Save Tag File

Saves all current address tags as .tgl file.

Load Tag File

Loads the existing .tgl file of address tag to the current

project.

Export CSV Saves all current address tags as .csv file.

Import CSV Loads the existing .csv file of address tag to the
current project.

Export EXCEL Saves all current address tags as .xls file.

Import EXCEL Loads the existing .xls file of address tag to the current

project.

Use UTF-8 format
to export CSV file

If selected, the .csv file will be exported in UTF-8
format. If not selected, in ANSI format.

[\& WEINTEK
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1. Click [New] and set the relevant properties.

Address Tags l&]

Comment : test pump

Tag name : pump

Address
PLC name : [MODBUS RTU -
Address type : ) Bit @ word
Device type : Original format :
Address: 0

Address format : |DDDDD [range : 1 ~ 65535]

Conversion (Use macro)

[¥] Enable
Data format : | 16-bit BCD -
Read conversion : [add -
Write conversian : [None (Only data type conversion) -
[ ok || cncel
Setting Description
Comment The information of the address tag.
Tag name The name of the address tag.
PLC name As defined in [System Parameter Settings] » [Device list].
Address type The tag address type; select [Bit] or [Word].
Device type The available device types depend on [PLC name] and
[Address type].
Address Address of the tag.

Data format

If select [Word] in [Address type], the data format can be
specified.

Conversion
(Use Macro)

When enabled, the data format that the address tag will
be converted into can be specified. Macro subroutines can

be selected to do read/write conversion.

Read / Write
convertion

Select the macro subroutine to do read/write conversion.
The macro subroutine can only be selected when the data

format is identical to the one in the macro subroutine.

I__| WE!NTEK
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16-4

2. Click [OK], a newly added tag can be found in the [User-defined tags] library.

| Exportcsvi. || ImportCsv... | [luse UTFS format to export CsV fie

| Bport EXCEL.. || Import EXCEL... |

Array size

Address Tag Library
© User-defined tags (©) System tags
No. Tagname Conversion Data format Original format
1 pump Enable 16-bit BCD 16-bit Unsigned 2
< | ]
* Edit system_tag.xml to customize categories of system tags
[ New... ] [ Delete ] [ Delete All ] [ Settings... ]

Addr...
Word

Ad
-

PLC name
MODBUS RTU

16.3.

A W INR

Using Address Tag Library

Create a tag in Address Tag Library.

Create an object, select [General] » [PLC name].
Click [Setting] to finish the settings.

Select [User-defined tag] check box.

Mew Mumeric Input Object

GFeneral |Data Entry | Numeric Format I Security | Shape I Font |

Diescription :

[ ReadWrite use different addresses

Read address

PLC name : | Mitsubishi FXOS/FXON/FX1S/FXIN/FX2
-]

Address : ’purnp {test pump)

v] Setting...

Address

==

PLC name : ’Mitsubishi FX0S/FXON/FX1S/FXINFX2

)

Device type : ’purnp {test pump)

7]

Address : [TV-0
Address format : DDD [range : 0 ~ 255]

[ index register

| User-defined tag |

Tag Library...

OK

Caneel

In [Device type] select the defined tag.

If [Data type] is selected when creating the address tag, the system automatically restricts

the data format to the one selected.

I__| WE!NTEK
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Mew Mumeric Input Object

(feneral | Dats Entry | Wumeric Format |Secu:fity | Shape | Font |

Display
Data format: 16-bit Tnsigned  w | 7] Mask
Number of digits
Leftof decimal Pt. : 4 + Rightof decimal Pt.:
Sealing
Method : [Hone -]

7. When finished, the window tree will show the address tag name used by the object.

[\& WEINTEK

X

Windows
| Object fist

4

- 3 : Fast Selection
: Commeon Window

[

:PLC Response

: HMI Connection

: Password Restriction

: Storage Space Insufficient

[T = T T Y

.. 9

B <10 - WINDOW 010

L. ME_O (purnp : TV0) (Bottom Layer)
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17.Transferring Recipe Data

This chapter explains how to transfer recipe data.

17.1.
17.2.
17.3.
17.4.
17.5.

OVBIVIBW ...ttt ettt e e e ettt et e e e s e sttt e e e e e s e s anbrbbeeeaeeeesaannnreebeaeeessessnnnneens 17-2
Steps to Update Recipe Data with Ethernet or USB Cable .......ccoovveviiviveeeeeeieiee, 17-2
Steps to Update Recipe Data with SD Card or USB Disk........ccevveviviicciiiieeieeeeeecnee, 17-3
Transferring RECIPE Data.....cccccuuieeiiciiiee ettt et ar e e e e e e e 17-3
Saving Recipe Data AUtomMatiCally ........ceeveriieiciiiieeeee e 17-4
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17.1. Overview

Recipe Data refers to the data stored in RW and RW_A addresses. The way of reading and

writing these addresses is the same as operating a word register. The difference is that recipe

data is stored in flash memory, when restarting HMI, the latest data records in RW and RW_A

are kept.

The size of recipe data a RW address can store is 512K words, and RW_A is 64K words. Users

can update recipe data with SD card, USB disk, USB cable or Ethernet and use the data to

update PLC data. Recipe Data can also be uploaded to PC; furthermore, PLC data can be saved

in recipe data. The following explains the ways of transferring recipe data.

17.2. Steps to Update Recipe Data with Ethernet or USB Cable

1. Open Utility Manager and click [Download)].

2. Select [RW] and [RW_A] and [Browse] the source file.

3. After downloading, restart HMI, RW and RW_A will be updated.
When [Reboot HMI after download] is selected, users don’t have to manually reboot HMI.

When [Reset recipe] check box is selected, the system will clear all the data in [RW] and [RW_A]

before downloading.

Download

()

¥ Project C:\EBpro'test.rcp

¥ RW C\EBproitest_A.rcp
[~ RW_A
[ Recipe database

[~ Datalog

[” Startup screen

Browse...
Browse...

Connection
(+ Ethernet " USE cable

Kl P =28

IP: |192.168.1.222 hd

¥ Reboot HMI after download
¥ Resetrecipe I¥ Reset recipe database
¥ Reset event log ¥ Resetdata log

Download Settings.

[¥ Delete startup screen

¥ Reset operation log

L—| WE!NTEK
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17.3. Steps to Update Recipe Data with SD Card or USB Disk

Insert a SD card or USB disk into PC.
Click [Browse] to designate the file path.

A W INR

Open Utility Manager and click [Build Download Data for SD Card or USB Disk].

Click [Build], EasyBuilder Pro will save the data in SD card or USB disk.

Utility Manager

Select the folder to save download data :

(el

| D\test

Sources
™ Project

Browse...

[+ Recipe (RW)

| C:\EBpro\test.rcp

Browse...

[+ Recipe A (RW_A)

| C:\EBpro\test_A.rcp

Browse...

[~ Data log

Build

0 Note

B When download data is successfully built, two folders can be found: history and emt3000.

emt3000 is for storing project file; history is for storing recipe data and data sampling /

event log records.

17.4. Transferring Recipe Data

Use [Data Transfer (Trigger-based) Object] to transfer recipe data to a specific address, or save

the data of this address in [RW] and [RW_A].
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Mew Data Transfer (Trigger-based) Object @

General |5ECL.Iri1.‘5-' | Shape | Label |

Comment :

Source address

PLC name : [MDDEUS RTU v] Setting... |

Address : [3}( |1

Destination address
PLC name : [|_m3| HMI v] Setting... |

Address : [p_w_p, - | 10

Attribute
Mo. of word : | 120

Mode : [Tuu::h trigger v]

o] [

Setting Description

Source address Sets the source of the data.

Destination address Sets the destination of the data to transfer to.
Attribute Sets the number of words to transfer from source

to destination.

17.5. Saving Recipe Data Automatically

In order to prolong the life span of HMI flash memory, the system will automatically save the
recipe data to HMI every minute. To avoid losing data when turning HMI off during the interval
of saving data, system register [LB-9029: Save all recipe data to machine (set ON)] is provided.
Set ON LB-9029 will make the system save recipe data once. Set ON [LB-9028: Reset all recipe

data (set ON)], the system will clear all recipe data.
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18.Macro Reference

This chapter describes the syntax, programming methods and usage of macro commands.

L18.1.  OVEOIVIBW ..ueieeiiiieei ittt e e e e e sttt e e e e e e ettt et e e e e e seanreteeeeeeeseaanbsreeeeeeeeessannnrraneaaeens 18-2
18.2. Instructions to use the Macro Editor.........coouviiiiiiiiiiiiiiiieeeeeee e 18-2
T T @0 o | T={U T 1 4 o] o PSR 18-7
T V] o | = G PRPPRE 18-8
R TR TN =1 =T o 4 1T o | A USSP P PP PPPTROP 18-13
18.6.  FUNCEION BIOCKS ....eiiiiiiiiiiieeeee ettt e e s aree s 18-18
18.7.  BUIlt-In FUNCEION BIOCK....ccciiuiiiiiiiiiiieeiieee ettt 18-21
18.8. How to Create and EXECULE @ IMACIO .....uuiiiiiiiiiei ettt 18-84
18.9. User Defined Macro FUNCLION.......cccuiiiiiiiiiieccie ettt 18-88
18.10. Some Notes about Using the Macro .........cccuvvveeiiii e e 18-100
18.11. Use the Free Protocol to Control @ DeVICE .......cceovvuieeeiriiiieeiiiiiee e 18-100
18.12. CompPiler Error IMESSAZE ..eeieiiieiieiieeeee e e e ettt e e e e e e e seeareree e e e e e e sernstaaneeeeeesesnnnnnennns 18-105
18.13. SAMPIE MACIO COUE....uuuiiiiiiiiiecetie e e e e e e e e e e e s e rrrer e e e e e e e e s ennreaees 18-111
18.14. Macro TRACE FUNCLION ..ciiiiiiiiieetteeee ettt ettt e e et e e e e e e 18-116
18.15. Example of String Operation FUNCLIONS........ccuviiiiiiiiieeccieee e 18-120
18.16. Macro Password ProteCtion........cccueeeeiiiiieiiiiiiiee ettt 18-128
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18.1. Overview

Macros provide the additional functionality your application may need. Macros are automated
sequences of commands that are executed at run-time. Macros allow you to perform tasks
such as complex scaling operations, string handling, and user interactions with your projects.

This chapter describes syntax, usage, and programming methods of macro commands.

18.2. Instructions to use the Macro Editor

Macro editor provides the following functions:

Display line number

Undo / Redo

Cut / Copy / Paste

Select All

Toggle Bookmark / Previous Bookmark / Next Bookmark / Clear All Bookmarks
Toggle All Outlining

Security -> Use execution condition

Periodical execution

Execute one time when HMI starts

The instructions in the following part show you how to use these functions.
1. Open the macro editor; you’ll see the line numbers displayed on the left-hand side of the

edit area.

Work Space [=E3a]
Security
MacroID: O Macro name : macro_0 [Tl use execution condition

[T Periodical execution [Tl Execute one time when HMI starts
A% % %

macro_command main ()

end macro command

4 [m C

* (lick the right mouse button to display edit menu.

GET/SETF... | [ Compie Exit J [ Help
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2. Right click on the edit area to open the pop-up menu as shown in the following figure.

Disabled operations are colored grey, which indicates that it is not possible to use that

function in the current status of the editor. For example, you should select some text to

enable the copy function, otherwise it will be disabled. Keyboard shortcuts are also

shown.

Select Al Chrltd

Toggle Bookmark — Chl+F2
Wewxt Boolrnark F2
Prewious Bookmark  Shit+F2
Clear 411 Bookmarks

Toggle A1 Outlining
Tpdate AL Cutlining

3. The toolbar provides [Undo], [Redo], [Cut], [Copy], [Paste], [Toggle Bookmark], [Next
Bookmark], [Previous Bookmark] and [Clear All Bookmarks] buttons.

A% AR

4. Any modification will enable the [Undo] function. [Redo] function will be enabled after

the undo action is used. To perform the undo/redo, right click to select the item or use the

keyboard shortcuts. (Undo: Ctrl+Z, Redo: Ctrl+Y).

L—| WE!NTEK

Work Space
MicroID: O Macro name :  maoo_0

Perindical execution

o] AR

Select A1l

Toggle Bockmark
Hest Bockmark

* Cick the right mause button to dispy

GET/SET Fi... Compie

Securty

ez

ShiteF2

Work Space

Maco D : 0 Macro name :  macro_0

20 AR

GET/SET Fll... Canpie

Securty
Use execution candtion

Execute ane time when HMI starts
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5.

performed, [Paste] function is enabled.

Sl s L R

macro command main()

ST

Unda
Redo

Cut
Copy
Paste

Select All

Toggle Bookmark
Mext Bookmark
Previous Bookmark

Clear All Bockmarks

Toggle All Qutlining
Update All Outlining

Ctrl+Z
Ctrl+Y

Ctrl+X
Ctrl+C
Ctrl+V

Ctrl+ A

Ctrl+F2
F2
Shft+F2

abc abc

macro_command main ()

Select a word in the editor to enable the [Cut] and [Copy] function. After [Cut] or [Copy] is

Sl N B b R

end macr

™

Undo

Redo

Cut
Copy
Paste
Select All

Toggle Bookmark
MNext Bookmark
Previous Bookmark

Clear All Bockmarks

Toggle All Outlining
Update All Qutlining

Ctrl+Z
Cirl+Y

Ctrl+X
Ctrl+C
Ctri+V

Ctrl+A

Ctrl+F2
F2
Shft+F2

6. Use [Select All] to include all the content in the edit area.

o slm g b G b E

end macro command

m,

Undo

Redo

Cut

Copy

Paste

Select All

Toggle Bookmark
Next Bookmark
Previous Bookmark

Clear All Bookmarks

Teggle All Outlining
Update All Qutlining

Ctrl+Z
Ctrl+Y

Ctrl+X
Ctrl+C
Ctrl+V

Crl+A

Ctrl+F2
F2
Shft+F2

7. If the macro is too long, use bookmarks to manage and read the code with ease. The

following illustration shows how it works.

® Move your cursor to the position in the edit area where to insert a bookmark. Right click,

select [Toggle Bookmark]. There will be a blue little square that represents a bookmark on

the left hand side of edit area.

I__| WE!NTEK

macro command main()

2

4 bool a
5 short b
g end mac

4 |

* Click the right mouse

Undo

Redo

Cut
Copy
Paste

Select All

Toggle Bookmark
MNext Beokmark
Previous Bookmark

Clear All Bookmarks

Toggle All Qutlining
Update All Qutlining

Ctrl+Z
Ctrl+Y

Ctrl+X
Ctrl+C
Crl+V

Ctrl+A

Ctrl+F2
F2
Shft+F2
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® If thereis already a bookmark where the cursor is placed, select [Toggle Bookmark] to

close it, otherwise to open it.

® Right click and select [Next Bookmark], the cursor will move to where the next bookmark

locates. Selecting [Previous Bookmark] will move the cursor to the previous bookmark.

Work Space (==
Security
MacoID: 0 Macro name ;- macro_0 [“Juse execution condition
[Cperiodical execution [/ Execute one time when HMI starts
2 4% % %
2 macro_command main()
4 ©bool a
5 short b
[ & dnte E
[J 168 for b=0 to 31
11 | SetData(b, "Local HMI", LW, 0, 1)
12 L next
14
15
[J 16 sSetData(e, "Local EMI", LW, 100, 1)
end macro_command
« [ r
* Click the right mouse button to display edit menu.
GET/SETFN... | [  Compie | Exit ] | Help

® Selecting [Clear All Bookmarks] will delete all bookmarks.

8. Macro editor provides outlining (or code-folding). Outlining will hide macro codes that

belong to the same block, and display them as ™ |-

-\ There will be a tree diagram on the

left hand side of edit area. Click = to hide the block or to open, as shown in the

following figure.

Work Space
MacroID : 0 Macro name @ macro_0
[7] Periodical execution
o,
=) A%
2 macro_command main()
4 bool a
5 short b
£; int ¢
8 for b=0 to 31
o | SetData(b, "Local EMI", LW, 0, 1)
10; next
12i SetData(c, "Local EMI", LW, 100, 1)

14 end macro command

4 [

Work Space
MacroID : 0 Macro name :  macro_0

[7] periodical execution

=) AT % %
; macro_command main ()
: bool a
5 short b
&; int ¢
:
i; SecData(c, "Local HMI LW, 1 1)
:: end macro_command

4 [m

* Click the right mouse button to display edit menu.

* Click the right mouse button to display edit menu.

GET/SET AN.. | |  Comple

GET/SET FN... | [ Compie

L—| WE!NTEK
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9. Right click to select [Toggle All Outlining] to open all folded macro code blocks.

2 macro_command main()

4 bool a

5i short b

&; int ¢

B for b=0 to 31

= SetData(b, "Local HMI",
10; next

12 SetData(c, "Local HMI",

14 end macro command

T

ck the right mouse button to display edit menu.

2

4 bocl a

5 short b

6, int c

L

; & Undo Ctrl+Z

:; SetData(c, "Local HY Redo Ctrl+Y

14 end macro_command e Ea
Copy Ctrl+C
Paste Ctrl+V
Select All Ctrl+A
Toggle Bookmark Ctrl+F2
Next Bookmark F2
Previous Bookmark Shft+F2

1

% the right mouse button to display

macro_command main ()

Clear All Bockmarks

Toggle All Outlining &
Update All Qutlining

10. Sometimes the outlining might be incorrect since that the keywords are misjudged as

shown in the following figure. To solve this problem, right click and select [Update All

Outlining].

if 1 then

A R
—

'

H

'

o

i

v

H

m

end macro command

macro_command main()

Undo

Redo

Cut
Copy
Paste

Select All

Teoggle Bookmark
Mext Bookmark
Previous Bookmark

Clear All Bookmarks

Toggle All Outlining
Update All Outlining

Ctrl+Z
Ctrl+Y
Ctrl+X
Ctrl+C
Ctrl+V
Ctrl+A
Ctrl+F2

F2
Shft+F2

e T

macro_ command main ()

if 1 then

end macro_ command

11. The statements enclosed in the following keywords are called a “block” of the macro

code:

® Function block: sub —end sub

® |terative statements:
i for — next
ii. while —wend

® logical statements:
i if —end if

® Selective statements: select case — end select

12. The macro editor is not a monopoly window. Returning to the main screen and editing the

project with the Work Space window open is allowed.

GET/SET FM...

L—| WE!NTEK

Save & Compile

| Off-line Simulation

0On-line Simulation I Exit Help

EasyBuilder Pro V5.05.02
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13. The macro editor provides Find and Replace features.

DC BB ARAA[W |
E>

2 macro_command main()

Replace with : Replace & Find Replace Al
4 short h,i,3,%=0,m=0,n=0

5 [IMatch case [IMatch whole word

6 O for b=0 to 10

7| kel

s | SetData(k, "Local EMI", LN, 14, 1)

14. When [Periodical execution] is checked, this macro will be triggered periodically.

[¥] Periodical execution Time interval (0 ~86400) : 10 second(s)

15. Select [Security] » [Use execution condition] » [Settings] to enable security settings:
® [Disable when Bit is ON]: When Bit is ON, this macro is disabled.
® [Disable when Bit is OFF]: When Bit is OFF, this macro is disabled.

Security
lUse execution condition
’Securi'ty

(") Disable when Bit is OFF

PLC name : | Local HMI
Address @ | LB v] 0
[ QK ] [ Cancel ]

16. Select [Execute one time when HMI starts], this macro will be executed once when HMI
starts up.

18.3. Configuration
A macro contains statements. The statements contain constants, variables and operations. The

statements are put in a specific order to create the desired output.

A macro has the following structure:
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Global Variable Declaration Optional

Sub Function Block Declarations Optional
Local Variable Declarations
End Sub

macro_command main() Required
Local Variable Declarations
[Statements]

end macro_command Required

Macro must have one and only one main function which is the execution start point of macro.
The format is:

macro_command main()
end macro_command

Local variables are used within the main macro function or in a defined function block. Its
value remains valid only within the specific block.

Global variables are declared before any function blocks and are valid for all functions in the
macro. When local variables and global variables have the same declaration of name, only the

local variables are valid.

The following example shows a simple macro which includes a variable declaration and a
function call.
macro_command main()
short pressure = 10 // local variable declaration
SetData(pressure, "Allen-Bradley DF1",N7,0,1) // function calling

end macro_command

18.4. Syntax

18.4.1. Constants and Variables
18.4.1.1. Constants

Constants are fixed values and can be directly written into statements. The formats are:
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Constant Type Note Example
Decimal integer 345, -234, 0, 23456
Hexadecimal Must begin with 0x 0x3b, Oxffff, 0x237
ASCII Single character must be enclosed in single ‘a’, "data", "name"
quotation marks and a string (group of
characters) must be enclosed by double
guotation marks.
Boolean true, false

Here is an example using constants:

macro_command main()

short A, B // A and B are variables
A=1234
B =0x12 // 1234 and 0x12 are constants

end macro_command

18.4.1.2. Variables

Variables are names that represent information. The information can be changed as the

variable is modified by statements.

Naming Rules for Variables

® Avariable name must start with an alphabet.

® Variable names longer than 32 characters are not allowed.

® Reserved words cannot be used as variable names.

There are 8 different Variable types, 5 for signed data types and 3 for unsigned data types:

Variable Type Description Range

bool (boolean) 1 bit (discrete) 0,1

char (character) 8 bits (byte) +127 to -128

short (short integer) 16 bits (word) +32767 to -32768

int (integer) 32 bits (double word) +2147483647t0 -2147483648
float (floating point) 32 bits (double word)

unsigned char 8 bits (byte) 0 to 255

unsigned short 16 bits (word) 0to 65535

unsigned int

32 bits (double word) 0 to 4,294,967,295

Declaring Variables

Variables must be declared before being used. To declare a variable, specify the type before

the variable name.

I__| WE!NTEK
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Example:

int a

short b, switch
float pressure

unsigned short ¢
Declaring Arrays

Macros support one-dimensional arrays (zero-based index). To declare an array of variables,
specify the type and the variable name followed by the number of variables in the array
enclosed in brackets “[]”. The length of an array could be 1 to 4096. (Macros only support at

most 4096 variables per macro).

Example:

int a[10]

short b[20], switch[30]
float pressure[15]

The minimum array index is 0 and the maximum is (array size — 1).

Example:

char data [100] // arraysizeis 100

In this case, the minimum of array index is 0 and maximum of array index is 99 (=100-1)

Variable and Array Initialization

There are two ways variables can be initialized:
® By statement using the assignment operator (=)
Example:
inta
float b[3]
a=10
b[0]=1
® During declaration
chara=‘5,b=9
The declaration of arrays is a special case. The entire array can be initialized during declaration
by enclosing comma separated values inside curly brackets “{}".
Example:
float data[4] = {11, 22, 33, 44} //now data[0] is 11, data[1] is 22....

18.4.2. Operators

Operators are used to designate how data is manipulated and calculated.
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Operator Description Example

= Assignment operator pressure =10
Arithmetic Operators Description Example

+ Addition A=B+C

- Subtraction A=B-C

* Multiplication A=B*C

/ Division A=B/C

% Modulo division (return A=B %5

remainder)

By default, integer numbers (1, 2,3..etc) are considered having integer data type; therefore,
when division is carried out involving two integer numbers where the result should have
decimal point, the decimal part will be removed. To avoid this, add .0 (1.0, 2.0, 3.0...etc) behind
the dividend or the divisor to turn it into a floating point number calculation.

Examples:

A=3/2=1 » 3 and 2 are both integers; therefore the result is an integer.
B=3/2.0=15 » 3isaninteger whereas 2.0 is a floating point number, therefore the
result is a floating point number.

C=3.0/2=1.5 » 3.0is afloating point number whereas 2 is an integer, therefore the
result is a floating point number.

Comparison Operators Description Example
< Less than if A<10thenB=5
<= Less than or equal to if A<=10thenB=5
> Greater than if A>10thenB=5
>= Greater thanorequalto ifA>=10thenB=5
== Equal to if A==10thenB =5
<> Not equal to if A<>10thenB=5
Logic Operators Description Example
and Logical AND if A< 10 and B>5thenC=10
or Logical OR if A>=10or B>5thenC=10
xor Logical Exclusive OR if A xor 256 thenB =5
not Logical NOT if not AthenB=5

Shift and bitwise operators are used to manipulate bits of signed/unsigned character and
integer variables. The priority of these operators is from left to right within the statement.

Shift Operators Description Example

<< Shifts the bits in a bitset to A=B<<8
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the left a specified number

of positions
>> Shifts the bits in a bitset to A=B>>8
the right a specified number
of positions
Bitwise Operators Description Example

& Bitwise AND A =B & Oxf

| Bitwise OR A=B|C

A Bitwise XOR A=BA"C

~ One’s complement A="~B

Priority of All Operators

The overall priority of all operations from highest to lowest is as follows:
Operations within parenthesis are carried out first

Arithmetic operations

Shift and Bitwise operations

Comparison operations

Logic operations

o u A wN R

Assignment
Reserved Keywords

The following keywords are reserved for system. These keywords cannot be used as variable,

array, or function names.

+, -, %/, %, >=,>,<=, <, <> ==, and, or, xor, not, <<, >>,=, &, |, A, ~

exit, macro_command, for, to, down, step, next, return, bool, short, int, char, float, void, if,
then, else, break, continue, set, sub, end, while, wend, true, false

SQRT, CUBERT, LOG, LOG10, SIN, COS, TAN, COT, SEC, CSC, ASIN, ACOS, ATAN, BIN2BCD,
BCD2BIN, DEC2ASCII, FLOAT2ASCII, HEX2ASCII, ASCII2DEC, ASCII2FLOAT, ASCII2HEX, FILL, RAND,
DELAY, SWAPB, SWAPW, LOBYTE, HIBYTE, LOWORD, HIWORD, GETBIT, SETBITON, SETBITOFF,
INVBIT, ADDSUM, XORSUM, CRC, INPORT, OUTPORT, POW, GetError, GetData, GetDataEx,
SetData, SetDataEx, SetRTS, GetCTS, Beep, SYNC_TRIG_MACRO, ASYNC_TRIG_MACRO, TRACE,
FindDataSamplingDate, FindDataSamplingindex, FindEventLogDate, FindEventLogIndex
StringGet, StringGetEx, StringSet, StringSetEx, StringCopy, StringMid, StringDecAsc2Bin,
StringBin2DecAsc, StringDecAsc2Float, StringFloat2DecAsc, StringHexAsc2Bin,
StringBin2HexAsc, StringLength, StringCat, StringCompare, StringCompareNoCase, StringFind,
StringReverseFind, StringFindOneOf, Stringincluding, StringExcluding, StringToUpper,
StringToLower, StringToReverse, StringTrimLeft, StringTrimRight, Stringlnsert, String2Unicode
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18.5. Statement

18.5.1. Definition Statement

This covers the declaration of variables and arrays. The formal construction is as follows:

type name

This defines a variable with name as “name” and type as “type”.

Example:
int A // define a variable A as an integer
type name[constant]

This defines an array variable called “name” with size as “constant” and type as “type”.
Example:

int B[10] // where define a variable B as a one-dimensional array of size 10

18.5.2. Assignment Statement

Assignment statements use the assignment operator to move data from the expression on the
right side of the operator to the variable on the left side. An expression is the combination of
variables, constants and operators to yield a value.

VariableName Expression
Example
A=2 where a variable A is assigned to 2

18.5.3. Logical Statements

Logical statements perform actions depending on the condition of a boolean expression.
The syntax is as follows:

Single-Line Format

If <Condition> then
[Statements]
else
[Statements]
end if
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Example:
if a==2then
b=1
else
b=2
end if

Block Format

18-14

If <Condition> then
[Statements]

else if <Condition-n> then

[Statements]
else
[Statements]
end if
Example:
if a==2then
b=1
else if a == 3 then
b=2
else
b=3
end if

Syntax description

if

Must be used to begin the statement.

<Condition> Required. This is the controlling statement. It is FALSE when the
<Condition> evaluates to 0 and TRUE when it evaluates to non- zero.

then Must precede the statements to execute if the <Condition> evaluates to
TRUE.

[Statements] It is optional in block format but necessary in single-line format without
else. The statement will be executed when the <Condition> is TRUE.

else if Optional. The else if statement will be executed when the relative

<Condition-n>is TRUE.

<Condition-n>

Optional. see <Condition>

else Optional. The else statement will be executed when <Condition> and
<Condition-n> are both FALSE.
end if Must be used to end an if-then statement.

I__| WE!NTEK
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18.5.4. Selective Statements

The select-case construction can be used like multiple if-else statements and perform selected
actions depending on the value of the given variable. When the matched value is found, all the
actions below will be executed until a break statement is met. The syntax is as follows:

Format without a Default Case

Select Case [variable]

Case [value]
[Statements]
break

end Select

Example:
Select Case A
Case 1
b=1
break
end Select

Format with a Default Case (Case else)

Select Case [variable]
Case [value]
[Statements]
break
Case else
[Statements]
break

end Select

Example:

Select Case A

Case 1
b=1

break
Case else
b=0

break

end Select
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Multiple cases in the same block

Select Case [variable]

Case [valuel]
[Statements]

Case [value?]
[Statements]
break

end Select

Example:
Select Case A
Case 1
break
Case 2
b=2
break
Case 3
b=3
break

end Select

Syntax description

Select Case Must be used to begin the statement.

[variable] Required. The value of this variable will be compared to the value of
each case.

Case else Optional. It represents the default case. If none of the cases above are

matched, the statements under default case will be executed. When a
default case is absent, it will skip directly to the end of the select-case
statements if there is no matched case.
break Optional. The statements under the matched case will be executed until
the break command is reached. If a break command is absent, it simply
keeps on executing next statement until the end command is reached.
end Select Indicates the end of the select-case statements.

18.5.5. Iterative Statements

Iterative statements control loops and repetitive tasks depending on condition. There are two

types of iterative statements.
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18.5.5.1. for-next Statements

The for-next statement runs for a fixed number of iterations. A variable is used as a counter to
track the progress and test for ending conditions. Use this for fixed execution counts. The
syntax is as follows:

[Statements]
next [Counter]

for [Conunter] = <StartValue> to <EndValue> [step <StepValue>]

Or

[Statements]
next [Counter]

for [Conunter] = <StartValue> to <EndValue> [step <StepValue>]

Example:

fora=0to 10 step 2

b=a

next a

Syntax description

for

Must be used to begin the statement

[Counter]

Required. This is the controlling statement. The result of evaluating the
variable is used as a test of comparison.

<StartValue>

Required. The initial value of [Counter]

to/down

Required. This determines if the <step> increments or decrements the
<Counter>.

“to” increments <Counter> by <StepValue>.

“down” decrements <Counter> by <StepValue>.

<EndValue>

Required. The test point. If the <Counter> is greater than this value, the
macro exits the loop.

step

Optional. Specifies that a <StepValue> other than one is to be used.

[StepValue]

Optional. The increment/decrement step of <Counter>. It can be
omitted when the value is 1 If [step <StepValue>] are omitted the step
value defaults to 1.

[Statements] Optional. Statements to execute when the evaluation is TRUE.
“for-next” loops may be nested.

next Required.

[Counter] Optional. This is used when nesting for-next loops.
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18.5.5.2. while-wend Statements

The while-wend statement runs for an unknown number of iterations. A variable is used to test
for ending conditions. When the condition is TRUE, the statements inside are executed
repetitively until the condition becomes FALSE. The syntax is as follows.

while <Condition>
[Statements]

wend

Example:
while a< 10
a=a+10
wend
Syntax description

while Must be used to begin the statement.

continue Required. This is the controlling statement. When it is TRUE, the loop
begins execution. When it is FALSE, the loop terminates.

return [value] Statements to execute when the evaluation is TRUE.

wend Indicates the end of the while-end statements.

18.5.5.3. Other Control Commands

break Used in for-next and while-wend. It skips immediately to the end of the
iterative statement.
continue Used in for-next and while-wend. It ends the current iteration of a loop

and starts the next one.

return The return command inside the main block can force the macro to stop
anywhere. It skips immediately to the end of the main block.

18.6. Function Blocks

Function blocks are useful for reducing repetitive codes. It must be defined before use and
supports any variable and statement type. A function block could be called by putting its name
followed by parameters in parenthesis. After the function block is executed, it returns the value
to the caller function where it is used as an assignment value or as a condition. A return type is
not required in function definition, which means that a function block does not have to return
a value. The parameters can also be ignored in function definition while the function has no
need to take any parameters from the caller. The syntax is as follows:

Function definition with return type
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sub type <name> [(parameters)]
Local variable declarations
[Statements]
[return [value]]

end sub

Example:
sub int Add(int x, int y)
int result
result = x +y
return result

end sub

macro_command main()
inta=10, b =20, sum
sum = Add(a, b)

end macro_command

or:
sub int Add()
int result, x=10, y=20
result = x +y
return result
end sub

macro_command main()
int  sum
sum = Add()

end macro_command

Function definition without return type

sub <name> [(parameters)]
Local variable declarations

[Statements]

end sub

Example:
sub Add(int x, int y)
int result

result = x +y
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end sub

macro_command main()
int a=10,b=20

Add(a, b)

end macro_command

or:
sub Add()

int result, x=10, y=20

result = x +y

end sub

macro_command main()

Add()

end macro_command

Syntax description

18-20

sub Must be used to begin the function block

type Optional. This is the data type of value that the function returns. A
function block is not always necessary to return a value.

(parameters) Optional. The parameters hold values that are passed to the function.

The passed parameters must have their type declared in the parameter
field and assigned a variable name.

For example: sub int MyFunction(int x, int y). x and y would be integers
passed to the function. This function is called by a statement that looks
similar to this: ret = MyFunction(456, pressure) where “pressure” must
be integer according to the definition of function.

Notice that the calling statement can pass hard coded values or
variables to the function. After this function is executed, an integer
values is return to ‘ret’.

Local variable

Variables that are used in the function block must be declared first.
This is in addition to passed parameters. In the above example x and y

declaration
are variables that the function can used. Global variables are also
available for use in function block.

[Statements] Statements to execute

[return [value]]

Optional. Used to return a value to the calling statement. The value can
be a constant or a variable. Return also ends function block execution.
A function block is not always necessary to return a value, but, when
the return type is defined in the beginning of the definition of function,
the return command is needed.

end sub

Must be used to end a function block.
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18.7. Built-In Function Block

EasyBuilder Pro has many built-in functions for retrieving and transferring data to the PLC, data

management and mathematical functions.

18.7.1. Mathematical Functions

Name

SQRT

Syntax

SQRT(source, result)

Description

Calculate the square root of source and store the result into result.

source can be a constant or a variable. result must be a variable.
source must be a nonnegative value.

Example

macro_command main()
float source, result

SQRT(15, result)

source =9.0
SQRT(source, result)// resultis 3.0

end macro_command

Name

CUBERT

Syntax

CUBERT(source, result)

Description

Calculate the cube root of source and store the result into result.
source can be a constant or a variable. result must be a variable.
source must be a nonnegative value.

Example

macro_command main()
float source, result

CUBERT (27, result) // result is 3.0

source =27.0
CUBERT(source, result)// resultis 3.0

end macro_command

Name

POW

Syntax

POW(sourcel, source2, result)

Description

Calculate sourcel to the power of source?2.

sourcel and source2 can be a constant or a variable.
result must be a variable.

sourcel and source2 must be a nonnegative value.

L—| WE!NTEK

EasyBuilder Pro V5.05.02



Macro Reference

18-22

Example

macro_command main()

float y, result

y=0.5

POW (25, y, result) // result =5
end macro_command

Name

SIN

Syntax

SIN(source, result)

Description

Calculate the sine of source (degree) into result.

source can be a constant or a variable. result must be a variable.

Example

macro_command main()
float source, result

SIN(90, result)// resultis 1

source = 30
SIN(source, result)// resultis 0.5

end macro_command

Name

COsS

Syntax

COS(source, result)

Description

Calculate the cosine of source (degree) into result.

source can be a constant or a variable. result must be a variable.

Example

macro_command main()
float source, result

COS(90, result)// resultis0
source = 60
GetData(source, "Local HMI", LW, 0, 1)

COS(source, result)// resultis 0.5

end macro_command

Name

TAN

Syntax

TAN(source, result)

Description

Calculate the tangent of source (degree) into result.

source can be a constant or a variable. result must be a variable.

Example

macro_command main()
float source, result

TAN(45, result)// resultis 1
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source = 60
TAN(source, result)// resultis 1.732

end macro_command
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Name CcoT
Syntax COT(source, result)
Description | Calculate the cotangent of source (degree) into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()
float source, result
COT(45, result)// resultis 1
source = 60
COT(source, result)// resultis 0.5774
end macro_command
Name SEC
Syntax SEC(source, result)
Description | Calculate the secant of source (degree) into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()
float source, result
SEC(45, result)// resultis 1.414
source = 60
SEC(source, result)// if source is 60, result is 2
end macro_command
Name CSC
Syntax CSC(source, result)
Description | Calculate the cosecant of source (degree) into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()

float source, result
CSC(45, result)// resultis 1.414

source = 30
CSC(source, result)// resultis 2

end macro_command
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Name ASIN
Syntax ASIN(source, result)
Description | Calculate the arc sine of source into result (degree).
source can be a constant or a variable. result must be a variable.
Example macro_command main()
float source, result
ASIN(0.8660, result)// result is 60
source = 0.5
ASIN(source, result)// resultis 30
end macro_command
Name ACOS
Syntax ACOS(source, result)
Description | Calculate the arc cosine of source into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()
float source, result
ACOS(0.8660, result)// resultis 30
source =0.5
ACOS(source, result)// result is 60
end macro_command
Name ATAN
Syntax ATAN(source, result)
Description | Calculate the arc tangent of source into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()

float source, result
ATAN(1, result)// resultis 45

source =1.732
ATAN(source, result)// result is 60

end macro_command
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Name LOG
Syntax LOG (source, result)
Description | Calculates the natural logarithm of a number.
source can be either a variable or a constant. result must be a variable.
Example macro_command main()
float source = 100, result
LOG (source, result)// result is approximately 4.6052
end macro_command
Name LOG10
Syntax LOG10(source, result)
Description | Calculates the base-10 logarithm of a number.
source can be either a variable or a constant. result must be a variable.
Example macro_command main()
float source = 100, result
LOG10 (source, result) // result is 2
end macro_command
Name RAND
Syntax RAND(result)
Description | Calculates a random integer and save into result.
result must be a variable.
Example macro_command main()

short result
RAND (result) //result is not a fixed value when executes macro every time

end macro_command
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Name

BIN2BCD

Syntax

BIN2BCD(source, result)

Description

Transforms a binary-type value (source) into a BCD-type value (result).
source can be a constant or a variable. result must be a variable.

Example

macro_command main()
short source, result
BIN2BCD(1234, result)// result is 0x1234

source = 5678

BIN2BCD(source, result)// result is 0x5678

end macro_command

Name

BCD2BIN

Syntax

BCD2BIN(source, result)

Description

Transforms a BCD-type value (source) into a binary-type value (result).
source can be a constant or a variable. result must be a variable.

Example

macro_command main()
short source, result
BCD2BIN(0x1234, result)// resultis 1234

source = 0x5678

BCD2BIN(source, result)// resultis 5678

end macro_command

Name

DEC2ASCII

Syntax

DEC2ASClI(source, result[start], len)

Description

Transforms a decimal value (source) into an ASCII string and save it to an array
(result).

len represents the length of the string and the unit of length depends on
result’s type., i.e. if result’s type is “char” (the size is byte), the length of the
string is (byte * len). If result’s type is “short” (the size is word), the length of
the string is (word * /en), and so on.

The first character is put into result[start], the second character is put into
result[start + 1], and the last character is put into result[start + (len -1)].
source and len can be a constant or a variable. result must be a variable. start
must be a constant.

Example

macro_command main()
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short source
char result1[4]
short result2[4]
char result3[6]
source = 5678

DEC2ASClI(source, result1[0], 4)

// resultl[0] is '5', result1[1] is '6', result1[2] is '7', result1[3] is '8'
// the length of the string (resultl) is 4 bytes( =1 * 4)
DEC2ASCII(source, result2[0], 4)

// result2[0] is '5', result2[1] is '6', result2[2] is '7', result2[3] is '8'
// the length of the string (result2) is 8 bytes( =2 * 4)

source=-123

DEC2ASClI(source3, result3[0], 6)

// result1[0] is '-', result1[1] is '0', result1[2] is '0', result1[3] is '1'
// resultl[4] is '2', result1[5] is '3

// the length of the string (resultl) is 6 bytes( =1 * 6)

end macro_command

Name

HEX2ASCII

Syntax

HEX2ASClI(source, result[start], len)

Description

Transforms a hexadecimal value (source) into ASCII string saved to an array
(result).

len represents the length of the string and the unit of length depends on
result’s type., i.e. if result’s type is “char” (the size is byte), the length of the
string is (byte * len). If result’s type is “short” (the size is word), the length of
the string is (word * /en), and so on.

source and len can be a constant or a variable. result must be a variable. start
must be a constant.

Example

macro_command main()
short source
char result[4]

source = 0x5678
HEX2ASCII (source, result[0], 4)
// result[0] is'5', result[1] is '6', result[2] is '7', result[3] is '8

end macro_command
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Name

FLOAT2ASCII

Syntax

FLOAT2ASClI(source, result[start], len)

Description

Transforms a floating value (source) into ASCII string saved to an array (result).

len represents the length of the string and the unit of length depends on
result’s type., i.e. if result’s type is “char” (the size is byte), the length of the
string is (byte * len). If result’s type is “short” (the size is word), the length of
the string is (word * len), and so on.

source and len can be a constant or a variable. result must be a variable. start
must be a constant.

Example

macro_command main()
float source
char result[4]

source = 56.8
FLOAT2ASCII (source, result[0], 4)
// result[0] is'5', result[1] is '6', result[2] is'.!, result[3] is '8’

end macro_command

Name

ASCII2DEC

Syntax

ASCII2DEC(source[start], result, len)

Description

Transforms a string (source) into a decimal value saved to a variable (result).
The length of the string is len. The first character of the string is source[start].
source and len can be a constant or a variable. result must be a variable. start
must be a constant.

Example

macro_command main()
char source[4]
short result

source[0] ='5'
source[1] ='6'
source[2] ='7'
source[3] ='8'

ASCII2DEC(source[0], result, 4) // result is 5678

end macro_command
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Name

ASCII2HEX

Syntax

ASCII2HEX (source[start], result, len)

Description

Transforms a string (source) into a hexadecimal value saved to a variable
(result).

The length of the string is len. The first character of the string is source[start].
source and len can be a constant or a variable. result must be a variable. start
must be a constant.

Example

macro_command main()
char source[4]
short result

source[0] ='5'
source[1] ='6'
source[2] ='7"
source[3] ='8'

ASCII2HEX (source[0], result, 4) // result is 0x5678

end macro_command

Name

ASCII2FLOAT

Syntax

ASCII2FLOAT (source[start], result, len)

Description

Transforms a string (source) into a float value saved to a variable (result).

The length of the string is len. The first character of the string is source[start].
source and len can be a constant or a variable. result must be a variable. start
must be a constant.

Example

macro_command main()
char source[4]
float result

source[0] ='5'
source[1] ='6'
source[2] ="'
source[3] ='8'

ASCII2FLOAT (source[0], result, 4) // result is 56.8

end macro_command
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18.7.3. Data Manipulation
Name FILL
Syntax FILL(source[start], preset, count)
Description | Sets the first count elements of an array (source) to a specified value (preset).
source and start must be a variable, and preset can be a constant or variable.
Example macro_command main()
char result[4]
char preset
FILL(result[0], 0x30, 4)
// result[0] is 0x30, result[1] is 0x30, , result[2] is 0x30, , result[3] is 0x30
preset =0x31
FILL(result[0], preset, 2) // result[0] is Ox31, result[1] is Ox31
end macro_command
Name SWAPB
Syntax SWAPB(source, result)
Description | Exchanges the high-byte and low-byte data of a 16-bit source into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()
short source, result
SWAPB(0x5678, result)// result is 0x7856
source = 0x123
SWAPB(source, result)//  result is 0x2301
end macro_command
Name SWAPW
Syntax SWAPW(source, result)
Description | Exchanges the high-word and low-word data of a 32-bit source into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()

int source, result
SWAPW (0x12345678, result)// result is 0x56781234

source = 0x12345

SWAPW (source, result)//  result is 0x23450001

end macro_command
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Name LOBYTE
Syntax LOBYTE(source, result)
Description | Retrieves the low byte of a 16-bit source into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()
short source, result
LOBYTE(0x1234, result)// result is 0x34
source = 0x123
LOBYTE(source, result)//  result is 0x23
end macro_command
Name HIBYTE
Syntax HIBYTE(source, result)
Description | Retrieves the high byte of a 16-bit source into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()
short source, result
HIBYTE(Ox1234, result)// resultis 0x12
source = 0x123
HIBYTE(source, result)//  result is 0x01
end macro_command
Name LOWORD
Syntax LOWORD(source, result)
Description | Retrieves the low word of a 32-bit source into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()

int source, result
LOWORD(0x12345678, result)// result is 0x5678

source = 0x12345
LOWORD(source, result)//  result is 0x2345

end macro_command
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Name HIWORD
Syntax HIWORD(source, result)
Description | Retrieves the high word of a 32-bit source into result.
source can be a constant or a variable. result must be a variable.
Example macro_command main()

int source, result
HIWORD(0x12345678, result)// result is 0x1234

source = 0x12345
HIWORD(source, result)//  result is 0x0001

end macro_command

18.7.4. Bit Transformation

Name GETBIT

Syntax GETBIT(source, result, bit_pos)

Description | Gets the state of designated bit position of a data (source) into result.
result value will be 0 or 1.
source and bit_pos can be a constant or a variable.
result must be a variable.

Example macro_command main()

int source, result
short bit_pos

GETBIT(9, result, 3)// resultis1
source =4
bit_pos =2

GETBIT(source, result, bit_pos)// resultis 1

end macro_command
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Name

SETBITON

Syntax

SETBITON(source, result, bit_pos)

Description

Changes the state of designated bit position of a data (source) to 1, and put
changed data into result.

source and bit_pos can be a constant or a variable.

result must be a variable.

Example

macro_command main()
int source, result
short bit_pos

SETBITON(1, result, 3)// resultis9

source =0

bit_pos =2

SETBITON (source, result, bit_pos)// resultis 4

end macro_command

Name

SETBITOFF

Syntax

SETBITOFF(source, result, bit_pos)

Description

Changes the state of designated bit position of a data (source) to 0, and put in
changed data into result.

source and bit_pos can be a constant or a variable.

result must be a variable.

Example

macro_command main()
int source, result
short bit_pos

SETBITOFF(9, result, 3)// resultis 1
source =4
bit_pos =2

SETBITOFF(source, result, bit_pos)// resultis 0

end macro_command
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Name INVBIT
Syntax INVBIT(source, result, bit_pos)
Description | Inverts the state of designated bit position of a data (source), and put changed
data into result.
source and bit_pos can be a constant or a variable. result must be a variable.
Example macro_command main()

int source, result
short bit_pos

INVBIT(4, result, 1)// result=6
source =6
bit_ pos=1

INVBIT(source, result, bit_pos)// result=4

end macro_command

18.7.5. Communication

Name DELAY

Syntax DELAY(time)

Description | Suspends the execution of the current macro for at least the specified interval
(time). The unit of time is millisecond.
time can be a constant or a variable.

Example macro_command main()

int time == 500

DELAY(100)// delay 100 ms
DELAY(time)// delay 500 ms

end macro_command
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Name

ADDSUM

Syntax

ADDSUM(source([start), result, data_count)

Description

Adds up the elements of an array (source) from source[start] to source[start +
data_count - 1] to generate a checksum. Puts in the checksum into result.
result must be a variable. data_count is the amount of the accumulated
elements and can be a constant or a variable.

Example

macro_command main()
char datal5]
short checksum

data[0] = Ox1
data[1] = Ox2
data[2] = 0x3
data[3] = 0x4
data[4] = Ox5

ADDSUM(data[0], checksum, 5)// checksum is Oxf

end macro_command

Name

XORSUM

Syntax

XORSUM(sourcel[start], result, data_count)

Description

Uses an exclusion method to calculate the checksum from source[start] to
source[start + data_count - 1]. Puts the checksum into result. result must be a
variable. data_count is the amount of the calculated elements of the array and
can be a constant or a variable.

Example macro_command main()
char data[5] = {Ox1, 0x2, 0x3, 0x4, 0x5}
short checksum
XORSUM(data[0], checksum, 5)// checksum is Ox1
end macro_command

Name BCC

Syntax BCC(source[start], result, data_count)

Description | Uses an XOR method to calculate the checksum from source[start] to
source(start + data_count - 1]. Puts the checksum into result. result must be a
variable. data_count is the amount of the calculated elements of the array and
can be a constant or a variable.

Example macro_command main()

char data[5] = {Ox1, 0x2, 0x3, 0x4, 0x5}
char checksum
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BCC(source[0], checksum, 5)  // checksum is Ox1
end macro_command
Name CRC
Syntax CRC(source[start], result, data_count)
Description | Calculates 16-bit CRC of the variables from source[start] to source[start +
data_count - 1]. Puts in the 16-bit CRC into result. result must be a variable.
data_count is the amount of the calculated elements of the array and can be a
constant or a variable.
Example macro_command main()
char data[5] = {Ox1, 0x2, 0x3, 0x4, Ox5}
short 16bit_CRC
CRC(data[0], 16bit_CRC, 5)// 16bit_CRC is Oxbb2a
end macro_command
Name OUTPORT
Syntax OUTPORT(sourcel[start], device_name, data_count)
Description | Sends out the specified data from source[start] to source[start + count -1] to
PLC via a COM port or the ethernet.
device_name is the name of a device defined in the device table and the device
must be a “Free Protocol”-type device.
data_count is the amount of sent data and can be a constant or a variable.
Example To use an OUTPORT function, a “Free Protocol” device must be created first as

follows:

[l

System Parameter Settings

e-Mail I
Security |

Printer/Backup Server I

| Extended Memory I
General I System Setting |

Device Model I

Recipes
Font

Device list :

M. Mame Location Device type Interface |

Lacal HMI Lacal HMI Local eMT3105 (800 ... - -

3 MODBUS RTU ... Free Protocol | COM 1 (9600,E...[H

The device is named "MODBUS RTU Device”. The port attribute depends on the
setting of this device. (the current setting is “19200,E, 8, 1”)

Below is an example of executing an action of writing single coil (SET ON) to a
MODBUS device.

macro_command main()

char command[32]
short address, checksum
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FILL{command|0], 0, 32)// command initialization

command[0] = 0x1// station no
command[1] =0x5// function code : Write Single Coil

address =0
HIBYTE(address, command[2])
LOBYTE(address, command|[3])

command[4] = 0xff// force bit on
command[5] =0

CRC(command[0], checksum, 6)

LOBYTE(checksum, command[6])
HIBYTE(checksum, command(7])

// send out a “Write Single Coil” command
OUTPORT(command[0], "MODBUS RTU Device", 8)

end macro_command

Name

INPORT

Syntax

INPORT(read_data(start], device_name, read_count, return_value)

Description

Reads data from a COM port or the ethernet. These data is stored to
read_datal[start]~ read_data(start + read_count - 1].

device_name is the name of a device defined in the device table and the device
must be a “Free Protocol”-type device.

read_count is the required amount of reading and can be a constant or a
variable.

If the function is used successfully to get sufficient data, return_value is 1,
otherwise is 0.

Example

Below is an example of executing an action of reading holding registers of a
MODBUS device.

// Read Holding Registers
macro_command main()

char command[32], response[32]

short address, checksum

short read_no, return_value, read_data[2]

FILL(command][0], 0, 32)// command initialization
FILL(response[0], O, 32)
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command[0] = 0x1// station no
command[1] = 0x3// function code : Read Holding Registers

address =0
HIBYTE(address, command|[2])
LOBYTE(address, command[3])

read_no=2// read2 words (4x_1 and 4x_2)
HIBYTE(read_no, command[4])
LOBYTE(read_no, command[5])
CRC(command[0], checksum, 6)

LOBYTE(checksum, command[6])
HIBYTE(checksum, command[7])

// send out a ‘Read Holding Registers” command
OUTPORT(command[0], "MODBUS RTU Device", 8)

// read responses for a ‘Read Holding Registers” command
INPORT(response[0], "MODBUS RTU Device", 9, return_value)

if return_value > 0 then
read_data[0] = response[4] + (response[3] << 8)// datain4x_1
read_data[1] = response[6] + (response[5] << 8)// datain 4x_2

SetData(read_data[0], "Local HMI", LW, 100, 2)
end if

end macro_command

Name INPORT2

Syntax INPORT2(response|[start], device_name, receive_len, wait_time)

Description | Read data from a communication port (COM Port or Ethernet Port). The data
read will be saved in response. The description of device_name is the same as
OUTPORT.
receive_len stores the length of the data received, this must be a variable.
receive_len total length can’t exceed the size of response.
wait_time (in millisecond) can be a constant or variable. After the data is read,
if there's no upcoming data during the designated time interval, the function
returns.

Example macro_command main()

short wResponse[6], receive_len, wait_time=20
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INPORT2(wResponse[0], "Free Protocol", receive_len, wait_time)
// wait_time unit : millisecond
if receive_len > 0 then
SetData(wResponse[0], "Local HMI", LW, O, 6)
// set responses to LWO
end if
end macro_command
Name INPORT3
Syntax INPORT3(response[start], device_name, read_count, receive_len)
Description | Read data from a communication port (COM Port or Ethernet Port). The data
read will be saved in response.
The amount of data to be read can be specified. The data that is not read yet
will be stored in HMI buffer memory for the next read operation, in order to
prevent losing data. The description of device_name is the same as OUTPORT.
read_count stores the length of the data read each time.
receive_len stores the length of the data received, this must be a variable.
receive_len total length can’t exceed the size of response.
Example macro_command main()
short wResponse[6], receive_len
INPORT3(wResponse[0], "Free Protocol", 6, receive_len) // read 6 words
if receive_len >= 6 then
SetData(wResponse[0], "Local HMI", LW, 0, 6) // set responses to LWO
end if
end macro_command
Name GetData
Syntax GetData(read_data(start], device_name, device_type, address_offset,
data_count)
or
GetData(read_data, device_name, device_type, address_offset, 1)
Description | Receives data from the PLC. Data is stored into read_data[start]™
read_data([start + data_count - 1].
data_count is the amount of received data. In general, read_data is an array,
but if data_count is 1, read_data can be an array or an ordinary variable. Below
are two methods to read one word data from PLC.
macro_command main()
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short read_data_1[2], read_data_2
GetData(read_data_1[0], “FATEK KB Series”, RT, 5, 1)
GetData(read_data_2,  “FATEK KB Series”, RT, 5, 1)
end macro_command

Device_name is the PLC name enclosed in the double quotation marks (“) and
this name has been defined in the device list of system parameters as follows
(see FATEK KB Series):

Systermn Parameter Settings @
| Fant I Extended Memory | Printer (Backup Server
Device | Model | General I System Setting I Security
Device list :
Mo, Maime | Location | Device type | Interface
Local HMI Local HMI Local MTELDIH (800 ... |-
Local Server  Free Protocol | Local Free Protocol COM 1 (9600,

Device_type is the device type and encoding method (binary or BCD) of the PLC
data. For example, if device_type is LW_BIN, it means the register is LW and the
encoding method is binary. If use BIN encoding method, “_BIN” can be ignored.
If device_type is LW_BCD, it means the register is LW and the encoding method
is BCD.

Address_offset is the address offset in the PLC.

For example, GetData(read_data_1[0], “FATEK KB Series”, RT, 5, 1) represents
that the address offset is 5.

If address_offset uses the format — “N#AAAAA”, N indicates that PLC’s station
number is N. AAAAA represents the address offset. This format is used while
multiple PLCs or controllers are connected to a single serial port. For example,
GetData(read_data_1[0], “FATEK KB Series”, RT, 2#5, 1) represents that the
PLC’s station number is 2. If GetData() uses the default station number defined
in the device list as follows, it is not necessary to define station number in
address_offset.
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Device Properties

MName : FATEK FB Series

) HMI

Location : | Remote || Setfings ... IP : 192.168.1.10 (Port = 8000)

@ PLC

PLC type : [ FATEK FE Series

)

V.1.80, FATEK_FB.si

PLC IF : [RS—232 =

COM : [COM1 Settings...
PLC default station no. : 2
[Tl Defautt station no. use station no. variable
Interval of block pack (words) : |5 -
Max. read-command size (words) : |64
Max. write-command size (words) : |64
[ oK ] I Cancel I

The number of registers actually read from depends on both the type of the
read_data variable and the value of the number of data_count.

actual number of
type of read_data data_count ] ]
16-bit register read
char (8-bit) 1 1
char (8-bit) 2 1
bool (8-bit) 1 1
bool (8-bit) 2 1
short (16-bit) 1 1
short (16-bit) 2 2
int (32-bit) 1 2
int (32-bit) 2 4
float (32-bit) 1 2
float (32-bit) 2 4

When a GetData() is executed using a 32-bit data type

(int or float), the

function will automatically convert the data. For example,

macro_command main()
float f

GetData(f, "MODBUS", 6x, 2, 1)
end macro_command

// f will contain a floating point value

Example

macro_command main()
bool a
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bool b[30]
short ¢
short d[50]
inte

int f[10]
double g[10]

// get the state of LB2 to the variable a
GetData(a, “Local HMI”, LB, 2, 1)

// get 30 states of LBO ~ LB29 to the variables b[0] ~ b[29]
GetData(b[0], “Local HMI”, LB, 0, 30)

// get one word from LW-2 to the variable c
GetData(c, “Local HMI”, LW, 2, 1)

// get 50 words from LW-0 ~ LW-49 to the variables d[0] ~ d[49]
GetData(d[0], “Local HMI”, LW, 0, 50)

// get 2 words from LW-6 ~ LW-7 to the variable e
// note that the type of e is int
GetData(e, “Local HMI”, LW, 6, 1)

// get 20 words (10 integer values) from LW-0 ~ LW-19 to variables f[0] ~ f[9]
// since each integer value occupies 2 words

GetData(f[0], “Local HMI”, LW, 0, 10)

// get 2 words from LW-2 ~ LW-3 to the variable f
GetData(f, “Local HMI”, LW, 2, 1)

end macro_command

Name GetDataEx
Syntax GetDataEx(read_data([start], device_name, device_type, address_offset,
data_count)
or
GetDataEx(read_data, device_name, device_type, address_offset, 1)
Description | Receives data from the PLC and continue executing next command even if no
response from this device.
Descriptions of read_data, device_name, device_type, address_offset and
data_count are the same as GetData.
Example macro_command main()

bool a
bool b[30]
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short c
short d[50]
inte

int f[10]
double g[10]

// get the state of LB2 to the variable a
GetDataEx (a, “Local HMI”, LB, 2, 1)

// get 30 states of LBO ~ LB29 to the variables b[0] ~ b[29]
GetDataEx (b[0], “Local HMI”, LB, 0, 30)

// get one word from LW-2 to the variable c
GetDataEx (c, “Local HMI”, LW, 2, 1)

// get 50 words from LW-0 ~ LW-49 to the variables d[0] ~ d[49]
GetDataEx (d[0], “Local HMI”, LW, 0, 50)

// get 2 words from LW-6 ~ LW-7 to the variable e
// note that he type of e is int
GetDataEx (e, “Local HMI”, LW, 6, 1)

// get 20 words (10 integer values) from LW-0 ~ LW-19 to f[0] ~ f[9]
// since each integer value occupies 2 words

GetDataEx (f[0], “Local HMI”, LW, 0, 10)

// get 2 words from LW-2 ~ LW-3 to the variable f
GetDataEx (f, “Local HMI”, LW, 2, 1)

end macro_command

Name SetData
Syntax SetData(send_data([start], device_name, device_type, address_offset,
data_count)
or
SetData(send_data, device_name, device_type, address_offset, 1)
Description | Send data to the PLC. Data is defined in send_data[start]~ send_data(start +

data_count - 1].

data_count is the amount of sent data. In general, send_data is an array, but if
data_count is 1, send_data can be an array or an ordinary variable. Below are
two methods to send one word data.

macro_command main()
short send_data_1[2] = {5, 6}, send_data_2 =5
SetData(send_data_1[0], “FATEK KB Series”, RT, 5, 1)
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SetData(send_data_2,  “FATEK KB Series”, RT, 5, 1)
end macro_command

device_name is the PLC name enclosed in the double quotation marks (“) and
this name has been defined in the device list of system parameters.
device_type is the device type and encoding method (binary or BCD) of the PLC
data. For example, if device _type is LW_BIN, it means the register is LW and the
encoding method is binary. If use BIN encoding method, “_BIN” can be ignored.
If device_type is LW_BCD, it means the register is LW and the encoding method
is BCD.

address_offset is the address offset in the PLC.

For example, SetData(read_data_1[0], “FATEK KB Series”, RT, 5, 1) represents
that the address offset is 5.

If address_offset uses the format — “N#AAAAA”, N indicates that PLC’s station
number is N. AAAAA represents the address offset. This format is used while
multiple PLCs or controllers are connected to a single serial port. For example,
SetData(read_data_1[0], “FATEK KB Series”, RT, 2#5, 1) represents that the PLC’s
station number is 2. If SetData () uses the default station number defined in the
device list, it is not necessary to define station number in address_offset.

The number of registers actually sends to depends on both the type of the
send_data variable and the value of the number of data_count.

type of read_data data_count iCGt—ll;?tl peugr.g?eerrsoefn d
char (8-bit) 1 1
char (8-bit) 2 1
bool (8-bit) 1 1
bool (8-bit) 2 1
short (16-bit) 1 1
short (16-bit) 2 2
int (32-bit) 1 2
int (32-bit) 2 4
float (32-bit) 1 2
float (32-bit) 2 4

When a SetData() is executed using a 32-bit data type (int or float), the function
will automatically send int-format or float-format data to the device. For
example,

macro_command main()

floatf=2.6

SetData(f, "MODBUS", 6x, 2, 1)  // will send a floating point value to the
device

end macro_command

Example

macro_command main()
inti
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bool a = true
bool b[30]
short c = false
short d[50]
inte=5

int f[10]

fori=0to 29
b[i] = true
next i

fori=0to 49
dli]=i*2
next i

fori=0to9
fli]=i*3
next i

// set the state of LB2
SetData(a, “Local HMI”, LB, 2, 1)

// setthe states of LBO ~ LB29
SetData(b[0], “Local HMI”, LB, 0, 30)

// setthe value of LW-2
SetData(c, “Local HMI”, LW, 2, 1)

// setthe values of LW-0 ~ LW-49
SetData(d[0], “Local HMI”, LW, 0, 50)

// se